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About this document

Purpose

This document provides the information and procedures necessary to install, self-test and 
turn up the Alcatel-Lucent 1665 Data Multiplexer (Alcatel-Lucent 1665 DMX).

Reason for reissue

This document is being reissued to include information about new features and hardware 
associated with R9.0 including:

• LNW87 Private Line Ethernet circuit pack supports up to four PTM-based FE or GigE 
optical/electrical interfaces. All FE and GigE optical and electrical PTMs currently 
supported by Alcatel-Lucent 1665 DMX are compatible with the LNW87.

• LNW203 OC-12 Main circuit pack supports a single PTM-based OC-12 signal. All 
OC-12 PTMs currently supported by Alcatel-Lucent 1665 DMX are compatible with 
the LNW203.

• LNW504 OC-48/OC-192 VLF Main circuit pack supports four PTM-based OC-48 
signals or four PTM-based OC-192 signals. All OC-48 and OC-192 PTMs currently 
supported by Alcatel-Lucent 1665 DMX are compatible with the LNW504.

• LNW603 OC-192 circuit pack supports a single PTM-based low-speed OC-192 
signal. All OC-192 PTMs currently supported by Alcatel-Lucent 1665 DMX are 
compatible with the LNW603.

• 100BASE-FX-I1 and 100BASE-ZX-I1 FE PTMs support on LNW74 , LNW87, and 
LNW170.

• OC3X12X48-LR1-I1 and OC3X12X48-IR1-I1 multi-rate PTM for LNW82 and 
LNW55.

• G.8032 Ethernet Ring Protection (ERP) support on the LNW170.

• SSH File Transfer Protocol (SFTP) supported for software download, database 
backup, and database restoration.

• SNMP v3 Monitoring (gets and traps).

• RADIUS authentication support for user login.
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About this document

• Configuration for SONET and SDH on a per port basis on VLF packs (LNW45, 
LNW49, LNW55).

• Single TID between shelves (up to 12) for DCS applications.

Intended audience

This installation manual is intended to provide individuals and customers the information 
and procedures necessary to install, self-test and turn up the Alcatel-Lucent 1665 DMX 
system.

This manual is not a service or operations manual. For any activities involving circuit turn-
up, regular maintenance, or trouble analysis, see 

• Alcatel-Lucent 1665 Data Multiplexer (DMX) User Operations Guide, 365-372-301

• Alcatel-Lucent 1665 Data Multiplexer (DMX) Alarm Messages and Trouble Clearing 
Guide, 365-372-302

How to use this document

This manual is divided into the following sections with a brief description of the contents 
of each major part/chapter/appendix:

About this document

This chapter describes the purpose, intended audience, reason for reissue, and 
organization of this document. This section references related documentation and explains 
how to order, make comments or recommend Preliminaryhanges to this document.

Chapter 1, “Safety”

This chapter provides important safety instructions for Alcatel-Lucent 1665 DMX.

Part I: “Physical installation and powering”

Part I provides a checklist to ensure that all necessary procedures have been completed. 
Use of the installation checklist is required to ensure a quality installation, all completed 
tasks should be checked off and those not completed should be duly noted as to the reason 
why. This checklist should be turned in as part of your job complete paperwork.

Chapter 2, “Physical installation”

This section provides physical installation instructions for Alcatel-Lucent 1665 DMX 
power cabling and fiber management.
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About this document

Chapter 3, “Cable and fiber installation”

This chapter provides the information and procedures for installing and cabling the 
Alcatel-Lucent 1665 DMX system. It provides the additional cabling information needed 
for the added DS1, DS3 capacity and Ethernet capacity.

Chapter 4, “Powering and initial circuit pack installation”

This chapter provides information for verifying that the shelf is being supplied with the 
proper power and provides instructions for circuit pack installation.

Part II: “Stand-alone installation tests”

Chapter 5, “Software download and circuit pack installation”

Software download and circuit pack installation is covered in this chapter.

Chapter 6, “Installation tests”

This chapter verifies proper transmission cabling installation and functionality.

Chapter 7, “Operational tests”

This chapter provides instructions to test protection switching and the non-transmission 
cabling. This section is not intended to replace acceptance test procedures.

Part III: “Network turn-up and testing”

Chapter 8, “OC-3/12/48 ring setup and testing: integration procedures”

This chapter provides the tests to verify proper ring fiber cabling and protection switching.

Chapter 9, “WDMX setup and testing: integration procedures”

This chapter is used to verify WDMX connectivity between Alcatel-Lucent 1665 DMX 
nodes. The chapter includes the LNW785 8 channel Optical Multiplexer Demultiplexer 
(OMD) and the LNW705 XM10G/8 Muxponder circuit packs. It is not intended to replace 
acceptance test procedures.

Part IV: “Supplementary information and installation checklist”

Appendix A, “Fiber cleaning”

This appendix describes the Lucent recommended method for the cleaning and inspection 
of optical connectors using specific tools and materials that have been proven to be 
effective in the assembly and testing of optical equipment.
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About this document

Appendix B, “Installing fiber connectors and LBOs”

This appendix provides procedures for installing and removing the types of Line Build 
Out (LBO) units and fiber connectors onto input and output ports found on the Alcatel-
Lucent 1665 DMX circuit packs.

Appendix C, “Backplane pin replacement”

This appendix provides information and the procedures used when a pin or blade on the 
Alcatel-Lucent 1665 DMX backplane has been bent or broken.

Appendix D, “Fiber labeling”

This appendix provides a description of how to label the fiber.

Appendix E, “Pluggable transmission module installation”

Provides examples of various SFP installation.

Glossary

The Glossary provides definitions for telecommunication acronyms and terms.

Index

The Index supplies users with specific subjects and corresponding page numbers to find 
necessary information.

Safety information

This information product contains hazard statements for your safety. Hazard statements 
are given at points where safety consequences to personnel, equipment, and operation may 
exist. Failure to follow these statements may result in serious consequences.

Safety precautions

Adhere to the following safety precautions:

• Electrostatic discharge (ESD)

You must be properly grounded when making contact with the Alcatel-Lucent 1665 Data 
Multiplexer (1665 DMX) frame and handling circuit packs. Wrist strap ground cords 
should be routinely tested for the minimum 1-megohm resistance.

• Plug-in storage

Circuit packs should be stored in static-safe packaging or in a grounded cabinet.

For additional safety precautions, please see the Alcatel-Lucent 1665 Data Multiplexer 
(DMX) User Operations Guide, 365-372-301.
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About this document

Laser safety

For more detailed information and safety precautions, see Chapter 1, “Safety”.

Conventions used

Italic typeface denotes a particular product line or information product.

Helvetica Bold typeface signifies a window, section, command or parameter.

Helvetica typeface indicates a faceplate or Alcatel-Lucent 1665 DMX label designation, 
as in the ACTIVE LED on a circuit pack.

Courier Bold indicates a TL1 command typed in a terminal window by the user, as in 
act-user:LT-DMX:LUC01:ctag::DMX2.5G10G;

Courier typeface indicates the system or PC response to a command.

For the remainder of this document, “Alcatel-Lucent 1665 DMX” is used in place of 
Alcatel-Lucent 1665 Data Multiplexer (Alcatel-Lucent 1665 DMX) in most cases.

NOTICE

Laser safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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About this document

Related information

Alcatel-Lucent 1665 DMX Documentation Set

The following table lists the documents included in the Alcatel-Lucent 1665 DMX 
documentation set.

Table 1-1 1665 DMX documentation set

Technical support

For technical support, contact your local Alcatel-Lucent customer support team. See the 
Alcatel-Lucent Support web site (http://www.alcatel-lucent.com/support) for contact 
information. 

Comcode Document number Title

NA 365-372-330 WaveStar® CIT User Guide

109 696 807 365-372-300R9.0 Alcatel-Lucent 1665 Data Multiplexer (DMX) 
Applications and Planning Guide

109 696 765 365-372-301R9.0 Alcatel-Lucent 1665 Data Multiplexer (DMX) User 
Operations Guide

109 696 773 365-372-302R9.0 Alcatel-Lucent 1665 Data Multiplexer (DMX) Alarm 
Messages and Trouble Clearing Guide

109 696 781 365-372-304R9.0 Alcatel-Lucent 1665 Data Multiplexer (DMX) 
Installation Manual

109 696 799 365-372-306R9.0 Alcatel-Lucent 1665 Data Multiplexer (DMX) TL1 
Message Details

NA ED8C871-10 Alcatel-Lucent 1665 Data Multiplexer (DMX) 
Engineering and Ordering Information

NA ED8C871-20 Alcatel-Lucent 1665 Data Multiplexer (DMX) 
Interconnect Information

109 747 055 NA Alcatel-Lucent 1665 Data Multiplexer (DMX) Release 
9.0.0 Software Release Description (Paper)

109 747 063 NA Alcatel-Lucent 1665 Data Multiplexer (DMX) Release 
9.0.0 Software Release Description (CD-ROM)

109 747 071 Alcatel-Lucent 1665 Data Multiplexer (DMX) Release 
9.0.0 Customer Documentation CD-ROM

www.alcatel-lucent.com/support
www.alcatel-lucent.com/support
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About this document

How to order

To order Alcatel-Lucent documents contact your local sales representative or use Online 
Customer Support (OLCS) (https://support.alcatel-lucent.com).

How to comment

To comment on this document, go to the Online Comment Form (http://infodoc.alcatel-
lucent.com/comments) or email your comments to the Comments Hotline 
(comments@alcatel-lucent.com).

Packaging collection and recovery requirements

Countries, states, localities, or other jurisdictions may require that systems be established 
for the return and/or collection of packaging waste from the consumer, or other end user, 
or from the waste stream. Additionally, reuse, recovery, and/or recycling targets for the 
return and/or collection of the packaging waste may be established.

For more information regarding collection and recovery of packaging and packaging 
waste within specific jurisdictions, please contact the Alcatel-Lucent Services - 
Environmental Health and Safety organization.

Material content compliance

European Union RoHS

European Union (EU) Directive 2002/95/EC, &ldquo;Restriction of the use of certain 
Hazardous Substances&rdquo; (RoHS), restricts the use of lead, mercury, cadmium, 
hexavalent chromium, and certain flame retardants in electrical and electronic equipment. 
This Directive applies to electrical and electronic products placed on the EU market after 1 
July 2006, with various exemptions, including an exemption for lead solder in network 
infrastructure equipment. Alcatel-Lucent products shipped to the EU after 1 July 2006 
comply with the EU RoHS Directive.

China RoHS

The Peoples Republic of China Ministry of Information Industry has published a 
regulation (Order #39) and associated standards regarding restrictions on hazardous 
substances (China RoHS). Currently, the legislation requires all Electronic and 
Information Products (EIP) to comply with certain labeling and documentation 
requirements. Alcatel-Lucent products manufactured on or after 1 March 2007, that are 
intended for sale to customers in the China market, comply with these requirements. 

support.alcatel-lucent.com
support.lucent.com
http://infodoc.alcatel-lucent.com/comments
infodoc.alcatel-lucent.com/comments
infodoc.alcatel-lucent.com/comments
mailto:comments@alcatel-lucent.com
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About this document

In accordance with the People’s Republic of China Electronic Industry Standard “Marking 
for the Control of Pollution Caused by Electronic Information Product” (SJ/T11364- 
2006), customers may access Alcatel-Lucent’s Hazardous Substances Table information at 
either of the following two URLs (for the convenience of our diverse customer base):

• Access via the Alcatel-Lucent Corporate website at: http://www.alcatel-
sbell.com.cn/live/home/index.jsp (http://www.alcatel-sbell.com.cn/

• Access via the Alcatel Shanghai Bell website at: http://www.alcatel-
sbell.com.cn/wwwroot/images/upload/private/1/media/China-RoHS-HST-3.1.pdf 
(http://www.alcatel-sbell.com.cn/wwwroot/images/upload/)

Recycling/take-back/disposal of product

Electronic products bearing or referencing the symbols shown below shall be collected 
and treated at the end of their useful life, in compliance with applicable European Union 
and other local legislation. They shall not be disposed of as part of unsorted municipal 
waste. Due to materials that may be contained in the product and batteries, such as heavy 
metals, the environment and human health may be negatively impacted as a result of 
inappropriate disposal.

Note: For electronic products put on the market in the European Union, a solid bar 
under the crossed-out wheeled bin indicates that the product was put on the market.

Moreover, in compliance with legal requirements and contractual agreements, where 
applicable, Alcatel-Lucent will offer to provide for the collection and treatment of Alcatel-
Lucent products bearing the logo at the end of their useful life, or products. For 
information regarding take-back, recycling, or disposal of equipment by Alcatel-Lucent or 
for equipment take-back requests, visit the Alcatel-Lucent Take-Back web page 
(http://www.alcatel-lucent.com/product_takeback) or contact Alcatel-Lucent Take-Back 
Support (takeback@alcatel-lucent.com). For technical information on product treatment, 
consult the Alcatel-Lucent Recycling Information web page.

http://www.alcatel-lucent.com/product_takeback
www.alcatel-lucent.com/product_takeback
www.alcatel-lucent.com/product_takeback
www.alcatel-lucent.com/product_takeback
mailto:takeback@alcatel-lucent.com
www.alcatel-lucent.com/product_takeback
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1 Safety

Overview

Purpose

This chapter provides important safety instructions for the Alcatel-Lucent 1665 Data 
Multiplexer (1665 DMX).

Contents

This appendix provides information on the following topics:

Laser safety

System design

The Alcatel-Lucent system complies with FDA/CDRH 21 CFR 1040.10 and 1040.11 as a 
Class I and with IEC 60825-1 as a Class 1 Optical Fiber Telecommunication laser product. 
The system has been designed to ensure that the operating personnel is not endangered by 
laser radiation during normal system operation. The safety measures specified in the Food 
and Drug Administration’s Center for Devices and Radiological Health (FDA/CDRH) 
regulations and the international standards IEC-60825 or DIN/EN 60825 are met. Please 
also see “Laser product classification” (p. 1-9).

Laser safety  1-1

Electrostatic discharge ESD considerations  1-3

Laser product classification  1-9

Alcatel-Lucent 1665 DMX optical specifications  1-11
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Laser safetySafety

Potential sources of danger

Beware of the following potential sources of danger which will remain despite all safety 
measures taken:

• Laser radiation can cause damage to the skin and eyes.

• Laser radiation from optical transmission systems is in a wavelength range that is 
invisible to the human eye.

Laser warning labels 

The laser warning labels indicate either only the laser class or both the laser class and the 
maximum output power of laser radiation. The following figure shows different types of 
laser warning labels and their characteristics. 

CAUTION

Do not view directly
with optical
instruments.

CLASS 1M INVISIBLE
LASER RADIATION
WHEN OPEN
AND FIBER
DISCONNECTED.

ATTENTION
RAYONNEMENT
LASER DE CLASSE
1M INVISIBLE
LORSQUE
L’APPAREIL EST
OUVERT ET QUE
LA FIBRE EST
DÉCONNECT E.
Ne pas regarder
directement au moyen
d’un instrument optique.

É

848950572

H

H

HAZARD
LEVEL

1M

1

2

3

CLASS 1 LASER

PRODUCT

H

DANGER

INVISIBLE LASER RADIATION
WHEN OPEN AND FIBER
DISCONNECTED

Avoid direct exposure to beam
Do not view beam directly with
optical instruments
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Electrostatic discharge ESD considerationsSafety

Legend

1. Laser symbol.

2. Laser classification label. This label may show only the laser class or both the laser 
class and the maximum output power.

3. Laser warning label.

Laser safety instructions

Observe the following instructions to avoid exposing yourself and others to risk.

• Read the relevant descriptions in the manuals before taking equipment into operation 
or carrying out any installation and maintenance work on the optical port units, and 
follow the instructions. Ignoring the instructions can result in exposure to dangerous 
radiation.

• Do not view directly into the laser beam with optical instruments such as a fiber 
microscope, because viewing of laser emission in excess of Class 1 limits significantly 
increases the risk of eye damage.

• Never look into the end of an exposed fiber or an open connector as long as the optical 
source is still switched on.

• Ensure that the optical source is switched off before disconnecting optical fiber 
connectors.

• In the event of doubt, check that the optical source is switched off by measuring with 
an optical power meter.

• When connecting fiber loops between the IN and OUT ports on optical circuit packs, 
always connect to the IN port first and then the OUT port. This will prevent any optical 
radiation from being present at the fiber end.

Electrostatic discharge ESD considerations

ESD precautions

Industry experience has shown that all integrated circuit packs can be damaged by static 
electricity that builds up on work surfaces and personnel. The static charges are 
produced by various charging effects of movement and contact with other objects. Dry air 
allows greater static charges to accumulate. Higher potentials are measured in areas 
with low relative humidity, but potentials high enough to cause damage can occur 
anywhere. 

CAUTION

ESD hazard
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Electrostatic discharge ESD considerationsSafety

In order to prevent damage by electrostatic discharge the following precautions should be 
observed when handling circuit packs:

• Assume all circuit packs contain solid state electronic components that can be 
damaged by ESD. 

• When handling circuit packs (storing, inserting, removing, etc.) or when working on 
the backplane, always wear a grounded wrist strap such as the one shown in 
Figure 1-1, “Static control wrist strap” (p. 5) or wear a heel strap and stand on a 
grounded, static dissipating floor mat. If a static dissipating floor mat is used, be sure 
that it is clean to ensure a good discharge path.

• Handle all circuit packs by the faceplate or latch and by the top and bottom outermost 
edges. Never touch the components, conductors, or connector pins.

• Observe warning labels on bags and cartons. Whenever possible, do not remove circuit 
packs from antistatic packaging until ready to insert them into slots.

• If possible, open all circuit packs at a static safe work position, using properly 
grounded wrist straps and static dissipating table mats. If a static dissipating floor mat 
is used, be sure that it is clean to ensure a good discharge path.

• Always store and transport circuit packs in static safe packaging. Shielding is not 
required unless specified. 

• Keep all static generating materials such as food wrappers, plastics, and styrofoam 
containers away from all circuit packs. Upon removal from bay, immediately put 
circuit packs into static safe packages. 

• Whenever possible, maintain relative humidity above 20 percent.

To reduce the possibility of ESD damage, assemblies are equipped with grounding jacks 
to enable personnel to ground themselves using wrist straps [Figure 1-1, “Static control 
wrist strap” (p. 1-5)] while handling circuit packs or working on an assembly. The jacks 
for connection of wrist straps are located at the lower right-hand corner of each assembly 
and are labeled. When grounding jacks are not provided, an alligator clip adapter enables 
connection to bay frame ground. 
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Electrostatic discharge ESD considerationsSafety

Figure 1-1 Static control wrist strap

TO
GROUND
CONNECTION
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Electrostatic discharge ESD considerationsSafety

IMPORTANT SAFETY INSTRUCTIONS

READ AND UNDERSTAND ALL INSTRUCTIONS

The exclamation point within an equilateral triangle is intended to alert the user 
to the presence of important operating and maintenance (servicing) 
instructions in the literature accompanying this product.

When installing, operating, or maintaining this equipment, basic safety 
precautions should always be followed to reduce the risk of fire, electric shock, and injury 
to persons, including the following:

1. Read and understand all instructions.

2. Follow all warnings and instructions marked on this product. 

3. This product should be only operated from the type of power sources indicated on the 
marking label.

4. Connect this product only to the type of power sources recommended by Alcatel-
Lucent. For information on the powering instructions, consult the Installation Manual.

5. This equipment is suitable for mounting on a concrete or other noncombustible surface 
only.

6. For information on proper mounting instructions, consult the Installation Manual.

7. Install only equipment identified in the Installation Manual. Use of other equipment 
may result in improper connection of circuitry leading to fire or injury to persons.

8. All metallic telecommunication interfaces should not leave the building premises 
unless connected to telecommunication devices providing primary and secondary 
protection, as applicable.

9. Do not use this product near water, for example, in a wet basement.

10. Do not place this product on an unstable cart, stand or table. The product may fall, 
causing serious damage to the product.

11. Use caution when installing or modifying telecommunications lines.

12. Never install telecommunications wiring during a lightning storm.

13. Never install telecommunications connections in wet locations.

14. Never touch uninsulated telecommunications wires or terminals unless the 
telecommunications line has been disconnected at the network interface.

15. Never touch uninsulated wiring or terminals carrying direct current or ringing current, 
or leave this wiring exposed. Protect and tape uninsulated wiring and terminals to 
avoid risk of fire, electric shock, and injury to service personnel.

16. Never push objects of any kind into this product through slots as they may touch 
dangerous voltage points or short out parts that could result in a risk of fire or electrical 
shock. Never spill liquids of any kind on the product.
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Electrostatic discharge ESD considerationsSafety

17. Slots and openings in the unit are provided for ventilation, to protect it from 
overheating, and these openings must not be blocked or covered. This product should 
not be placed in a built-in installation unless proper ventilation is provided.

18. To reduce the risk of an electrical shock, do not disassemble this product. Service 
should be performed by trained personnel only. Opening or removing covers and/or 
circuit boards may expose you to dangerous voltages or other risks. Incorrect 
reassembly can cause electrical shock when the unit is subsequently used.

19. Some of the Alcatel-Lucent 1665 DMX hardware modules contain FDA/CDRH Class 
I/IEC Class 1 single-mode laser products that are enclosed lightwave transmission 
systems. Under normal operating conditions, lightwave transmission systems are 
completely enclosed; nonetheless, the following precautions must be observed because 
of the potential for eye damage:

• Do not disconnect any lightwave cable or splice and stare into the optical 
connectors terminating the cables.

• Lightwave/lightguide operations should not be performed by a technician who has 
not satisfactorily completed an approved training course.

• Do not use optical instruments such as an eye loupe to view a fiber or unterminated 
connector.

• More information about laser safety can be found in the Installation Manual.

20. For a unit intended to be powered from –48 V dc voltage sources, read and understand 
the following:

• To be powered only by Safety Extra Low Voltage (SELV) -48 V dc Sources.

• Disconnect up to Two (2) power supply connections when removing power from 
the system.

• This equipment must be provided with a readily accessible disconnect device as 
part of the building installation.

• Ensure that there is no exposed wire when the input power cables are connected to 
the unit. 

• Installation must include an independent frame ground drop to building ground. 
See Alcatel-Lucent 1665 Data Multiplexer (DMX) User Operations Guide, 365-
372-301.

This symbol is marked on the product, 
adjacent to the ground (earth) area for the 
connection of the ground (earth) conductor.
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Electrostatic discharge ESD considerationsSafety

• This Equipment is to be Installed Only in Restricted Access Areas on Business and 
Customer Premises Applications in Accordance with Articles 110-16, 110-17, and 
110-18 of the National Electrical Code, ANSI/NFPA No. 70. Other Installations 
Exempt from the Enforcement of the National Electrical Code May Be Engineered 
According to the Accepted Practices of the Local Telecommunications Utility.

21. For a unit intended to be powered from 100-120/200-240 V ac voltage sources, read 
and understand the following:

• Unplug this product from the wall outlet before cleaning. Do not use liquid 
cleaners or aerosol cleaners. Use a damp cloth for cleaning.

• Do not staple or otherwise attach the power supply cord to the building surfaces.

• Do not overload wall outlets and extension cords as this can result in the risk of fire 
or electric shock.

• The socket outlet should be installed near the equipment and should be readily 
accessible.

• This product is equipped with a three-wire grounding type plug, a plug having a 
third (grounding) pin. This plug is intended to fit only into a grounding type power 
outlet. This is a safety feature. If you are unable to insert the plug into the outlet, 
contact your electrician to replace your obsolete outlet. Do not defeat the safety 
purpose of the grounding type plug. Do not use a 3-to-2-prong adapter at the 
receptacle. Use of this type adapter may result in risk of electrical shock and/or 
damage to this product.

• Do not allow anything to rest on the power cord. Do not locate this product where 
the cord may be abused by persons walking on it.

• Unplug this product from the wall outlet and refer servicing to qualified service 
personnel under the following conditions:

a. When the powers supply cord or plug is damaged or frayed.

b. If liquid has been spilled into the product.

c. If the product has been exposed to rain or water.

d. If the product does not operate normally by following the operating instructions. 
Adjust only those controls that are covered by the operating instructions because 
improper adjustment of other controls may result in damage and will often require 
extensive work by qualified technician to restore the product to normal operation.

e. If the product has been dropped or the cabinet has been damaged.

f. If the product exhibits a distinct change in performance.

SAVE THESE INSTRUCTIONS
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Laser product classificationSafety

Laser product classification

Standards compliance

The product complies with both IEC standards and the Food and Drug Administration’s 
Center for Devices and Radiological Health (FDA/ CDRH) regulations.

FDA/CDRH regulations 

Laser products are classified in accordance with the FDA/CDRH - 21 CFR 1010 and 1040. 
The classification scheme is based on the ability of the laser emission to cause injury to 
eye or skin during normal operating conditions.

In the United States, lasers and laser systems in the infrared wavelength range (greater 
than 700 nm) are assigned to one of the following classes:

• Class I,

• Class IIIb, or

• Class IV.

Laser classification is dependent upon operating wavelength, output power and fiber 
modefield diameter (core diameter).

IEC requirements 

The International Electro-Technical Commission (IEC) establishes standards for the 
electrical and electronic industries. IEC-60825 has been established for the worldwide 
safety of laser products.

According to the IEC classification, lasers and laser systems in the infrared wavelength 
range (greater than 700 nm) are assigned to one of the following classes:

• Class 1,

• Class 3A,

• Class 3B, or

• Class 4.

There are some major differences between the FDA/CDRH regulations and IEC:

1. The Accessible Emission Limits (AEL) are different.

2. Class 3A applies to all wavelengths.

3. Class 3B requires strict engineering controls.

4. Classification is under single fault conditions.
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Laser product classificationSafety

Laser classes

The maximum output power of laser radiation depends on the type of laser diode used. 
The international standards IEC-60825 or DIN/EN 60825 define the maximum output 
power of laser radiation for each laser class in accordance with the wavelength.

Table 1-1 Laser classes

Hazard level assignment 

Hazard level refers to the potential hazard from laser emission at any location in an end-
to-end optical fiber communication system that may be accessible during service or in the 
event of a failure. The assignment of hazard level uses the AELs for the classes.

Hazard levels for optical transmission equipment are assigned in either of the following 
two ways:

• Actual output power from the connector or fiber cut.

• If automatic power reduction is used, output power at the connector or fiber cut at one 
second after automatic power reduction takes place provided that maximum output 
and restart conditions are met.

Classification of optical telecommunication equipment

Optical telecommunication equipment is generally classified as IEC Class 1 or 
FDA/CDRH Class I, because under normal operating conditions, the transmitter ports 
terminate on optical fiber connectors. These are covered by a front panel to ensure 
protection against emissions from any energized, unterminated transmitter. The circuit 
packs themselves, however, may be IEC Class 1 or 3A or FDA/CDRH Class I or IIIb.

Laser class Wavelength
Maximum output power 
of laser radiation

1 1310 nm 8.85 mW

1550 nm 10 mW

3A 1310 nm 24 mW

1550 nm 50 mW

3B 1310 nm 0.5 W

1550 nm 0.5 W
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Alcatel-Lucent 1665 DMX optical specifications

Overview

Table 1-2 provides the optical specifications for Alcatel-Lucent 1665 DMX internal laser 
circuit packs; these packs do not use PTMs.

Table 1-2 Alcatel-Lucent 1665 DMX optical circuit pack laser safety specifications

Laser Circuit 
Pack Code

Wavelength 
(nm)

Maximum 
Out Pwr 
(dBm)

Max/Min 
Rcv Pwr 
(dBm)

Fiber 
Type 
(µm)

Conn 
Type

FDA Class/
IEC Class

LNW27 1310 +3.0 -8.0/-29.0 SM (9) LC I(LN50)/1

LNW29 1550 +3.0 -8.0/-29.0 SM (9) LC I(LN50)/1

LNW31 1310 0.0 0.0/-18.0 SM (9) LC I(LN50)/1

LNW32 1310 1.5 -8.0/-29.0 SM (9) LC I(LN50)/1

LNW48 1310 -8.0 -8.0/-28.0 SM (9) LC I(LN50)/1

LNW50 1310 +2.0 -7.0/-30.5 SM (9) LC I(LN50)/1

LNW54 1550 +2.0 -8.0/-29.0 SM (9) LC I(LN50)/1

LNW56 1550 +2.0 -1.0/-14.0 SM (9) LC I(LN50)/1

LNW57 1533.465 +6.0 3.0/-7.0 SM (9) LC I(LN50)/1

LNW58 1310 -1.0 -1.0/-11.0 SM (9) LC I(LN50)/1

LNW60 1533.465 +12.5 11.5.-7.0 SM (9) LC I(LN50)/1

LNW76 1310 -3.0 -3.0/-18.0 SM (9) LC I(LN50)/1
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Table 1-3 shows the pluggable transmission module (PTM) laser safety specifications and 
the supported circuit packs. Use only the following Alcatel-Lucent Approved Class 1 
SFP/XFP transceivers.

Table 1-3 Alcatel-Lucent 1665 DMX optical PTM laser safety specifications

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Maximum 
Out Pwr 
(dBm)

Max/Min 
Rcv Pwr 
(dBm)

Fiber 
Type 
(µm)

Conn 
Type

FDA 
Class/
IEC Class

100BASE-
ZX-I1

LNW74
LNW87
LNW170

1550 +2.0 -8.0/-31.0 SM (9) LC I(LN50)/1

100BASE-
LX-L1

LNW63
LNW64
LNW74
LNW87
LNW170

1310 -8.0 -8.0/-25.0 SM (9) LC I(LN50)/1

100BASE-
FX-I1

LNW74
LNW87
LNW170

1310 -14.0 -14.0/-29.0 MM (50 
and 62.5)

LC I(LN50)/1

1000BASE-
ZX-I1

LNW63
LNW64
LNW74
LNW87
LNW170

1550 +5.0 0.0/-22.5 SM (9) LC I(LN50)/1

1000BASE-
LX-I1

LNW63
LNW64
LNW87
LNW170

1310 -3.0 -3.0/-19.0 SM (9) LC I(LN50)/1

1000BASE-
SX-I1

LNW63
LNW64
LNW87
LNW170

850 0.0 0.0/-19.0 MM (50 
and 62.5)

LC I(LN50)/1

BASE-T-C1 
electrical

LNW63
LNW64
LNW87
LNW170

NA NA NA NA RJ45 NA

ESCON-MM-
I1

LNW73/73C 1310 -14.0 -14.5/-29.0 MM (50 
and 62.5)

LC I(LN50)/1
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GE-1X2XFC-
LX-I1

LNW63 
LNW64 
LNW73/73C
LNW87
LNW170
LNW705

1310 -3.0 -3.0/-19.0 SM (9) LC I(LN50)/1

GE-1X2XFC-
SX-I1

LNW63 
LNW64 
LNW73/73C
LNW87
LNW170
LNW705

850 -2.5 0.0/-17.0 MM (50 
and 62.5)

LC I(LN50)/1

S15512 LNW37
LNW45
LNW55
LNW82
LNW705

1310 -8.0 -8.0/-23.0 SM (9) LC I(LN50)/1

OC3IR1-I1 LNW37
LNW45
LNW55
LNW82
LNW705

1310 -8.0 -15.0/-28.0 SM (9) LC I(LN50)/1

OC3LR1-I1 LNW37
LNW45
LNW55
LNW82
LNW705

1310 0.0 -10.0/-34.0 SM (9) LC I(LN50)/1

OC3X12X48I
R1-I1

LNW55
LNW84

1310 
(OC-3)

0.0 -10.0/-18.0 SM (9) LC I(LN50)/1

1310 
(OC-12/48)

0.0 0.0/-18.0

OC3X12X48
LR1-I1

LNW55
LNW84

1310
(OC-3)

+3.0 -15.0/-2.0 SM (9) LC I(LN50)/1

1310 
(OC-12/48)

+3.0 -9.0/-2.0

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Maximum 
Out Pwr 
(dBm)

Max/Min 
Rcv Pwr 
(dBm)

Fiber 
Type 
(µm)

Conn 
Type

FDA 
Class/
IEC Class
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OC12IR1-I1 LNW49
LNW55
LNW82
LNW203
LNW705

1310 -8.0 -8.0/-28.0 SM (9) LC I(LN50)/1

OC12LR1-I1 LNW49
LNW55
LNW82
LNW203
LNW705

1310 +2.0 -8.0/-28.0 SM (9) LC I(LN50)/1

OC12LR2-I1 LNW49
LNW55
LNW82
LNW203
LNW705

1550 +2.0 -8.0/-28.0 SM (9) LC I(LN50)/1

OC48LR1-I1 LNW55
LNW62
LNW82
LNW202
LNW402
LNW504
LNW705

1310 +3.0 -9.0/-27.0 SM (9) LC I(LN50)/1

OC48LR2-I1 LNW55
LNW62
LNW82
LNW202
LNW402
LNW504
LNW705

1550 +3.0 -9.0/-28.0 SM (9) LC I(LN50)/1

OC48SR1-I1 LNW55
LNW62
LNW82
LNW202
LNW402
LNW705

1310 -3.0 -3.0/-18.0 SM (9) LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Maximum 
Out Pwr 
(dBm)

Max/Min 
Rcv Pwr 
(dBm)

Fiber 
Type 
(µm)

Conn 
Type

FDA 
Class/
IEC Class
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S2D23C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1558.983 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S2D25C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1557.363 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S2D27C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1555.747 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S2D31C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1552.524 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S2D33C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1550.918 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Maximum 
Out Pwr 
(dBm)

Max/Min 
Rcv Pwr 
(dBm)

Fiber 
Type 
(µm)

Conn 
Type

FDA 
Class/
IEC Class
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S2D35C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1549.315 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S2D37C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1547.715 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S2D45C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1541.349 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S2D47C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1539.766 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S2D49C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1538.186 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Maximum 
Out Pwr 
(dBm)

Max/Min 
Rcv Pwr 
(dBm)

Fiber 
Type 
(µm)

Conn 
Type

FDA 
Class/
IEC Class
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S2D53C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1535.036 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S2D55C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1533.465 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S2D59C6 LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1530.334 +4.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S622C47EL LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1447 +5.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S622C49EL LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1491 +5.0 -9.0/-28.0 SM (9) LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Maximum 
Out Pwr 
(dBm)

Max/Min 
Rcv Pwr 
(dBm)

Fiber 
Type 
(µm)

Conn 
Type

FDA 
Class/
IEC Class
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S622C51EL LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1511 +5.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S622C53EL LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1531 +5.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S622C55EL LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1551 +5.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S622C57EL LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1571 +5.0 -9.0/-28.0 SM (9) LC I(LN50)/1

S622C59EL LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1691 +5.0 -9.0/-28.0 SM (9) LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Maximum 
Out Pwr 
(dBm)

Max/Min 
Rcv Pwr 
(dBm)

Fiber 
Type 
(µm)

Conn 
Type

FDA 
Class/
IEC Class
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S622C61EL LNW37
LNW45
LNW49
LNW55
LNW82
LNW504
LNW705

1611 +5.0 -9.0/-28.0 SM (9) LC I(LN50)/1

OC192IR2-
C1

LNW59
LNW705

1550 +2.0 -1.0/-14.0 SM (9) LC I(LN50)/1

OC192IR2-I1 LNW59
LNW502
LNW504
LNW603
LNW705

1550 +2.0 -7.0/-24.0 SM (9) LC I(LN50)/1

OC192LR2-
C1

LNW59
LNW705

1550 +4.0 -7.0/-24.0 SM (9) LC I(LN50)/1

OC192SR1-
C1

LNW59
LNW502
LNW504
LNW603
LNW705

1310 -1.0 -1.0/-11.0 SM (9) LC I(LN50)/1

X10G21C5 LNW59 
LNW502
LNW603
LNW705

1560.606 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G22C5 LNW59 
LNW502
LNW603
LNW705

1559.794 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G23C5 LNW59 
LNW502
LNW603
LNW705

1558.983 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G24C5 LNW59 
LNW502
LNW603
LNW705

1558.173 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Maximum 
Out Pwr 
(dBm)

Max/Min 
Rcv Pwr 
(dBm)

Fiber 
Type 
(µm)

Conn 
Type

FDA 
Class/
IEC Class
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X10G25C5 LNW59 
LNW502
LNW603
LNW705

1557.363 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G26C5 LNW59 
LNW502
LNW603
LNW705

1556.555 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G27C5 LNW59 
LNW502
LNW603
LNW705

1555.747 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G28C5 LNW59 
LNW502
LNW603
LNW705

1554.940 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G31C5 LNW59 
LNW502
LNW504
LNW603
LNW705

1552.524 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G33C5 LNW59 
LNW502
LNW504
LNW603
LNW705

1550.918 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G35C5 LNW59 
LNW502
LNW504
LNW603
LNW705

1549.315 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G37C5 LNW59 
LNW502
LNW504
LNW603
LNW705

1547.715 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Maximum 
Out Pwr 
(dBm)

Max/Min 
Rcv Pwr 
(dBm)

Fiber 
Type 
(µm)

Conn 
Type

FDA 
Class/
IEC Class
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X10G45C5 LNW59 
LNW502
LNW504
LNW603
LNW705

1541.349 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G47C5 LNW59 
LNW502
LNW504
LNW603
LNW705

1539.766 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G49C5 LNW59 
LNW502
LNW504
LNW603
LNW705

1538.186 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G52C5 LNW59 
LNW502
LNW603
LNW705

1535.822 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G53C5 LNW59 
LNW502
LNW603
LNW705

1535.036 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G54C5 LNW59 
LNW502
LNW603
LNW705

1534.250 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G55C5 LNW59 
LNW502
LNW603
LNW705

1533.465 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G56C5 LNW59 
LNW502
LNW603
LNW705

1532.681 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Maximum 
Out Pwr 
(dBm)

Max/Min 
Rcv Pwr 
(dBm)

Fiber 
Type 
(µm)

Conn 
Type

FDA 
Class/
IEC Class
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Table 1-4 Dispersion-limited receiver sensitivity for OC-192 DWDM PTMs

X10G57C5 LNW59 
LNW502
LNW603
LNW705

1531.898 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G58C5 LNW59 
LNW502
LNW603
LNW705

1531.116 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

X10G59C5 LNW59 
LNW502
LNW603
LNW705

1530.334 +3.0 -8.0/Table 1-4 SM (9) LC I(LN50)/1

Module 
Code

Supported 
Circuit 
Pack(s)

Wavelength 
(nm)

Maximum 
Out Pwr 
(dBm)

Max/Min 
Rcv Pwr 
(dBm)

Fiber 
Type 
(µm)

Conn 
Type

FDA 
Class/
IEC Class

Data Rate

Receiver 
Sensitivity 
0 ps/nm 
dispersion

Receiver 
Sensitivity 
1300 ps/nm 
dispersion

Receiver 
Sensitivity 
1600 ps/nm 
dispersion

9.9 Gb/s -24.0 dBm -22.0 dBm NA

10.7-11.1 Gb/s with 
Forward Error 
Correction (FEC) 
enabled

-27.0 dBm NA -25.0 dBm
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Part I:  Physical installation 
and powering

Overview

Purpose

Part I covers the physical mounting of the Alcatel-Lucent 1665 Data Multiplexer (Alcatel-
Lucent 1665 DMX) shelf, the running and connecting of power cables, interconnecting 
cables, alarm cables, and as required, external timing and communication cables. This 
section also covers initial circuit pack installation (not seated).

Contents

This section is organized into the following chapters:

Note: The high-capacity shelf does not require the installation of an additional fan 
shelf since the fan unit is integral to the shelf itself. Check Figure I-1, “Alcatel-Lucent 
1665 DMX high-capacity shelf backplane” (p. I-2) to determine if the shelf is a 
Alcatel-Lucent 1665 DMX high-capacity shelf. If the shelf you are installing is NOT 
equipped with the additional middle connectors (J20 - J27), see the Metropolis®  DMX 
Access Multiplexer (DMX)  Release 5.0 Installation Manual. Installation details for the 
Alcatel-Lucent 1665 DMX standard shelf are not included in this issue.

Chapter 2, “Physical installation”

Chapter 3, “Cable and fiber installation”

Chapter 4, “Powering and initial circuit pack installation”
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Figure I-1 Alcatel-Lucent 1665 DMX high-capacity shelf backplane

Tools, test equipment, and accessories

This section lists the tools, test equipment and accessories needed to perform all the 
procedures in this installation manual.

Listed below are the required tools, test equipment and accessories.

J8
D OUT

J6
C OUT

J19
INTEROP

J16
IAOLAN

J3
B OUT

J1
A OUT

J4
B IN

J2
A IN

J13
ALM MULT

J12
ALM

J18
DLAN

J10
X.25

J5
C IN

J7
D IN

NC-DMX-156

J22 C IN

J23 D IN

J26 C OUT

J27 D OUT

J20 A IN

J21 B IN

J24 A OUT

J25 B OUT

IN

OUT

EXP2 EXP1

IN

OUT

CTL

-48RTNB

P15
J14

SYNC2
J11

MISC
J17

MODEM

J9
SYNC1 P14

-48RTNA

-48VA-48VB

CTL

J15
FAN
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Table I-1 Tool, test equipment and accessories required

Quantity Description Comments

Screwdriver(s) A screwdriver(s) with the appropriate head(s) is 
(are) required for securing the mounting screws, 
repositioning the mounting brackets, installing the 
interfacing cables, and for setting the circuit 
breakers to the OFF position.

1 Tube NO OX 

ITE R-3266

1 Thomas & Betts* R-
5648B Crimping Tool

The crimping tool and wire stripper are only 
required if installing DS3 cables. The replacement 
cassette is for the wire stripper tool.

1 Paladin† Coaxial Wire 
Stripper R-5648B

Replacement Paladin† 
Cassette R-5648B D5

1 Wire-Wrap Gun
R-4496A

The wire-wrap gun is required for terminating 
DS1 cable and must be able to accommodate 24 
gauge wire.

1 Impact Tool -Wire
R-5974

The impact tool is required for terminating 
Ethernet cable onto a 110 type panel.

1 ESD Wrist Strap
R-4987C

A wrist strap must be worn when handling circuit 
packs. Use the electrostatic discharge (ESD) jack 
provided on the shelf.

1 Torque Wrench
R-5952

A torque wrench (50-250 IN-LBS) is used when 
tightening the Alcatel-Lucent 1665 DMX shelf 
to the frame. It is also used when reattaching the 
mounting brackets to the Alcatel-Lucent 1665 
DMX shelf.

1 Multimeter (Optional)
ITE-6379C

The voltmeter must be capable of measuring DC 
voltage in the 40 to 60 volt range. The use of the 
voltmeter is optional since the shelf will alarm or 
shut down if the proper voltage is not supplied.

1 Ohmmeter

ITE-6379C

An ohmmeter is required to verify that the 
Alcatel-Lucent 1665 DMX is properly 
grounded.

1 DS1 Error Rate Test Set
ITE-7113

A DS1 error rate test set is required for testing of 
DS1 cabling. A T-BERD 2209 or equivalent is 
recommended.
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1 DS3 Error Rate Test Set
ITE-7113

A DS3 error rate test set is required for testing of 
DS3 cabling. A T-BERD 209 or equivalent is 
recommended.

1 SONET Optical Test Set An OC-3, OC-12 or OC-48 test set as required for 
testing of optical circuit packs. An Agilent 
OmniBER 718 or equivalent is recommended.

2 or 3 LC-Type Optical Fiber 
Jumper ITE-7169 
(108918269)

Two optical fiber jumpers with LC type 
connectors are required to optically loop the 
Alcatel-Lucent 1665 DMX shelf for test purposes. 
In addition, for shelves containing optical circuit 
packs in any of the Function unit slots, a single 
optical fiber jumper is required for testing of the 
individual ports.

2 or 3 15-dB LC-Type LBO 
ITE-7196 (108279480)

Two 15-dB LBOs are required when optically 
looping the Alcatel-Lucent 1665 DMX shelf for 
test purposes. In addition, for shelves containing 
optical circuit packs in any of the Function unit 
slots, a single 15-dB LBO is required for testing of 
the individual ports

2 LC-Type Optical Fiber 
Jumper (108918269)

Two optical fiber jumpers with LC type 
connectors are required to optically loop the 
Alcatel-Lucent 1665 DMX shelf for test purposes.

Noyes OFS 300-200X 
Optical Fiber Scope
ITE-7129

Optical Fiber Scope

2.5 mm Universal 
Adapter Cap ITE-7129 
D1

For use with the Noyes OFS 300-200X Optical 
Fiber Scope

1.25mm Universal 
Adapter Cap ITE-7129 
D2

Noyes VFS-1 ITE-7187 
Video Fiber Scope1

This equipment may not be necessary at all 
locations. It is to be used when the ports need to 
be verified for cleanliness. If care is exercised 
when cleaning fibers, the video scope may not be 
needed

Quantity Description Comments
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Individual Presaturated 
Alcohol Wipes ITE-
7136

99% pure isopropyl alcohol

1 CLETOP Cleaning 
Cassette ITE-7137

Type A Reel

1 CLETOP Cleaning
Cassette Replacement
Reel
ITE-7137 D1

Type A Reel

Luminex Stick Port 
Cleaners ITE-7134 & 
ITE-7135

1.25 mm and 2.5 mm sizes

Luminex Cloth R-6033 5.5” x 5.5”

1 SPG800 Electric Continuity Test Tool LNW94 TESTPK 
(for DS1/DS3/Ethernet Cabling) 

1 Personal Computer (PC) Required to run the WaveStar® CIT software. See 
PC and cable requirements for WaveStar® CIT (p. 
I-6).

1 CIT Interface Cable 8-ft. long RJ45 to 9-pin D-sub serial cable 
(Comcode 848748869). Required to connect the 
PC to the CIT jack on the front of the SYSCTL 
circuit pack.

1 LAN 10BaseT Cross-
over Cable CAT 5 or 
better

As required to reach from front of Alcatel-Lucent 
1665 DMX to the PC

Notes:
* Registered trademark of Thomas & Betts Corporation

† Registered trademark of Paladin Corporation. 

Quantity Description Comments
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PC and cable requirements for WaveStar® CIT

This section lists the required equipment needed to run the WaveStar® CIT software with 
the Alcatel-Lucent 1665 DMX.

PC minimum requirements

It is anticipated that most customers will dedicate a laptop or personal computer (PC) to 
run the WaveStar® CIT software. However, any properly configured computer will also 
suffice. The following table shows the requirements for the computer.

Note: Windows Vista is not supported.

Table I-2 Computer requirements

Quantity Description Comments

1 Personal Computer 
(PC)

See PC minimum requirements 
below.

1 CIT Interface Cable 8-ft. long RJ45 to 9-pin D-sub 
serial cable (Comcode 
848748869).

1 Cross Over LAN 
Cable (If CIT cable is 
not available)

10-ft. long cable (Comcode 
109321810) or equivalent.

Components Minimum* Recommended

Processor Pentium 266 MHz Pentium IV 1 GHz

RAM (1 system view) 128 MB 512 MB

RAM (up to 5 system 
views)

256 MB 1 GB

Virtual Memory 139 MB 267 MB

Available Hard Disk Space† 500 MB 850 MB (for all graphical 
packages)

Video ‡ 800X600 256 Colors
(8 Bit)

1024X768 16 Million 
Colors (24 Bit)

Network Interface** 10/100 baseT Network 
Card

100 baseT Network Card

CD ROM Drive Required Required
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Table I-3 Installation acceptance checklist

Operating System Windows® NT 4.0, 
Windows® 2000 or 
Windows® XP

Windows® 2000 or 
Windows® XP

Internet Browser Internet Explorer
5.0/5.5/6.0/7.0

Internet Explorer
5.0/5.5/6.0/7.0

Notes:
* Minimum requirements are sufficient to run two to three GUI System Views, unless 

otherwise noted. Recommended requirements are intended to be used as a general guideline 
to optimize WaveStar® CIT performance. As the CIT is used with multiple NE connections 
and multiple NE types, the processor type and speed and the memory size will all factor into 
CIT performance.

† Available hard disk space required to install and store the CIT and Generic Software is 
approximately 250 MB (it is 550 MB, if all graphical packages are installed). The additional 
disk space specified is to provide hard disk space to store Alcatel-Lucent 1665 Data 
Multiplexer (1665 DMX) backup files.

‡ Download and install the latest Video Drivers from the PC/Video manufacturer’s web site 

** Download and install the latest NIC Drivers from the PC/NIC manufacturer’s web site 

Components Minimum* Recommended

Section and Chapter Procedure Required

Completed

Yes No

Part I: “Physical installation and powering”

Chapter 2, “Physical installation” Inspection (p. 2-3) Yes

Alcatel-Lucent 1665 DMX high-capacity 
shelf installation (p. 2-4)

Yes

Heat baffle installation (p. 2-8) See Note 1

Power cable and cable bracket installation (p. 
2-10)

Yes

Fiber management installation (optional) (p. 
2-20)

See Note 1

Installing the fiber ducts (optional) (p. 2-23) See Note 1

Alcatel-Lucent 1665 DMX high capacity shelf 
deep add-on fiber tray installation (optional) 
(p. 2-24)

See Note 1
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Alcatel-Lucent 1665 DMX high capacity shelf 
deep add-on fiber tray and 1-inch sideplate 
extension installation (optional) (p. 2-26)

See Note 1

Chapter 3, “Cable and fiber 
installation”

Cable and optical fiber installation (p. 3-6) Yes

DS1 cable installation (p. 3-7) See Note 1

DS3/EC1 and TMUX 48-port cable 
installation (p. 3-14)

See Note 1

12-DS3/EC1 and TMUX (LNW16 LNW18) 
cable installation (p. 3-25)

See Note 1

10/100BaseT backplane ethernet cable 
installation (p. 3-32)

See Note 1

Ethernet cabling to SFP modules on circuit 
pack faceplates (p. 3-36)

See Note 1

IAO LAN and TCP/IP cable installation (p. 3-
39)

See Note 1

Modem cable installation (p. 3-43) See Note 1

Sync cable installation (p. 3-45)

Sync cable with molded DB-9 connector 
procedure (p. 3-46)

See Note 1

Sync cable with wire-wrap DB-9 connector 
procedure (p. 3-48)

See Note 1

Office alarm cable installation (p. 3-51) See Note 1

Miscellaneous (environmental) discrete 
telemetry cable installation (p. 3-57)

See Note 1

Main optical fiber installation (OC-12, OC-48, 
OC-192) (p. 3-61)

See Note 1

Fiber installation for low-speed packs (p. 3-
62)

See Note 1

1000Base-F and 100Base-F fiber installation 
(p. 3-64)

See Note 1

Fibre channel fiber installation (p. 3-66) See Note 1

Section and Chapter Procedure Required

Completed

Yes No
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CIT cable installation (p. 3-67) See Note 1

Final operations (p. 3-70) Yes

Chapter 4, “Powering and initial 
circuit pack installation”

Powering (p. 4-2) Yes

Initial circuit pack installation (p. 4-10) Yes

LNW2 (SYSCTL) installation (p. 4-10) Yes

OC-12 main OLIU installation (p. 4-11) See Note 1

OC-48 main OLIU installation (p. 4-12) See Note 1

OC192 main OLIU installation (p. 4-13) See Note 1

multi-rate main OLIU installation (p. 4-14) See Note 1

LNW80 main switch pack installation (p. 4-
15)

See Note 1

LNW785 OMD5/8 8-channel low-loss 
DWDM Optical mux/demux (p. 4-16)

See Note 1

LNW705 XM10G/8 muxponder pack (p. 4-
17)

See Note 1

LNW7(28DS1PM), LNW8(56DS1E1), 
LNW801(56DS1E1) low-speed installation 
(optional) (p. 4-18)

See Note 1

LNW16 (12DS3/EC1), LNW18 (TMUX), 
LNW19B (48 DS3/EC1), LNW20 (48TMUX) 
low-speed installation (optional) (p. 4-19)

See Note 1

LNW37 (4 OC-3 PTM OLIUs), LNW45 (8 
OC-3 PTM OLIUs), LNW49 (4 OC-12 PTM 
OLIUs), LNW55 (12OC-3/12OC-12/4 OC-48 
PTM OLIUs), LNW62 (4 OC-48 PTM 
OLIUs), LNW603 (OC-192 PTM OLIU) low-
speed installation (optional) (p. 4-20)

See Note 1

LNW31 (OC-48 OLIU) or LNW402 (OC-48 
PTB-based DWDM) low-speed installation 
(optional) (p. 4-22)

See Note 1

Section and Chapter Procedure Required

Completed

Yes No
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LNW31 (OC-48 OLIU) or LNW402 (OC-48 
PTB-based DWDM) low-speed installation 
(optional) (p. 4-22)

See Note 1

LNW66 (10/100T) installation (optional) (p. 
4-23)

See Note 1

LNW63 (1000BASE-SX/LX/LX10), LNW64 
(8 GbE), LNW74 (10/100 T/F), LNW87 
(FE/GBE PL) and LNW170 (100/1G FXS) 
installation (optional) (p. 4-24)

See Note 1

LNW73 (FC-1X/2X) and LNW73C (FC-
1X/2X with compression) installation 
(optional) (p. 4-25)

See Note 1

177D/LNW98 blank CP installation (optional) 
(p. 4-27)

See Note 1

177E/LNW97 blank CP installation (optional) 
(p. 4-27)

See Note 1

Part II: “Stand-alone installation tests”

Chapter 5, “Software download 
and circuit pack installation”

Software installation (p. 5-2) See Note 1

Circuit pack installation (p. 5-2) See Note 1

Use of WaveStar® CIT software (p. 5-6) Yes

Circuit pack firmware version verification (p. 
5-11)

Yes

Alcatel-Lucent 1665 DMX shelf initialization 
(p. 5-13)

Yes

Provision/enable/disable TCP/IP on an IAO 
LAN port (p. 5-13)

See Note 1

Reset system date and time (p. 5-16) Yes

Provision/enable/disable the Alcatel-Lucent 
1665 DMX as a TL1 TCP/IP GNE (p. 5-17)

See Note 1

Chapter 6, “Installation tests” LBO software settings (p. 6-2)

Setting DS1 LBOs (p. 6-2) See Note 1

Setting DS3/EC1 and TMUX LBOs (p. 6-3) See Note 1

Section and Chapter Procedure Required

Completed

Yes No
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Local equipment and cross-connect tests (p. 6-
6)

Yes

Local equipment and cross-connect tests (p. 6-6)

DS1 terminating equipment loopback testing 
(p. 6-6)

See Note 1

DS1 non-terminating equipment transmission 
testing (optical main OLIU) (p. 6-8)

See Note 1

DS1 non-terminating equipment transmission 
testing (LNW80 switch or LNW59 without 
optics) (p. 6-9)

See Note 1

DS1 protection switching (p. 6-10)

DS1 function unit protection switching test 
(manual) (p. 6-10)

See Note 1

DS1 function unit protection switching test 
(command) (p. 6-12)

See Note 1

DS1 path switching test (manual) (p. 6-13) See Note 1

DS1 cleanup procedures (p. 6-14)

Delete any existing DS1 cross-connections (p. 
6-14)

See Note 1

Verify cross-connects removed (p. 6-17) See Note 1

DS3/EC1 and TMUX testing procedure (p. 6-17)

Verify provisioning (p. 6-18) See Note 1

DS3 terminating equipment loopback testing 
(optical main OLIUs) (p. 6-18)

See Note 1

DS3 non-terminating transmission (optical 
main OLIU) (p. 6-22)

See Note 1

“DS3 protection switching” (p. 6-23)

DS3 function unit protection switching test 
(manual) (p. 6-23)

See Note 1

DS3 function unit protection switching test 
(command) (p. 6-24)

See Note 1

DS3 path switching test (command) (p. 6-25) See Note 1

Section and Chapter Procedure Required

Completed

Yes No



............................................................................................................................................................................................................................................................
I-12 Alcatel-Lucent 1665 DMX R9.0

365-372-304R9.0 Issue 2
July 2010

............................................................................................................................................................................................................................................................

OverviewPhysical installation and powering
I

DS3 cleanup procedures (p. 6-26)

Delete the existing DS3 cross-connections (p. 
6-26)

See Note 1

LNW66 and LNW74 (10/100T) TX ethernet 
cabling testing (p. 6-29)

Ethernet port assignment verification testing 
(p. 6-30)

See Note 1

Ethernet port wiring verification testing (p. 6-
31)

See Note 1

OC-3 (LNW37, LNW45, LNW55)/OC-12 
(LNW49, LNW55)/OC-48 (LNW55, LNW62, 
LNW402) low-speed SFP test procedure (p. 6-
34)

OC-3/OC-12/OC-48 SFP low-speed SFP test 
procedure (p. 6-34)

See Note 1

OC-3 (low-speed) testing (p. 6-35)

OC-3 testing procedure (p. 6-35) See Note 1

OC-12 testing procedure (p. 6-39) See Note 1

OC-12 facility loopback testing (p. 6-42) See Note 1

OC-48 low-speed testing procedure (p. 6-44) See Note 1

OC-192 facility loopback testing (p. 6-49) See Note 1

OC-192 low-speed testing procedure (p. 6-48) See Note 1

OC-192 facility loopback testing (p. 6-49) See Note 1

LED test procedure (p. 6-52) See Note 1

Additional optical tests (optional) (p. 6-52)

Low-speed optical testing (p. 6-52) See Note 1

Chapter 7, “Operational tests” See Note 

Office alarm test procedure (p. 7-3) See Note 1

Automatic protection switching and alarm test 
(p. 7-6)

Main OLIU switching test (p. 7-7) See Note 1

Section and Chapter Procedure Required

Completed

Yes No
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Manual switching tests (p. 7-9)

Main OLIU switching test (p. 7-9) See Note 1

External timing verification (p. 7-10)

Timing verification test procedure (p. 7-11) See Note 1

Miscellaneous (environmental) discrete 
telemetry test (p. 7-14)

Miscellaneous discrete telemetry test 
procedure (p. 7-14)

See Note 1

Modem connection test (p. 7-17)

Modem connection test procedure (p. 7-17) See Note 1

Final operations (p. 7-19) Yes

Part III: “Network turn-up and testing”

Chapter 8, “OC-3/12/48 ring 
setup and testing: integration 
procedures”

Fiber installation (p. 8-2)

Fiber installation procedure (p. 8-4)

Optical transmission test (OC-192, OC-48, 
OC-12) (p. 8-9)

Transmission test procedure (p. 8-9)

Automatic protection switching test (p. 8-10)

Main OLIU switch test (p. 8-11)

Manual switching tests (p. 8-12)

Manual switching test procedure (p. 8-12) Yes

Function units/growth slots, switching test (p. 
8-13)

Final operations (p. 8-14)

Steps (p. 8-14)

Clear PM registers (p. 8-14)

Chapter 9, “WDMX setup and 
testing: integration procedures”

Turn-up and test the LNW785 8-channel 
OMD (p. 9-4)

Section and Chapter Procedure Required

Completed

Yes No
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Turn up and test the LNW705 muxponder (p. 
9-6)

Integrating the LNW705 into the LNW785 (p. 
9-9)

Connecting the ring (Mains) to the WDMX (p. 
9-11)

Removing provisioning and equipage from the 
LNW705 and LNW785 (p. 9-14)

Notes:  
1. Only required if equipped.

Section and Chapter Procedure Required

Completed

Yes No
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Overview

Purpose

This section provides physical installation instructions for the Alcatel-Lucent 1665 Data 
Multiplexer (Alcatel-Lucent 1665 DMX), power cabling and fiber management. 

Contents

This chapter provides information on the following topics

Planning 2-2

Inspection 2-3

Alcatel-Lucent 1665 DMX high-capacity shelf installation 2-4

Heat baffle installation 2-8

Power cable and cable bracket installation 2-10

Fiber management installation (optional) 2-20

Installing the fiber ducts (optional) 2-23

Alcatel-Lucent 1665 DMX high capacity shelf deep add-on fiber tray installation 
(optional)

2-24

Alcatel-Lucent 1665 DMX high capacity shelf deep add-on fiber tray installation 
(optional)

2-26



............................................................................................................................................................................................................................................................
2-2 Alcatel-Lucent 1665 DMX R9.0

365-372-304R9.0 Issue 2
July 2010

............................................................................................................................................................................................................................................................

PlanningPhysical installation

Planning

Description

This section provides information about the following:

• Tools, test equipment and accessories

• Mounting options

• Cabling checklist.

Tools, test equipment and accessories

The tools, test equipment and accessories necessary to perform the procedures in this 
section are listed in Table I-1, “Tool, test equipment and accessories required” (p. I-3) 
Installers should have both metric and English unit tools.

Mounting options

The mounting brackets on the Alcatel-Lucent 1665 DMX high-capacity shelf are designed 
to allow for mounting in the following:

• Standard 23-inch wide network bay frames

The recommended network bay frames are the ED-8C500 and the ED-8C501 (rear 
access only). See Figure 2-3, “Typical Alcatel-Lucent 1665 DMX high-capacity shelf 
bay mounting arrangements” (p. 2-7) for Alcatel-Lucent 1665 DMX shelf placement 
in a network bay frame. 

• Seismic 23-inch network bay frame

The ED-8C800-500 and ED-8C801-501 seismic network bay frames are designed for 
use in all earthquake zones, and in general, do not require top support at the 7-foot 
level. These frames meet Pacific Bell Equipment Framework Standard PBS-000-
102PT. 

• 19-inch bay frames

• 23-inch wide EIA-Type bay frames

Alcatel-Lucent 1665 DMX added to the Alcatel-Lucent1675 LambdaUnite MSS configurations 

In order for the Alcatel-Lucent 1665 DMX shelf to be placed in a NEBS-2000 Cabinet 
frame combined with Alcatel-Lucent 1675 LambdaUnite MSS, mounting kit 848856514 
is required. For a more complete view of mounting the Alcatel-Lucent 1665 DMX into the 
Alcatel-Lucent 1675 LambdaUnite MSS Frame, see SIG-L-WW-161A, Alcatel-Lucent 
1665 DMX added to the Alcatel-Lucent 1675 LambdaUnite MSS configurations.
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Cabling checklist

This section briefly describes cabling information. For information regarding available 
cable lengths and ordering comcodes, see ED8C871-10.

Table 2-1, “Cable requirements and options” (p. 2-3) lists available cables.

Table 2-1 Cable requirements and options

Notes:  
1. One -48VA and -48VB main power feeder is required per shelf. 

2. One Fan Cable (848839551) is shipped with each Alcatel-Lucent 1665 DMX high-
capacity shelf.

Inspection

Description

Perform the following procedure before installing the Alcatel-Lucent 1665 DMX high-
capacity shelf.

Steps

........................................................................................................................................................................................................................

1 Inspect the shelf for visible damage including bent or touching backplane pins.

Note: If any backplane pins are damaged, see Appendix C, “Backplane pin 
replacement” for instructions on repairing the damaged pin(s).

........................................................................................................................................................................................................................

2 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Cable assembly description Required See note

Power Yes 1

Fan Yes 2
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Alcatel-Lucent 1665 DMX high-capacity shelf installation

Description

As an example of the Alcatel-Lucent 1665 DMX high-capacity shelf installation, the 
following steps describe mounting the shelf from the rear of a 23-inch bay frame. 
Mounting from the front of a 23-inch bay frame or from the front/rear of a 19-inch bay 
frame is similar with the exception of the position of the side brackets.

Positioning of the side brackets is also specified.

Note: This section requires previous bay frame installation and grounding.

Steps

........................................................................................................................................................................................................................

1 Determine the mounting configuration for the Alcatel-Lucent 1665 DMX high-capacity 
shelf:

• Type of bay frame (23-inch or 19-inch wide)

• Mounting position (front or rear)

• Position in bay (bottom to top).

Note: The Alcatel-Lucent 1665 DMX high-capacity shelf is shipped with the 
mounting brackets positioned for mounting to the rear of a 23-inch wide network bay 
frame.

The Alcatel-Lucent 1665 DMX high-capacity shelf mounting brackets may have to be 
repositioned and remounted, depending on the frame type and mounting position (front or 
rear).

........................................................................................................................................................................................................................

2 If necessary, reposition the shelf mounting brackets accordingly.

For 23-inch frame, front or rear mounting, see Figure 2-1, “Alcatel-Lucent 1665 DMX 
high-capacity shelf mounting bracket positions — 23-inch frame” (p. 2-5).

For 19-inch frame, front or rear mounting, see Figure 2-2, “Alcatel-Lucent 1665 DMX 
high-capacity shelf mounting bracket positions — 19-inch frame” (p. 2-6).
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Alcatel-Lucent 1665 DMX high-capacity shelf installationPhysical installation

Figure 2-1 Alcatel-Lucent 1665 DMX high-capacity shelf mounting bracket 
positions — 23-inch frame
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Alcatel-Lucent 1665 DMX high-capacity shelf installationPhysical installation

Figure 2-2 Alcatel-Lucent 1665 DMX high-capacity shelf mounting bracket 
positions — 19-inch frame

........................................................................................................................................................................................................................

3 Determine the position that the Alcatel-Lucent 1665 DMX high-capacity shelf will be 
mounted. Figure 2-3, “Typical Alcatel-Lucent 1665 DMX high-capacity shelf bay 
mounting arrangements” (p. 2-7) shows the recommended mounting positions. Start at the 
bottom of the bay and add shelves from bottom to top.

Note: There is a switch on the fan unit controller board. It is labeled "CF ALM ON" 
(Clogged Filter Alarm ON) and "CF ALM OFF" (Clogged Filter OFF). The fan ships 
with the switch in the disable position which prevents the filter alarm from working. 
To enable the filter alarm, remove the fan unit from the Alcatel-Lucent 1665 DMX 
high-capacity shelf, move the switch to the "CF ALM ON" position and then reinstall 
the fan unit in the shelf.

........................................................................................................................................................................................................................

4  Position the Alcatel-Lucent 1665 DMX high-capacity shelf in the frame and secure it to 
the frame using the thread-forming screws included with the shelf (4 screws per side). 
Tighten the screws to 21 in.-lb. (minimum)/30 in.-lb. (maximum).

TIGHTEN SCREWS
TO 10 IN.-LB.
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Alcatel-Lucent 1665 DMX high-capacity shelf installationPhysical installation

Note: Be sure to mount the shelf using the thread-forming screws provided with the 
shelf to ensure a solid ground connection from the bay to the shelf.

Figure 2-3 Typical Alcatel-Lucent 1665 DMX high-capacity shelf bay mounting 
arrangements

........................................................................................................................................................................................................................

5 Verify with an ohmmeter that the Alcatel-Lucent 1665 DMX high-capacity shelf is 
grounded to the bay frame. Measure between the Alcatel-Lucent 1665 DMX high-
capacity shelf mounting bracket and the office ground lug on the bay frame.

Requirement: The ohmmeter reads less than 1 ohm.
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Heat baffle installationPhysical installation

........................................................................................................................................................................................................................

6 If the Ohmmeter reading is not less than 1 ohm, a secondary ground should be used for 
each shelf. Use an 8 AWG wire from the UL (Green M5 Screw) safety ground on the side 
of the shelf to bay frame or office ground.

Note: It is important to remove the paint in the area where the wire is to be 
connected to the bay and to apply no-ox before connecting the wire.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Heat baffle installation

Description

If an Alcatel-Lucent 1665 DMX shelf is added above existing non-Alcatel-Lucent 1665 
DMX equipment, one heat baffle (848862181) must be installed between the Alcatel-
Lucent 1665 DMX shelf and the existing equipment.

........................................................................................................................................................................................................................

1 Determine the mounting configuration for the heat baffle:

• Type of bay frame (23-inch or 19-inch wide)

• Mounting position (front or rear)

• Position in bay (below shelf mounted above non-Alcatel-Lucent 1665 DMX heat 
generating equipment).

Note: The heat baffle is shipped with the mounting brackets positioned for mounting 
to the rear of a 23-inch wide network bay frame.

The heat baffle mounting brackets may have to be repositioned and remounted, depending 
on the frame type and mounting position (front or rear).

........................................................................................................................................................................................................................

2 If necessary, reposition the heat baffle mounting brackets to match the position of the 
Alcatel-Lucent 1665 DMX high-capacity shelf.
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Heat baffle installationPhysical installation

........................................................................................................................................................................................................................

3 See Figure 2-4, Heat baffle position (p. 2-9) for the mounting position and orientation of 
the heat baffle.

Figure 2-4 Heat baffle position

........................................................................................................................................................E N D  O F  S T E P S
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Power cable and cable bracket installation

Description

This section provides instructions on installing the power cable and cable bracket for the 
Alcatel-Lucent 1665 DMX high-capacity shelf.

Note: Two feeders (A and B) are required from the battery distribution fuse board 
(BDFB) or battery distribution circuit breaker bay (BDCBB) to the Alcatel-Lucent 
1665 DMX bay.

Table 2-3, “Power cable assemblies” (p. 2-19) and Table 2-4, “Power connections” 
(p. 2-20) list the available power cable assemblies and power connections, respectively.

Steps

........................................................................................................................................................................................................................

1 Install cable brackets (two per Alcatel-Lucent 1665 DMX high-capacity shelf, 1 on each 
side) as shown in Figure 2-5, “Cable brackets” (p. 2-11).

Important! Verify that the BDCBB breakers are off or that the BDFB fuses 
are not installed. 
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Power cable and cable bracket installationPhysical installation

Figure 2-5 Cable brackets

Note: Depicted above is the Alcatel-Lucent 1665 DMX shelf for reference purposes 
only, the cable bracket is the same for the Alcatel-Lucent 1665 DMX high-capacity 
shelf.

........................................................................................................................................................................................................................

2 If installation is on raised floors, rotate the power connectors on each side of the shelf 180 
degrees, as shown:

Otherwise, ensure that power connector is in the following position:

CABLE
BRACKET
(ordered separately)
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Power cable and cable bracket installationPhysical installation

Table 2-2 Power cable positioning 

........................................................................................................................................................................................................................

3 There are two mounting positions on each side of the Alcatel-Lucent 1665 DMX high-
capacity shelf chassis as shown in Figure 2-6, “Power connector mounting positions” 
(p. 2-13). It is recommended that if multiple shelves are being installed in a frame, the 
power connector positions be alternated as shown in Figure 2-7, “Alternating power cable 
routing” (p. 2-14). 

Determine if the power connector needs to be moved to the other mounting position. If so, 
move the power connector to the other mounting position now.

Important! Use provided hardware only to adjust the position of the power 
connector housing.
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Power cable and cable bracket installationPhysical installation

Figure 2-6 Power connector mounting positions 

Note: Figure 2-7, “Alternating power cable routing” (p. 2-14) shows the typical 
power cabling for four Alcatel-Lucent 1665 DMX high-capacity shelf shelves in a 
standard bay frame. The side view shows the power connectors for shelves 3 and 1 
mounted closest to the rear of the shelves (default position) with the cabling for shelf 1 
bending away from the power connector on shelf 3 and running over it until the power 
cables exit the bay. The power connectors for shelves 4 and 2 are mounted in the 
alternate position on the shelf and the power cables routed in the same manner.

POWER CONNECTOR
MOUNTING POSITIONS

RIGHT SIDE
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Power cable and cable bracket installationPhysical installation

Figure 2-7 Alternating power cable routing 

........................................................................................................................................................................................................................

4 Connect power cable to the power connector housing on the Alcatel-Lucent 1665 DMX 
high-capacity shelf chassis Figure 2-8, “Power connection” (p. 2-15).
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Power cable and cable bracket installationPhysical installation

Figure 2-8 Power connection

........................................................................................................................................................................................................................

5 Route the power cable out of the bay and toward the BDCBB or BDFB, stacking the cable 
in the bay as shown in Figure 2-9, “Power cable routing with cable bracket” (p. 2-16) or 
Figure 2-10, “Power cable routing without cable bracket” (p. 2-17).

Note: The Alcatel-Lucent 1665 DMX high-capacity shelf is powered by -48 V DC.

NOTICE

Equipment damage

Ensure that the 4 pins inside the connector attached to the power cable are 
properly aligned before inserting the connector into the power connector 
housing. Failure to do so may result in damage to the connector.

POWER

POWER CONNECTORHOUSING MOUNTING
POSITION HOUSING

CABLE
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:

Figure 2-9 Power cable routing with cable bracket

Note: The shelf shown in Figure 2-9, “Power cable routing with cable bracket” 
(p. 2-16) is the Alcatel-Lucent 1665 DMX and not the Alcatel-Lucent 1665 DMX 
high-capacity shelf, however the power cabling remains the same and is depicted here 
for reference.

Important! Verify that the BDCBB breakers are off or that the BDFB fuses 
are not installed.

POWER

CABLE

POWER
CONNECTOR

CABLES

BRACKET
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Power cable and cable bracket installationPhysical installation

Figure 2-10 Power cable routing without cable bracket

Note:  The shelf shown in Figure 2-9, “Power cable routing with cable bracket” 
(p. 2-16) is the Alcatel-Lucent 1665 DMX and not the Alcatel-Lucent 1665 DMX 
high-capacity shelf, however the power cabling remains the same and is depicted here 
for reference.

........................................................................................................................................................................................................................

6 Splice feeders from the BDCBB or BDFB to the Alcatel-Lucent 1665 DMX high-capacity 
shelf power cable. See Table 2-4, “Power connections” (p. 2-20).

Note: Four cables are spliced to each power cable:

1. BAT A

2. BAT A RTN

3. BAT B

4. BAT B RTN

POWER

POWER
CONNECTOR

CABLES
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Power cable and cable bracket installationPhysical installation

........................................................................................................................................................................................................................

7 Label the feeders at the BDCBB or BDFB as follows:

1. BAT A

2. BAT A RTN

3. BAT B

4. BAT B RTN

Note: Each feeder at the BDCBB should be rated 1.25 times the rating of the circuit 
breaker on the shelf. For the BDFB, the fuse rating should be 1.5 times the rating of 
the circuit breaker on the shelf.

........................................................................................................................................................................................................................

8 Leave the BDCBB breakers off or BDFB fuses out until you are ready to perform the 
procedures in Chapter 4, “Powering and initial circuit pack installation” of this manual.

........................................................................................................................................................................................................................

9 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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Power cable and cable bracket installationPhysical installation

Table 2-3 Power cable assemblies

Description
Cable 
gauge

Cable 
assembly #

Cable 
length 
(feet)

Alcatel-Lucent 1665 
DMX high-capacity 
shelf backplane 
connections

Power cable 10 848841839 12 Connectors mounted on 
sides of the shelf 
(BAT A and BAT B)

6 848635009 12

848635033 50

848635041 75

848635058 100

4 848935268 35

848634986 55

848635025 100

2 848935276 55

848634978 85

848635017 100

Cable 
connector kit

2 848635231

4 848635249

6 848635934

Cable bracket 846593002
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Fiber management installation (optional)Physical installation

Table 2-4 Power connections

Fiber management installation (optional)

Description

This section describes how to install the fiber management pieces that may be shipped 
with the bay.

Note: If fiber management is to be installed, the width of the bay footprint must be 
extended by at least 2.5 inches beyond the bay upright on each side. This is typically 
done using base fillers.

Comcode numbers are in parentheses next to the part.

Steps

........................................................................................................................................................................................................................

1 Locate three spools (106738156), one fiber radius control module (321-1B), one left fiber 
spool bracket (848919213) and three M4 X 6 bracket mounting screws (901340059) for 
each shelf being installed.

........................................................................................................................................................................................................................

2 For each spool, put a nylach fastener through the middle, then insert a pin halfway 
through.

Backplane 
connection

Shelf power 
connectors 
(on sides) Pin# Color Designation Name

P14 BAT A 1 R -48VA BAT A

2 W -48RTNA BAT A RTN

P15 BAT B 1 R -48VB BAT B

2 W -48RTNB BAT B RTN

Notes:  
1. Power cables for shelves 4 and 2 are mounted using the connector mounting holes located 

closest to the rear of the shelves with the cabling for shelf 2 bending away (out) from the 
power connector in shelf 4 and running over it until the power cables exit the bay. The 
power runs for shelves 1 and 3 are run in the same manner as described for shelves 2 and 
4 using the connector holes located furthest from the rear of the shelf.
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Fiber management installation (optional)Physical installation

Note: It is very important that the pin is not completely inserted. This will deform 
the fastener and prevent it from being assembled to the bracket.

........................................................................................................................................................................................................................

3 Line up the nylach fastener in one of the spools with the large holes on the top arm of the 
bracket.

........................................................................................................................................................................................................................

4 Spin the spool until the peg on its back fits into the smaller hole on the arm of the bracket. 
This will keep the spool from spinning any further.

........................................................................................................................................................................................................................

5 Push the pin until it is completely fastened.

........................................................................................................................................................................................................................

6 Repeat Step 3 through Step 5 for all the spools, with three per bracket. 
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........................................................................................................................................................................................................................

7 Attach one fiber radius control module to the bottom of each bracket, as shown:

........................................................................................................................................................................................................................

8 Position one of the brackets along the left side of shelf 1. Secure with three bracket 
mounting screws.

........................................................................................................................................................................................................................

9 Repeat Step 8 for all the other shelves being installed.

........................................................................................................................................................................................................................

10 Locate three spools (848919221), one fiber radius control module (321-1B), one right 
fiber spool bracket (848919221) and three M4 X 6 bracket mounting screws (901340059) 
for each shelf being installed.

........................................................................................................................................................................................................................

11 For each spool, put a nylach fastener through the middle. Then insert a pin halfway 
through.

Note: It is very important that the pin is not completely inserted. This will deform 
the fastener and prevent it from being assembled to the bracket.

........................................................................................................................................................................................................................

12 Line up the nylach fastener in one of the spools with the large holes on the top arm of the 
bracket.

........................................................................................................................................................................................................................

13 Spin the spool until the peg on its back fits into the smaller hole on the arm of the bracket. 
This will keep the spool from spinning any further.
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........................................................................................................................................................................................................................

14 Push the pin until it is completely fastened.

........................................................................................................................................................................................................................

15 Repeat Step 12 through Step 14 for all the spools, with three per bracket.

........................................................................................................................................................................................................................

16 Attach one fiber radius control module to the bottom of each bracket.

........................................................................................................................................................................................................................

17 Position one of the brackets along the right side of shelf 1. Secure with 3 bracket mounting 
screws.

........................................................................................................................................................................................................................

18 Repeat Step 17 for all the other shelves being installed.

........................................................................................................................................................................................................................

19 Using a label maker, create 16 labels "LS" and 8 labels "HS".

........................................................................................................................................................................................................................

20 Attach the "HS" labels to the uppermost spool on each of the brackets.

........................................................................................................................................................................................................................

21  Attach the "LS" labels to the middle and lower spools on each of the brackets.

........................................................................................................................................................................................................................

22 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Installing the fiber ducts (optional)

Description

This procedure describes how to install the fiber ducts on either side of the bay. The fiber 
ducts may be shipped with the Alcatel-Lucent 1665 DMX. 

Note: If fiber management is to be installed, the width of the bay footprint must be 
extended by at least 2.5 inches beyond the bay upright on each side. This is typically 
done using base fillers. 
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Alcatel-Lucent 1665 DMX high capacity shelf deep add-on
fiber tray installation (optional)

Physical installation

Steps

........................................................................................................................................................................................................................

1 From the 848920476 Fiber Duct Components Kit, locate 2 fiber ducts (848955845), 6 
metal fiber duct brackets (848915153), 12 12-24 X 3/8” HWH screws (901211177) and 6 
M5 X 8 (901340547).

........................................................................................................................................................................................................................

2 Using the 12-24 X 3/8” screws, secure the metal brackets to the front of the bay (three on 
each side), using the holes in between shelf 1 and shelf 2; shelf 2 and shelf 3; shelf 3 and 
shelf 4.

........................................................................................................................................................................................................................

3 Position one of the fiber ducts along the left side of the shelves.

........................................................................................................................................................................................................................

4 From the front of the duct, use the M5 X 8 screws to secure it to the metal brackets.

........................................................................................................................................................................................................................

5 Position the other fiber ducts along the right side of the shelves.

........................................................................................................................................................................................................................

6 From the front of the duct, use the M5 X 8 screws to secure it to the metal brackets. 

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Alcatel-Lucent 1665 DMX high capacity shelf deep add-on fiber 
tray installation (optional)

Purpose

This procedure describes how to install the deep add-on fiber tray that ships loose with 
1665 DMX high capacity shelf (849130158). The procedure assumes that the shelf has 
already been mounted in a bay frame.
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Alcatel-Lucent 1665 DMX high capacity shelf deep add-on
fiber tray installation (optional)

Physical installation

Steps

........................................................................................................................................................................................................................

1 Verify shelf has been physically mounted in a bay frame prior to installing installing the 
new deep add-on fiber tray.

........................................................................................................................................................................................................................

2 Move any fibers/cables from the existing 1665 DMX high capacity shelf fiber tray out of 
to way to avoid damage.

........................................................................................................................................................................................................................

3 Align the end of the deep add-on tray with the existing shelf fiber tray as shown in 
Figure 2-11, Deep add-on fiber tray (p. 2-26).

........................................................................................................................................................................................................................

4 Push straight down on the add-on fiber tray to install it to the shelf.

Note: Do not use installed add-on fiber tray as a means to lift or position the shelf or 
risk of injury could occur.

NOTICE

Laser hazard

Be careful when touching fibers that are live and ensure the minimum bend 
radius is met to prevent a service event.
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Alcatel-Lucent 1665 DMX high capacity shelf deep add-on
fiber tray and 1-inch sideplate extension installation

(optional)

Physical installation

Figure 2-11 Deep add-on fiber tray

Alcatel-Lucent 1665 DMX high capacity shelf deep add-on fiber 
tray and 1-inch sideplate extension installation (optional)

Purpose

This procedure describes how to install optional add-on sideplate extensions, a deep add-
on fiber tray, edging grommet material and a flush front coveron the 1665 DMX high 
capacity shelf (848793287). The procedure assumes that the shelf has already been 
mounted in a bay frame.

Steps

........................................................................................................................................................................................................................

1 Verify shelf has been physically mounted in a bay frame prior to installing installing the 
new deep add-on fiber tray.

........................................................................................................................................................................................................................

2 Move any fibers/cables from the existing 1665 DMX high capacity shelf fiber tray out of 
to way to avoid damage.



............................................................................................................................................................................................................................................................
Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

2-27

............................................................................................................................................................................................................................................................

Alcatel-Lucent 1665 DMX high capacity shelf deep add-on
fiber tray and 1-inch sideplate extension installation

(optional)

Physical installation

........................................................................................................................................................................................................................

3 If present, remove and discard the extended front cover, see Figure 2-12, Cover, fiber tray, 
and edging grommet (p. 2-27). It will not be reused on the shelf.

Figure 2-12 Cover, fiber tray, and edging grommet

........................................................................................................................................................................................................................

4 If present, remove and discard the existing shallow add-on fiber tray, see Figure 2-12, 
Cover, fiber tray, and edging grommet (p. 2-27), by rotating/bending the front of the tray 
upward and then pushing the whole tray upward.

........................................................................................................................................................................................................................

5 Remove the existing edging grommet, see Figure 2-12, Cover, fiber tray, and edging 
grommet (p. 2-27), from the sideplates near each end of the fiber tray. If too many 
fibers/cables are routed thru this area to make removal possible, this step can be skipped 
and the existing fiber tray can remain.

NOTICE

Laser hazard

Be careful when touching fibers that are live and ensure the minimum bend 
radius is met to prevent a service event.
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Alcatel-Lucent 1665 DMX high capacity shelf deep add-on
fiber tray and 1-inch sideplate extension installation

(optional)

Physical installation

........................................................................................................................................................................................................................

6 Loosen the two screws pre-mounted in the left sideplate extension assembly and mount 
the assembly to the shelf left sideplate, see Figure 2-13, Sideplate extensions (p. 2-28), 
Part A.

Figure 2-13 Sideplate extensions

........................................................................................................................................................................................................................

7 Install two additional sideplate extension screws, see Figure 2-13, Sideplate extensions (p. 
2-28), Part B. Tighten all four screws.

........................................................................................................................................................................................................................

8 Repeat Step 5 - Step 7 for the right side plate extension assembly.

........................................................................................................................................................................................................................

9 Install the new edging grommet on each sideplate and sideplate extension. The left side 
installation, see Figure 2-14, Deep add-on fiber tray with edging grommet (p. 2-29). If the 
original grommet could not be removed due to existing fibers/cables, then cut a short 
(approximately, 1-inch long) piece of grommet and install it on the bottom edge of each 
sideplate extension.
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Alcatel-Lucent 1665 DMX high capacity shelf deep add-on
fiber tray and 1-inch sideplate extension installation

(optional)

Physical installation

Figure 2-14 Deep add-on fiber tray with edging grommet

........................................................................................................................................................................................................................

10 Align the end of the deep add-on tray with the existing shelf fiber tray, see Figure 2-14, 
Deep add-on fiber tray with edging grommet (p. 2-29).

........................................................................................................................................................................................................................

11 Push straight down on the add-on fiber tray to install it to the shelf.

Note: Do not use installed add-on fiber tray as a means to lift or position the shelf or 
risk of injury could occur.

........................................................................................................................................................................................................................

12 Install the Kit ID label on the left sideplate, see Figure 2-15, Kit ID label (p. 2-30).
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Alcatel-Lucent 1665 DMX high capacity shelf deep add-on
fiber tray and 1-inch sideplate extension installation

(optional)

Physical installation

Figure 2-15 Kit ID label

........................................................................................................................................................................................................................

13 Install the flush front cover, see Figure 2-16, Flush front cover (p. 2-30).

Figure 2-16 Flush front cover

........................................................................................................................................................E N D  O F  S T E P S
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3 Cable and fiber 
installation

Overview

Purpose

This section provides installation and cabling instructions for the Alcatel-Lucent 1665 
Data Multiplexer (Alcatel-Lucent 1665 DMX). 

Contents

This chapter provides information on the following topics:

Planning 3-2

Connector references 3-4

Cable and optical fiber installation 3-6

DS1 cable installation 3-7

DS3/EC1 and TMUX 48-port cable installation 3-14

12-DS3/EC1 and TMUX (LNW16 LNW18) cable installation 3-25

10/100BaseT backplane ethernet cable installation 3-32

Ethernet cabling to SFP modules on circuit pack faceplates 3-36

IAO LAN and TCP/IP cable installation 3-39

Modem cable installation 3-43

Sync cable installation 3-45

Office alarm cable installation 3-51

Miscellaneous (environmental) discrete telemetry cable installation 3-57

Main optical fiber installation (OC-12, OC-48, OC-192) 3-61

Fiber installation for low-speed packs 3-62

1000Base-F and 100Base-F fiber installation 3-64
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PlanningCable and fiber installation

Planning

Description

This section provides information about the following:

• Tools, test equipment and accessories

• Mounting options

• Cabling checklist.

Tools, test equipment and accessories

The tools, test equipment and accessories required in this section are located in Tools, test 
equipment, and accessories (p. I-2). Installers should have both metric and English unit 
tools.

.Cabling checklist

This section briefly describes cabling information. For information regarding available 
cable lengths and ordering comcodes, see ED8C871-10.

Table 3-1, “Cable requirements and options” (p. 3-3) lists available cables.

Fibre channel fiber installation 3-66

CIT cable installation 3-67

Final operations 3-70
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PlanningCable and fiber installation

Table 3-1 Cable requirements and options

Cable assembly description Required See note

CIT or Cross over LAN Cable Yes 1, 7

DS1 Optional 2

DS3 Optional 3

TMUX Optional 3

10/100BaseT Ethernet Optional 4

Office Alarm Optional 5

Office Alarm Mult Optional 5

Miscellaneous Discrete Optional 6

LAN 10BaseT (Crossover) Optional 7

LAN 10BaseT (Straight Through) Optional 7

Sync Timing Optional 8

Modem Optional 9
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Connector referencesCable and fiber installation

Notes:  
1. One CIT Cable Assembly or Crossover LAN cable is required for PC interface with the 

Alcatel-Lucent 1665 DMX high-capacity shelf (not included with equipment).

2. a. One DS1 Cable Assembly is required for each Function unit equipped for 28 DS1 service ( 
LNW7). Each DS1 Cable Assembly consists of two separate cables, both containing 28 pairs 
of 24 gauge cable. One cable is for input and the other cable is for output.
b.Two DS1 Cable Assemblies are required for each Function unit equipped for 56 DS1 service 
(LNW8, LNW801). Each DS1 Cable Assembly consists of two separate cables, both 
containing 28 pairs of 24 gauge cable. One cable is for input and the other cable is for output.

3. a. One DS3 Cable Assembly is required for each Function unit equipped for 12 DS3 service 
(LNW16/LNW18). Each orderable code provides two cables One cable consists of 12 inputs 
and the other cable consists of 12 outputs. One DS3 Cable Assembly equipped with 24-coax 
cables may be used if growth to 48 DS3 packs is planned.
b. Two DS3 Cable Assemblies are required for each Function unit equipped for 48 DS3 
service (LNW19B/LNW20). Each DS3 Cable Assembly consists of two separate cable 
groups, both containing 735A cables. One cable consists of 24 inputs and the other cable 
consists of 24 outputs.

4. One cable is required for channels 1 through 12 and another for channels 13 through 24 
(LNW66). LNW74 provides only ports 1 through 16.

5. When cabling the Alcatel-Lucent 1665 DMX high-capacity shelf for office alarm 
applications, one Office Alarm Cable Assembly is required for the bottom Alcatel-Lucent 
1665 DMX shelf in a bay frame. One Office Alarm Mult Cable Assembly is required for each 
additional Alcatel-Lucent 1665 DMX shelf in the bay frame. 
For example, if four Alcatel-Lucent 1665 DMX shelves are located in a single 7-foot bay 
frame, one Office Alarm Cable Assembly and three Office Alarm Mult Cable Assemblies are 
required.

6. One misc. discrete cable per shelf as required.

7. These cables are used for IAO LAN (OSI/TCP-IP)/Front LAN (OSI/TCP-IP) connection (J16 
and Front LAN port). LAN 10BaseT cross over cable should be used if the shelf is directly 
connected to a PC and LAN 10BaseT straight through cable should be used if shelf is 
connected to a hub.

8. Two cables per shelf for Ref1 and Ref2.

9. RS232 modem cable (RJ45 to 25-pin).

Connector references

Description

Figure 3-1, Connector types and pinouts (p. 3-5) provides the pinouts of some of the 
connectors used to interface with the Alcatel-Lucent 1665 DMX.
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Connector referencesCable and fiber installation

Figure 3-1 Connector types and pinouts

:

DB-9 male-type connector

DB-15 male-type connector

DB-25 male-type connector

DB-62 male-type connector

1 5

6 9

1 8

9 15

1 13

14 25

1 21

43 62

22 42

DB-9 female-type connector

DB-15 female-type connector

DB-25 female-type connector

DB-62 female-type connector

15

69

8 1

15 9

13 1

24 14

21 1

62 43

42 22

RJ-45 type connector

1

8 1 8
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Cable and optical fiber installationCable and fiber installation

Cable and optical fiber installation

Introduction

Note: Ensure only ANGLED LC connectors appear at IN ports of optical circuit 
packs. The “ANGLED” is referring to the rotating boot on the connector and not the 
connector. APC or Angled Polished Connectors are not supported.

........................................................................................................................................................................................................................

1 If fiber management systems have been installed:

a. High-speed fibers should be routed along the fiber radius control module and then 
up to the uppermost spool. 

b. Fiber management of low speed fibers should start with the lowest spool. Once 
full, fiber should be routed along the fiber radius control module and then up to the 
middle spool.

c. As shown in the picture below, fiber from the lowest spool (low speed) is routed in 
the outermost section of the fiber duct; the middle spool (low speed) to the middle 
section; and the upper spool (high speed) to the inner section.

Note: The high-speed fiber, routed in the innermost duct, should be held with 
Hellerman Tyton RED grip tie (GT.75X1802) or equivalent. The low speed fiber 
should be held with Hellerman Tyton YELLOW grip tie (GT.75X1804) or equivalent.
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DS1 cable installationCable and fiber installation

........................................................................................................................................................................................................................

2 Check off the appropriate box in Table I-2, Computer requirements.

........................................................................................................................................................E N D  O F  S T E P S

DS1 cable installation

Description

This section describes how to connect the DS1 transmission cables to the shelf, route the 
cables out of the bay and connect the cables to the DSX. Perform this procedure if DS1 
cables are required.
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DS1 cable installationCable and fiber installation

Note: When cabling the Alcatel-Lucent 1665 DMX high-capacity shelf to a DSX, 
the DSX becomes an extension of the Alcatel-Lucent 1665 DMX high-capacity shelf 
backplane connections. Thus the IN on the Alcatel-Lucent 1665 DMX high-capacity 
shelf backplane connects to the IN of the DSX and the OUT of the Alcatel-Lucent 
1665 DMX high-capacity shelf backplane connects to the OUT of the DSX 
respectively.

The cables are connectorized at the Alcatel-Lucent 1665 DMX high-capacity shelf end 
and must be wire-wrapped at the DSX end. A total of four function groups fully cabled 
may have up to 224 DS1 drop capacity if the higher density DS1 circuit packs are 
equipped.

Note: The connectorized cable end is grounded to the Alcatel-Lucent 1665 DMX 
frame ground through the backplane. Alcatel-Lucent recommends that the shield at 
both ends of the cable be grounded. Ground at the DSX end per office requirements.

Steps

........................................................................................................................................................................................................................

1 See the engineering job specification. Obtain the DS1 cables per Table 3-2, “DS1 cable 
assemblies” (p. 3-11) and note the function group where each cable will be used. Label the 
cables, indicating bay, shelf, function group (A, B, C or D) and direction (IN or OUT of 
the bay) at each end.

Note: The first 28 DS1s of a Function Group, must be connected to the bottom 
connectors (J1- J8). The additional capacity (28 additional DS1s, 29-56) of the 
Function Group use the connectors located in the middle of the backplane (J20 - J27).

........................................................................................................................................................................................................................

2 Connect the function group cables at the Alcatel-Lucent 1665 DMX high-capacity shelf 
end, carefully matching the correct connector with the appropriate backplane connectors 
as shown in Figure 3-2, “DS1 cable installation” (p. 3-9).

Note: Inspect the DS1 connector for damaged or bent pins before connecting. The 
DS1 cable retaining screws must be tightened to a maximum of 6.5 in-lb. Do not 
overtighten.
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DS1 cable installationCable and fiber installation

Figure 3-2 DS1 cable installation

........................................................................................................................................................................................................................

3 Route the cables along the backplane and out of the bay to the DSX per Figure 3-3, “DS1 
cable routing” (p. 3-10).
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DS1 cable installationCable and fiber installation

Figure 3-3 DS1 cable routing

........................................................................................................................................................................................................................

4 Route the cables along the cable rack and into the terminating bay.

........................................................................................................................................................................................................................

5 Remove slack and cut the DS1 cables to the desired length at the DSX.

........................................................................................................................................................................................................................

6 Referring to Table 3-3, “DS1 transmission connections” (p. 3-12), carefully observe color 
codes and wire-wrap the cables at the DSX.

........................................................................................................................................................................................................................

7 Verify DS1 cabling using the LNW94 TESTPK or equivalent method.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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DS1 cable installationCable and fiber installation

Table 3-2 DS1 cable assemblies

Cable length
(feet)

Cable 
assembly # Description

Alcatel-Lucent 1665 DMX 
backplane connections

Function Group
Outputs

Function Group
Inputs

10 848954988 DS1 Cables, 24 gauge Function Group A

20 848955001 J1 (DS1) 1-28
J24 DS1 29-56

J2 DS1 1-28
J20 DS1 29-56

30 848923074

50 848548327 Function Group B

75 848923082 J3 DS1 1-28
J25 DS1 29-56

J4 DS1 1-28
J21 DS1 29-56

100 848548335

125 848923090 Function Group C

150 848548343 J6 DS1 1-28
J26 DS1 29-56

J5 DS1 1-28
J22 DS1 29-56

175 848923108

200 848923116 Function Group D

250 848548350 J8 DS1 1-28
J27 DS1 29-56

J7 DS1 1-28
J23 DS1 29-56

350 848790762

450 848548368

550 848790770

655 848790788

Notes:  
1. One code provides one input and one output cable for 28 DS1's, e.g, "J1 A OUT" & "J2 A IN".

2. For Input connections use cable CA1 (DS1 IN) and for Output connections use cable CA2 (DS1 
OUT).

3. Cables are terminated in J1 through J8 and J20 through J27 connectors at the Alcatel-Lucent 1665 
DMX high-capacity shelf end and unterminated at the other end for wire-wrap installation.

4. P1 through P8 are 62 pins D-Sub male-type connectors fit into J1 through J8. P20 through P27 are 
62 pins D-Sub male type connectors fit into J20 through J27.

5. Two codes required for the high-capacity 56 DS1 LNW8 & LNW801, i.e., for DS1 function groups, 
e.g., "J1 A OUT" & "J2 A IN" and "J24 A OUT"&"J20 A IN"
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DS1 cable installationCable and fiber installation

Table 3-3 DS1 transmission connections

DSX-1 connections*
Alcatel-Lucent 1665 DMX high-capacity shelf backplane 
connections

G
r
o
u
p

Chan
DS1

T/R 
term

T/R 
color

62 pin 
conn.
Pin# 
T/R

Function 
group  A 
conn.

Function 
group  B 
conn.

Function 
group  C 
conn.

Function 
group  D 
conn.

In Out In Out In Out In Out

1 1 (1)

2 (2)

3 (3)

4 (4)

B8/B7

B6/B5

B4/B3

B2/B1

W/BL*

W/O*

W/G*

W/BR

19/40

18/39

60/59

17/38

J2

A

J1

A

J4

B

J3

B

J5

C

J6

C

J7

D

J8

D

2 1 (5)

2 (6)

3 (7)

4 (8)

B8/B7

B6/B5

B4/B3

B2/B1

W/S

R/BL

R/O

R/G

58/57

16/37

15/36

14/35

3 1 (9)

2 (10)

3 (11)

4 (12)

B8/B7

B6/B5

B4/B3

B2/B1

R/BR

R/S

BK/BL

BK/O

56/55

13/34

54/53

12/33

4 1 (13)

2 (14)

3 (15)

4 (16)

B8/B7

B6/B5

B4/B3

B2/B1

BK/G

BK/BR

BK/S

Y/BL

11/32

10/31

52/51

9/30

5 1 (17)

2 (18)

3 (19)

4 (20)

B8/B7

B6/B5

B4/B3

B2/B1

Y/O

Y/G

Y/BR

Y/S

50/49

8/29

7/28

6/27

6 1 (21)

2 (22)

3 (23)

4 (24)

B8/B7

B6/B5

B4/B3

B2/B1

V/BL

V/O

V/G

V/BR

48/47

5/26

46/45

4/25
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DS1 cable installationCable and fiber installation

7 1 (25)

2 (26)

3 (27)

4 (28)

B8/B7

B6/B5

B4/B3

B2/B1

V/S

W/BL*

W/O*

W/G*

3/24

2/23

44/43

1/22

1 1 (29)

2 (30)

3 (31)

4 (32)

B8/B7

B6/B5

B4/B3

B2/B1

W/BL*

W/O*

W/G*

W/BR

19/40

18/39

60/59

17/38

J20

A

J24

A

J21

B

J25

B

J22

C

J26

C

J23

D

J27

D

2 1 (33)

2 (34)

3 (35)

4 (36)

B8/B7

B6/B5

B4/B3

B2/B1

W/S

R/BL

R/O

R/G

58/57

16/37

15/36

14/35

3 1 (37)

2 (38)

3 (39)

4 (40)

B8/B7

B6/B5

B4/B3

B2/B1

R/BR

R/S

BK/BL

BK/O

56/55

13/34

54/53

12/33

4 1 (41)

2 (42)

3 (43)

4 (44)

B8/B7

B6/B5

B4/B3

B2/B1

BK/G

BK/BR

BK/S

Y/BL

11/32

10/31

52/51

9/30

5 1 (45)

2 (46)

3 (47)

4 (48)

B8/B7

B6/B5

B4/B3

B2/B1

Y/O

Y/G

Y/BR

Y/S

50/49

8/29

7/28

6/27

6 1 (49)

2 (50)

3 (51)

4 (52)

B8/B7

B6/B5

B4/B3

B2/B1

V/BL

V/O

V/G

V/BR

48/47

5/26

46/45

4/25

DSX-1 connections*
Alcatel-Lucent 1665 DMX high-capacity shelf backplane 
connections

G
r
o
u
p

Chan
DS1

T/R 
term

T/R 
color

62 pin 
conn.
Pin# 
T/R

Function 
group  A 
conn.

Function 
group  B 
conn.

Function 
group  C 
conn.

Function 
group  D 
conn.

In Out In Out In Out In Out
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DS3/EC1 and TMUX 48-port cable installationCable and fiber installation

DS3/EC1 and TMUX 48-port cable installation

Description

This section describes how to connect the DS3/EC1 and TMUX cables to the Alcatel-
Lucent 1665 DMX high-capacity shelf and route the cables out of the bay and to the 
DS3/EC1 terminating equipment. Perform this procedure if DS3/EC1 or TMUX cables 
are required.

Note: When cabling the Alcatel-Lucent 1665 DMX high-capacity shelf to a DSX, 
the DSX becomes an extension of the Alcatel-Lucent 1665 DMX high-capacity shelf 
backplane connections. Therefore, the IN on the Alcatel-Lucent 1665 DMX high-
capacity shelf backplane connects to the IN of the DSX and the OUT of the Alcatel-
Lucent 1665 DMX high-capacity shelf backplane connects to the OUT of the DSX.

DS3/EC1 and TMUX cable options are listed in Table 3-5 and Table 3-6. Table 3-7 
contains miscellaneous DS3 cables for both the 12-port and 48-port installations.

DS3/EC1 and TMUX transmission connections are in Table 3-8. A total of four function 
groups fully cabled may have up to 192 DS3 drop capacity if using the 48-port DS3/EC1 
or TMUX circuit packs.

7 1 (53)

2 (54)

3 (55)

4 (56)

B8/B7

B6/B5

B4/B3

B2/B1

V/S

W/BL*

W/O*

W/G*

3/24

2/23

44/43

1/22

Notes:
* Some wire colors are used twice. White binder cables are for Channel 1 through 25 and 29 through 53 blue binder 

cables are for Channels 26, 27, 28, 54, 55 and 56.

DSX-1 connections*
Alcatel-Lucent 1665 DMX high-capacity shelf backplane 
connections

G
r
o
u
p

Chan
DS1

T/R 
term

T/R 
color

62 pin 
conn.
Pin# 
T/R

Function 
group  A 
conn.

Function 
group  B 
conn.

Function 
group  C 
conn.

Function 
group  D 
conn.

In Out In Out In Out In Out



............................................................................................................................................................................................................................................................
Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

3-15

............................................................................................................................................................................................................................................................

DS3/EC1 and TMUX 48-port cable installationCable and fiber installation

Steps

........................................................................................................................................................................................................................

1 See the engineering job specification. Obtain the DS3 cables per Table 3-5, Table 3-6 or 
Table 3-8 and note the function group where each cable will be used. Label the cables, 
indicating bay, shelf, function group (A, B, C or D) and direction (IN or OUT of the bay) 
at each end.

Note: The first 24 ports of a Function unit must be cabled to the bottom connectors 
(J1 - J8), the additional DS3 ports (25 - 48) are cabled to the middle section of the shelf 
(J20 - J27).

........................................................................................................................................................................................................................

2 Connect the function group cables at the Alcatel-Lucent 1665 DMX high-capacity shelf 
end, carefully matching the correct connector with the appropriate backplane connectors 
as shown in Figure 3-4, “DS3/EC1 and TMUX cable installation” (p. 3-16).

Note: Inspect the DS3/EC1 connector for damaged or bent pins before connecting. 
The DS3/EC1 and TMUX cable retaining screws must be tightened to a maximum of 
6.5 in-lb. Do not overtighten.

Table 3-4 DS3 connections for each function groups

Function group Associated Connectors

A A IN (J2 and J20) A OUT (J1 and J24)

B B IN (J4 and J21) B OUT (J3 and J25)

C C IN (J5 and J22) C OUT (J6 and J26)

D D IN (J7 and J23) D OUT (J8 and J27)
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DS3/EC1 and TMUX 48-port cable installationCable and fiber installation

Figure 3-4 DS3/EC1 and TMUX cable installation

........................................................................................................................................................................................................................

3 Route the cables along the backplane and out of the bay to the DSX per Figure 3-5, 
“DS3/EC1 and TMUX cable routing” (p. 3-16).

Figure 3-5 DS3/EC1 and TMUX cable routing

Note: This figure shows DS3 cabling for FNA and FNB.

J8
D OUT

J6
C OUT

J19
INTEROP

J16
IAOLAN

J3
B OUT

J1
A OUT

J4
B IN

J2
A IN

J13
ALM MULT

J12
ALM

J18
DLAN

J10
X.25

J5
C IN

J7
D IN

NC-DMX-156

J22 C IN

J23 D IN

J26 C OUT

J27 D OUT

J20 A IN

J21 B IN

J24 A OUT

J25 B OUT

IN

OUT

EXP2 EXP1

IN

OUT

CTL

-48RTNB

P15
J14

SYNC2
J11

MISC
J17

MODEM

J9
SYNC1 P14

-48RTNA

-48VA-48VB

CTL

J15
FAN
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DS3/EC1 and TMUX 48-port cable installationCable and fiber installation

........................................................................................................................................................................................................................

4 Route the cables along the cable rack and into the terminating bay (DSX or other 
terminating transmission equipment).

........................................................................................................................................................................................................................

5 Cut the cables to desired length and install the BNC connectors shipped with the cable 
assemblies.

Note: When installing BNC connectors, follow the manufacturer’s instruction 
carefully to ensure a proper connection. Failure to do so may result in faulty DS3 
signals as a result of improperly installed BNC connectors.

........................................................................................................................................................................................................................

6 Connect the cables to their respective positions on the terminating equipment.

Note: The 12-port cable and the 24-port cable use different signal grounds based on 
the circuit pack not the backplane. There is no issue interchanging these cables on the 
backplane. The Signals are common between both cables.

........................................................................................................................................................................................................................

7 Verify DS3 cabling using the LNW74 TESTPK or equivalent method.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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DS3/EC1 and TMUX 48-port cable installationCable and fiber installation

Table 3-5 DS3 Cable with 24 DS3 with BNC (LNW16/LNW18/LNW19B/LNW20)

Description
Cable 
assembly #

Cable length
(feet)

Alcatel-Lucent 1665 DMX 
backplane connections

Output Input

 24 individual 735A coaxial cables 
and 24 ITT Canon 7-ohm BNC 
plugs shipped loose

849040688 10 Function Group A

849040696 20 J1 DS3 1-24
J24 DS3 25-48

J2 DS3 1-24
J20 DS3 25-48

849040704 30

849040712 40 Function Group B

849040720 50 J3 DS3 1-24
J25 DS3 25-48

J4 DS3 1-24
J21 DS3 25-48

849040738 60

849040746 100 Function Group C

849040753 150 J6 DS3 1-24
J26 DS3 25-48 

J5 DS3 1-24
J22 DS3 25-48

849040761 250

849040779 450 Function Group D

849041710 450 J8 DS3 1-24
J27 DS3 25-48 

J7 DS3 1-24
J23 DS3 25-48

849041736 750

849041744 900



............................................................................................................................................................................................................................................................
Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

3-19

............................................................................................................................................................................................................................................................

DS3/EC1 and TMUX 48-port cable installationCable and fiber installation

Table 3-6 DS3 Cable with 24 DS3 w/o BNC(LNW16/LNW18/LNW19B/LNW20))

Description
Cable 
assembly #

Cable length
(feet)

Alcatel-Lucent 1665 DMX 
backplane connections

Output Input

 24 individual 735A coaxial 
cables. Similar to above except no 
BNCs are shipped.

849040886 10 Function Group A

849040894 20 J1 DS3 1-24
J24 DS3 25-48

J2 DS3 1-24
J20 DS3 25-48

849040902 30

849040910 40 Function Group B

849040928 50 J3 DS3 1-24
J25 DS3 25-48

J4 DS3 1-24
J21 DS3 25-48

849040936 60

849040944 70 Function Group C

849040951 80 J6 DS3 1-24
J26 DS3 25-48 

J5 DS3 1-24
J22 DS3 25-48

849040969 90

849040977 100 Function Group D

849040985 110 J8 DS3 1-24
J27 DS3 25-48 

J7 DS3 1-24
J23 DS3 25-48

849040993 120

849041009 140

849041017 150

849041025 160

849041033 180

849041041 200

849041066 250

849041074 300

849041082 400

849041090 450
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DS3/EC1 and TMUX 48-port cable installationCable and fiber installation

Table 3-7 Miscellaneous DS3 Cables (LNW16/LNW18/LNW19B/LNW20)

Description
Cable 
assembly #

Cable length
(feet)

Alcatel-Lucent 1665 DMX 
backplane connections

Output Input

 DS3#1-24 Cables with ITT Canon 
BNCs

Similar to above except ~10 ft of 
735A spliced to 734D coaxial 
cable with loose ITT Canon BNCs 
for > 450 ft between two Alcatel-
Lucent 1665 DMX’s.

900ft is the maximum amount of 
734D cable allowed between two 
Alcatel-Lucent 1665 DMX’s.

This is a factory splice. Stagger the 
splices in the cable rack to save 
space.

848932083 250 Function Group A

848932018 275 J1 DS3 1-24
J24 DS3 25-48

J2 DS3 1-24
J20 DS3 25-48

848932026 300

848932034 325 Function Group B

848932042 350 J3 DS3 1-24
J25 DS3 25-48

J4 DS3 1-24
J21 DS3 25-48

848932059 375

848932067 400 Function Group C

848932075 425 J6 DS3 1-24
J26 DS3 25-48 

J5 DS3 1-24
J22 DS3 25-48

848839528 450

848839536 750 Function Group D

848839544 900 J8 DS3 1-24
J27 DS3 25-48 

J7 DS3 1-24
J23 DS3 25-48

DS3#1-24 Cables with no BNC

Similar to above except no BNC’s 
are shipped loose.

849041785 250

849041793 275

849041801 300

849041819 325

849041827 350

849041835 375

849041843 400

849041850 425

849041868 450

849041876 750

849041884 900
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DS3/EC1 and TMUX 48-port cable installationCable and fiber installation

Customer-specific DS3#1-24 
Cables

Similar to above except Alcatel-
Lucent 1665 DMX backplane 62-
pin plugs on both ends of 735A 
coaxial cable

848956249 150

Customer-specific 12-pack Mini-
BNC Cable Harness

12 individual 735A coaxial cables 
under one jacket, one harness per 
code, with 12 Mini-BNC plugs to 
12 standard BNC plugs .

109508416 25

109508424 50

109508432 75

109508440 100

109508457 125

109508465 150

109508473 175

109508481 200

109508499 250

Customer-specific Mini-BNC 
Cable

One 735A coaxial cable per code 
with one mini-BNC plug to one 
standard BNC plug.

109508325 25

109508333 50

109508341 75

109508358 100

109508366 125

109508374 150

109508382 175

109508390 200

109508408 250

Description
Cable 
assembly #

Cable length
(feet)

Alcatel-Lucent 1665 DMX 
backplane connections

Output Input
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Table 3-8 DS3/EC1 and TMUX transmission connections

Coaxial 
cable

Lead 
designation* Name Connector pin #

Connectors 
J1 - J8

(Ports 1 - 24)

1 DS3 1R/1T Signal 40

FRG1 Ground 19

2 DS3 2R/2T Signal 17

FRG2 Ground 38

3 DS3 3R/3T Signal 57

FRG3 Ground 58

4 DS3 4R/4T Signal 13

FRG4 Ground 34

5 DS3 5R/5T Signal 53

FRG5 Ground 54

6 DS3 6R/6T Signal 10

FRG6 Ground 31

7 DS3 7R/7T Signal 51

FRG7 Ground 52

8 DS3 8R/8T Signal 6

FRG8 Ground 27

9 DS3 9R/9T Signal 47

FRG9 Ground 48

10 DS3 10R/10T Signal 4

FRG10 Ground 25

11 DS3 11R/11T Signal 24

FRG11 Ground 3

12 DS3 12R/12T Signal 1

FRG12 Ground 22

13 DS3 13R/13T Signal 59

FRG13 Ground 60
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14 DS3 14R/14T Signal 16

FRG14 Ground 37

15 DS3 15R/15T Signal 36

FRG15 Ground 15

16 DS3 16R/16T Signal 55

FRG16 Ground 56

17 DS3 17R/17T Signal 12

FRG17 Ground 33

18 DS3 18R/18T Signal 32

FRG18 Ground 11

19 DS3 19R/19T Signal 9

FRG19 Ground 30

20 DS3 20R/20T Signal 49

FRG20 Ground 50

21 DS3 21R/21T Signal 28

FRG21 Ground 7

22 DS3 22R/22T Signal 5

FRG22 Ground 26

23 DS3 23R/23T Signal 45

FRG23 Ground 46

24 DS3 24R/24T Signal 43

FRG24 Ground 44

Connectors 
J20 - J27

(Ports 25 - 48)

25 DS3 25R/25T Signal 40

FRG25 Ground 19

26 DS3 26R/26T Signal 17

FRG26 Ground 38

Coaxial 
cable

Lead 
designation* Name Connector pin #
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27 DS3 27R/27T Signal 57

FRG27 Ground 58

28 DS3 28R/28T Signal 13

FRG28 Ground 34

29 DS3 29R/29T Signal 53

FRG29 Ground 54

30 DS3 30R/30T Signal 10

FRG30 Ground 31

31 DS3 31R/31T Signal 51

FRG31 Ground 52

32 DS3 32R/32T Signal 6

FRG32 Ground 27

33 DS3 33R/33T Signal 47

FRG33 Ground 48

34 DS3 34R/34T Signal 4

FRG34 Ground 25

35 DS3 35R/35T Signal 24

FRG35 Ground 3

36 DS3 36R/36T Signal 1

FRG36 Ground 22

37 DS3 37R/37T Signal 59

FRG37 Ground 60

38 DS3 38R/38T Signal 16

FRG38 Ground 37

39 DS3 39R/39T Signal 36

FRG39 Ground 15

40 DS3 40R/40T Signal 55

FRG40 Ground 56

Coaxial 
cable

Lead 
designation* Name Connector pin #
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12-DS3/EC1 and TMUX (LNW16 LNW18) cable installation

Description

This section describes how to connect the 12-DS3/TMUX cables to the Alcatel-Lucent 
1665 DMX high-capacity shelf and route the cables out of the bay and to the TMUX 
terminating equipment. Perform this procedure if TMUX cables are required for an 
LNW18 in a function group.

41 DS3 41R/41T Signal 12

FRG41 Ground 33

42 DS3 42R/42T Signal 32

FRG42 Ground 11

43 DS3 43R/43T Signal 9

FRG43 Ground 30

44 DS3 44R/44T Signal 49

FRG44 Ground 50

45 DS3 45R/45T Signal 28

FRG45 Ground 7

46 DS3 46R/46T Signal 5

FRG46 Ground 26

47 DS3 47R/47T Signal 45

FRG47 Ground 46

48 DS3 48R/48T Signal 43

FRG48 Ground 44

Notes:
* Lead designation for EC1 connection for cable# x should be read as EC1 xR/xT 

instead of DS3 xR/xT, where x is a number from 1 to 48.

Coaxial 
cable

Lead 
designation* Name Connector pin #
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It should be noted that the cables used for 12-DS3/TMUX support are DS3 cables (12-
port). The new high capacity DS3 cables will also support 12-DS3/TMUX, but only in a 
12-port capacity.

Note: When cabling the Alcatel-Lucent 1665 DMX high-capacity shelf to a DSX, 
the DSX becomes an extension of the Alcatel-Lucent 1665 DMX high-capacity shelf 
backplane connections. Therefore, the IN on the Alcatel-Lucent 1665 DMX high-
capacity shelf backplane connects to the IN of the DSX and the OUT of the Alcatel-
Lucent 1665 DMX high-capacity shelf backplane connects to the OUT of the DSX.

DS3/TMUX cable options are listed in Table 3-9, Table DS3 Cable assemblies with BNC 
with 12-DS3 (LNW16/LNW18) and Table 3-10, DS3 Cable assemblies w/o BNC with 12-
DS3 (LNW16/LNW18). Table 3-7 contains miscellaneous DS3 cables for both the 12-port 
and 48-port installations.

TMUX transmission connections are in Table 3-11. 

Steps

........................................................................................................................................................................................................................

1 See the engineering job specification. Obtain the TMUX (DS3) cables per Table 3-8, 
Table 3-9 or Table 3-7 and note the function group where each cable will be used. Label 
the cables, indicating bay, shelf, function group (A, B, C or D) and direction (IN or OUT 
of the bay) at each end.

........................................................................................................................................................................................................................

2 Connect the function group cables at the Alcatel-Lucent 1665 DMX high-capacity shelf 
end, carefully matching the correct connector with the appropriate backplane connectors 
as shown in Figure 3-6, “12-port DS3/EC1 and TMUX cable installation” (p. 3-27).

Note: DS3/EC1 and TMUX cable retaining screws must be tightened to a maximum 
of 6.5 in-lb. Do not overtighten.
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Figure 3-6  12-port DS3/EC1 and TMUX cable installation

........................................................................................................................................................................................................................

3 Route the cables along the backplane and out of the bay to the DSX per Figure 3-7, “12-
DS3/TMUX cable routing” (p. 3-28).

OUT

IN

OUT

IN IN

OUT

IN

OUT
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Figure 3-7 12-DS3/TMUX cable routing

Note: The shelf depicted above is a Alcatel-Lucent 1665 DMX standard shelf and is 
used for cable routing reference only.

........................................................................................................................................................................................................................

4 Route the cables along the cable rack and into the terminating bay (DSX or other 
terminating transmission equipment).

........................................................................................................................................................................................................................

5 Cut the cables to desired length and install the BNC connectors shipped with the cable 
assemblies.

Note: When installing BNC connectors, follow the manufacturer’s instruction 
carefully to ensure a proper connection. Failure to do so may result in faulty DS3 
signals as a result of improperly installed BNC connectors.

........................................................................................................................................................................................................................

6 Connect the cables to their respective positions on the terminating equipment.

........................................................................................................................................................................................................................

7 Verify DS3 cabling using the LNW74 TESTPK or equivalent method.

TMUX
Cables
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........................................................................................................................................................................................................................

8 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Table 3-9 Table DS3 Cable assemblies with BNC with 12-DS3 (LNW16/LNW18)

Description
Cable 
assembly #

Cable length
(feet)

Alcatel-Lucent 1665 DMX 
backplane connections

Output Input

12 individual 735A coaxial cables 
with 12 ITT Canon 75-ohm BNC 
plugs shipped loose.

DS3#1-12 Cables with no BNC, 
LNW16, LNW18 only

849040779 uses 735A cable, and 
450 ft is the maximum amount of 
735A allowed between two 
Alcatel-Lucent 1665 DMXs

849041710 and lengths > 450 ft 
use ~10ft 735A spliced to 734D 
cable and 900 ft is the maximum 
amount of 734D allowed between 
two Alcatel-Lucent 1665 DMXs. 
This splice is factory made. 
Stagger the splices in the cable 
rack to save space

848955407 10 Function Group A

848955415 20 J1 DS3 1-12 J2 DS3 1-12

848955423 30 Function Group B

848955431 40 J3 DS3 1-12 J4 DS3 1-12

848548277 50 Function Group C

848980504 60 J6 DS3 1-12 J5 DS3 1-12

848548285 100 Function Group D

848548293 150 J8 DS3 1-12 J7 DS3 1-12

848548301 250

848548319 450 (NE to NE)

848815742 450 (NE to NE)

848815734 750 (NE to NE)

848815759 900 (NE to NE)
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Table 3-10 DS3 Cable assemblies w/o BNC with 12-DS3 (LNW16/LNW18)

Description
Cable 
assembly #

Cable length
(feet)

Alcatel-Lucent 1665 DMX 
backplane connections

Output Input

12 individual 735A coaxial cables 

DS3#1-12 Cables with no BNC

849040779 uses 735A cable, and 
450 ft is the maximum amount of 
735A allowed between two 
Alcatel-Lucent 1665 DMXs

849041710 and lengths > 450 ft 
use ~10 ft 735A spliced to 734D 
cable and 900 ft is the maximum 
amount of 734D allowed between 
two Alcatel-Lucent 1665 DMXs. 
This splice is factory made. 
Stagger the splices in the cable 
rack to save space

849040688 10 Function Group A

849040696 20 J1 DS3 1-12 J2 DS3 1-12

849040704 30 Function Group B

849040712 40 J3 DS3 1-12 J4 DS3 1-12

849040720 50 Function Group C

849040738 60 J6 DS3 1-12 J5 DS3 1-12

849040746 100 Function Group D

849040753 150 J8 DS3 1-12 J7 DS3 1-12

849040761 250

849040779 450

849041710 450

849041736 750

849041744 900
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Table 3-11 12-port DS3/EC1 and TMUX transmission connections

Coaxial 
cable

Lead 
designation Name Connector pin #

1 DS3 1R/1T Signal 40

FRG1 Ground 39

2 DS3 2R/2T Signal 17

FRG2 Ground 18

3 DS3 3R/3T Signal 57

FRG3 Ground 58

4 DS3 4R/4T Signal 13

FRG4 Ground 14

5 DS3 5R/5T Signal 53

FRG5 Ground 54

6 DS3 6R/6T Signal 10

FRG6 Ground 11

7 DS3 7R/7T Signal 51

FRG8 Ground 50

8 DS3 8R/8T Signal 6

FRG8 Ground 7

9 DS3 9R/9T Signal 47

FRG9 Ground 46

10 DS3 10R/10T Signal 4

FRG10 Ground 3

11 DS3 11R/11T Signal 24

FRG11 Ground 23

12 DS3 12R/12T Signal 1

FRG12 Ground 2
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10/100BaseT backplane ethernet cable installation

Description

This section describes how to connect the 10/100BaseT cables to the Alcatel-Lucent 1665 
DMX high-capacity shelf backplane and route the cables out of the bay and to the 
10/100BaseT terminating equipment (for example, a 110/RJ45® punch-down block). 
Perform this procedure if 10/100BaseT cables are required.

The next section covers installation of Ethernet cables connected directly to SFP modules 
on circuit pack faceplates if applicable.

Steps

........................................................................................................................................................................................................................

1 See the engineering job specification. Obtain the 100BASE-TX Ethernet cables per 
Table 3-12, “10/100BaseT ethernet cable assemblies” (p. 3-34) and note the function 
group where each cable will be used. Label the cables, indicating bay, shelf and function 
group (A, B, C or D) at each end.

........................................................................................................................................................................................................................

2 Connect the function group cables at the Alcatel-Lucent 1665 DMX high-capacity shelf 
end, carefully matching the correct connector with the appropriate backplane connectors 
as shown in Figure 3-8, “10/100BaseT cable installation” (p. 3-33). See Table 3-13, 
“10/100BaseT ethernet connections” (p. 3-35).

Note: 100BASE-TX Ethernet cable retaining screws must be tightened to a 
maximum of 6.5 in-lb. Do not overtighten.
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Figure 3-8 10/100BaseT cable installation

........................................................................................................................................................................................................................

3 Route the cables along the backplane and out of the bay to the 110/RJ45 punch down 
block. Route the cables in the same manner as DS3/EC1 cables. See Figure 3-5, 
“DS3/EC1 and TMUX cable routing” (p. 3-16).

........................................................................................................................................................................................................................

4 Route the cables along the cable rack and into the terminating bay.

........................................................................................................................................................................................................................

5 Cut cable to length and punch down cable to the 110 block. See Table 3-13, “10/100BaseT 
ethernet connections” (p. 3-35) for pin out assignments.
:

OUT

IN

OUT

IN IN

OUT

IN

OUT

NOTICE
The LNW66 and LNW74 10/100BaseT-Ethernet packs do not have lightning 
protection for the metallic connections. Therefore it is necessary to use a 
lightning-protected patch panel, such as the Black Box CAT5 protected patch 
panel JSM110A, for intra-office applications only.
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Note: Backplane connectors are associated with function Groups as follows:

• J1, J2  ➠ Function Group A

• J3, J4  ➠ Function Group B

• J5, J6  ➠ Function Group C

• J7, J8  ➠ Function Group D

........................................................................................................................................................................................................................

6 Verify LAN cabling using the LNW94 TESTPK or equivalent method.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Table 3-12 10/100BaseT ethernet cable assemblies

Description Cable assembly #
Cable length 
(feet)

Alcatel-Lucent 
1665 DMX 
backplane 
connections

10/100baseT ethernet cable 848819090 8 Function Group A

848778114 20 J1 (ports 1-12)
J2 (ports 13-24)

848923280 35

848778122 50 Function Group B

848923298 75 J3 (ports 1-12)
J4 (ports 13-24)

848778106 100

848923306 125 Function Group C

848778148 150 J6 (ports 1-12)
J5 (ports 13-24)

848923314 175

848923322 200 Function Group D

848923330 225 J8 (ports 1-12)
J7 (ports 13-24)

848923348 250

848923355 275

848778130 300
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Table 3-13 10/100BaseT ethernet connections

Notes:  
1. 10/100baseT Ethernet cables have transmit and receive on the same cable.

2. LNW74 has 16 10/100BaseT ports.

Description Cable assembly #
Cable length 
(feet)

Alcatel-Lucent 
1665 DMX 
backplane 
connections

Port# J2, J4, 
J5, J7

J1, J3, J6, 
J8

Wire 
color

Dsub 62M 
pin # Signal RJ-45 pin #

13 1 W/O 50/49 R+/R- 1/2

W/BL 8/29 T+/T- 3/6

14 2 W/BR 48/47 R+/R- 1/2

W/G 5/26 T+/T- 3/6

15 3 R/BL 7/28 R+/R- 1/2

W/S 6/27 T+/T- 3/6

16 4 R/G 46/45 R+/R- 1/2

R/O 4/25 T+/T- 3/6

17 5 R/S 56/55 R+/R- 1/2

R/BR 13/34 T+/T- 3/6

18 6 BK/O 11/32 R+/R- 1/2

BK/BL 10/31 T+/T- 3/6

19 7 BK/BR 54/53 R+/R- 1/2

BK/G 12/33 T+/T- 3/6

20 8 Y/BL 52/51 R+/R- 1/2

BK/S 9/30 T+/T- 3/6

21 9 Y/G 19/40 R+/R- 1/2

Y/O 18/39 T+/T- 3/6

22 10 Y/S 58/57 R+/R- 1/2

Y/BR 16/37 T+/T- 3/6
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Ethernet cabling to SFP modules on circuit pack faceplates

Description

Use this section to run Category 5e cables to the SFP modules on the front of LNW63, 
LNW64, or LNW170, Ethernet circuit packs. See Figure 3-9.

Steps

........................................................................................................................................................................................................................

1 See Figure 3-9.

23 11 V/O 60/59 R+/R- 1/2

V/BL 17/38 T+/T- 3/6

24 12 V/BR 15/36 R+/R- 1/2

V/G 14/35 T+/T- 3/6

Notes:  
1. 10/100baseT Ethernet cables have transmit and receive on the same cable.

2. LNW74 has 16 10/100BaseT ports.

Port# J2, J4, 
J5, J7

J1, J3, J6, 
J8

Wire 
color

Dsub 62M 
pin # Signal RJ-45 pin #
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faceplates

Cable and fiber installation

Figure 3-9 Ethernet cable routing to faceplate SFP modules

........................................................................................................................................................................................................................

2 Connect the RJ45 plugs to the faceplate SFP modules and run the cables out of the shelf as 
shown.



............................................................................................................................................................................................................................................................
3-38 Alcatel-Lucent 1665 DMX R9.0

365-372-304R9.0 Issue 2
July 2010

............................................................................................................................................................................................................................................................

Ethernet cabling to SFP modules on circuit pack faceplatesCable and fiber installation

Table 3-14 GbE ethernet cables

........................................................................................................................................................E N D  O F  S T E P S

Description Cable assembly # Cable length (feet)

GbE ethernet cables

CAT5e Gigabit ethernet 
shielded connectorized on 
both ends with straight 
RJ45 connector.

849010483 5

849010491 10

849010509 15

849010517 20

849010525 25

849010533 30

849010541 40

849010558 50

849010566 60

849010574 70

849010582 80

849010590 90

849010608 100

849010616 110

849010624 120

849010632 130

849010640 140

849010657 150

849010665 160

849010673 180

849010681 200

849010699 220

849010707 240

849010715 260

849010723 280

849010731 300
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IAO LAN and TCP/IP cable installation

Description

This section describes how to connect the IAO LAN/TCP-IP (LAN 10BaseT) cable to the 
Alcatel-Lucent 1665 DMX high-capacity shelf and to the interfacing equipment. Perform 
this procedure if this cabling is required.

The Alcatel-Lucent 1665 DMX high-capacity shelf supports an IntraOffice LAN (IAO 
LAN) interface for operations data communications to support operations systems such as 
the Navis Optical Management System (OMS).

Since the IAO LAN can be provisioned as an extension of the SONET DCC, the IAO 
LAN can also be used to join multiple, otherwise separate subnetworks. 

All NE-to-NE OI features that are supported over the DCC are also supported over the 
IAO LAN.

The IAO LAN/TCP-IP interface cable is available in two configurations (cross-over and 
straight-through) and may be connected to either the front or rear of the Alcatel-Lucent 
1665 DMX high-capacity shelf. The following tables provide additional information:

• Table 3-15, “LAN 10BaseT cable assemblies” (p. 3-42)

• Table 3-16, “LAN 10BaseT cross-over cable connections” (p. 3-43)

• Table 3-17, “LAN 10BaseT straight-through cable connections” (p. 3-43)

Steps

........................................................................................................................................................................................................................

1 If connecting directly to a PC, use a LAN 10BaseT cross-over cable assembly (see 
Table 3-15).

If connecting to a hub, use a LAN 10BaseT straight-through cable assembly (see 
Table 3-15).

........................................................................................................................................................................................................................

2 If connecting to the front of the Alcatel-Lucent 1665 DMX high-capacity shelf, connect 
the cable to the LAN (RJ45) jack on the SYSCTL circuit pack. See Figure 3-10, “LAN 
cable installation to front of Alcatel-Lucent 1665 DMX high-capacity shelf” (p. 3-40).

If connecting to the rear of the Alcatel-Lucent 1665 DMX high-capacity shelf, connect the 
cable to the J16 port (IAO LAN) on the Alcatel-Lucent 1665 DMX high-capacity shelf 
backplane. See Figure 3-11, “IAO LAN/TCP-IP cable installation to rear of Alcatel-
Lucent 1665 DMX high-capacity shelf” (p. 3-41).
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Figure 3-10 LAN cable installation to front of Alcatel-Lucent 1665 DMX high-
capacity shelf

Note: The above figure shows a standard Alcatel-Lucent 1665 DMX shelf as 
reference only. The placement of the packs and PC lan port are the same on the 
Alcatel-Lucent 1665 DMX high-capacity shelf.
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Figure 3-11 IAO LAN/TCP-IP cable installation to rear of Alcatel-Lucent 1665 DMX 
high-capacity shelf

........................................................................................................................................................................................................................

3 If a cross-over cable is used, route the cable to the desired PC LAN port.

If a straight-through cable is used, route the cable to the desired hub port location.

........................................................................................................................................................................................................................

4 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

LAN Cable
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IAO LAN and TCP/IP cable installationCable and fiber installation

Table 3-15 LAN 10BaseT cable assemblies

Description
Cable 
assembly #

Cable 
length (feet)

Alcatel-Lucent 1665 DMX 
connections

Front Rear

LAN 10BaseT 
cross-over cable

109321810 10 SYSCTL
LAN jack

J16 (IAO LAN)

848605028 50

848605036 100

848605051 150

848605069 200

848605077 300

LAN 10BaseT 
straight-through cable

109321836 20 SYSCTL
LAN jack

J16 (IAO LAN)

109321844 30

109321851 40

848604948 50

109321869 60

109321877 70

109321885 80

109321893 90

848604955 100

109321901 110

109321919 120

109321927 130

109321935 140

848604963 150

109321943 160

109321950 180

848604971 200

109321968 220

109321976 240
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Table 3-16 LAN 10BaseT cross-over cable connections

Table 3-17 LAN 10BaseT straight-through cable connections

Modem cable installation

Description

The use of a modem will allow the Alcatel-Lucent 1665 DMX high-capacity shelf to be 
accessed remotely via dial up.

Note: Perform this procedure for the shelf that will be directly connected to a 
modem or a distribution frame (if specified in the order).

109321984 260

109321992 280

848604997 300

Connection
 Backplane 
Pin Color Other end

 J16 (IAO LAN) 1 BL - W 3

2 W - BL 6

3 O - W 1

6 W - O 2

Connection
 Backplane 
Pin Color Other end

 J16 (IAO LAN) 1 BL - W 1

2 W - BL 2

3 O - W 3

6 W - O 6

Description
Cable 
assembly #

Cable 
length (feet)

Alcatel-Lucent 1665 DMX 
connections

Front Rear
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Steps

........................................................................................................................................................................................................................

1 Obtain the modem cable per Table 3-18, “Modem cable assemblies” (p. 3-45). Connect 
the RJ45 end of the modem cable to the MODEM port (J17) of Alcatel-Lucent 1665 DMX 
high-capacity shelf [see Figure 3-12, “Modem cable installation” (p. 3-44)].

Figure 3-12 Modem cable installation 

........................................................................................................................................................................................................................

2 Route the modem cable out of the Alcatel-Lucent 1665 DMX high-capacity shelf bay to 
the modem or distribution frame.

........................................................................................................................................................................................................................

3 Dress and tie the modem cable to the Alcatel-Lucent 1665 DMX high-capacity shelf 
backplane per Figure 3-12, “Modem cable installation” (p. 3-44).

........................................................................................................................................................................................................................

4 Connect the modem cable to the modem or distribution frame.



............................................................................................................................................................................................................................................................
Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

3-45

............................................................................................................................................................................................................................................................

Sync cable installationCable and fiber installation

........................................................................................................................................................................................................................

5 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Table 3-18 Modem cable assemblies

Table 3-19 Modem cable connections

Sync cable installation

Description

This section provides the instructions for installing the two types of synchronization 
(Sync) cables to the Alcatel-Lucent 1665 DMX high-capacity shelf.

A Sync cable is required if the shelf is to be externally timed. The Alcatel-Lucent 1665 
DMX high-capacity shelf can provide DS1 external timing to a BITS clock. When the 
shelf is externally timed by a DS1 Reference and/or is configured to provide a Sync 
Output, a Sync Input timing cable is required.

This procedure should be performed on each Alcatel-Lucent 1665 DMX high-capacity 
shelf requiring an external timing source. There are two types of cables available:

Description
Cable 
assembly #

Cable length 
(feet) Connections

Modem cable 848756508 50 J17 (MODEM)

848756524 100

848756516 150

848756532 250

Connection

RJ45 
connector 
pin# Color

DB25 
Connector 
Pin #

Modem cable (J17) 1 W - O 8

2 BR 20

3 W - BL 3

5 O / Shield 7

6 G 2
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1. Sync cable with a molded D-Sub 9-Pin (DB-9) connector 

2. Sync cable with a wire-wrap DB-9 connector. 

Note: Each of the Sync connections on the backplane provides an input (gray) and 
output (red) termination for timing. See Table 3-21, “Synchronization cable (DS1 
timing reference) connections” (p. 3-51) for the pinouts.

Sync cable with molded DB-9 connector procedure

Perform the following steps when using a Sync cable with a molded DB-9 connector.

........................................................................................................................................................................................................................

1 Connect the DB-9 connector end of the Sync cable to the SYNC1 (J9) port on the Alcatel-
Lucent 1665 DMX high-capacity shelf backplane. See Figure 3-13, “Sync cable with 
molded DB9 connector installation” (p. 3-47).
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Figure 3-13 Sync cable with molded DB9 connector installation

........................................................................................................................................................................................................................

2 Route the cable to proper location and cut to desired length.

........................................................................................................................................................................................................................

3 Terminate the wires in the red jacket for an output signal.

........................................................................................................................................................................................................................

4 Terminate the wires in the gray jacket for an input signal.

........................................................................................................................................................................................................................

5 Repeat Step 1 through Step 4 to connect the Sync cable to the SYNC2 (J14) port.

TO DS1 SYNCHRONOUS TIMING REFERENCE

CABLE TIE (TYPICAL)

TIE CABLE ASSY'S TO CABLE SUPPORT BAR

(AS REQUIRED)
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........................................................................................................................................................................................................................

6 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Sync cable with wire-wrap DB-9 connector procedure

Perform the following steps when using the Sync cable with the wire-wrap DB-9 
connector.

........................................................................................................................................................................................................................

1 Connect the wire-wrap DB-9 connector to SYNC1 (J9). See Figure 3-14, “Sync cable with 
wire-wrap connector installation” (p. 3-48).

Figure 3-14 Sync cable with wire-wrap connector installation

TO DS1 SYNCHRONOUS TIMING REFERENCE

CABLE TIE (TYPICAL)

TIE CABLE ASSY'S TO CABLE SUPPORT BAR

(AS REQUIRED)
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........................................................................................................................................................................................................................

2 Wire-wrap Rx1 and Tx1 (red cable) on the D-Sub connector for an output signal.

........................................................................................................................................................................................................................

3 Wire-wrap Rx2 and Tx2 (gray cable) on the D-Sub connector for an input signal.

........................................................................................................................................................................................................................

4 Route the cable to proper location and cut to desire length.

........................................................................................................................................................................................................................

5 Terminate the other end to a clock source or equipment.

........................................................................................................................................................................................................................

6 Repeat Step 1 through Step 5 for SYNC2 (J14) connection.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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Table 3-20 Synchronization cable assemblies (SYNC1 and SYNC2)

Description
Cable 
Assembly #

Cable Length 
(feet)

 Backplane 
connections

Sync cable with molded 
DB-9 connector
DS1 timing reference for DS1 
external sync in/out timing

848839619 50 J9 (Sync1)/
J14 (Sync2)

848923363 75

848839627 100

848923371 125

848839635 150

848923389 175

848923439 200

848923447 225

848839643 250

848923454 275

848923462 300

848839650 450

Sync cable with wire-wrap
DB-9 connector
DS1 timing reference for DS1 
external sync in/out timing 

848631255 50

848631271 100

848631289 150

848631297 250

848631305 450

Sync cable with filter 
connector (sync input signal 
only)
DS1 timing reference for DS1 
external sync in timing 

848929311 50

848929329 100

848929337 150

848929345 250

848929352 450

Notes:  
1. The Sync cable is 22 gauge.

2. Ground the filter connector either at the bay frame ground or at the office timing source. See office records.
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Table 3-21 Synchronization cable (DS1 timing reference) connections

Office alarm cable installation

Description

Office alarms are the common method used in a central office for maintenance personnel 
to quickly isolate a failure. Perform this procedure if connection to the office alarm system 
is required.

Note: The office alarm relay contacts are rated at 50 VA which means that they are 
capable of switching 1 amp at 50 volts, or 2 amps at 25 volts. Their ability to switch 
large transient currents means that they can, if necessary, switch up to ten 5-watt aisle 
pilot lamps.

If transient voltages or currents are above these limits, transient noise-suppressing devices 
such as diodes or contact protection networks must be used to keep within the voltage and 
current limits. If these protection devices are not sufficient, an external buffer relay MUST 
be provided.

In all cases, and as a matter of good practice, suppression devices such as diodes or contact 
protection networks must be provided across any external relay coil being driven by the 
Alcatel-Lucent 1665 DMX high-capacity shelf to limit transient voltages and currents.

Office alarm cable assemblies are listed in Table 3-22, “Office alarm cable assemblies” 
(p. 3-56).

Conn. Jacket Color
9-Pin 
conn.

Special 
conn. Designation Name

Sync1 (J9)/
Sync2 (J14)

Red BL 1 Rx1 RGO1/RGO2 Sync Output

W 6 Tx1 TPO1/TPO2

Gray BL 2 Rx2 RGI1/RGI2 Sync Input

W 7 Tx2 TPI1/TPI2

Drain 5 GND GRD
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Alarm Mult

Office alarm cabling in a Alcatel-Lucent 1665 DMX high-capacity shelf bay starts at the 
bottom shelf which is cabled directly to the office alarm system. Then as shelves are added 
to the bay, the office alarm connection is extended by multing the alarm cabling from shelf 
to shelf (bottom to top). Alarm mults do not leave the bay.

For example, J12 of one shelf should be connected to the office alarm terminal. J13 of the 
same shelf should be connected to J12 of the next Alcatel-Lucent 1665 DMX high-
capacity shelf and the same procedure should be continued to connect more shelves.
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Steps

........................................................................................................................................................................................................................

1 Obtain the office alarm cable per Table 3-22, “Office alarm cable assemblies” (p. 3-56). 
Connect the office alarm cable to ALM (J12) of the bottom Alcatel-Lucent 1665 DMX 
high-capacity shelf.

........................................................................................................................................................................................................................

2 Route the office alarm cable from the bottom shelf out of the Alcatel-Lucent 1665 DMX 
high-capacity shelf bay per Figure 3-15, “Office alarm cable installation” (p. 3-53) to the 
office alarm panel.

Figure 3-15 Office alarm cable installation

........................................................................................................................................................................................................................

3 Inspect the office alarm panel and add a contact protection network (if required).

CABLE TIE (TYPICAL)

TIE CABLE ASSY'S TO

CABLE SUPPORT BAR

(AS REQUIRED)

TO OFFICE ALARM INTERFACE
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........................................................................................................................................................................................................................

4 Cut the office alarm cable to the desired length.

........................................................................................................................................................................................................................

5 Wire-wrap the loose end of the office alarm cable to the alarm panel, making connections 
as listed in Table 3-23, Office alarm connections.

........................................................................................................................................................E N D  O F  S T E P S

Alarm mult

The following steps should be performed when the bottom shelf in the bay will be directly 
connected to the office alarms. The cable added in this procedure is to mult office alarms 
in a bay to the bottom shelf. In this procedure the bottom shelf is multed to the shelf 
immediately above. That shelf is then multed to the shelf above it. Continue until the top 
shelf is connected.

Note: In order for office alarms in a shelf (other than the bottom shelf) to be 
reported, all office alarm cable mults from that shelf to the bottom shelf must be in 
place. No shelf should be skipped.

........................................................................................................................................................................................................................

1 Obtain the office alarm mult cable (848589602 for Alcatel-Lucent 1665 DMX to Alcatel-
Lucent 1665 DMX and 848861530 for Alcatel-Lucent 1665 DMX to 1675 LambdaUnite). 
Connect one end to ALM MULT (J13) of the Alcatel-Lucent 1665 DMX high-capacity 
shelf.

........................................................................................................................................................................................................................

2 Route the office alarm mult cable to the side of the bay and connect it to ALM (J12) of the 
Alcatel-Lucent 1665 DMX high-capacity shelf above or to Alcatel-Lucent 1675 
LambdaUnite as required.
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Figure 3-16 Office alarm mult cable installation

848589602 CABLE ASSEMBLY

CONNECT THIS END OF CABLE
ASSEMBLY AS FOLLOWS

FROM TO

PATCH
CONNECTOR

TO PANEL
POSITION

OFFICE
ALARM MULT

J13
ALM MULT

CONNECT OTHER END OF CABLE ASSEMBLY
TO SUCCEEDING DMX SHELF (J12 ALM)
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........................................................................................................................................................................................................................

3 Repeat this procedure for each shelf in the bay.

........................................................................................................................................................................................................................

4 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Table 3-22 Office alarm cable assemblies

Description
Cable 
assembly #

Cable 
length 
(feet)

 Backplane 
connections

Office alarm cable 848558193 50 J12

848562286 100

848562294 150

848562302 250

Office alarm mult 
cable (Alcatel-Lucent 
1665 DMX to Alcatel-
Lucent 1665 DMX)

848589602 3 J13

Office alarm mult 
cable (Alcatel-Lucent 
1665 DMX to 1675 
LambdaUnite)

848861530 3 J13
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Miscellaneous (environmental) discrete telemetry cable
installation

Cable and fiber installation

Table 3-23 Office alarm connections

Miscellaneous (environmental) discrete telemetry cable 
installation

Description

The miscellaneous (environmental) discrete telemetry access allows the maintenance 
center to control and monitor equipment collocated with the Alcatel-Lucent 1665 DMX 
high-capacity shelf.

The environmental control feature enables the maintenance center to remotely initiate up 
to four contact closures at the remote terminal (RT) for equipment operation such as 
pumps, generators, etc.

The environmental alarm status indications allow up to 23 miscellaneous user-settable 
alarm status indications (SI) at the remote terminal for transmission toward the central 
office.

Conn. Pin# Color Designation Name

J12-J13 1

2

3

4

BL-W

W-BL

O-W

W-O

RYMJV1

RYMJV2

RYMJA1

RYMJA2

Major Alarm Visible

Major Alarm Visible Return

Major Alarm Audible

Major Alarm Audible Return

5

6

7

8

G-W

W-G

BR-W

W-BR

RYMNV1

RYMNV2

RYMNA1

RYMNA2

Minor Alarm Visible

Minor Alarm Visible Return

Minor Alarm Audible

Minor Alarm Audible Return

9

10

11

12

S-W

W-S

BL-R

R-BL

RYCRV1

RYCRV2

RYCRA1

RYCRA2

Critical Alarm Visible

Critical Alarm Visible Return

Critical Alarm Audible

Critical Alarm Audible Return

Notes:  
1. The SYSCTL circuit pack reports office alarms. 

2. The connection to the central office alarms from P12 is run for each 1665 
DMX assembly when used in a miscellaneously-mounted individual 
application or from the first 1665 DMX assembly when mounted in a typical 
bay arrangement.
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Miscellaneous (environmental) discrete telemetry cable
installation

Cable and fiber installation

Miscellaneous (environmental) discrete telemetry cable assemblies and the length options 
are listed in Table 3-24, “Miscellaneous discrete cable assemblies” (p. 3-59).

Steps

........................................................................................................................................................................................................................

1 Connect the miscellaneous discrete telemetry cable to the J11 MISC connector on the 
backplane of the Alcatel-Lucent 1665 DMX high-capacity shelf per Figure 3-17, 
“Miscellaneous discrete cable installation” (p. 3-58).

Figure 3-17 Miscellaneous discrete cable installation 

........................................................................................................................................................................................................................

2 Route the cable out of the Alcatel-Lucent 1665 DMX high-capacity shelf bay per 
Figure 3-17, “Miscellaneous discrete cable installation” (p. 3-58) to the telemetry panel.

TO TELEMETRY CIRCUIT, MISCELLANEOUS DISCRETES

CABLE TIE (TYPICAL)
TIE CABLE ASSY'S TO
CABLE SUPPORT BAR
(AS REQUIRED)
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........................................................................................................................................................................................................................

3 Cut the miscellaneous (environmental) discrete telemetry cable to the desired length at the 
telemetry panel.

........................................................................................................................................................................................................................

4 Wire-wrap the loose end of the miscellaneous (environmental) discrete telemetry cable to 
the wire-wrap terminal strip, making connections per Table 3-25, “Miscellaneous 
(environmental) discrete telemetry connections” (p. 3-60).

Note: Each miscellaneous (environmental) discrete telemetry designation is 
connected to the Alcatel-Lucent 1665 DMX high-capacity shelf by two leads (wires). 
For each input, one lead should be connected to input-common and the other lead 
should be connected to the appropriate alarm indication. 
For each output, one lead should be connected to output-common and the other lead 
should be connected to the appropriate alarm indication. 

........................................................................................................................................................................................................................

5 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Table 3-24 Miscellaneous discrete cable assemblies

Description
Cable 
assembly #

Cable 
length  
(feet)

 Backplane 
connections

Miscellaneous 
discrete cable

109321794 15 J11

109321802 30

848839569 50

848839577 100

848839585 150

848839593 250

848839601 350
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Table 3-25 Miscellaneous (environmental) discrete telemetry connections

Conn. Pin# Color Designation Name

 J11 1
2
3
4

BL-W
W-BL
O-W
W-O

TLMI1
TLMI2
TLMI3
TLMI4

Env. Input - #1
Env. Input - #2
Env. Input - #3
Env. Input - #4

5
6
7
8

G-W
W-G
BR-W
W-BR

TLMI5
TLMI6
TLMI7
TLMI8

Env. Input - #5
Env. Input - #6
Env. Input - #7
Env. Input - #8

9
10
11
12

S-W
W-S
BL-R
R-BL

TLMI9
TLMI10
TLMI11
TLMI12

Env. Input - #9
Env. Input - #10
Env. Input - #11
Env. Input - #12

13
14
15
16

O-R
R-O
G-R
R-G

TLMI13
TLMI14
TLMI15
TLMI16

Env. Input - #13
Env. Input - #14
env. input -#15 fan fail alarm
Env. Input - #16

17
18
19
20

BR-R
R-BR
S-R
R-S

TLMI17
TLMI18
TLMI19
TLMIC48VTRN

Env. Input - #17
Env. Input - #18
Env. Input - #19
Input Common

21
22
23
24
25

BL-BK/
BK-BL
O-BK
BK-O
G-BK

TLMO1
TLMO2
TLMO3
TLMO4
TLMOC

Env. Output - #1
Env. Output - #2
Env. Output - #3
Env. Output - #4
Output Common
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Main optical fiber installation (OC-12, OC-48, OC-192)

Description

This section describes how to route the optical fiber cables from the interconnecting 
equipment (for example, a LGX® optical fiber distributing frame) to the Main OLIUs of 
the Alcatel-Lucent 1665 DMX high-capacity shelf. This procedure does not cover routing 
the optical fiber cable between sites.

The optical fiber cables will be connected to the Alcatel-Lucent 1665 DMX after the 
circuit packs are installed. The Alcatel-Lucent 1665 DMX requires single-mode fiber for 
the main OLIUs.

Note: The optical fiber cable is fragile and must be protected. The fibers should be 
placed in a protective tube or channel, such as PVC tubing, or PANDUIT cable 
channel, when running the cable from the Alcatel-Lucent 1665 DMX high-capacity 
shelf to the cable rack. The fibers should be placed in the cable rack in a protective 
channel with nothing on top of them. Cable ties should NOT be used with the optical 
fiber cables.

Note: Ensure only ANGLED LC connectors appear at IN ports of optical circuit 
packs. The “ANGLED” is referring to the rotating boot on the connector and not the 
connector. APC or Angled Polished Connectors are not supported.

Unterminated optical connectors may emit laser radiation. Do not view an unterminated 
optical connector with optical instruments.

Invisible laser radiation when unterminated. Avoid direct exposure of the eyes to the 
beam.

Note: Prior to connecting the optical fiber cables, the fibers should be examined to 
ensure that they are clean. See Appendix A, “Fiber cleaning” for recommended 
cleaning procedures.

WARNING

Laser hazard

WARNING

Laser hazard
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Steps

........................................................................................................................................................................................................................

1 Route the optical fiber cables from the interconnecting equipment into the Alcatel-Lucent 
1665 DMX high-capacity shelf.

Note: Protective covers must be left on fibers.

........................................................................................................................................................................................................................

2 Place the optical fiber cables in a protective tube or channel.

........................................................................................................................................................................................................................

3 Label the optical fiber cables, indicating bay, shelf, pack, and direction (IN or OUT).

........................................................................................................................................................................................................................

4 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Fiber installation for low-speed packs

Description

This section describes how to route the single-mode fiber optical cables from the 
interconnecting equipment (for example, a LGX® optical fiber distributing frame) to the 
Alcatel-Lucent 1665 DMX high-capacity shelf OC-3/OC-12/OC-48 optical ports. This 
procedure does not cover routing the optical fiber cable between sites. 

The optical fiber cables will be connected to the optical ports after the circuit packs are 
installed.

Note: The optical fiber cable is fragile and must be protected. The fibers should be 
placed in a protective tube or channel, such as PVC tubing, or PANDUIT cable 
channel, when running the cable from the Alcatel-Lucent 1665 DMX to the cable rack. 
The fibers should be placed in the cable rack in a protective channel with nothing on 
top of them. Cable ties should NOT be used with the optical fiber cables.

Note: Ensure only ANGLED LC connectors appear at IN ports of optical circuit 
packs.
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Fiber installation for low-speed packsCable and fiber installation

Unterminated optical connectors may emit laser radiation. Do not view an unterminated 
optical connector with optical instruments.

Invisible laser radiation when unterminated. Avoid direct exposure of the eyes to the 
beam.

Note: Prior to connecting the optical fiber cables, the fibers should be examined to 
ensure that they are clean. See Appendix A, “Fiber cleaning” for recommended 
cleaning procedures.

WARNING

Laser hazard

WARNING

Laser hazard
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Steps

........................................................................................................................................................................................................................

1 See the engineering job specification. Determine the function slot where the pack will be 
inserted. The OC-3/OC-12/OC-48 pack can be inserted into any of the function slots 
including the growth slots.

........................................................................................................................................................................................................................

2 Label the optical fiber cables, indicating bay, shelf, function group, pack, and direction (IN 
or OUT).

........................................................................................................................................................................................................................

3 Route optical fiber cables from the interconnecting equipment into the OC-3/OC-12/OC-
48 optical ports

........................................................................................................................................................................................................................

4 Place the optical fiber cables in a protective tube or channel.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

1000Base-F and 100Base-F fiber installation

Description

This section describes how to route the optical fiber cables from the interconnecting 
equipment (for example, an LGX® optical fiber distributing frame) to the optical ports on 
LNW63, LNW64, LNW74, LNW87, and LNW170 Ethernet circuit packs. Multi-mode 
optical fiber is required for LNW74 (100 Base-F ports) and LNW170 (100Base-F ports). 
Single-mode fiber is required for LNW170 (1000Base-F ports).

The optical fiber cables will be connected to the optical ports after the circuit packs are 
installed.

Note: The optical fiber cable is fragile and must be protected. The fibers should be 
placed in a protective tube or channel, such as PVC tubing, or PANDUIT cable 
channel, when running the cable from the Alcatel-Lucent 1665 DMX high-capacity 
shelf to the cable rack. The fibers should be placed in the cable rack in a protective 
channel with nothing on top of them. Cable ties should NOT be used with the optical 
fiber cables.
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1000Base-F and 100Base-F fiber installationCable and fiber installation

Unterminated optical connectors may emit laser radiation. Do not view an unterminated 
optical connector with optical instruments.

Invisible laser radiation when unterminated. Avoid direct exposure of the eyes to the 
beam.

Note: Prior to connecting the optical fiber cables, the fibers should be examined to 
ensure that they are clean. See Appendix A, “Fiber cleaning” for recommended 
cleaning procedures.

Steps

........................................................................................................................................................................................................................

1 See the engineering job specification. Determine the function group (slot 1 only) where 
the pack will be inserted. The LNW63, LNW64, LNW74, LNW87, and LNW170 packs 
can be inserted into any of the function groups (slot 1) including the growth slot (g1). In 
order to use the 10/100BaseT electrical ports on the LNW74 and LNW87, use FN-A, FN-
B, FN-C or FN-D. Only optical ports can be used when LNW74 is located in the Growth-
1 position.

........................................................................................................................................................................................................................

2 Label the optical fiber cables, indicating bay, shelf, function group, pack, and direction 
(IN or OUT).

........................................................................................................................................................................................................................

3 Route optical fiber cables from the interconnecting equipment into the optical ports.

........................................................................................................................................................................................................................

4 Place the optical fiber cables in a protective tube or channel.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

WARNING

Laser hazard

WARNING

Laser hazard
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Fibre channel fiber installation

Description

This section describes how to route the optical fiber cables from the interconnecting 
equipment (for example, an LGX® optical fiber distributing frame) to the optical ports on 
LNW73/73C Fibre Channel circuit packs. Multi-mode and single-mode optical fiber is 
supported. See engineering job spec for fiber requirements.

The optical fiber cables will be connected to the optical ports after the circuit packs are 
installed.

Note: The optical fiber cable is fragile and must be protected. The fibers should be 
placed in a protective tube or channel, such as PVC tubing, or PANDUIT cable 
channel, when running the cable from the Alcatel-Lucent 1665 DMX to the cable rack. 
The fibers should be placed in the cable rack in a protective channel with nothing on 
top of them. Cable ties should NOT be used with the optical fiber cables.

Unterminated optical connectors may emit laser radiation. Do not view an unterminated 
optical connector with optical instruments.

Invisible laser radiation when unterminated. Avoid direct exposure of the eyes to the 
beam.

Note: Prior to connecting the optical fiber cables, the fibers should be examined to 
ensure that they are clean. See Appendix A, “Fiber cleaning” for recommended 
cleaning procedures.

Steps

........................................................................................................................................................................................................................

1 See the engineering job specification. Determine the function slot that the pack will be 
inserted. The LNW73/73C can be inserted into any of the function slots including the 
growth slots. 

........................................................................................................................................................................................................................

2 Label the optical fiber cables, indicating bay, shelf, function group, pack, and direction 
(IN or OUT).

WARNING

Laser hazard

WARNING

Laser hazard
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........................................................................................................................................................................................................................

3 Route optical fiber cables from the interconnecting equipment into the optical ports.

........................................................................................................................................................................................................................

4 Place the optical fiber cables in a protective tube or channel.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

CIT cable installation

Description

This section provides the procedure to connect the CIT cable from the LNW2 (SYSCTL) 
to a PC (serial port). This will allow communications between the PC and the CIT port 
located on the LNW2.

Steps

........................................................................................................................................................................................................................

1 Connect the RJ45 end of the CIT cable to the CIT jack located on the LNW2 (SYSCTL). 
See Figure 3-18, “CIT cable installation” (p. 3-68).

Note: The LNW2 (SYSCTL) is not in the shelf at this time, this procedure is here to 
demonstrate the placement of the cable once the circuit pack is in place.

........................................................................................................................................................................................................................

2 Connect the 9-pin D-type connector to the serial port on the PC.
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Figure 3-18 CIT cable installation

........................................................................................................................................................................................................................

3 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Table 3-26 CIT Cable Assembly

Description
Cable 
assembly #

Cable 
length

Alcatel-Lucent 1665 DMX high-
capacity shelf connections

Front CIT cable 848748869 8 feet CIT/RS-232 jack on SYSCTL 
(LNW2)
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Table 3-27 Standard CIT cable connections

Table 3-28 RJ-45 to DB-9 connector connections

Connection

RJ45 connector

Color

9-Pin D-type connector

Pin# Designation Pin# Designation

Front CIT cable 1 FRS232N W - O 6 DCE Ready

3 FDTR W - BL 4 DTE Ready

4 Ground W - G 5 Ground

5 FTXD O 2 Receive Data

6 FRXD G 3 Transmit Data

Notes:  
1. The connection and the colors shown above are for a standard Alcatel-Lucent made 

cable. If you use a RJ-45 to DB-9 connector with a standard straight-through 
10BaseT LAN cable, see Table 3-28, “RJ-45 to DB-9 connector connections” 
(p. 3-69).

From RJ45 
connector

To 9-pin D-type 
connector

Pin# Color Pin#

1 Blue 6

3 Black 4

4 Red 5

5 Green 2

6 Yellow 3

Notes:  
1. The connection and the colors shown above are for RJ-45 to 

DB-9 connector.

2. This connector should be used with a standard straight-through 
cable which has all eight wires connected.
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Final operations

Description

Final check on equipment and cable installation.

Steps

........................................................................................................................................................................................................................

1 Verify that all the cables are properly dressed/connected.

........................................................................................................................................................................................................................

2 Verify that all cables are properly labeled.

........................................................................................................................................................................................................................

3 Verify that designations where cables were wire-wrapped are properly labeled.

........................................................................................................................................................................................................................

4 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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4 Powering and initial 
circuit pack installation

Overview

Purpose

This section provides information for performing the following:

• Shelf powering

• Circuit pack option settings and installation.

Detailed information on the function of each circuit pack is contained in Alcatel-Lucent 
1665 Data Multiplexer (DMX) Applications and Planning Guide, 365-372-300.

Contents

This chapter provides information on the following topics:

Description

Overview

This section should be performed on all shelf installations.

Tools, test equipment and accessories

The tools, test equipment and accessories necessary to perform the procedures in this 
section are listed in Tools, test equipment, and accessories (p. I-2) Installers should have 
both metric and English unit tools. 

Description 4-1

Powering 4-2

Circuit pack compatibility 4-5

Initial circuit pack installation 4-10
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Powering

Overview

The following table lists the power requirements for the Alcatel-Lucent 1665 DMX high-
capacity shelf.

Table 4-1 Alcatel-Lucent 1665 DMX high-capacity shelf power supply requirements

Steps

........................................................................................................................................................................................................................

1 Verify that the frame or structure into which the Alcatel-Lucent 1665 DMX high-capacity 
shelf is installed is properly grounded.

........................................................................................................................................................................................................................

2 Verify that both circuit breakers on the Alcatel-Lucent 1665 DMX high-capacity shelf are 
in the OFF position. These breakers are located on the front of the Alcatel-Lucent 1665 
DMX high-capacity shelf.

Note: A small flat-bladed screwdriver or other similar type tool is required to set the 
Alcatel-Lucent 1665 DMX high-capacity shelf circuit breakers to the OFF position.

........................................................................................................................................................................................................................

3 Verify no circuit packs seated in shelf

........................................................................................................................................................................................................................

4 Disconnect the power cables from the backplane connectors (P15 from J15 and P14 from 
J14). 

Item Description

Voltage range, all components -40.0V to -60.0V DC

Power feeders two -48V power feeders

BREAKER (A)
BREAKER (B)

Circuit breakers (two per shelf) 20.0A or 30.0 A
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PoweringPowering and initial circuit pack installation

Figure 4-1 Power connections on Alcatel-Lucent 1665 DMX high-capacity shelf 
backplane

Note: The 30-ampere shelf is comcode 848793287. The 20-ampere shelf is comcode 
848935193.

........................................................................................................................................................................................................................

5 If fuses are being used, install fuses that are rated 1.5 times higher than the circuit breaker 
value on the shelf, in the BDFB that powers the Alcatel-Lucent 1665 DMX high-capacity 
shelf A and B feeders.

........................................................................................................................................................................................................................

6 If breakers are being used, use circuit breakers that are rated 1.25 times higher than the 
circuit breaker value on the shelf, in the BDCBB that powers the Alcatel-Lucent 1665 
DMX high-capacity shelf. Then switch the breakers to the ON position for the Alcatel-
Lucent 1665 DMX high-capacity shelf A and B feeders.

J8
D OUT

J6
C OUT

J19
INTEROP

J16
IAOLAN

J3
B OUT

J1
A OUT

J4
B IN

J2
A IN

J13
ALM MULT

J12
ALM

J18
DLAN

J10
X.25

J5
C IN

J7
D IN

NC-DMX-156

J22 C IN

J23 D IN

J26 C OUT

J27 D OUT

J20 A IN

J21 B IN

J24 A OUT

J25 B OUT

IN

OUT

EXP2 EXP1

IN

OUT

CTL

-48RTNB

P15
J14

SYNC2
J11

MISC
J17

MODEM

J9
SYNC1 P14

-48RTNA

-48VA-48VB

CTL

J15
FAN
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........................................................................................................................................................................................................................

7 At the Alcatel-Lucent 1665 DMX high-capacity shelf backplane power connector, use a 
voltmeter and measure the voltage on the power cable between BAT A and BAT A RTN. 
Then measure the voltage between BAT B and BAT B RTN.

Requirement: The voltage MUST be between -40.00 and -60.0 VDC. 

........................................................................................................................................................................................................................

8 At the BDFB/BDCBB either remove the fuses or put the both circuit breakers, associated 
with the of the Alcatel-Lucent 1665 DMX high-capacity shelf in the OFF position.

........................................................................................................................................................................................................................

9 Reconnect the “A” feed of the power cable to the backplane connector (P14 to J14), and 
reconnect the “B” feed of the power cable to the backplane connector (P15 to J15). 

........................................................................................................................................................................................................................

10 At the BDFB/BDCBB either insert the fuses or put the both circuit breakers, associated 
with the of the Alcatel-Lucent 1665 DMX high-capacity shelf in the ON position.

........................................................................................................................................................................................................................

11 Place both circuit breakers on the Alcatel-Lucent 1665 DMX high-capacity shelf in the 
ON position.

........................................................................................................................................................................................................................

12 Verify that the fans have started running.

........................................................................................................................................................................................................................

13 At the BDFB/BDCBB either remove the fuse or put the circuit breaker, associated with the 
“B” feed of the Alcatel-Lucent 1665 DMX high-capacity shelf in the OFF position.

........................................................................................................................................................................................................................

14 Verify the PWR A LED on the Alcatel-Lucent 1665 DMX high-capacity shelf is lighted 
with only the “A” feed powered. 

Designation Color

BAT A Red

BAT A RTN Black/Red

BAT B Red

BAT B RTN Black/Red
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........................................................................................................................................................................................................................

15 At the BDFB/BDCBB either insert the fuse or put the circuit breaker, associated with the 
“B” feed of the Alcatel-Lucent 1665 DMX high-capacity shelf in the ON position. Then 
either remove the fuse or put the circuit breaker, associated with the “A” feed of the 
Alcatel-Lucent 1665 DMX, in the OFF position.

........................................................................................................................................................................................................................

16 Verify the PWR B LED on the Alcatel-Lucent 1665 DMX high-capacity shelf is lighted 
with only the “B” feed powered. 

........................................................................................................................................................................................................................

17 At the BDFB either insert the fuse or put the circuit breaker, associated with the “A” feed 
of the Alcatel-Lucent 1665 DMX high-capacity shelf in the ON position. 

........................................................................................................................................................................................................................

18 Verify that the both the PWR A LED and PWR B LED on the Alcatel-Lucent 1665 DMX 
high-capacity shelf user panel are lighted with both the “A” and “B” feeds powered. 

........................................................................................................................................................................................................................

19 Verify that the fans are still running and are moving air.

........................................................................................................................................................................................................................

20 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Circuit pack compatibility

Overview

Table 4-2, “R9.0 circuit pack compatibility” (p. 4-6) lists all the circuit packs that are 
compatible with R9.0 and their respective shelf locations (slots).

Note: If installing the 20 Amp Alcatel-Lucent 1665 DMX high-capacity shelf, the 
following configurations should be avoided:

Fan Unit LNW2 (2) LNW59 (10)LNW170

Fan Unit LNW2 (2) LNW82 (10)LNW170
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Table 4-2 R9.0 circuit pack compatibility

Fan Unit LNW2 (2) LNW59 (10)LNW20

Fan Unit LNW2 (2) LNW59 (8)LNW20 and any optical pack

Slot name

A1, A2* † B1, B2* † G1* M1 CTL G2* † M2 C1, C2* † D1, D2* †

LNW2

LNW7† LNW7† LNW7† LNW7†

LNW8 LNW8 LNW8 LNW8

LNW16 LNW16 LNW16 LNW16

LNW18 LNW18 LNW18 LNW18

LNW19B LNW19B LNW19B LNW19B

LNW20 LNW20 LNW20‡ LNW20‡ LNW20 LNW20

LNW27 LNW27

LNW29 LNW29

LNW31 LNW31 LNW31 LNW31 LNW31 LNW31

LNW32 LNW32

LNW37 LNW37 LNW37 LNW37 LNW37 LNW37

LNW45 LNW45 LNW45 LNW45 LNW45 LNW45

LNW48 LNW48

LNW49 LNW49 LNW49 LNW49 LNW49 LNW49

LNW50 LNW50

LNW54 LNW54

LNW55 LNW55 LNW55 LNW55 LNW55 LNW55

LNW56 LNW56

LNW58 LNW58

LNW59 LNW59

LNW62 LNW62 LNW62 LNW62 LNW62 LNW62

LNW63 LNW63 LNW63 LNW63 LNW63 LNW63

LNW64 LNW64 LNW64 LNW64 LNW64 LNW64
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LNW66 LNW66 LNW66 LNW66

LNW73 LNW73 LNW73 LNW73 LNW73 LNW73

LNW73C LNW73C LNW73C LNW73C LNW73C LNW73C

LNW74 LNW74 LNW74** LNW74** LNW74 LNW74

LNW76 LNW76

LNW80 LNW80

LNW82 LNW82

LNW87† LNW87 LNW87 LNW87 LNW87 LNW87

LNW93 LNW93 LNW93 LNW93

LNW94 LNW94 LNW94 LNW94

LNW97

LNW98 LNW98 LNW98 LNW98 LNW98 LNW98

LNW170 LNW170 LNW170 LNW170 LNW170 LNW170

177D 177D 177D 177D 177D 177D

177E 177E

LNW202 LNW202

LNW203 LNW203

LNW402 LNW402 LNW402 LNW402 LNW402 LNW402

LNW502 LNW502

LNW504 LNW504

LNW603 LNW603 LNW603 LNW603 LNW603 LNW603

LNW705 LNW705 LNW705 LNW705 LNW705 LNW705

LNW785 LNW785 LNW785 LNW785 LNW785 LNW785

LNW801 LNW801 LNW801 LNW801

Notes:
* 177D Apparatus Blanks are required in all unequipped Function unit and Growth slots to provide proper air flow for cooling.

† The Etherent/Data packs (LNW63, LNW64, LNW73/73C, LNW74, LNW87, LNW170) can only be installed in slot 2 of 
function or growth slot if the shelf is equipped with VLF mains (LNW59, LNW82, or LNW504). 

‡ In G1 and G2, the LNW20 only supports portless operation.

Slot name

A1, A2* † B1, B2* † G1* M1 CTL G2* † M2 C1, C2* † D1, D2* †
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Switch fabric compatibility

When equipping high-speed slots, it is imperative that the switch fabric of the circuit packs 
located in Main 1 and Main 2 match. 

Table 4-3 OC-12 mains with 12 STS-1s of vt switch fabric

Table 4-4 OC-48/OC-192 Mains with 48 STS-1s of vt switch fabric

Table 4-5 OC192 circuit packs with 48 STS-1s of vt switch fabric

Table 4-6 OC192 circuit packs with 192 STS-1s of vt switch fabric (VLF)

Table 4-7 Main Switch Pack (no optics) with 96 STS-1s of vt switch fabric 

Once a high-speed OLIU is installed and placed in service, another OLIU with a different 
capacity switch fabric may not be substituted without disruption to traffic.

** Only optical ports on the LNW74 can be used in growth slots.

OC-12 Circuit packs

LNW48 LNW50

LNW54 LNW203

OC-48 Circuit Packs

LNW27 LNW76

LNW29 LNW82

LNW32 LNW504

LNW202

OC-192 Circuit Packs

LNW56 LNW58

LNW57 LNW60

LNW502 (PTM)

OC-192 Circuit Packs

LNW59 (VLF)

Switch Circuit Pack

LNW80

CAUTION

Service disruption hazard
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Figure 4-2 Alcatel-Lucent 1665 DMX high-capacity shelf 
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Initial circuit pack installation

Description

This section provides instructions for installing, BUT NOT fully seating, circuit packs into 
the Alcatel-Lucent 1665 DMX high-capacity shelf. After circuit packs have been 
unpacked, they may be placed in their respective slots in the Alcatel-Lucent 1665 DMX 
high-capacity shelf but NOT FULLY ENGAGED IN THE BACKPLANE CONNECTOR. 
The circuit packs will be fully installed (seated) in Chapter 5, “Software download and 
circuit pack installation”, “Circuit pack installation procedure” (p. 5-4).

Note: If office alarms are connected, it is advisable to disconnect the office alarm 
cable while performing the procedures in this section to prevent spurious alarms from 
being reported. Reconnect the office alarm cable after completion of all testing.

To protect against damage due to electrostatic discharge, a properly grounded ESD wrist 
strap must be worn when handling equipment.

Note: When only one main OLIU (OC-12, OC-48, OC-192) or main switch pack 
(LNW80) is required, it must be installed in the M1 slot.

LNW2 (SYSCTL) installation

Follow this procedure to install the LNW2 (SYSCTL) circuit pack into the Alcatel-Lucent 
1665 DMX high-capacity shelf.

........................................................................................................................................................................................................................

1 Remove the SYSCTL circuit pack from the packing material. Verify that there are two 
NVM memory cards.

Note: Do not remove the NVM cards.

........................................................................................................................................................................................................................

2 Identify the CTL slot on the Alcatel-Lucent 1665 DMX high-capacity shelf. See 
Figure 4-2, “Alcatel-Lucent 1665 DMX high-capacity shelf” (p. 4-9).

NOTICE
Blank circuit packs are required in all unequipped Main slots, Function unit, 
and Growth slots to provide proper air flow for cooling.

CAUTION

ESD hazard
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........................................................................................................................................................................................................................

3 Place the SYSCTL circuit pack into the CTL slot on the Alcatel-Lucent 1665 DMX high-
capacity shelf. Do NOT engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Main OLIU Circuit Pack Installation

........................................................................................................................................................................................................................

1 If installing OC-12 main OLIUs proceed to “OC-12 main OLIU installation” (p. 4-11).

........................................................................................................................................................................................................................

2 If installing OC-48 main OLIUs proceed to “OC-48 main OLIU installation” (p. 4-12).

........................................................................................................................................................................................................................

3 If installing OC-192 main OLIUs proceed to “OC192 main OLIU installation” (p. 4-13).

........................................................................................................................................................................................................................

4 If installing OC-3/8OC-12/2OC-48 main OLIU (LNW82) proceed to “multi-rate main 
OLIU installation” (p. 4-14)

........................................................................................................................................................................................................................

5 If installing LNW80 main switch OLIU proceed to “LNW80 main switch pack 
installation” (p. 4-15).

........................................................................................................................................................E N D  O F  S T E P S

OC-12 main OLIU installation

Follow this procedure to install the OC-12 OLIU circuit packs listed in Table 4-3, “OC-12 
mains with 12 STS-1s of vt switch fabric” (p. 4-8) in the Alcatel-Lucent 1665 DMX high-
capacity shelf.

........................................................................................................................................................................................................................

1 Remove the first OC-12 OLIU circuit pack from the packing material. 

........................................................................................................................................................................................................................

2 Identify the M1 slot on the Alcatel-Lucent 1665 DMX high-capacity shelf. See Figure 4-2, 
“Alcatel-Lucent 1665 DMX high-capacity shelf” (p. 4-9).
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........................................................................................................................................................................................................................

3 Place the OC-12 OLIU circuit pack into the M1 slot on the Alcatel-Lucent 1665 DMX 
high-capacity shelf. Do NOT engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Remove the second OC-12 OLIU from the packing material.

........................................................................................................................................................................................................................

5 Identify the M2 slot on the Alcatel-Lucent 1665 DMX high-capacity shelf. See Figure 4-2, 
“Alcatel-Lucent 1665 DMX high-capacity shelf” (p. 4-9).

........................................................................................................................................................................................................................

6 Place the second OLIU circuit pack into the M2 slot on the Alcatel-Lucent 1665 DMX 
high-capacity shelf. Do NOT engage the circuit pack in the backplane connector.

Important! If any of the Main slots are to remain unequipped, install a blank circuit pack 
to provide proper air flow for cooling. Always use Main-1 (M1) for shelves equipped with 
only one main pack.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
 OC-3

OC-48 main OLIU installation

Follow this procedure to install the OC-48 OLIU circuit packs in the Alcatel-Lucent 1665 
DMX high-capacity shelf. Verify Switch fabric compatibility (p. 4-8) using Table 4-4, 
OC-48/OC-192 Mains with 48 STS-1s of vt switch fabric. 

........................................................................................................................................................................................................................

1 Remove the first OC-48 OLIU circuit pack from the packing material. 

........................................................................................................................................................................................................................

2 Identify the M1 slot on the Alcatel-Lucent 1665 DMX high-capacity shelf. See Figure 4-2, 
“Alcatel-Lucent 1665 DMX high-capacity shelf” (p. 4-9).

........................................................................................................................................................................................................................

3 Place the OC-48 OLIU circuit pack into the M1 slot on the Alcatel-Lucent 1665 DMX 
high-capacity shelf. Do NOT engage the circuit pack in the backplane connector.
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........................................................................................................................................................................................................................

4 Remove the second OC-48 OLIU from the packing material.

........................................................................................................................................................................................................................

5 Identify the M2 slot on the Alcatel-Lucent 1665 DMX high-capacity shelf. See Figure 4-2, 
“Alcatel-Lucent 1665 DMX high-capacity shelf” (p. 4-9).

........................................................................................................................................................................................................................

6 Place the second OLIU circuit pack into the M2 slot on the Alcatel-Lucent 1665 DMX 
high-capacity shelf. Do NOT engage the circuit pack in the backplane connector.

Important! If any of the Main slots are to remain unequipped, install a blank circuit pack 
to provide proper air flow for cooling. Always use Main-1 (M1) for shelves equipped with 
only one main pack.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

OC192 main OLIU installation

Follow this procedure to install the OC-192 OLIU circuit packs in the Alcatel-Lucent 
1665 DMX high-capacity shelf. Verify Switch fabric compatibility (p. 4-8) using 
Table 4-5, OC192 circuit packs with 48 STS-1s of vt switch fabric and Table 4-6, OC192 
circuit packs with 192 STS-1s of vt switch fabric (VLF),

........................................................................................................................................................................................................................

1 Remove the first OC-192 OLIU circuit pack from the packing material. 

........................................................................................................................................................................................................................

2 Identify the M1 slot on the Alcatel-Lucent 1665 DMX high-capacity shelf. See Figure 4-2, 
“Alcatel-Lucent 1665 DMX high-capacity shelf” (p. 4-9).

........................................................................................................................................................................................................................

3 Place the OC-192 OLIU circuit pack into the M1 slot on the Alcatel-Lucent 1665 DMX 
shelf. Do NOT engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Remove the second OC-192 OLIU from the packing material.
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........................................................................................................................................................................................................................

5 Identify the M2 slot on the Alcatel-Lucent 1665 DMX high-capacity shelf. See Figure 4-2, 
“Alcatel-Lucent 1665 DMX high-capacity shelf” (p. 4-9).

........................................................................................................................................................................................................................

6 Place the second OLIU circuit pack into the M2 slot on the Alcatel-Lucent 1665 DMX 
high-capacity shelf. Do NOT engage the circuit pack in the backplane connector.

Important! If any of the Main slots are to remain unequipped, install a blank circuit pack 
to provide proper air flow for cooling. Always use Main-1 (M1) for shelves equipped with 
only one main pack.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

multi-rate main OLIU installation

Follow this procedure to install the following LNW82 OC3/OC12/OC48 or LNW504 OC-
48/OC-192 circuit packs in the Alcatel-Lucent 1665 DMX high-capacity shelf.

• LNW82

• LNW504

Note: A deeper shelf cover (comcode 849068358) is required for shelves equipped 
with LNW55 OC3/OC12/OC48, LNW82 OC3/OC12/OC48, LNW504 OC-48/OC-
192, LNW785 OMD, and/or LNW705 XM10G/8 circuit packs. This shelf cover 
provides more space to prevent fibers from touching the front cover when the cover is 
closed.

........................................................................................................................................................................................................................

1 Remove the first OLIU circuit pack from the packing material. 

........................................................................................................................................................................................................................

2 Identify the M1 slot on the Alcatel-Lucent 1665 DMX high-capacity shelf. See Figure 4-2, 
“Alcatel-Lucent 1665 DMX high-capacity shelf” (p. 4-9).

........................................................................................................................................................................................................................

3 Place the OLIU circuit pack into the M1 slot on the Alcatel-Lucent 1665 DMX high-
capacity shelf. Do NOT engage the circuit pack in the backplane connector.
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........................................................................................................................................................................................................................

4 Remove the second OLIU from the packing material.

........................................................................................................................................................................................................................

5 Identify the M2 slot on the Alcatel-Lucent 1665 DMX high-capacity shelf. See Figure 4-2, 
“Alcatel-Lucent 1665 DMX high-capacity shelf” (p. 4-9).

........................................................................................................................................................................................................................

6 Place the second OLIU circuit pack into the M2 slot on the Alcatel-Lucent 1665 DMX 
high-capacity shelf. Do NOT engage the circuit pack in the backplane connector.

Important! If any of the Main slots are to remain unequipped, install a blank circuit pack 
to provide proper air flow for cooling. Always use Main-1 (M1) for shelves equipped with 
only one main pack.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
 

LNW80 main switch pack installation

Follow this procedure to install the LNW80 circuit packs in the Alcatel-Lucent 1665 
DMX high-capacity shelf.

........................................................................................................................................................................................................................

1 Remove the first LNW80 circuit pack from the packing material.

........................................................................................................................................................................................................................

2 Identify the M1 slot on the Alcatel-Lucent 1665 DMX high-capacity shelf. See Figure 4-2, 
“Alcatel-Lucent 1665 DMX high-capacity shelf” (p. 4-9).

........................................................................................................................................................................................................................

3 Place the LNW80 circuit pack into the M1 slot on the Alcatel-Lucent 1665 DMX high-
capacity shelf. Do NOT engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Remove the second LNW80 from the packing material.

........................................................................................................................................................................................................................

5 Identify the M2 slot on the Alcatel-Lucent 1665 DMX high-capacity shelf. See Figure 4-2, 
“Alcatel-Lucent 1665 DMX high-capacity shelf” (p. 4-9).
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........................................................................................................................................................................................................................

6 Place the second LNW80 circuit pack into the M2 slot on the Alcatel-Lucent 1665 DMX 
high-capacity shelf. Do NOT engage the circuit pack in the backplane connector.

Important! If any of the Main slots are to remain unequipped, install a blank circuit pack 
to provide proper air flow for cooling. Always use Main-1 (M1) for shelves equipped with 
only one main pack.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

LNW785 OMD5/8 8-channel low-loss DWDM Optical mux/demux

Follow this procedure to install the LNW785 circuit packs in the Alcatel-Lucent 1665 
DMX high-capacity shelf. The LNW785 OMD5/8 circuit pack multiplexes/demultiplexes 
up to 8 DWDM optical channels spaced 100 GHz apart, ranging from 1530 to 1536 nm.

Note: A deeper shelf cover (comcode 849068358) is required for shelves equipped 
with LNW55 OC3/OC12/OC48, LNW82 OC3/OC12/OC48, LNW504 OC-48/OC-
192, LNW785 OMD, and/or LNW705 XM10G/8 circuit packs. This shelf cover 
provides more space to prevent fibers from touching the front cover when the cover is 
closed.

........................................................................................................................................................................................................................

1 See the engineering job specification. Identify the proper function group slots where 
LNW785 circuit packs will be installed.

........................................................................................................................................................................................................................

2 Remove the first LNW785 circuit pack from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, A2, B1, B2, C1, C2, D1, D2, G1, or G2 as 
required). Do NOT engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Repeat Step 1 through Step 3 for each additional LNW785 to be equipped.
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........................................................................................................................................................................................................................

5 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

LNW705 XM10G/8 muxponder pack

Follow this procedure to install the LNW705 circuit packs in the Alcatel-Lucent 1665 
DMX high-capacity shelf. The LNW705 XM10G/8 circuit pack 
multiplexes/demultiplexes up to 8 ports onto a single 10G wavelength. The LNW705 
XM10G/8 circuit pack provides transport for the following types of signals:
OC-3/12/48, 1GE, FC, FICON and 2XFC

Note: A deeper shelf cover (comcode 849068358) is required for shelves equipped 
with LNW55 OC3/OC12/OC48, LNW82 OC3/OC12/OC48, LNW504 OC-48/OC-
192, LNW785 OMD, and/or LNW705 XM10G/8 circuit packs. This shelf cover 
provides more space to prevent fibers from touching the front cover when the cover is 
closed.

Note: The LNW705 circuit packs require PTM modules for the optical interface. 
This procedure will consist of two parts. Installing the circuit card and installing the 
PTM per Appendix E, “Pluggable transmission module installation”, Pluggable 
transmission modules (PTM) (p. E-1).

........................................................................................................................................................................................................................

1 See the engineering job specification. Identify the proper function group slots where 
LNW705 circuit packs will be installed.

........................................................................................................................................................................................................................

2 Remove the first LNW705 circuit pack from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, A2, B1, B2, C1, C2, D1, D2, G1, or G2 as 
required). Do NOT engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Repeat Step 1 through Step 3 for each additional LNW705 to be equipped.

........................................................................................................................................................................................................................

5 See Appendix E, Pluggable transmission modules (PTM) (p. E-1).
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........................................................................................................................................................................................................................

6 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

LNW7(28DS1PM), LNW8(56DS1E1), LNW801(56DS1E1) low-speed installation (optional)

Follow this procedure only if installing LNW7 (28DS1PM), LNW8 (56DS1E1), or 
LNW801 (56DS1E1) circuit packs into the Alcatel-Lucent 1665 DMX high-capacity 
shelf.

Note: LNW7 is not supported with VLF main circuit packs.

........................................................................................................................................................................................................................

1 See the engineering job specification. Identify the proper function group slots where 
LNW7, LNW8, or LNW801 circuit packs will be installed.

........................................................................................................................................................................................................................

2 Remove the LNW7, LNW8, or LNW801 from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, B1, C1 or D1 as required). Do NOT engage 
the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 If a protection circuit pack is required, continue with Step 5. If not, install a blank circuit 
pack into the protection circuit pack slot (A2, B2, C2 or D2 as required), then proceed to 
Step 7.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Remove the second LNW7, LNW8, or LNW801 from the packing material.

........................................................................................................................................................................................................................

6 Place the circuit pack into the shelf (slot A2, B2, C2, or D2 as required). Do NOT engage 
the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

7 Repeat Step 1 through Step 6 for each additional function group to be equipped with 
LNW7, LNW8, or LNW80 circuit packs.
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........................................................................................................................................................................................................................

8 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

LNW16 (12DS3/EC1), LNW18 (TMUX), LNW19B (48 DS3/EC1), LNW20 (48TMUX) low-speed 
installation (optional)

Follow this procedure only if installing LNW16 (12DS3/EC1), LNW18 (TMUX), 
LNW19B (48 DS3/EC1 supporting Terminal Loopbacks) or LNW20 (48TMUX) circuit 
packs into the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

1 See the engineering job specification. Identify the proper function group(s) where 
LNW16, LNW18, LNW19B or LNW20 circuit packs will be installed.

........................................................................................................................................................................................................................

2 Remove the LNW16, LNW18, LNW19B or LNW20 from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, B1, C1, D1 or G1 as required). Do NOT 
engage the circuit pack in the backplane connector.

Note: The LNW20 (48TMUX) is allowed in G1, G2 when used in portless mode. 
LNW16, LNW18, and LNW19B are not allowed in G1, G2.

........................................................................................................................................................................................................................

4 If a protection circuit pack is required, continue with Step 5. If not, install a blank circuit 
pack into the protection circuit pack slot (A2, B2, C2, D2 or G2 as required), then proceed 
to Step 7.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Remove the second LNW16, LNW18, LNW19B or LNW20 from the packing material.

........................................................................................................................................................................................................................

6 Place the circuit pack into the shelf (slot A2, B2, C2, D2 or G2 as required). Do NOT 
engage the circuit pack in the backplane connector.
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Note: The LNW20 is allowed in G1, G2 when used in portless mode. LNW16, 
LNW18, and LNW19B are not allowed in G1, G2.

........................................................................................................................................................................................................................

7 Repeat Step 1 through Step 6 for each additional function group to be equipped with 
LNW16, LNW18, LNW19B or LNW20 circuit packs.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

LNW37 (4 OC-3 PTM OLIUs), LNW45 (8 OC-3 PTM OLIUs), LNW49 (4 OC-12 PTM OLIUs),
LNW55 (12OC-3/12OC-12/4 OC-48 PTM OLIUs), LNW62 (4 OC-48 PTM OLIUs), LNW603 (OC-192 
PTM OLIU) low-speed installation (optional)

Follow this procedure only if installing the LNW37 (4 OC-3 PTM OLIUs), LNW45 (8 
OC-3 PTM OLIUs), LNW49 (4 OC-12 PTM OLIUs), LNW55 (12 OC-3/12 OC-12/4 OC-
48 PTM OLIUs), LNW62 (4 OC-48 PTM OLIUs), or LNW603 (OC-192 PTM OLIU) 
circuit packs into the Alcatel-Lucent 1665 DMX shelf.

Note: A deeper shelf cover (comcode 849068358) is required for shelves equipped 
with LNW55 OC3/OC12/OC48, LNW82 OC3/OC12/OC48, LNW504 OC-48/OC-
192, LNW785 OMD, and/or LNW705 XM10G/8 circuit packs. This shelf cover 
provides more space to prevent fibers from touching the front cover when the cover is 
closed.

Note: The LNW37, LNW45, LNW49, LNW55 and LNW62 circuit packs require 
PTM modules for the optical interface. This procedure will consist of two parts. 
Installing the circuit card and installing the PTM per Appendix E, Pluggable 
transmission modules (PTM) (p. E-1).

........................................................................................................................................................................................................................

1 See the engineering job specification. Identify the proper function group(s) and/or growth 
slot(s) where the low-speed OLIU circuit packs will be installed.

........................................................................................................................................................................................................................

2 Remove the OLIU from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, B1, C1, D1 or G1 as required). Do NOT 
engage the circuit pack in the backplane connector.



............................................................................................................................................................................................................................................................
Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

4-21

............................................................................................................................................................................................................................................................

Initial circuit pack installationPowering and initial circuit pack installation

Note: If using VLF mains (LNW59, LNW82, LNW504), the circuit pack may be 
installed in slots A2, B2, C2, D2, G2. Always consult the engineering job specification 
for placement of circuit packs.

........................................................................................................................................................................................................................

4 If a companion circuit pack is required, continue with Step 5. If not, install a blank circuit 
pack into the companion circuit pack slot (A2, B2, C2, D2 or G2 as required), then 
proceed to Step 7.

Note: Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Remove the second OLIU from the packing material.

........................................................................................................................................................................................................................

6 Place the circuit pack into the shelf (slot A2, B2, C2, D2 or G2 as required). Do NOT 
engage the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

7 Repeat Step 1 through Step 6 for each additional function group and/or growth slot to be 
equipped with LNW37, LNW45, LNW49, LNW55 or LNW62 circuit packs.

........................................................................................................................................................................................................................

8 Install the PTM module per Pluggable transmission modules (PTM) (p. E-1).

........................................................................................................................................................................................................................

9 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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LNW31 (OC-48 OLIU) or LNW402 (OC-48 PTB-based DWDM) low-speed installation (optional)

Follow this procedure only if installing LNW31 or LNW402circuit packs into the Alcatel-
Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

1 See the engineering job specification. Identify the proper function group(s) and/or growth 
slot(s) where LNW31 or LNW402 circuit pack will be installed.

........................................................................................................................................................................................................................

2 Remove the LNW31 or LNW402 from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, B1, C1, D1 or G1 as required). Do NOT 
engage the circuit pack in the backplane connector.

Note: If using VLF mains (LNW59, LNW82, LNW504), the circuit pack may be 
installed in slots A2, B2, C2, D2, G2. Always consult the engineering job specification 
for placement of circuit packs.

........................................................................................................................................................................................................................

4 If a companion circuit pack is required, continue with Step 5. If not, install a blank circuit 
pack into the companion circuit pack slot (A2, B2, C2, D2 or G2 as required) then proceed 
to Step 7.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Remove the second LNW31 or LNW402 from the packing material.

........................................................................................................................................................................................................................

6 Place the circuit pack into the shelf (slot A2, B2, C2, D2 or G2). Do NOT engage the 
circuit pack in the backplane connector.

........................................................................................................................................................................................................................

7 Repeat Step 1 through Step 6 for each additional function group and/or growth slot to be 
equipped with LNW31 or LNW402 circuit packs.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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LNW66 (10/100T) installation (optional)

Follow this procedure only if installing LNW66 (10/100T) circuit packs into the Alcatel-
Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

1 See the engineering job specification. Identify the proper function group slot (A1, B1, C1 
or D1) where the LNW66 circuit pack will be installed.

Note: The LNW66 or circuit pack can only be installed in slot 1 of any function 
group.

........................................................................................................................................................................................................................

2 Remove the LNW66 from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf (slot A1, B1, C1 or D1 as required). Do NOT engage 
the circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Install a blank circuit pack into the companion circuit pack slot (A2, B2, C2 or D2 as 
required).

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Repeat Step 1 through Step 4 for each additional function group slot 1’s to be equipped 
with LNW66 circuit packs.

........................................................................................................................................................................................................................

6 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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LNW63 (1000BASE-SX/LX/LX10), LNW64 (8 GbE), LNW74 (10/100 T/F), LNW87 (FE/GBE PL) and 
LNW170 (100/1G FXS) installation (optional)

Follow this procedure only if installing LNW63 (1000BASE-SX/LX/LX10), LNW64 (8 
GbE), LNW74 (10/100 T/F), LNW87 (FE/GBE PL), and LNW170 (100/1G FXS) circuit 
packs into the Alcatel-Lucent 1665 DMX shelf.

Note: The LNW63, LNW64, LNW74, LNW87, and LNW170 circuit packs require 
PTM modules for the Ethernet interface. This procedure will consist of two parts. 
Installing the circuit card and installing the PTM per Appendix E, Pluggable 
transmission modules (PTM) (p. E-1).

........................................................................................................................................................................................................................

1 See the engineering job specification. Identify the proper function group slot (A1, A2, B1, 
B2, C1, C2, D1, D2, G1 or G2) where the LNW63, LNW64, LNW74, LNW87, or 
LNW170 circuit pack will be installed.

Note: When LNW74 is installed in the G1 or G2 position, only the faceplate optical 
100 Base-F ports are available for use.

The LNW63, LNW64, LNW74, LNW87, and LNW170 circuit packs can only be 
installed in slot 1 of any function group unless the mains are equipped with VLF 
mains (LNW59, LNW82, LNW504). With the VLF mains, both slots in a function or 
growth group may be equipped.

........................................................................................................................................................................................................................

2 Remove the LNW63, LNW64, LNW74, LNW87, or LNW170 from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf fn slot. Do NOT engage the circuit pack in the 
backplane connector.

........................................................................................................................................................................................................................

4 Install a blank circuit pack into the companion function group circuit pack slot as required.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Repeat Step 1 through Step 4 for each additional function group to be equipped with 
LNW63, LNW64, LNW74, LNW87, or LNW170 circuit packs.

........................................................................................................................................................................................................................

6 Install the PTM module per Appendix E, Pluggable transmission modules (PTM) (p. E-1).
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........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

LNW73 (FC-1X/2X) and LNW73C (FC-1X/2X with compression) installation (optional)

Follow this procedure only if installing LNW73 (FC-1X/2X) and LNW73C (FC-1X/2X 
with compression) circuit packs into the Alcatel-Lucent 1665 DMX high-capacity shelf.

Note: The LNW73 and LNW73C circuit pack requires PTM modules for the optical 
interface. This procedure will consist of two parts. Installing the circuit card and 
installing the PTM per Pluggable transmission modules (PTM) (p. E-1).

........................................................................................................................................................................................................................

1 See the engineering job specification. Identify the proper function group slot (A1, A2, B1, 
B2, C1, C2, D1, D2) and/or growth slot (G1, G2) where the LNW73 or LNW73C circuit 
pack will be installed.

Note: The LNW73 and LNW73C circuit packs can only be installed in slot 1 of any 
function group unless the mains are equipped with VLF mains (LNW59, LNW82, 
LNW504). With the VLF mains, both slots in a function or growth group may be 
equipped.

........................................................................................................................................................................................................................

2 Remove the LNW73 or LNW73C from the packing material.

........................................................................................................................................................................................................................

3 Place the circuit pack into the shelf function group slot as required. Do NOT engage the 
circuit pack in the backplane connector.

........................................................................................................................................................................................................................

4 Install a blank circuit pack into the companion circuit pack slot as required.

Important! Blank circuit packs are required in all unused slots to provide proper air flow 
for cooling.

........................................................................................................................................................................................................................

5 Repeat Step 1 through Step 4 for each additional function group and/or growth slot to be 
equipped with LNW73 or LNW73C circuit packs.
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........................................................................................................................................................................................................................

6 Install the PTM module per Appendix E, Pluggable transmission modules (PTM) (p. E-1).

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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177D/LNW98 blank CP installation (optional)

Follow this procedure to install 177D Apparatus Blank(s) or LNW98 Detectable Blank(s) 
into the Alcatel-Lucent 1665 DMX high-capacity shelf.

Note: A 177D Apparatus Blank or LNW98 Detectable Blank is required in any 
unequipped slots to provide proper air flow for cooling.

........................................................................................................................................................................................................................

1 Identify all the unequipped Function unit or Growth slots.

........................................................................................................................................................................................................................

2 Remove the 177D or LNW98 from the packing material.

........................................................................................................................................................................................................................

3 Insert (fully seat) the 177D or LNW98 blank into an unequipped slot on the shelf.

........................................................................................................................................................................................................................

4 Continue with the next unequipped slot until all the unused slots are equipped with an 
177D Apparatus Blank or LNW98 Detectable Blank.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

 177E/LNW97 blank CP installation (optional)

Follow this procedure to install 177E Apparatus Blank(s) or LNW97 Detectable Blank(s) 
into the Alcatel-Lucent 1665 DMX high-capacity shelf.

Note: A 177E Apparatus Blank or LNW97 Detectable Blank is required in the 
Main-2 (M2) slot to provide proper air flow for cooling when only one main is 
equipped. Always use Main-1 (M1) for shelves equipped with only one main pack.

........................................................................................................................................................................................................................

1 Identify any unequipped Main slots.

........................................................................................................................................................................................................................

2 Remove the 177E or LNW97 from the packing material.

........................................................................................................................................................................................................................

3 Insert (fully seat) the 177E or LNW97 into the unequipped Main slot on the shelf.
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........................................................................................................................................................................................................................

4 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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Part II:  Stand-alone 
installation tests

Overview

Purpose

Part II covers the generic software download to the Alcatel-Lucent 1665 Data Multiplexer 
(Alcatel-Lucent 1665 DMX), stand-alone installation tests to verify correct interconnect 
cabling, alarm cabling, and as required, external timing and communication cabling. This 
section also covers circuit pack installation (fully seated).

Contents

This section is organized into the following chapters:

Chapter 5, “Software download and circuit pack installation”

Chapter 6, “Installation tests”

Chapter 7, “Operational tests”



............................................................................................................................................................................................................................................................
I I -2 Alcatel-Lucent 1665 DMX R9.0

365-372-304R9.0 Issue 2
July 2010

............................................................................................................................................................................................................................................................

OverviewStand-alone installation tests
II

Tools, test equipment, and accessories

This section lists the tools, test equipment and accessories needed to perform all the 
procedures in this installation manual.

Listed below are the required tools, test equipment and accessories.

Quantity Description Comments

Screwdriver(s) A screwdriver(s) with the appropriate head(s) is (are) 
required for securing the mounting screws, repositioning 
the mounting brackets, installing the interfacing cables, 
and for setting the circuit breakers to the OFF position.

1 ESD Wrist Strap A wrist strap must be worn when handling circuit packs. 
Use the electrostatic discharge (ESD) jack provided on the 
shelf.

1 Multimeter 
(Optional)

The voltmeter must be capable of measuring DC voltage 
in the 40 to 60 volt range. The use of the voltmeter is 
optional since the shelf will alarm or shut down if the 
proper voltage is not supplied.

1 DS1 Error Rate Test 
Set

A DS1 error rate test set is required for testing of DS1 
cabling. A T-BERD 211 or equivalent is recommended.

1 DS3 Error Rate Test 
Set

A DS3 error rate test set is required for testing of DS3 
cabling. A T-BERD 305 or equivalent is recommended.

1 SONET Optical Test 
Set

An OC-3, OC-12, or OC-48 test set is required for testing 
of optical circuit packs. An Agilent OmniBER 718 or 
equivalent is recommended.

1 Optical Power Meter An optical power meter capable of measuring optical 
levels from +5.0 dBm to -30.0 dBm. The meter should 
also have adapters for LC type connectors and any other 
connectors used in the office.

2 or 3 LC-type Optical 
Fiber Jumper 
(108918269)

Two optical fiber jumpers with LC type connectors are 
required to optically loop the Alcatel-Lucent 1665 DMX 
shelf for test purposes.

2 15 dB LC-type LBO 
(108279480)

Two 15-dB LBOs are required when optically looping the 
Alcatel-Lucent 1665 DMX shelf for test purposes.

1 Personal Computer 
(PC)

See Chapter 5, “Software download and circuit pack 
installation”, “PC minimum requirements” (p. 5-2).

1 CIT Interface Cable 8-ft. long RJ45 to 9-pin D-sub serial cable (Comcode 
848748869).
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5 Software download and 
circuit pack installation

Overview

Purpose 

This chapter provides the procedures for the Alcatel-Lucent 1665 Data Multiplexer 
(Alcatel-Lucent 1665 DMX) initial software download and use of the craft interface 
terminal (CIT).

Contents

This chapter provides information on the following topics

Tools, test equipment and accessories

The tools, test equipment and accessories necessary to perform the procedures in this 
section are listed in “Tools, test equipment, and accessories” (p. II-2).

Software installation 5-2

Circuit pack installation 5-2

Use of WaveStar® CIT software 5-6

Circuit pack firmware version verification 5-11

Alcatel-Lucent 1665 DMX shelf initialization 5-13

Provision/enable/disable TCP/IP on an IAO LAN port 5-13

Reset system date and time 5-16

Provision/enable/disable the Alcatel-Lucent 1665 DMX as a TL1 TCP/IP GNE 5-17
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PC minimum requirements

It is anticipated that most customers will dedicate a laptop or personal computer (PC) to 
run the WaveStar® CIT software. However, any properly configured computer will also 
suffice. The minimum PC requirements are found in Table I-2, Computer requirements 
following table shows the requirements for the computer:

Software installation

Description

Software installation is accomplished by performing the appropriate software download 
procedures in the Alcatel-Lucent 1665 Data Multiplexer (DMX) Release 9.0.0 Software Release 
Description which is shipped with the software.

When the software installation is complete check off the appropriate box in Table I-3, 
Installation acceptance checklist.

Circuit pack installation

Description

This section provides instructions and the recommended order for installing (fully seating) 
the circuit packs in the Alcatel-Lucent 1665 DMX shelf. The procedures in this section 
assume that the SYSCTL is installed and software has been successfully downloaded as 
described in the section, “Software installation” (p. 5-2). 

Locations of circuit packs (Function unit slots) are shown in Chapter 4, “Powering and 
initial circuit pack installation”, Figure 4-2, “Alcatel-Lucent 1665 DMX high-capacity 
shelf” (p. 4-9). 

Circuit packs are keyed to prevent being inserted into the wrong shelf position. Installing 
circuit packs requires some force.

NOTICE

Laser safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.



............................................................................................................................................................................................................................................................
Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

5-3

............................................................................................................................................................................................................................................................

Circuit pack installationSoftware download and circuit pack installation

When a circuit pack is installed, its FAULT LED will light for several seconds to possibly 
several minutes then extinguish.

A properly grounded ESD wrist strap MUST be worn when handling circuit packs. 

Note: The UPD/INIT pushbutton on the SYSCTL circuit pack is recessed and will 
require a pointed object.

NOTICE

Equipment damage

When installing the circuit packs, be careful to insert them straight to avoid 
damaging the backplane pins.

CAUTION

ESD hazard
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Circuit pack installation procedure

Note: Dust plugs supplied with the optical packs should always be in each optical 
port if no optical connector is installed. The dust plugs should be saved so that they can 
be reinstalled when the optical connector is removed.

........................................................................................................................................................................................................................

1 Fully insert both M1 and M2 (OC-3/OC-12/OC-48, OC-12, OC-48, OC-192 or Switch) 
OLIUs into the shelf.

Note: When LNW59, LNW82, LNW202, LNW203, LNW502, or LNW504 packs 
are used in the main slots, pluggable transmission modules are required for the optical 
interface. From the engineering work order, determine if PTMs are required and in 
which port(s).

The LNW59 can operate as a switch pack when PTMs are not equipped.

LNW80 is a main switch pack with no optics. If equipped, continue with Step 6.

........................................................................................................................................................................................................................

2 For circuit packs in the main slots, determine if PTMs are required. If the installation calls 
for optical interfaces to the mains, locate and install the PTMs per the procedure in 
Appendix E, Install pluggable transmission modules (p. E-3).

........................................................................................................................................................................................................................

3 Insert the proper LBO into the IN connectors of each MAIN OLIU. See Chapter 1, 
“Safety” for maximum and minimum transmit levels. If necessary, see Appendix B, 
“Installing fiber connectors and LBOs”.

Note: Attenuation may be required when optically looping an OLIU on itself. See 
Chapter 8, “OC-3/12/48 ring setup and testing: integration procedures”, Table 8-1, 
“Attenuation Table” (p. 8-5), to find out the attenuator value.

........................................................................................................................................................................................................................

4 If not already inserted, fully seat blank packs in any unequipped Main slots.

........................................................................................................................................................................................................................

5 Connect IN to OUT on the OLIU in the M1 slot of the Alcatel-Lucent 1665 DMX shelf 
using an optical fiber jumper cable. See Appendix A, “Fiber cleaning” for proper fiber 
cleaning instructions.

Connect IN to OUT on the OLIU in the M2 slot of the Alcatel-Lucent 1665 DMX shelf 
using an optical fiber jumper cable.
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Result: After a few minutes the flashing FAULT LEDs should extinguish on each 
OLIU circuit pack. The FAULT, MJ and NE LEDs will light on the SYSCTL due to 
DCC alarms created by optically looping the OLIUs. These SYSCTL LEDs will 
remain lit until the DCC is disabled. See Chapter 6, “Installation tests”, Local 
equipment and cross-connect tests (p. 6-6) to clear the alarms.

........................................................................................................................................................................................................................

6 Starting with slot A1, fully seat the circuit pack slotted there using a steady pressure on 
both of the faceplate latches at the same time until the circuit pack is fully seated.

Note: All electrical circuit packs must be slotted in the function slots with the proper 
cables attached in the back of the shelf.

The ACTIVE and FAULT LEDs should light when circuit packs are inserted and the 
FAULT LED should extinguish after a short period of time. Some circuit packs such as 
may take several minutes before their FAULT LEDs extinguish.

........................................................................................................................................................................................................................

7 Continue seating the circuit packs with slot A2 and then on to B1, B2, G1, G2, C1, C2, 
D1, and D2.

........................................................................................................................................................................................................................

8 Fully seat Blank packs in any other unfilled slots.

Blank Types Comcode Series Continue with

LNW177D w/o PEMS 108950585 S1:2 Step 10

LNW98 w/o PEMS 109412866 S1:2 Step 10

LNW177D w/ PEMS
If installing the Fiber 
Bracket Kit*

Notes:
* The fiber bracket kit is used in conjunction with the LNW177D and LNW98 that 

is equipped with the PEMS.

108950585
848949871

S1:3
NA

Step 10
Step 9

LNW98 w/ PEMS
If installing the Fiber 
Bracket Kit*

109412866
848949871

S1:3
NA

Step 10
Step 9

LNW177D w/ Fiber Bracket 
Installed

848960175 S1:3 Step 10

LNW98 w/ Fiber Bracket 
Installed

848960167 S1:3 Step 10
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........................................................................................................................................................................................................................

9 If equipping the fiber bracket, attach the fiber bracket to the blank pack with the hardware 
provided.

Note: The bracket must be positioned with the LC openings in the down position.

........................................................................................................................................................................................................................

10 If there are any FAULT LEDs on or flashing on any of the inserted circuit packs, press the 
UPD/INIT pushbutton on the SYSCTL circuit pack.

Result: The operation of the UPD/INIT pushbutton on the SYSCTL circuit pack will 
update the system and should clear all standing alarms.

........................................................................................................................................................................................................................

11 If FAULT LEDs remain lit on any of the inserted circuit packs, replace the respective 
circuit pack.

........................................................................................................................................................................................................................

12 Any other alarms will be cleared later on in this chapter.

........................................................................................................................................................................................................................

13 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Use of WaveStar® CIT software

Description

Complete the following steps to login to the Alcatel-Lucent 1665 DMX via WaveStar® 
CIT. It is assumed that the CIT software has been installed on the PC and the NE software 
has been downloaded to the Alcatel-Lucent 1665 DMX shelf per the Software Release 
Description. See “Software installation” (p. 5-2).
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Steps

........................................................................................................................................................................................................................

1 Connect the PC Serial cable to the RS232 (Serial) jack on the front of the SYSCTL circuit 
pack. Or connect a PC LAN cable (cross-over) to the LAN (OSI) connector on the front of 
the SYSCTL circuit pack.

Note: An IP address must be assigned to the NIC card on the PC or laptop. 
Otherwise, you may experience login problems. To assign an IP address, start the DOS 
prompt on the computer, and type the command ipconfig/all. The command will show 
an IP address line. If there is no address line or 0.0.0.0 for an IP address, then you must 
assign an IP address to the NIC card of the computer.

........................................................................................................................................................................................................................

2 Start the WaveStar® CIT software on the PC by double clicking on the WaveStar® icon that 
was created by the installation procedure.

The following windows appear:
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........................................................................................................................................................................................................................

3 If necesssary, enter the following in the Login window: Note: User ID and password are 
case sensitive.

User ID: LUC01
Password: LUC+01

Note: When the CIT is installed, there is an optional step to enable or disable CIT 
logins. This screen shot would not be displayed if the user chose to disable CIT logins.



............................................................................................................................................................................................................................................................
Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

5-9

............................................................................................................................................................................................................................................................

Use of WaveStar® CIT softwareSoftware download and circuit pack installation

........................................................................................................................................................................................................................

4 Click OK to connect. The screen appears:

........................................................................................................................................................................................................................

5 Under NE Name, enter LT-DMX.

........................................................................................................................................................................................................................

6 Under NE Type, select DMX from the drop-down list.

........................................................................................................................................................................................................................

7 Under Connection Type, click on the drop-down menu arrow and choose Serial, OSI, or 
TCP/IP depending on the type of connection you are using.

Note: TCP/IP is available when the SYSCTL has a bootcode of 7.1 or higher. The 
SYSCTL (LNW2) displays the boot code on initial turn up and the 7.1 bootcode is 
indicated by a flashing M P 7 1 in the display. When the bootcode is 7.1 or higher, the 
SYSCTL has a default IP address of 169.254.1.1. If the PC’s LAN card to is 
configured as DHCP, the SYSCTL will provide the PC with an IP address within a 
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minute or so. Connection through TCP/IP is now possible using the default IP address 
of 169.254.1.1.

........................................................................................................................................................................................................................

8 Click Graphical and the NE login screen appears.

........................................................................................................................................................................................................................

9 Enter the Login information (case sensitive)for the shelf:
User Id: LUC01
Password: DMX2.5G10G
Click OK and the NE legal notice appears.
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........................................................................................................................................................................................................................

10 Click OK and the System View appears.

........................................................................................................................................................................................................................

11 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Circuit pack firmware version verification

Description

This section provides instructions to verify firmware versions on the circuit packs in the 
Alcatel-Lucent 1665 DMX shelf. The procedures in this section assume that the SYSCTL 
is installed and software has been successfully downloaded and the circuit packs have 
been installed in the shelf as described in the preceding sections. 
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Steps

........................................................................................................................................................................................................................

1 Log on to the Alcatel-Lucent 1665 DMX shelf using the CIT software as described in the 
“Use of WaveStar® CIT software” (p. 5-6).

........................................................................................................................................................................................................................

2 In the System View, select View > Equipment.

Result: All packs inserted into the shelf are displayed.

........................................................................................................................................................................................................................

3 Click on an installed circuit pack.

........................................................................................................................................................................................................................

4 Click Select to issue the command.

The circuit pack information will be displayed. If the circuit pack has a program 
associated with it, the version number will be displayed next to Program Version:. 
Compare it to the table of Program Versions in Chapter 6 of the Alcatel-Lucent 1850 
Transport Service Switch (TSS-60) Release 9.0.0 Software Release Description.

........................................................................................................................................................................................................................

5 Compare the Program Version: again for the circuit pack just reseated and if it still does 
not match the table, see Alcatel-Lucent 1665 Data Multiplexer (DMX) User Operations 
Guide, 365-372-301 for detailed troubleshooting procedures.

........................................................................................................................................................................................................................

6 Compare the Program Version to the information provided in the Alcatel-Lucent 1850 
Transport Service Switch (TSS-60) Release 9.0.0 Software Release Description.

Note: OLIU circuit packs are not considered “smart packs”, therefore will not 
provide program version. The exception is the VLF Mains.

........................................................................................................................................................................................................................

7 If the Program Version did not match the version number in the Firmware Version table in 
the SRD, reseat that circuit pack and wait 15 minutes.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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Alcatel-Lucent 1665 DMX shelf initialization

Description

This section provides instructions for initializing the Alcatel-Lucent 1665 DMX shelf, to 
insure that all circuit pack databases are correct for the current shelf and software release. 
The procedures in this section assume that the SYSCTL is installed and software has been 
successfully downloaded and the circuit packs have all been installed in the shelf as 
described in the preceding sections.

Steps

........................................................................................................................................................................................................................

1 Log on to the Alcatel-Lucent 1665 DMX shelf using the CIT software as described in the 
“Use of WaveStar® CIT software” (p. 5-6).

........................................................................................................................................................................................................................

2 Select Fault > Reset > Initialize System...

........................................................................................................................................................................................................................

3 Click OK and then Yes to the Warning.

Result: After a few minutes the shelf will reset and end the CIT session. 

........................................................................................................................................................................................................................

4 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Provision/enable/disable TCP/IP on an IAO LAN port

Description 

This is an optional task which describes the steps necessary to provision, enable or disable 
the TCP/IP on the IAO LAN Port. 

Before you begin

Prior to performing this task, you must:

• Obtain the work instructions for this task.

• Know which LAN Port is being provisioned.
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• Obtain the IP Address and IP Subnet Mask of the desired LAN Port and the IP Default 
Router Address if you are connecting to a router.

• Be able to log in to a Alcatel-Lucent 1665 DMX with the WaveStar® CIT and be 
familiar with the functions of the WaveStar® CIT.

Steps

........................................................................................................................................................................................................................

1 Use the WaveStar® CIT to log in to the Alcatel-Lucent 1665 DMX shelf being provisioned 
using a Graphical connection.

........................................................................................................................................................................................................................

2 Determine which IAO LAN Port(s) you want to use (front or rear).

Note: If you are using the rear IAO LAN port, use lan-2 as the AID. If you are using 
the front IAO LAN port, use lan-1 as the AID.

........................................................................................................................................................................................................................

3 From the System View menu, select

Administration > Data Communications

Result: The Data Communications window opens

........................................................................................................................................................................................................................

4 In the Data Communications window, click on the TCP/IP tab at the top of the window.

Result: The TCP/IP parameters are displayed.

........................................................................................................................................................................................................................

5 Select and/or modify the following parameters:

1. Select the Port Aid: (lan-1 [front] or lan-2 [rear]) being provisioned.

Note: When provisioning TCP/IP on the Network Element, do not disable the OSI 
function from LAN-1 unless the engineering specification calls for it. If the OSI 
function is disabled, the only access to the shelf may be through the Serial Port.

2. If applicable, one at time, click the Modify button to set the IP Address and IP 
Subnet Mask of the desired LAN port and the IP Default Router Address, if 
connecting to a default router.

When the provisioning window opens for the IP address being provisioned, enter the 
IP address as four dot-separated decimal numbers ranging from 0 to 255. Click OK to 
make your changes or Cancel to quit.
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3. Select Enable to enable the TCP/IP function, or Disable to disable the TCP/IP 
function.

Note: If you enter duplicate IP addresses and/or IP subnet addresses, a warning 
appears: Input, Data Not Valid, each IAO LAN Port must have a unique IP subnet 
mask.
Scroll through the Port AID drop-down menu and identify the duplication, then assign 
correct addresses as necessary.

Note: If you select Enable and click OK to apply any changes, then execute the 
command when requested, the system may reset and you will be logged off. Selecting 
Disable allows you to stay logged on to the system to perform more provisioning. You 
can then come back to this window and enable the TCP/IP function.

Note: Following a Alcatel-Lucent 1665 DMX system reset, the date and time may 
revert to January 1, 1970 (70-01-01) at midnight (00:00:00). If automatic 
synchronization is unsuccessful from the network, the date and time must be reset 
manually.

........................................................................................................................................................................................................................

6 Click Apply at the bottom of the window to make your changes.

Result: A warning window opens and asks if you want to execute this command.

........................................................................................................................................................................................................................

7 Click Yes to execute the command.

Result: If you made changes and also enabled the TCP/IP function, the changes are 
applied, the system resets, and you are logged off the system. If you made changes and 
disabled the TCP/IP function, the changes are applied and you are still logged on to the 
system.

........................................................................................................................................................................................................................

8 If the TCP/IP function was enabled and the system reset, provision the TCP/IP Gateway 
using “Provision/enable/disable the Alcatel-Lucent 1665 DMX as a TL1 TCP/IP GNE” 
(p. 5-17) to complete the TCP/IP provisioning, otherwise continue with Step 9.

........................................................................................................................................................................................................................

9 Click Close when you want to exit the window if you are still logged into the system.
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Reset system date and timeSoftware download and circuit pack installation

........................................................................................................................................................................................................................

10 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Reset system date and time

Steps

The following steps are instructions on how to change the date and time on your shelf if 
they have been reset to default values (January 1970).

........................................................................................................................................................................................................................

1 Connect the PC and establish a WaveStar® CIT session (graphical).

........................................................................................................................................................................................................................

2 From the System View menu, select Administration > Set Date and Time to bring up 
the Set Systems Date and Time screen for Alcatel-Lucent 1665 DMX.

........................................................................................................................................................................................................................

3 From the Date panel, select the Year and Month from the pull-down menus.

Result: A calendar is displayed for the month and year selected.

........................................................................................................................................................................................................................

4 Click on the Date from the calendar.

........................................................................................................................................................................................................................

5 From the Time panel, select the Hour, Minute and Second from the pull-down menus 
(based upon a 12-hour clock).

........................................................................................................................................................................................................................

6 Select am or pm.

........................................................................................................................................................................................................................

7 Click OK.

Result: The new date and time appear in the lower right-hand corner of the GUI 
System View.
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Provision/enable/disable the Alcatel-Lucent 1665 DMX as
a TL1 TCP/IP GNE

Software download and circuit pack installation

........................................................................................................................................................................................................................

8 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Provision/enable/disable the Alcatel-Lucent 1665 DMX as a 
TL1 TCP/IP GNE

Purpose

Use this task to provision, enable or disable the Alcatel-Lucent 1665 DMX as a TL1 
TCP/IP GNE.

Required equipment

The following equipment is required:

• Personal Computer (PC) with WaveStar CIT® software installed

• Wrist Strap

Safety precautions

To assure both personal safety and the proper functioning of the Alcatel-Lucent 1665 
DMX, it is imperative to review and understand these warnings and precautions prior to 
performing this task.

Use a static ground wrist strap whenever handling circuit packs or working on a system 
to prevent electrostatic discharge damage to sensitive components. 

CAUTION

ESD hazard
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Provision/enable/disable the Alcatel-Lucent 1665 DMX as a
TL1 TCP/IP GNE

Software download and circuit pack installation

Before you begin

Prior to performing this task, you must:

• Obtain the work instructions for this task.

• Complete the Circuit pack firmware version verification procedure to provision and 
enable TCP/IP for the selected LAN port.

• Complete the “Provision/enable/disable TCP/IP on an IAO LAN port” (p. 5-13).

• Know which LAN port is being provisioned.

• Know the IP addresses, host names and host types for the gateway hosts which will be 
allowed access to the Alcatel-Lucent 1665 DMX TL1 TCP/IP GNE.

• Be able to log in to a Alcatel-Lucent 1665 DMX WaveStar®CIT and be familiar with 
the functions of the WaveStar® CIT.
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Provision/enable/disable the Alcatel-Lucent 1665 DMX as
a TL1 TCP/IP GNE

Software download and circuit pack installation

Steps

........................................................................................................................................................................................................................

1 Use the WaveStar® CIT to log in to the Alcatel-Lucent 1665 DMX TL1 TCP/IP GNE to be 
modified, enabled or disabled, using a Graphical connection through the serial or OSI 
cable.

........................................................................................................................................................................................................................

2 On the System View menu, select Administration > Data Communications

Result: The Data Communications window opens.

........................................................................................................................................................................................................................

3 In the Data Communications window, click on the TCP/IP tab at the top of the window.

Result: The TCP/IP parameters display.

........................................................................................................................................................................................................................

4 Verify that TCP/IP is properly provisioned and enabled for the required LAN port(s).

........................................................................................................................................................................................................................

5 In the Data Communications window, click on the TCP/IP Gateway tab at the top of the 
window.

Result: The TCP/IP Gateway parameters display.

........................................................................................................................................................................................................................

6 From your work instructions, determine which IP calling addresses will be allowed to 
access the Alcatel-Lucent 1665 DMX TL1 TCP/IP GNE.

........................................................................................................................................................................................................................

7 Use the instructions on the screen to add, modify, or delete a gateway host from the 
TCP/IP Gateway Host List.

The following parameters apply:

• The OS host IP address which is four dot-separated decimal numbers, each ranging 
from 0 to 255.

Note: Only IP addresses listed in the TCP/IP Gateway tab will be allowed access 
into the system. Enter the wildcard address of 255.255.255.255 to disable this security 
feature, allowing access to all hosts. 

• The OS Host Name which may consist of 1 to 24 alpha-numeric characters.

• The OS Type which may consist of standard types or listed as other.
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Provision/enable/disable the Alcatel-Lucent 1665 DMX as a
TL1 TCP/IP GNE

Software download and circuit pack installation

Repeat this step for each of the Host IP address you want to authorize for access to the 
Alcatel-Lucent 1665 DMX TL1 TCP/IP GNE. There may be up to 50 provisioned entries 
in the list.

........................................................................................................................................................................................................................

8 On the Data Communications window under TCP/IP Gateway Control, select Enable to 
enable the TCP/IP Gateway, or select Disable to disable the TCP/IP Gateway.

........................................................................................................................................................................................................................

9 Click Apply at the bottom of the window.

Result: A warning window opens and asks if you want to execute this command.

........................................................................................................................................................................................................................

10 Click Yes to execute the command, then click Close to exit the window, if desired.

........................................................................................................................................................................................................................

11 Repeat this procedure for each TL1 TCP/IP GNE to be modified, enabled or disabled.

........................................................................................................................................................................................................................

12 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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6 Installation tests

Overview

Purpose

The purpose of this section is to verify proper transmission cabling installation and R9.0 
functionality as well as the associated functionality of the Alcatel-Lucent 1665 Data 
Multiplexer (Alcatel-Lucent 1665 DMX) shelf.

For end-to-end turn-up and testing procedures, see Alcatel-Lucent 1665 Data Multiplexer 
(DMX) User Operations Guide, 365-372-301.

Contents

This chapter provides information on the following topics

LBO software settings 6-2

Clearing alarms 6-4

Local equipment and cross-connect tests 6-6

DS1 protection switching 6-10

DS1 cleanup procedures 6-14

DS3/EC1 and TMUX testing procedure 6-17

DS3 protection switching 6-23

DS3 cleanup procedures 6-26

LNW66 and LNW74 (10/100T) TX ethernet cabling testing 6-29

OC-3 (LNW37, LNW45, LNW55)/OC-12 (LNW49, LNW55)/OC-48 (LNW55, 
LNW62, LNW402) low-speed SFP test procedure

6-34

OC-3 (low-speed) testing 6-35

OC-12 (low-speed) testing 6-39
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LBO software settingsInstallation tests

Tools, test equipment and accessories

The tools, test equipment and accessories necessary to perform the procedures in this 
section are listed in “Tools, test equipment, and accessories” (p. II-2).

LBO software settings

Description

This section provides instructions for setting the software Line Build Out (LBO) for the 
DS1, DS3/EC1 and TMUX cabling and requires that the SYSCTL, DS1, DS3/EC1 and/or 
TMUX circuit packs be installed and that software has been downloaded.

Setting DS1 LBOs 

If provisioning DS1 LBO settings for the DS1, circuit packs follow the procedure below 
otherwise, skip to Setting DS3/EC1 and TMUX LBOs (p. 6-3). 

........................................................................................................................................................................................................................

1 Log on to the Alcatel-Lucent 1665 DMX shelf using the CIT software as described in the 
5, “Use of WaveStar® CIT software” (p. 5-6).

........................................................................................................................................................................................................................

2 See the following table of cable lengths and LBO values. Determine the LBO value 
corresponding to the DS1 cables installed.

OC-48 (low-speed) testing 6-44

LED test 6-51

Additional optical tests (optional) 6-52

LBO value Distance (feet)

20 0 - 133 (default)

40 134 - 267

60 268 - 420

80 421 - 533

100 534 - 655
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LBO software settingsInstallation tests

........................................................................................................................................................................................................................

3 From the CIT GUI, select Configuration > Equipment...

........................................................................................................................................................................................................................

4 Select the desired DS1 port by clicking the “+” sign next to the CP and VT Group.

........................................................................................................................................................................................................................

5 Highlight the port and click Select.

From the pull-down next to Line Build Out: choose the LBO value determined in Step 2.

........................................................................................................................................................................................................................

6 If a change is made click Apply.

........................................................................................................................................................................................................................

7 Repeat Step 2 through Step 6 for all DS1 ports in all function unit slots which are 
populated with DS1 circuit packs.

........................................................................................................................................................................................................................

8 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Setting DS3/EC1 and TMUX LBOs

The DS3/EC1 and TMUX cabling will be tested with all ports provisioned for DS3. Set 
DS3 LBO values as follows.

........................................................................................................................................................................................................................

1 See the following table of cable lengths and LBO values. Determine the LBO value 
corresponding to the DS3 (TMUX) cables installed:

Table 6-1 Cable lengths (feet)

........................................................................................................................................................................................................................

2 From the CIT GUI, select Configuration > Equipment...

LBO Value  734D  735A

IN 0 - 225 0-125

OUT 225-450 125-250
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........................................................................................................................................................................................................................

3 Select the desired DS3 port by clicking the + sign next to the CP.

........................................................................................................................................................................................................................

4 Highlight the port and click Select.

........................................................................................................................................................................................................................

5 Next to Line Build Out: choose the LBO value determined in Step 1.

........................................................................................................................................................................................................................

6 Repeat Step 1 through Step 5 for all DS3 ports in all function unit slots that are populated 
with DS3 or TMUX circuit packs.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Clearing alarms

Description

In order to clear standing alarms the Alcatel-Lucent 1665 DMX synchronization will be 
optioned for "Free Running." The DCC will be disabled in order to prevent DCC alarms 
from being generated due to the optical loopback on the main OLIUs.

........................................................................................................................................................................................................................

1 Select Configuration > Timing/Sync...

Result: From the Timing Mode: pull-down, choose Free Running.

........................................................................................................................................................................................................................

2 Click OK.

........................................................................................................................................................................................................................

3 Select Configuration > DCC Terminations...

........................................................................................................................................................................................................................

4 From the Port AID: pull-down, select dcc-m1-1.
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Clearing alarmsInstallation tests

........................................................................................................................................................................................................................

5 Next to OSI Over DCC, click disabled.

........................................................................................................................................................................................................................

6 Click Apply.

........................................................................................................................................................................................................................

7 From the Port AID: pull-down, select dcc-m2-1.

........................................................................................................................................................................................................................

8 Next to OSI Over DCC, click disabled.

........................................................................................................................................................................................................................

9 Click Apply.

........................................................................................................................................................................................................................

10 Click Close.

........................................................................................................................................................................................................................

11 If there are any FAULT LEDs on or flashing, press the UPD/INIT push button on the 
SYSCTL circuit pack.

Note: LNW16 (DS3/EC1) circuit pack require either a 75-ohm termination or a 
loopback at the DSX-3 on all ports. If loopbacks are used, make sure to take down any 
cross-connections.

........................................................................................................................................................................................................................

12 If there are still FAULT LEDs on, replace the respective circuit pack. 

........................................................................................................................................................................................................................

13 Disconnect the office alarm cable until all procedures and testing have been completed.

........................................................................................................................................................................................................................

14 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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Local equipment and cross-connect testsInstallation tests

Local equipment and cross-connect tests

Description

The tests in this section verify the proper operation of the circuit packs and the circuit pack 
positions in the Alcatel-Lucent 1665 DMX shelf. It verifies proper cabling from the 
Alcatel-Lucent 1665 DMX to the DSX cross-connect panel or connecting equipment. The 
shelf must successfully pass this test before testing any other feature of the Alcatel-Lucent 
1665 DMX.

It is assumed that Chapter 4, “Powering and initial circuit pack installation” and Chapter 5, 
“Software download and circuit pack installation” have been completed and the Alcatel-
Lucent 1665 DMX shelf has fiber loop-back cables on the Main OLIUs with proper LBOs 
installed, and synchronization set to free-running.

On initial installation/turn-up of Alcatel-Lucent 1665 DMX there are no default cross-
connects. All cross-connects need to be entered for these tests. Upon completion of this 
test all cross-connections will be deleted.

Note: If the shelf is not fully equipped, move circuit packs to unequipped function 
slots and repeat the test. Test all circuit pack positions which have DSX cabling. 

Note: After completing this test, isolate and correct any incorrect wiring or isolate 
and replace any failed units. If any cabling is corrected or units replaced, repeat the 
Local Equipment and cross-connect tests until the units pass without failure. 

 A properly grounded ESD wrist strap MUST be worn when handling circuit packs.

Unterminated optical connectors may emit laser radiation. Do not view beam with 
optical instruments.

DS1 terminating equipment loopback testing

Facility Loopback testing allows the installer to verify electrical cabling to the DS1 
Terminating Equipment. This test is only required if the Alcatel-Lucent 1665 DMX shelf 
is connected to DS1 terminating equipment such as a DACS. It will be necessary to work 
with the Customer Network Control Center to have them establish a terminal loopback. If 
the shelf is NOT connected to DS1 terminating equipment, skip this section and continue 
with DS1 non-terminating equipment transmission testing (optical main OLIU) (p. 6-8).

CAUTION

ESD hazard

WARNING

Laser hazard
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The Function unit slot under test must contain a 28 DS1 (LNW7) or a 56DS1/E1 (LNW8 
or LNW801) circuit pack in order to perform this test. The 56DS1/E1 circuit packs can 
only be used with high capacity shelves. If the Alcatel-Lucent 1665 DMX shelf is not fully 
populated, it may be necessary to move the circuit pack(s) from slot to slot in order to test 
all DS1 cabling.

Steps

This command creates a cross-connect to map the first DS1 of a DS1 circuit pack in a 
Function unit to the first VT1.5 within the first VT Group of STS1 of the Main OLIUs.

........................................................................................................................................................................................................................

1 Log on to the Alcatel-Lucent 1665 DMX shelf using the CIT software as described in 5, 
“Use of WaveStar® CIT software” (p. 5-6).

........................................................................................................................................................................................................................

2 Select Configuration > Cross-Connections...

........................................................................................................................................................................................................................

3 Use the Cross-Connection Wizard to enter a new cross-connection at the VT1.5 rate, 
UPSR Ring Add/Drop, between m1-1-1-1-1 and fn1-1-1-1 (fn will be a,b,c or d 
depending on the slot where the DS1 CP is located).

........................................................................................................................................................................................................................

4 At this point it is necessary to have the Customer Network Control Center establish a 
terminal loopback at the port under test at the DS1 terminating equipment.

........................................................................................................................................................................................................................

5 Run a test transmission test to verify the electrical cabling.
Select Fault > Test > Transmission...

........................................................................................................................................................................................................................

6 Select the CP, VT Group and Port 1-1 (DS1) associated with the cross-connection 
entered above.

........................................................................................................................................................................................................................

7 Select the FACILITY direction.

Result: The results should indicate that the test ran for a duration of 60 seconds 
followed by 0 es (errored seconds).
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........................................................................................................................................................................................................................

8 Complete the above test on all Function unit slots terminating at DSX equipment. Once 
you have completed the test make sure that all loopbacks have been removed at the 
Customer Network Control Center before moving on to any other testing.

........................................................................................................................................................................................................................

9 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

DS1 non-terminating equipment transmission testing (optical main OLIU)

Perform the following steps for all Alcatel-Lucent 1665 DMX shelf Function unit slots 
that are cabled to a DSX-1 and not to any terminating equipment.

A Function unit slot cabled to the DSX-1 must contain a 28DS1 (LNW7) circuit pack or a 
56DS1/E1 (LNW8 or LNW801) circuit pack in order to perform these tests. If the Alcatel-
Lucent 1665 DMX shelf is not fully populated, it may be necessary to move the circuit 
pack(s) from slot to slot in order to test all DS1 cabling.

This procedure requires the use of a DS1 test set.

Steps

This command creates a cross-connect to map the first DS1 of a DS1 circuit pack in a 
Function unit to the first VT1.5 within the first VT Group of STS1 of the Main OLIUs.

........................................................................................................................................................................................................................

1 Log on to the Alcatel-Lucent 1665 DMX shelf using the CIT software as described in the 
5, “Use of WaveStar® CIT software” (p. 5-6).

........................................................................................................................................................................................................................

2 Select Configuration > Cross Connections...

........................................................................................................................................................................................................................

3 Use the Cross-Connection Wizard to enter a new cross-connection at the VT1.5 rate, 
UPSR Ring Add/Drop, starting with m1-1-1-1-1 and fn1-1-1-1 (fn will be a,b,c or d 
depending on the slot where the DS1 CP is located). See Table 6-2, “DS1 Cross-
Connections” (p. 6-14).

........................................................................................................................................................................................................................

4 Set the DS1 test set to transmit and receive a Quasi-Random Sequence Signal (QRSS) 
with B8ZS formatting.
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........................................................................................................................................................................................................................

5 Connect a cable from the DS1 test set transmit connection to the IN jack of the DSX-1 
associated with the DS1 tributary to be tested (start with the first).

........................................................................................................................................................................................................................

6 Connect a cable from the DS1 test set receive connection to the OUT jack of the DSX-1 
associated with the DS1 tributary to be tested (start with the first).

Result: The DS1 test set should indicate it is receiving an error-free QRSS signal with 
B8ZS formatting.

If an error-free signal is not received: 

• Verify that the DS1 line coding format is set to B8ZS using the View > Equipment 
command

• Verify that the LBOs are set according to cable length using the View > Equipment 
command (see Setting DS1 LBOs (p. 6-2).

• Check DS1 cabling for proper connections.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

DS1 non-terminating equipment transmission testing (LNW80 switch or LNW59 without optics)

Perform this test when the Alcatel-Lucent 1665 DMX is equipped with LNW80 switch 
packs or LNW59 without optics in the main slots.

Facility loopback testing allows the installer to verify the electrical cabling to the Alcatel-
Lucent 1665 DMX NE. Follow the procedure below to perform a facility loopback test at 
the Alcatel-Lucent 1665 DMX shelf. 

To test cabling to the DSX-1, use a DS1 test set to transmit and receive toward the facility 
loopback.

Perform the following tests for each DS1 circuit cabled to the Alcatel-Lucent 1665 DMX.

........................................................................................................................................................................................................................

1 Select Fault > Analysis > Loopback...

........................................................................................................................................................................................................................

2 Choose the DS1 port to test and click Select.
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........................................................................................................................................................................................................................

3 Select Operate and Loopback Type: Facility and click Apply.

........................................................................................................................................................................................................................

4 Once the loopback is up, a test signal is generated at the DS1 terminating equipment 
which will verify that the cabling is correct.

Note: A test set can be applied at the DSX-1 to test cabling toward the facility 
loopback.

........................................................................................................................................................................................................................

5 Once the test is complete, remove the loopback.

Select Fault > Analysis > Loopback...

........................................................................................................................................................................................................................

6 Choose the DS1 port to test and click Select.

........................................................................................................................................................................................................................

7 Select Release and Loopback Type: Facility and click Apply.

........................................................................................................................................................................................................................

8 Repeat Step 1 through Step 7 for each DS1 cabled to the DSX-1.

........................................................................................................................................................................................................................

9 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

DS1 protection switching

DS1 function unit protection switching test (manual)

While a VT cross-connection exists, and a test set is connected, path switching will be 
verified.

Use this procedure to test all of the Function unit Slots occupied by a 
LNW7/LNW8/LNW801 (DS1) circuit pack.

Note: This test is performed when the DS1 circuit packs are in a 1x1 protection 
arrangement. It is not mandatory to perform this test on each VT cross-connection, 
however this procedure should be performed on each Function unit Slot pair.
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Steps

........................................................................................................................................................................................................................

1 Locate the Function Group equipped with the DS1 circuit pack.

........................................................................................................................................................................................................................

2 Determine the system is alarm free by clicking on the Alarm List button on the system 
view.

........................................................................................................................................................................................................................

3 Unseat the active circuit pack. The active circuit pack has an ACTIVE LED lit. Monitor 
the test set connected to the DSX patch panel.

Result: The ACTIVE LED on the other circuit pack in the Function Group will light.
The MN alarm and the NE LED lamps on the SYSCTL will light.
Transmission at the test set will take a momentary hit and then re-establish.

Confirm that there is a CP Removed alarm by clicking on the Alarm List button on the 
system view.

........................................................................................................................................................................................................................

4 Unseat the second circuit pack of the pair.

Result: On the SYSCTL, the MN alarm extinguishes and the CR alarm lights. Test set 
will be registering continuous bit errors and indicate AIS alarm.

........................................................................................................................................................................................................................

5 Reseat the first circuit pack that was removed.

Result: The ACTIVE LED on the reseated circuit pack will light. The FAULT LED on 
the circuit pack will light for several seconds then extinguish.
On the SYSCTL, the CR alarm extinguishes and the MN alarm and the NE LED will 
be lit. Test set will indicate good transmission.

........................................................................................................................................................................................................................

6 Reseat the second circuit pack.

Requirement: The ACTIVE LED on the first circuit pack remains on.
The ACTIVE LED on the second circuit pack remains off.
The FAULT LED on the second circuit pack will light for several seconds then 
extinguish. On the SYSCTL, the MN alarm extinguishes.
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........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

DS1 function unit protection switching test (command)

This test will initiate switching commands from the CIT and verify proper switching and 
LED indications.

Note: It is not necessary to perform this test on each vt cross-connection, however 
this procedure should be performed on each Function unit Slot pair.

........................................................................................................................................................................................................................

1 Select Fault > Protection Switch...

........................................................................................................................................................................................................................

2 Click on 1+1 Equip fn-x (x is a,b,c or d corresponding to the function group equipped 
with DS1).

........................................................................................................................................................................................................................

3 Click Select.

........................................................................................................................................................................................................................

4 In the Switch Type: pull-down, select Manual (Normal).

........................................................................................................................................................................................................................

5 Click Apply.

Result: The pack that was active should now be the standby pack and the pack that 
was standby is now active. Transmission should take a momentary hit as it is switched 
to the other pack. This information should agree with the ACTIVE LEDs on the 
LNW7 or LNW8/LNW801 circuit packs.

........................................................................................................................................................................................................................

6 Repeat Step 1 through Step 5 to verify a switch back to the original Function unit circuit 
pack, with the same results as the previous step.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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DS1 path switching test (manual)

Note: It is not mandatory to perform this test on each vt cross-connection, however 
this procedure should be performed on each Function unit Slot pair.

........................................................................................................................................................................................................................

1 Select Fault > Protection Switch...

........................................................................................................................................................................................................................

2 Under Path Protection, click on Path m1-1-1-1.

........................................................................................................................................................................................................................

3 Click Select.

........................................................................................................................................................................................................................

4 At the Switch Type: pull-down, select Manual.

........................................................................................................................................................................................................................

5 Click Apply.

Result: The Active Path: indicates a change from m1 to m2 (or if m2 was originally 
the active path, the switch is from m2 to m1).
The Switch Request State: indicates Manual Switch.

........................................................................................................................................................................................................................

6 At the Switch Type: pull-down, select Clear.

........................................................................................................................................................................................................................

7 Click Apply.

........................................................................................................................................................................................................................

8 Repeat Step 1 through Step 7 to verify a switch back to the original ring.

........................................................................................................................................................................................................................

9 Check off the appropriate box in Table I-3, Installation acceptance checklist

........................................................................................................................................................E N D  O F  S T E P S
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DS1 cleanup procedures

Delete any existing DS1 cross-connections

Before moving on to the next port to test, it is necessary to remove the cross-connection. 
This procedure details the necessary steps to delete a cross-connection.

........................................................................................................................................................................................................................

1 Select Configuration > Cross-Connections...

........................................................................................................................................................................................................................

2 Use the Cross-Connection Wizard to Delete leg(s) of an existing cross-connection 
associated with CP main-1, Port 1.

Requirement: The DS1 test set should indicate a blue (AIS) signal is being received 
in place of the QRSS signal.

........................................................................................................................................................................................................................

3 Remove the test set connections from the DSX-1.

........................................................................................................................................................................................................................

4 Select Configuration > Update System... > Update All.

Result: This command will remove alarms generated by removing the test signals 
from the DSX-1.

........................................................................................................................................................................................................................

5 Repeat the DS1 terminating equipment loopback testing (p. 6-6) or the DS1 non-
terminating equipment transmission testing (optical main OLIU) (p. 6-8) procedure and 
the Delete any existing DS1 cross-connections (p. 6-14) procedure to test each of the 
remaining DS1 tributaries of the Function unit. This is necessary in order to ensure that the 
cabling of each port address is correct.

The table below lists the tributaries and cross-connections for all DS1s associated with a 
function group.

When testing cabling for a Function unit slot other than a, replace the a in each of the 
addresses with the letter (b, c, or d) corresponding to the Function unit slot under test.

Table 6-2 DS1 Cross-Connections

Tributary @ DSX-1 Cross-Connection

1 m1-1-1-1-1,a1-1-1-1

2 m1-1-1-1-2,a1-1-1-2
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3 m1-1-1-1-3,a1-1-1-3

4 m1-1-1-1-4,a1-1-1-4

5 m1-1-1-2-1,a1-1-2-1

6 m1-1-1-2-2,a1-1-2-2

7 m1-1-1-2-3,a1-1-2-3

8 m1-1-1-2-4,a1-1-2-4

9 m1-1-1-3-1,a1-1-3-1

10 m1-1-1-3-2,a1-1-3-2

11 m1-1-1-3-3,a1-1-3-3

12 m1-1-1-3-4,a1-1-3-4

13 m1-1-1-4-1,a1-1-4-1

14 m1-1-1-4-2,a1-1-4-2

15 m1-1-1-4-3,a1-1-4-3

16 m1-1-1-4-4,a1-1-4-4

17 m1-1-1-5-1,a1-1-5-1

18 m1-1-1-5-2,a1-1-5-2

19 m1-1-1-5-3,a1-1-5-3

20 m1-1-1-5-4,a1-1-5-4

21 m1-1-1-6-1,a1-1-6-1

22 m1-1-1-6-2,a1-1-6-2

23 m1-1-1-6-3,a1-1-6-3

24 m1-1-1-6-4,a1-1-6-4

25 m1-1-1-7-1,a1-1-7-1

26 m1-1-1-7-2,a1-1-7-2

27 m1-1-1-7-3,a1-1-7-3

28 m1-1-1-7-4,a1-1-7-4

29* m1-1-2-1-1,a1-2-1-1

30* m1-1-2-1-2,a1-2-1-2

31* m1-1-2-1-3,a1-2-1-3

Tributary @ DSX-1 Cross-Connection
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Note: Tribs 29-56 (denoted *) are only used for LNW8/LNW801 circuit packs.

........................................................................................................................................................................................................................

6 Repeat this procedure for each Function unit slots cabled to a DSX-1 via DS1 cabling.

32* m1-1-2-1-4,a1-2-1-4

33* m1-1-2-2-1,a1-2-2-1

34* m1-1-2-2-2,a1-2-2-2

35* m1-1-2-2-3,a1-2-2-3

36* m1-1-2-2-4,a1-2-2-4

37* m1-1-2-3-1,a1-2-3-1

38* m1-1-2-3-2,a1-2-3-2

39* m1-1-2-3-3,a1-2-3-3

40* m1-1-2-3-4,a1-2-3-4

41* m1-1-2-4-1,a1-2-4-1

42* m1-1-2-4-2,a1-2-4-2

43* m1-1-2-4-3,a1-2-4-3

44* m1-1-2-4-4,a1-2-4-4

45* m1-1-2-5-1,a1-2-5-1

46* m1-1-2-5-2,a1-2-5-2

47* m1-1-2-5-3,a1-2-5-3

48* m1-1-2-5-4,a1-2-5-4

49* m1-1-2-6-1,a1-2-6-1

50* m1-1-2-6-2,a1-2-6-2

51* m1-1-2-6-3,a1-2-6-3

52* m1-1-2-6-4,a1-2-6-4

53* m1-1-2-7-1,a1-2-7-1

54* m1-1-2-7-2,a1-2-7-2

55* m1-1-2-7-3,a1-2-7-3

56* m1-1-2-7-4,a1-2-7-4

Tributary @ DSX-1 Cross-Connection
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........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Verify cross-connects removed

........................................................................................................................................................................................................................

1 Select View > Cross-Connections...

........................................................................................................................................................................................................................

2 Choose shelf (Alcatel-Lucent 1665 DMX) and click Select.

........................................................................................................................................................................................................................

3 Verify that there are no cross-connections on the shelf.

........................................................................................................................................................................................................................

4 Select Configuration > Update System > Update All.

Result: This command will remove alarms generated by removing the test signals 
from the DSX-1.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

DS3/EC1 and TMUX testing procedure

Description

Perform the following steps for all Alcatel-Lucent 1665 DMX shelf Function unit slots 
containing 12DS3/EC1 (LNW16), 48DS3/EC1 (LNW19/LNW19B), 12TMUX (LNW18) 
and 48TMUX (LNW20) circuit packs and cabled to a DSX-3 via DS3/EC1 cabling. The 
48DS3/EC1 and 48TMUX circuit packs can only be used with high capacity shelves.

If the Alcatel-Lucent 1665 DMX is cabled to some other type of DS3/EC1 terminating 
equipment, use this procedure by substituting these ports for the DSX-3 ports called out in 
the procedure. If the Alcatel-Lucent 1665 DMX shelf is not fully populated, it may be 
necessary to move the circuit pack(s) from slot to slot in order to test all DS3/EC1 and 
TMUX cabling.
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This procedure requires the use of a DS3 test set.

Note: The LNW16 and LNW19/LNW19B circuit packs are provisioned on a “per 
port” basis for DS3 or EC1. The default setting for all ports is DS3. Tests in the section 
will verify proper cabling by using a DS3 test set with all ports provisioned as DS3.

Verify provisioning

Verify that all ports are provisioned as DS3.

........................................................................................................................................................................................................................

1 Select View > Equipment...

........................................................................................................................................................................................................................

2 Click on the “+” sign next to the CP fn with the DS3/EC1 circuit pack.

........................................................................................................................................................................................................................

3 Verify that all ports are labeled as DS3.

........................................................................................................................................................................................................................

4 To change provisioning from EC1 to DS3, select Configuration > Equipment... Select 
the DS3/EC1 circuit pack and port, then choose DS3 and click Apply.

........................................................................................................................................................................................................................

5 Repeat Step 1 through Step 4 for each Function Group equipped with DS3/EC1/TMUX 
circuit pack(s).

........................................................................................................................................................................................................................

6 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

DS3 terminating equipment loopback testing (optical main OLIUs)

When the Alcatel-Lucent 1665 DMX is equipped with optical main OLIUs, they are 
looped on themselves and the following tests verify correct operation.

When the Alcatel-Lucent 1665 DMX is equipped with LNW80 switch packs or LNW59 
mains without optics, go to DS3 terminating equipment loopback testing (LNW80 switch 
and LNW59 without optics) (p. 6-20).

Facility Loopback testing allows the installer to verify the electrical cabling to the Alcatel-
Lucent 1665 DMX NE. Follow the procedure below to perform a facility loopback test at 
the Alcatel-Lucent 1665 DMX shelf. When the Alcatel-Lucent 1665 DMX is cabled to 
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other DS3 terminating equipment, in order to complete the loopback testing, it will be 
necessary to contact the Customer Network Control Center and have a signal established 
at the port(s) under test. 

........................................................................................................................................................................................................................

1 Log on to the Alcatel-Lucent 1665 DMX shelf using the CIT software as described in 
Chapter 5, “Software download and circuit pack installation”, “Use of WaveStar® CIT 
software” (p. 5-6).

........................................................................................................................................................................................................................

2 Select Configuration > Cross-Connections...

........................................................................................................................................................................................................................

3 Using the Cross-Connection Wizard create a new cross-connection, UPSR Ring 
Add/Drop, at the STS1 rate from m1-1-1 to fn1-1 (fn is a,b,c or d). See Table 6-3, “DS3 
cross-connections” (p. 6-27).

........................................................................................................................................................................................................................

4 Select Fault > Analysis > Loopback...

........................................................................................................................................................................................................................

5 Choose the DS3 port to test and click Select.

........................................................................................................................................................................................................................

6 Select Operate and Loopback Type: Facility and click Apply.

........................................................................................................................................................................................................................

7 Once the loopback is up, a test signal is generated at the DS3 terminating equipment 
which will verify that the cabling is correct.

........................................................................................................................................................................................................................

8 While observing the error-free transmission, grasp the DS3 cable about two inches from 
the BNC connector head and gently rotate (twist) the cable in a clockwise and counter 
clockwise direction about 45 degrees (gently).

Result: If any errors are detected while performing this "wiggle test," the BNC 
connector must be cut off and replaced.

If an error-free signal is not received:

• Check the LBOs settings using View > Equipment (see Setting DS3/EC1 and TMUX 
LBOs (p. 6-3).

• Verify that the pack is provisioned for the framing format being sent from the test set, 
CBIT or M13.
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• Verify that the port is provisioned for DS3. See Verify provisioning (p. 6-18).

• Check the DS3/EC1 cabling for proper connections.

........................................................................................................................................................................................................................

9 Once the test is complete, remove the loopback.

Select Fault > Analysis > Loopback...

........................................................................................................................................................................................................................

10 Choose the DS3 port to test and click Select.

........................................................................................................................................................................................................................

11 Select Release and Loopback Type: Facility and click Apply.

........................................................................................................................................................................................................................

12 Repeat Step 1 through 11for each DS3 cabled to the DSX-3.

........................................................................................................................................................................................................................

13 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
.

DS3 terminating equipment loopback testing (LNW80 switch and LNW59 without optics)

Perform this test when the Alcatel-Lucent 1665 DMX is equipped with LNW80 switch 
packs or LNW59 without optics in the main slots.

Facility Loopback testing allows the installer to verify the electrical cabling to the Alcatel-
Lucent 1665 DMX NE. Follow the procedure below to perform a facility loopback test at 
the Alcatel-Lucent 1665 DMX shelf. When the Alcatel-Lucent 1665 DMX is cabled to 
other DS3 terminating equipment, in order to complete the loopback testing, it will be 
necessary to contact the Customer Network Control Center and have a signal established 
at the port(s) under test.

To test cabling to the DSX-3, use a DS3 test set to transmit and receive toward the facility 
loopback.

Perform the following tests for each DS3 circuit cabled to the Alcatel-Lucent 1665 DMX.

........................................................................................................................................................................................................................

1 Select Fault > Analysis > Loopback...

........................................................................................................................................................................................................................

2 Choose the DS3 port to test and click Select.
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........................................................................................................................................................................................................................

3 Select Operate and Loopback Type: Facility and click Apply.

........................................................................................................................................................................................................................

4 Once the loopback is up, a test signal is generated at the DS3 terminating equipment 
which will verify that the cabling is correct.

Note: A test set can be applied at the DSX-3 to test cabling toward the facility 
loopback.

........................................................................................................................................................................................................................

5 While observing the error-free transmission, grasp the DS3 cable about two inches from 
the BNC connector head and gently rotate (twist) the cable in a clockwise and counter 
clockwise direction about 45 degrees (gently).

Result: If any errors are detected while performing this "wiggle test," the BNC 
connector must be cut off and replaced.

If an error-free signal is not received:

• Check the LBOs settings using View > Equipment (see Setting DS3/EC1 and TMUX 
LBOs (p. 6-3).

• Verify that the pack is provisioned for the framing format being sent from the test set, 
CBIT or M13.

• Verify that the port is provisioned for DS3. See Verify provisioning (p. 6-18).

• Check the DS3/EC1 cabling for proper connections.

........................................................................................................................................................................................................................

6 Once the test is complete, remove the loopback.

Select Fault > Analysis > Loopback...

........................................................................................................................................................................................................................

7 Choose the DS3 port to test and click Select.

........................................................................................................................................................................................................................

8 Select Release and Loopback Type: Facility and click Apply.

........................................................................................................................................................................................................................

9 Repeat Step 1 through Step 8 for each DS3 cabled to the DSX-3.



............................................................................................................................................................................................................................................................
6-22 Alcatel-Lucent 1665 DMX R9.0

365-372-304R9.0 Issue 2
July 2010

............................................................................................................................................................................................................................................................

DS3/EC1 and TMUX testing procedureInstallation tests

........................................................................................................................................................................................................................

10 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
.

DS3 non-terminating transmission (optical main OLIU)

Perform the remaining steps in this procedure for all Function Groups equipped with 
LNW16 (12DS3/EC1), LNW19/LNW19B (48DS3/EC1), LNW18 (TMUX) or LNW20 
(48TMUX) circuit packs that are terminated at a DSX3 patch panel.

........................................................................................................................................................................................................................

1 Select Configuration > Cross-Connections...

........................................................................................................................................................................................................................

2 Use the Cross-Connection Wizard to enter a new cross-connection at the STS1 rate, 
UPSR Ring Add/Drop, between m1-1-1 and fn-1 (fn will be a,b,c or d depending on the 
slot where the DS3 or TMUX CP is located).

........................................................................................................................................................................................................................

3 Set the DS3 test set to transmit and receive a framed Pseudo Random Bit Stream (PRBS) 
DS3 test signal M13.

M13 should be used to test TMUX.

........................................................................................................................................................................................................................

4 Connect a cable from the DS3 test set transmit connection to the IN jack of the DSX-3 
associated with the first DS3 or TMUX tributary of the Alcatel-Lucent 1665 DMX 
Function unit slot to be tested.

........................................................................................................................................................................................................................

5 Connect a cable from the DS3 test set receive connection to the OUT jack of the DSX-3 
associated with the first DS3 or TMUX tributary of the Alcatel-Lucent 1665 DMX 
Function unit slot to be tested.

Result: The DS3 test set should indicate it is receiving an error-free PRBS signal. To 
verify that the port on the DS3 or TMUX pack is receiving the signal, verify that the 
port has transitioned to an "in service" state with the View > Equipment command.

A port state of "IS" indicates that the pack is receiving a good signal to the port.
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........................................................................................................................................................................................................................

6 While observing the error-free transmission at the DSX, grasp the DS3 cable about two 
inches from the BNC connector head and gently rotate (twist) the cable in a clockwise and 
counter clockwise direction about 45 degrees (gently).

Result: If any errors are detected while performing this “wiggle test,” the BNC 
connector must be cut off and replaced.

If an error-free signal is not received:

• Check the LBOs settings using the View > Equipment command (see Setting 
DS3/EC1 and TMUX LBOs (p. 6-3).

• Verify that the pack is provisioned for the framing format being sent from the test set, 
M13.

• Verify that the port is provisioned for DS3. See Verify provisioning (p. 6-18).

• Check the DS3/EC1 cabling for proper connections.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

DS3 protection switching

DS3 function unit protection switching test (manual)

Use this procedure to test all of the Function unit Slots occupied with an LNW16 
(DS3/EC1), LNW19/LNW19B (48DS3/EC1), LNW18 (TMUX) or LNW20 (48TMUX) 
circuit pack, whether they are cabled to a DSX or terminating equipment.

Note: This test is performed when the DS3 circuit packs are in a 1x1 protection 
arrangement.
It is not mandatory to perform this test on each sts cross-connection, however this 
procedure should be performed on each Function unit Slot pair.

........................................................................................................................................................................................................................

1 Locate the Function Group equipped with the DS3/TMUX circuit pack.

........................................................................................................................................................................................................................

2 Unseat the active circuit pack. The active circuit pack has an ACTIVE LED lit.
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Result: The ACTIVE LED on the other circuit pack in the Function Group will light. 
The MN alarm and the NE LED lamps on the SYSCTL will light. Transmission at the 
test set will take a momentary hit and then re-establish.

........................................................................................................................................................................................................................

3 Unseat the second circuit pack of the pair.

Result: On the SYSCTL, the MN alarm extinguishes and the CR alarm lights. The test 
set is registering loss of transmission.

........................................................................................................................................................................................................................

4 Reseat the first circuit pack that was removed.

Result: The ACTIVE LED on the reseated circuit pack will light. The FAULT LED on 
the circuit pack will light for several seconds then extinguish. On the SYSCTL, the CR 
alarm extinguishes and the MN alarm and the NE LED will be lit. Transmission is re-
established at the test set.

........................................................................................................................................................................................................................

5 Reseat the second circuit pack.

Requirement: The ACTIVE LED on the first circuit pack remains on.
The ACTIVE LED on the second circuit pack remains off.
The FAULT LED on the second circuit pack will light for several seconds then extinguish.
On the SYSCTL, the MN alarm extinguishes.

........................................................................................................................................................................................................................

6 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

DS3 function unit protection switching test (command)

While an STS cross-connection exists, and a test set is connected, the protection switching 
will be verified.

This test will initiate switching commands from the CIT and verify proper switching and 
LED indications while monitoring transmission at a test set.

Note: It is not necessary to perform this test on each sts cross-connection, however 
this procedure should be performed on each Function unit Slot pair.

........................................................................................................................................................................................................................

1 Select Fault > Protection Switch...
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........................................................................................................................................................................................................................

2 Click on 1+1 Equip fn-x (x is a,b,c or d corresponding to the function group equipped 
with DS3).

........................................................................................................................................................................................................................

3 Click Select.

........................................................................................................................................................................................................................

4 In the Switch Type: pull-down, select Manual (Normal).

........................................................................................................................................................................................................................

5 Click Apply.

Result: The pack that was active should now be the standby pack and the pack that 
was standby is now active. Transmission should take a momentary hit as it is switched 
to the other pack. This information should agree with the ACTIVE LEDs on the 
LNW16/LNW19/LNW19B, LNW18 or LNW20 circuit packs.

........................................................................................................................................................................................................................

6 Repeat Step 1 through Step 5 to verify a switch back to the original Function unit circuit 
pack, with the same results as the previous step.

........................................................................................................................................................................................................................

7 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

DS3 path switching test (command)

While an STS cross-connection exists, and a test set is connected, path switching will be 
verified.

Note: It is not mandatory to perform this test on each sts cross-connection, however 
this procedure should be performed on each Function unit Slot pair.

........................................................................................................................................................................................................................

1 Select Fault > Protection Switch...

........................................................................................................................................................................................................................

2 Under Path Protection, click on Path m1-1-1.

........................................................................................................................................................................................................................

3 Click Select.
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........................................................................................................................................................................................................................

4 At the Switch Type: pull-down, select Manual.

........................................................................................................................................................................................................................

5 Click Apply.

Result: The Active Path: indicates a change from m1 to m2 (or if m2 was originally 
the active path, the switch is from m2 to m1).
The Switch Request State: indicates Manual Switch.

........................................................................................................................................................................................................................

6 At the Switch Type: pull-down, select Clear.

........................................................................................................................................................................................................................

7 Click Apply.

........................................................................................................................................................................................................................

8 Repeat Step 1 through Step 7 to verify a switch back to the original ring.

........................................................................................................................................................................................................................

9 Check off the appropriate box in Table I-3, Installation acceptance checklist

........................................................................................................................................................E N D  O F  S T E P S

DS3 cleanup procedures

Delete the existing DS3 cross-connections

Before moving on to the next port to test, it is necessary to remove the cross-connection.

........................................................................................................................................................................................................................

1 Select Configuration > Cross-Connections...

........................................................................................................................................................................................................................

2 Use the Cross-Connection Wizard to Delete leg(s) of an existing cross-connection 
associated with CP main-1, Port 1.

Result: The DS3 test set should indicate a blue (AIS) signal is being received in place 
of the PRBS signal.
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........................................................................................................................................................................................................................

3 Remove the test set connections from the DSX-3.

........................................................................................................................................................................................................................

4 Select Configuration > Update System... > Update All.

Result: This command will remove alarms generated by removing the test signals 
from the DSX-3.

........................................................................................................................................................................................................................

5 Repeat the DS3 terminating equipment loopback testing (optical main OLIUs) (p. 6-18) or 
the DS3 non-terminating transmission (optical main OLIU) (p. 6-22) procedure and the 
Delete the existing DS3 cross-connections (p. 6-26) procedure to test each of the 
remaining DS3 tributaries of the Function unit, substituting the following address 
information within the Cross-Connection Wizard. This is necessary in order to ensure that 
the cabling of each port address is correct.

The table below lists the tributaries and cross-connections for all DS3s associated with a 
function group.

When testing cabling for a Function unit slot other than a, replace the a in each of the 
addresses with the letter (b, c, or d) corresponding to the Function unit slot under test.

Table 6-3 DS3 cross-connections

Tributary @ DSX-3 Cross-Connection

1 m1-1-1,a1-1

2 m1-1-2,a1-2

3 m1-1-3,a1-3

4 m1-1-4,a1-4

5 m1-1-5,a1-5

6 m1-1-6,a1-6

7 m1-1-7,a1-7

8 m1-1-8,a1-8

9 m1-1-9,a1-9

10 m1-1-10,a1-10

11 m1-1-11,a1-11

12 m1-1-12,a1-12
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13* m1-1-13,a1-13

14* m1-1-14,a1-14

15* m1-1-15,a1-15

16* m1-1-16,a1-16

17* m1-1-17,a1-17

18* m1-1-18,a1-18

19* m1-1-19,a1-19

20* m1-1-20,a1-20

21* m1-1-21,a1-21

22* m1-1-22,a1-22

23* m1-1-23,a1-23

24* m1-1-24,a1-24

25* m1-1-25,a1-25

26* m1-1-26,a1-26

27* m1-1-27,a1-27

28* m1-1-28,a1-28

29* m1-1-29,a1-29

30* m1-1-30,a1-30

31* m1-1-31,a1-31

32* m1-1-32,a1-32

33* m1-1-33,a1-33

34* m1-1-34,a1-34

35* m1-1-35,a1-35

36* m1-1-36,a1-36

37* m1-1-37,a1-37

38* m1-1-38,a1-38

39* m1-1-39,a1-39

40* m1-1-40,a1-40

41* m1-1-41,a1-41

Tributary @ DSX-3 Cross-Connection
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Note: Tribs 13-48 (denoted *) are for LNW19/LNW19B and LNW20 circuit packs only.

........................................................................................................................................................................................................................

6 Repeat this procedure for each Function unit slot cabled to a DSX-3 via DS3/EC1 cabling.

........................................................................................................................................................................................................................

7 Verify there are no existing DS3 cross-connections. Use the View > Cross-Connections 
command.

........................................................................................................................................................................................................................

8 Select Configuration > Update System... > Update All.

Result: This command will remove alarms generated by removing the test signals 
from the DSX-3.

........................................................................................................................................................................................................................

9 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

LNW66 and LNW74 (10/100T) TX ethernet cabling testing

Description

This procedure is used to test the ethernet 10/100 TX cabling from the function groups to 
the RJ45 patch panel.

42* m1-1-42,a1-42

43* m1-1-43,a1-43

44* m1-1-44,a1-44

45* m1-1-45,a1-45

46* m1-1-46,a1-46

47* m1-1-47,a1-47

48* m1-1-48,a1-48

Tributary @ DSX-3 Cross-Connection
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Ethernet port assignment verification testing

........................................................................................................................................................................................................................

1 Connect the Front CIT cable between the PC and the CIT/RS 232 jack of System 
Controller and login to the shelf using the serial connection.

........................................................................................................................................................................................................................

2 Identify the function groups that contain an LNW66 or LNW74 (10/100T) circuit packs 
with cabling for testing.

........................................................................................................................................................................................................................

3 Identify the RJ45 patch panel associated with the function groups identified above.

........................................................................................................................................................................................................................

4 Connect the RJ45 cable from the first RJ45 on the patch panel to the ethernet port on your 
PC.

........................................................................................................................................................................................................................

5 Watch for the link LED to light on the PC’s Ethernet card or wait for 30 seconds and then 
disconnect the RJ45 cable from the patch panel.

........................................................................................................................................................................................................................

6 The Fault LED will start flashing on the LNW66 or LNW74.

........................................................................................................................................................................................................................

7 Verify that there is an inc. FE-LAN LOS alarm associated with the ethernet port where the 
signal was removed. Use the Alarm List button on the CIT system view.

........................................................................................................................................................................................................................

8 Select Configuration > Update System... > Update All.

Result: The flashing fault LED on the LNW66 or LNW74 will clear.

........................................................................................................................................................................................................................

9 Connect the RJ45 cable to the next jack on the RJ45 patch panel and repeat starting at Step 
5 until all connected jacks have been tested.

........................................................................................................................................................................................................................

10 Check off the appropriate box in Table I-3, Installation acceptance checklist

........................................................................................................................................................E N D  O F  S T E P S
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Ethernet port wiring verification testing

Note: Continue with the following section only for LNW66 circuit packs. Testing is 
complete for LNW74 packs!

........................................................................................................................................................................................................................

1 If not still connected serially from the last procedure then, connect the Front CIT cable 
between the PC and the CIT/RS-232 jack of System Controller and login to the shelf using 
the serial connection.

........................................................................................................................................................................................................................

2 Select Configuration > Data > Create Virtual Switch.

........................................................................................................................................................................................................................

3 Choose the LNW66 that is being tested.

........................................................................................................................................................................................................................

4 Click Select.

........................................................................................................................................................................................................................

5 Enter Virtual Switch ID: 1.

........................................................................................................................................................................................................................

6 Under Ethernet (LAN) Ports, click Select All.

........................................................................................................................................................................................................................

7 Click Apply.

........................................................................................................................................................................................................................

8 Click Close.

........................................................................................................................................................................................................................

9 Select Configuration > Data > Create VLAN.

........................................................................................................................................................................................................................

10 Choose the CP fn circuit pack that applies.

........................................................................................................................................................................................................................

11 Click Select.

........................................................................................................................................................................................................................

12 Enter VLAN ID:100.
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........................................................................................................................................................................................................................

13 Choose Virtual Switch:1.

........................................................................................................................................................................................................................

14 Under “Untagged Traffic” click on Select All.

........................................................................................................................................................................................................................

15 Click Apply.

........................................................................................................................................................................................................................

16 Connect a RJ45 Ethernet cable from the LAN port on the LNW2 SYSCTL to the first 
position on the RJ45 Ethernet patch panel.

........................................................................................................................................................................................................................

17 Connect a second RJ45 Ethernet cable from the PC Ethernet port to the second position on 
the RJ45 Ethernet patch panel.

........................................................................................................................................................................................................................

18 Watch for the link LED to light on the PC’s Ethernet card or wait for 30 seconds.

........................................................................................................................................................................................................................

19 Login to the shelf using the OSI connection.

Result: Successful login to the Alcatel-Lucent 1665 DMX.

........................................................................................................................................................................................................................

20 Log out of the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

21 At the RJ45 Ethernet patch panel disconnect the RJ45 Ethernet cable run to the PC 
Ethernet port and connect it to the next position on the RJ45 Ethernet patch panel to be 
tested.

........................................................................................................................................................................................................................

22 Ignore the flashing fault LED on the Ethernet circuit pack and any alarms on the shelf.

........................................................................................................................................................................................................................

23 Watch for the link LED to light on the PC’s Ethernet card or wait for 30 seconds.

........................................................................................................................................................................................................................

24 Login to the shelf using the OSI connection.



............................................................................................................................................................................................................................................................
Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

6-33

............................................................................................................................................................................................................................................................

LNW66 and LNW74 (10/100T) TX ethernet cabling testingInstallation tests

Result: Successful login to the Alcatel-Lucent 1665 DMX.

........................................................................................................................................................................................................................

25 Log out of the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

26 Repeat this procedure starting at Step 21 for the remaining Ethernet connections on the 
RJ45 patch panel connected to the LNW66 under test, then continue on to Step 27.

........................................................................................................................................................................................................................

27 Disconnect the PC from the RJ45 patch panel and the Alcatel-Lucent 1665 DMX LAN 
port from the RJ45 patch panel.

........................................................................................................................................................................................................................

28 Connect the Front CIT cable between the PC and the CIT/RS 232 jack of System 
Controller and login to the shelf using the serial connection.

........................................................................................................................................................................................................................

29 Select Configuration > Update System... > Update All.

Result: The flashing fault LED on the Ethernet circuit pack will clear and any alarms 
on the Alcatel-Lucent 1665 DMX shelf will also clear.

........................................................................................................................................................................................................................

30 Select Configuration > Data > Delete Virtual Switch.

........................................................................................................................................................................................................................

31 Choose the LNW66 circuit pack and click Select.

........................................................................................................................................................................................................................

32 Select the VRTSW ID and click Apply.

........................................................................................................................................................................................................................

33 Log out and disconnect the PC from the Alcatel-Lucent 1665 DMX serial port.

........................................................................................................................................................................................................................

34 Repeat this procedure for every slot containing and LNW66.

........................................................................................................................................................................................................................

35 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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OC-3 (LNW37, LNW45, LNW55)/OC-12 (LNW49, LNW55)/OC-
48 (LNW55, LNW62, LNW402) low-speed SFP test procedure

Installation tests

OC-3 (LNW37, LNW45, LNW55)/OC-12 (LNW49, LNW55)/OC-48 
(LNW55, LNW62, LNW402) low-speed SFP test procedure

OC-3/OC-12/OC-48 SFP low-speed SFP test procedure

Note: When reference is made to optical fiber loopback connections to IN and OUT 
on the OLIU, make the connections at the LGX equipment in order to verify correct 
installation and labeling of the fibers.

LBOs are installed on the OLIU faceplate IN port.

........................................................................................................................................................................................................................

1 Identify the function groups that contain an LNW37/LNW45 OC-3, LNW49 OC-12, 
LNW62/LNW402 OC-48 or LNW55 12-port multi-rate OLIU circuit pack.

........................................................................................................................................................................................................................

2 Insert a 15-dB LC-type LBO into the top IN connector (Port 1) of the first SFP equipped. 
See Appendix B, “Installing fiber connectors and LBOs”.

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 1).

Note: If inserting an SFP, see Appendix E, “Pluggable transmission module 
installation”.

........................................................................................................................................................................................................................

3 Connect the Port 1 IN connector to the Port 1 OUT connector (at the LGX) of the OC-3, 
OC-12 or OC-48 OLIU using an optical fiber jumper cable. See Appendix A, “Fiber 
cleaning” for proper fiber cleaning instructions.

Requirement: The FAULT LED on the OLIU will begin flashing and the MN and NE 
LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OLIU 
and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

4 Remove the optical fiber jumper from the OLIU (at the LGX).

NOTICE

Laser safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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Result: The FAULT LED should begin flashing on the OLIU and only the MN and NE 
LEDs should be lit on the SYSCTL circuit pack.

The alarm on the SFP module will flash.

........................................................................................................................................................................................................................

5 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

6 Select Configuration > Update System... > Update All.

Requirement: The flashing FAULT LED should extinguish on the OLIU. There 
should be no alarm indications on the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

7 From the system view click Alarm List to verify that the circuit pack alarm is cleared.

........................................................................................................................................................................................................................

8 Repeat this entire procedure for each LNW37, LNW45, LNW49, LNW55, LNW62 or 
LNW402 SFP equipped in the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

9 Replace all protective dust covers on the LNW37, LNW45, LNW49, LNW55, LNW62 or 
LNW402 SFP OLIU connectors (OLIU and LGX), that were removed to perform this 
procedure.

........................................................................................................................................................................................................................

10 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

OC-3 (low-speed) testing

OC-3 testing procedure

Perform the following steps for all Alcatel-Lucent 1665 DMX shelf function unit or 
growth slots containing OC-3 OLIU circuit packs.
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Note: When reference is made to optical fiber loopback connections to IN and OUT 
on the OLIU, make the connections at the LGX equipment in order to verify correct 
installation and labeling of the fibers.

LBOs are installed on the OLIU faceplate IN port.

........................................................................................................................................................................................................................

1 Identify the function groups that contain an OC-3 OLIU circuit pack and fully insert the 
OLIU into the shelf.

Requirement: After a few moments, the ACTIVE LED should be lit on the OC-3 
OLIU.

........................................................................................................................................................................................................................

2 Insert a 15-dB LC-type LBO into the top IN connector (Port 1) of the OC-3 OLIU. See 
Appendix B, “Installing fiber connectors and LBOs”.

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 1).

........................................................................................................................................................................................................................

3 Connect the Port 1 IN connector to the Port 1 OUT connector (at the LGX) of the OC-3 
OLIU, using an optical fiber jumper cable. See Appendix A, “Fiber cleaning” for proper 
fiber cleaning instructions.

Requirement: The FAULT LED on the OC-3 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-3 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

4 Remove the optical fiber jumper from the OC-3 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-3 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

NOTICE

Laser safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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........................................................................................................................................................................................................................

5 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

6 Select Configuration > Update System... > Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-3 OLIU. There 
should be no alarm indications on the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

7 Place the 15-dB LBO that was removed from the OC-3 OLIU (Port 1) and place it on the 
IN connector directly below it (Port 2).

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 2).

........................................................................................................................................................................................................................

8 Connect the Port 2 IN connector to the Port 2 OUT connector (at the LGX) of the OC-3 
OLIU, using an optical fiber jumper cable.

Requirement: The FAULT LED on the OC-3 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-3 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

9 Remove the optical fiber jumper from the OC-3 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-3 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

10 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

11 Select Configuration > Update System... > Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-3 OLIU. There 
should be no alarm indications on the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

12 Remove the 15-dB LBO from the OC-3 OLIU (Port 2) and place it on the IN connector 
directly below it (Port 3).
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Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 3).

........................................................................................................................................................................................................................

13 Connect the Port 3 IN connector to the Port 3 OUT connector (at the LGX) of the OC-3 
OLIU, using an optical fiber jumper cable.

Requirement: The FAULT LED on the OC-3 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-3 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

14 Remove the optical fiber jumper from the OC-3 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-3 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

15 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

16 Select Configuration > Update System... > Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-3 OLIU. There 
should be no alarm indications on the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

17 Remove the 15-dB LBO from the OC-3 OLIU (Port 3) and place it on the IN connector 
directly below it (Port 4).

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 4).

........................................................................................................................................................................................................................

18 Connect the Port 4 IN connector to the Port 4 OUT connector (at the LGX) of the OC-3 
OLIU, using an optical fiber jumper cable.

Requirement: The FAULT LED on the OC-3 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-3 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

19 Remove the optical fiber jumper from the OC-3 OLIU (at the LGX).
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Result: The FAULT LED should begin flashing on the OC-3 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

20 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

21 Select Configuration > Update System... > Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-3 OLIU. There 
should be no alarm indications on the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

22 Remove the 15-dB LBO from the OC-3 OLIU (port 4).

........................................................................................................................................................................................................................

23 Replace all protective dust covers on the OC-3 OLIU connectors (OLIU and LGX), that 
were removed to perform this procedure.

........................................................................................................................................................................................................................

24 Repeat this entire procedure for each OC-3 OLIU in the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

25 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

OC-12 (low-speed) testing 

OC-12 testing procedure

Perform the following steps for all Alcatel-Lucent 1665 DMX shelf Function unit or 
Growth slots containing OC-12 OLIU circuit packs.

NOTICE

Laser safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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Note: When reference is made to optical fiber loopback connections to IN and OUT 
on the OLIU, make the connections at the LGX equipment in order to verify correct 
installation and labeling of the fibers.

LBOs are installed on the OLIU faceplate IN port.

........................................................................................................................................................................................................................

1 Identify the function groups that contain an OC-12 OLIU circuit pack and fully insert the 
OLIU into the shelf.

Requirement: After a few moments, the ACTIVE LED should be lit on the OC-12 
OLIU.

........................................................................................................................................................................................................................

2 Insert a 15-dB LC-type LBO into the top IN connector (Port 1) of the OC-12 OLIU. See 
Appendix B, “Installing fiber connectors and LBOs”.

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 1).

........................................................................................................................................................................................................................

3 Connect the Port 1 IN connector to the Port 1 OUT connector (at the LGX) of the OC-12 
OLIU, using an optical fiber jumper cable. See Appendix A, “Fiber cleaning” for proper 
fiber cleaning instructions.

Requirement: The FAULT LED on the OC-12 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC1-2 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

4 Remove the optical fiber jumper from the OC-12 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-12 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

5 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

6 Select Configuration > Update System... > Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-12 OLIU. 
There should be no alarm indications on the Alcatel-Lucent 1665 DMX shelf.
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........................................................................................................................................................................................................................

7 Remove the 15-dB LBO from the OC-12 OLIU (Port 1) and place it on the IN connector 
directly below it (Port 2).

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 2).

........................................................................................................................................................................................................................

8 Connect the Port 2 IN connector to the Port 2 OUT connector (at the LGX) of the OC-12 
OLIU, using an optical fiber jumper cable.

Requirement: The FAULT LED on the OC-12 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-12 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

9 Remove the optical fiber jumper from the OC-12 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-12 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

10 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

11 Select Configuration > Update System... > Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-12 OLIU. 
There should be no alarm indications on the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

12 Remove the 15-dB LBO from the OC-12 OLIU (Port 2).

........................................................................................................................................................................................................................

13 Replace all protective dust covers on the OC-12 OLIU connectors, that were removed to 
perform this procedure.

........................................................................................................................................................................................................................

14 Repeat this entire procedure for each OC-12 OLIU in the Alcatel-Lucent 1665 DMX 
shelf.
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........................................................................................................................................................................................................................

15 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

OC-12 facility loopback testing

Facility Loopback testing allows the installer to verify cabling to the OC-12 equipment. 
This test is only required if the Alcatel-Lucent 1665 DMX shelf is connected to OC-12 
equipment. If the shelf is NOT connected to OC-12 equipment, skip this section and 
continue to the section on OC-48 low-speed testing procedure (p. 6-44).

Note: An optical test set with the capability to transmit OC-12 SONET levels are 
necessary for the testing.

The Function unit slot under test must contain a OC-12 circuit pack in order to perform 
this test.

........................................................................................................................................................................................................................

1 Log on to the Alcatel-Lucent 1665 DMX shelf using the CIT software as described in the 
5, “Use of WaveStar® CIT software” (p. 5-6).

........................................................................................................................................................................................................................

2 Select Configuration > Cross-Connections...

........................................................................................................................................................................................................................

3 Use the Cross-Connection Wizard to enter a new cross-connection at the STS-12 rate, 
UPSR Ring Add/Drop, between m1-1-1 and fn-1-1 (fn will be a,b,c,d or g depending on 
the slot where the OC-12 CP is located).

This command creates a cross-connect to map the first OC-12 of an OC-12 circuit pack to 
the first STS-12 of the Main OLIUs.

........................................................................................................................................................................................................................

4 Verify transmission at the patch panel.

........................................................................................................................................................................................................................

5 Select Configuration > Cross-Connections...

........................................................................................................................................................................................................................

6 Use the Cross-Connection Wizard to Delete leg(s) of an existing cross-connection 
associated with CP main-1, Port 1 (the OC-12 cross-connection).
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........................................................................................................................................................................................................................

7 Verify loss of transmission at the patch panel. This should be evident by a SONET alarm 
and a loss of pattern alarm.

........................................................................................................................................................................................................................

8 Select Fault > Analysis > Loopback...

........................................................................................................................................................................................................................

9 Choose the correct port on the OC-12 CP and click Select.

........................................................................................................................................................................................................................

10 Click on Operate and Loopback Type: Facility.

........................................................................................................................................................................................................................

11 Click Apply.

This command creates a facility loopback on the OC-12 port of an OC-12 circuit pack.

........................................................................................................................................................................................................................

12 Verify transmission at the patch panel. There should be no alarms at the test set.

........................................................................................................................................................................................................................

13 Select Fault > Analysis > Loopback...

........................................................................................................................................................................................................................

14 Choose the correct port on the OC-12 CP and click Select.

........................................................................................................................................................................................................................

15 Click on Release.

........................................................................................................................................................................................................................

16 Click Apply.

........................................................................................................................................................................................................................

17 Verify loss of transmission at the patch panel. This should be evident by a SONET alarm 
and a loss of pattern alarm.

........................................................................................................................................................................................................................

18 Repeat this section for all OC-12 ports.
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........................................................................................................................................................................................................................

19 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

OC-48 (low-speed) testing 

OC-48 low-speed testing procedure

Perform the following steps for all Alcatel-Lucent 1665 DMX shelf Function unit or 
Growth slots containing OC-48 (LNW31 or LNW402) OLIU.

Note: When reference is made to optical fiber loopback connections to IN and OUT 
on the OLIU, make the connections at the LGX equipment in order to verify correct 
installation and labeling of the fibers.

LBOs are installed on the OLIU faceplate IN port.

........................................................................................................................................................................................................................

1 Identify the function groups that contain an OC-48 OLIU circuit pack and fully insert the 
OLIU into the shelf.

Requirement: After a few moments, the ACTIVE LED should be lit on the OC-48 
OLIU.

........................................................................................................................................................................................................................

2 Insert a 15-dB LC-type LBO into the IN connector of the OC-48 OLIU. See Appendix B, 
“Installing fiber connectors and LBOs”.

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 1).

NOTICE

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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........................................................................................................................................................................................................................

3 Connect the IN connector to the OUT connector (at the LGX) of the OC-48 OLIU, using 
an optical fiber jumper cable. See Appendix A, “Fiber cleaning” for proper fiber cleaning 
instructions.

Requirement: The FAULT LED on the OC-48 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-48 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

4 Remove the optical fiber jumper from the OC-48 OLIU (at the LGX).

Result: The FAULT LED should begin flashing on the OC-48 OLIU and only the MN 
and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

5 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

6 Select Configuration > Update System... > Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-48 OLIU. 
There should be no alarm indications on the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

7 Remove the 15-dB LBO from the OC-48 OLIU.

........................................................................................................................................................................................................................

8 Replace all protective dust covers on the OC-48 OLIU connectors, that were removed to 
perform this procedure.

........................................................................................................................................................................................................................

9 Repeat this entire procedure for each OC-48 OLIU in the Alcatel-Lucent 1665 DMX 
shelf.

........................................................................................................................................................................................................................

10 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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OC-48 facility loopback testing

Facility Loopback testing allows the installer to verify cabling to the OC-48 equipment. 
This test is only required if the Alcatel-Lucent 1665 DMX shelf is connected to OC-48 
equipment. If the shelf is NOT connected to OC-48 equipment, skip this section and 
continue to the next chapter.

Note: An optical test set with the capability to transmit OC-48 SONET levels are 
necessary for the testing.

The Function unit slot under test must contain an OC-48 (LNW31 or LNW402) circuit 
pack in order to perform this test. 

........................................................................................................................................................................................................................

1 Log on to the Alcatel-Lucent 1665 DMX shelf using the CIT software as described in the 
“Use of WaveStar® CIT software” (p. 5-6).

........................................................................................................................................................................................................................

2 Select Configuration > Cross-Connections...

........................................................................................................................................................................................................................

3 Use the Cross-Connection Wizard to enter a new cross-connection at the STS48 rate, 
UPSR Ring Add/Drop, between m1-1-1 and fn-1-1 (fn will be a,b,c,d or g depending on 
the slot where the OC-48 CP is located).

This command creates a cross-connect to map the first STS-48 of an OC-48 circuit pack to 
the first STS-48 of the Main OLIUs.

........................................................................................................................................................................................................................

4 Verify transmission at the patch panel. There should be no alarms at the test set.

........................................................................................................................................................................................................................

5 Select Configuration > Cross-Connections...

........................................................................................................................................................................................................................

6 Use the Cross-Connection Wizard to Delete leg(s) of an existing cross-connection 
associated with CP main-1, Port 1 (the OC-48 cross-connection).

........................................................................................................................................................................................................................

7 Verify loss of transmission at the patch panel. This should be evident by a SONET alarm 
and a loss of pattern alarm.

........................................................................................................................................................................................................................

8 Select Fault > Analysis > Loopback...



............................................................................................................................................................................................................................................................
Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

6-47

............................................................................................................................................................................................................................................................

OC-48 (low-speed) testingInstallation tests

........................................................................................................................................................................................................................

9 Choose the correct port on the OC-48 CP and click Select.

........................................................................................................................................................................................................................

10 Click on Operate and Loopback Type: Facility.

........................................................................................................................................................................................................................

11 Click Apply.

This command creates a facility loopback on the OC-48 port of an OC-48 circuit pack.

........................................................................................................................................................................................................................

12 Verify transmission at the patch panel. There should be no alarms at the test set.

........................................................................................................................................................................................................................

13 Select Fault > Analysis > Loopback...

........................................................................................................................................................................................................................

14 Choose the correct port on the OC-48 CP and click Select.

........................................................................................................................................................................................................................

15 Click on Release.

........................................................................................................................................................................................................................

16 Click Apply.

........................................................................................................................................................................................................................

17 Verify loss of transmission at the patch panel. This should be evident by a SONET alarm 
and a loss of pattern alarm.

........................................................................................................................................................................................................................

18 Repeat this section for all OC-48 ports.

........................................................................................................................................................................................................................

19 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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OC-192 (low-speed) testing 

OC-192 low-speed testing procedure

Perform the following steps for all Alcatel-Lucent 1665 DMX shelf Function unit or 
Growth slots containing OC-192 (LNW603) OLIU.

Note: When reference is made to optical fiber loopback connections to IN and OUT 
on the OLIU, make the connections at the LGX equipment in order to verify correct 
installation and labeling of the fibers.

LBOs are installed on the OLIU faceplate IN port.

........................................................................................................................................................................................................................

1 Identify the function groups that contain an OC-192 OLIU circuit pack and fully insert the 
OLIU into the shelf.

Requirement: After a few moments, the ACTIVE LED should be lit on the OC-192 
OLIU.

........................................................................................................................................................................................................................

2 Insert a 15-dB LC-type LBO into the IN connector of the OC-192 OLIU. See Appendix B, 
“Installing fiber connectors and LBOs”.

Connect the fibers labeled IN and OUT from the LGX to the OLIU (Port 1).

........................................................................................................................................................................................................................

3 Connect the IN connector to the OUT connector (at the LGX) of the OC-192 OLIU, using 
an optical fiber jumper cable. See Appendix A, “Fiber cleaning” for proper fiber cleaning 
instructions.

Requirement: The FAULT LED on the OC-192 OLIU will begin flashing and the MN 
and NE LEDs should be lit on the SYSCTL circuit pack. 

After approximately 20 seconds the flashing FAULT LED should extinguish on the OC-48 
OLIU and the FAULT, MJ and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

4 Remove the optical fiber jumper from the OC-192 OLIU (at the LGX).

NOTICE

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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Result: The FAULT LED should begin flashing on the OC-192 OLIU and only the 
MN and NE LEDs should be lit on the SYSCTL circuit pack.

........................................................................................................................................................................................................................

5 From the system view click Alarm List to verify that the circuit pack alarm is associated 
with the optical port being tested.

........................................................................................................................................................................................................................

6 Select Configuration > Update System... > Update All.

Requirement: The flashing FAULT LED should extinguish on the OC-192 OLIU. 
There should be no alarm indications on the Alcatel-Lucent 1665 DMX shelf.

........................................................................................................................................................................................................................

7 Remove the 15-dB LBO from the OC-192 OLIU.

........................................................................................................................................................................................................................

8 Replace all protective dust covers on the OC-192 OLIU connectors, that were removed to 
perform this procedure.

........................................................................................................................................................................................................................

9 Repeat this entire procedure for each OC-192 OLIU in the Alcatel-Lucent 1665 DMX 
shelf.

........................................................................................................................................................................................................................

10 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

OC-192 facility loopback testing

Facility Loopback testing allows the installer to verify cabling to the OC-192 equipment. 
This test is only required if the Alcatel-Lucent 1665 DMX shelf is connected to OC-192 
equipment. If the shelf is NOT connected to OC-192 equipment, skip this section and 
continue to the next chapter.

Note: An optical test set with the capability to transmit OC-192 SONET levels are 
necessary for the testing.

The Function unit slot under test must contain an OC-192 (LNW603) circuit pack in order 
to perform this test. 
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........................................................................................................................................................................................................................

1 Log on to the Alcatel-Lucent 1665 DMX shelf using the CIT software as described in the 
Chapter 5, “Software download and circuit pack installation”, “Use of WaveStar® CIT 
software” (p. 5-6).

........................................................................................................................................................................................................................

2 Select Configuration > Cross-Connections...

........................................................................................................................................................................................................................

3 Use the Cross-Connection Wizard to enter a new cross-connection at the STS48 rate, 
UPSR Ring Add/Drop, between m1-1-1 and fn-1-1 (fn will be a,b,c,d or g depending on 
the slot where the OC-48 CP is located).

This command creates a cross-connect to map the first STS-48 of an OC-48 circuit pack to 
the first STS-48 of the Main OLIUs.

........................................................................................................................................................................................................................

4 Verify transmission at the patch panel. There should be no alarms at the test set.

........................................................................................................................................................................................................................

5 Select Configuration > Cross-Connections...

........................................................................................................................................................................................................................

6 Use the Cross-Connection Wizard to Delete leg(s) of an existing cross-connection 
associated with CP main-1, Port 1 (the OC-48 cross-connection).

........................................................................................................................................................................................................................

7 Verify loss of transmission at the patch panel. This should be evident by a SONET alarm 
and a loss of pattern alarm.

........................................................................................................................................................................................................................

8 Select Fault > Analysis > Loopback...

........................................................................................................................................................................................................................

9 Choose the correct port on the OC-48 CP and click Select.

........................................................................................................................................................................................................................

10 Click on Operate and Loopback Type: Facility.

........................................................................................................................................................................................................................

11 Click Apply.

This command creates a facility loopback on the OC-48 port of an OC-48 circuit pack.
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........................................................................................................................................................................................................................

12 Verify transmission at the patch panel. There should be no alarms at the test set.

........................................................................................................................................................................................................................

13 Select Fault > Analysis > Loopback...

........................................................................................................................................................................................................................

14 Choose the correct port on the OC-48 CP and click Select.

........................................................................................................................................................................................................................

15 Click on Release.

........................................................................................................................................................................................................................

16 Click Apply.

........................................................................................................................................................................................................................

17 Verify loss of transmission at the patch panel. This should be evident by a SONET alarm 
and a loss of pattern alarm.

........................................................................................................................................................................................................................

18 Repeat this section for all OC-48 ports.

........................................................................................................................................................................................................................

19 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

LED test

Description

This test verifies proper operation of all LEDs on the Alcatel-Lucent 1665 DMX circuit 
packs. Operation of all the LEDs is necessary to assist in trouble isolation.

Note: If there are any LED failures, determine if the problem is with the circuit pack 
or shelf and replace the faulty unit.

Note: If the shelf is not fully equipped, move circuit packs around and repeat the test 
for all valid circuit pack positions.
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LED test procedure

........................................................................................................................................................................................................................

1 Select Fault > Test > LED...

........................................................................................................................................................................................................................

2 Choose shelf (Alcatel-Lucent 1665 DMX).

........................................................................................................................................................................................................................

3 Click Select.

........................................................................................................................................................................................................................

4 Choose Number of Iterations: 1.

........................................................................................................................................................................................................................

5 Click OK.

Result: All LEDs on the shelf should light for 10 seconds, then extinguish for 10 
seconds, and then the proper LEDs will light to indicate the current status of the shelf.

........................................................................................................................................................................................................................

6 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Additional optical tests (optional)

Low-speed optical testing

The following procedure is provided for installers wishing to further test the low-speed 
optical packs using an optical test set. Perform the following steps for all Alcatel-Lucent 
1665 DMX shelf Function unit or Growth slots. DCC will be disabled in order to prevent 
DCC alarms from being generated due to the optical loopback.

To test this procedure an optical test set is required as well as a 1x2 optical splitter.

NOTICE

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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Note: When reference is made to optical fiber loopback connections to IN and OUT 
on the High-Speed OLIU, make the connections at the LGX equipment in order to 
verify correct installation and labeling of the fibers.

The high-speed packs (OC-12, OC-48 or OC-192) should still be looped back on 
themselves and the dcc disabled to prevent dcc alarms. The dcc can be verified with 
the View > DCC GUI command. If the high speed packs are no longer looped back, 
do so at the LGX panel. The dcc should also be disabled at the function unit slot under 
test since it will be connected to a test set and will register alarms. The dcc can be 
provisioned with the Provision > DCC Terminations GUI command. Change the dcc 
on M2 and the FN slots by using the same command and double clicking on the m1 
and selecting m2 or selecting the FN a-g slot.

The OC-48 Optical Packs including the High-Speed OLIUs should be attenuated with 
15-dB LBOs. If using OC-192 in the high-speed slots, attenuate with 5 dB. LBOs are 
installed on the OLIU faceplate IN port. 

Steps

Log in to the Alcatel-Lucent 1665 DMX shelf and verify that there are no existing alarms 
by viewing the Alarm List. 

........................................................................................................................................................................................................................

1 Starting at Function Slot A, insert the optical packs to be tested in Slot A-1 and A-2. Both 
packs must be of the same type, otherwise a circuit pack not allowed alarm will be 
displayed.

Note: If using VLF mains, some applications are allowed where the circuit packs in 
a function group are not the same type. See the Alcatel-Lucent 1665 Data Multiplexer 
(DMX) Applications and Planning Guide, 365-372-300.

........................................................................................................................................................................................................................

2 At the LS LGX Bay, measure the TX output level of all Ports on all OC-3, OC-12 and OC-
48 low-speed cards. Ensure the transmit level conforms to Chapter 1, “Alcatel-Lucent 
1665 DMX optical specifications”. If the levels are not within specification, check the 
levels at the Alcatel-Lucent 1665 DMX. If levels are not within specification at the 
Alcatel-Lucent 1665 DMX, replace the pack with a spare and return the suspect pack back 
through the RMA process. If levels meet specifications, check the fiber to the LGX panel 
for continuity. 

........................................................................................................................................................................................................................

3 Ensure that the optical packs to be tested have 15-dB attenuators inserted to the IN port of 
the port under test. Failing to insert attenuators may overdrive the circuitry and cause 
permanent damage to the circuit packs. Start testing in Port 1.
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........................................................................................................................................................................................................................

4 Connect the optical test set using the 1 x 2 optical splitter. The TX of the test set is 
connected to the LGX ports corresponding to the RX of both FN-1 and FN-2 of the 
function slots under test. The LGX port corresponding to the TX of the port under test of 
FN-1 (active slot) is connected to the RX of the test set. (Some test sets require an 
attenuation of at least 10dB on the RX side). Reference Figure 6-1, “Optical test set 
arrangement” (p. 6-54).

Figure 6-1 Optical test set arrangement

........................................................................................................................................................................................................................

5 Set the test set to the required rate for the packs under test. See Table 6-4, Transmission 
rate.

Table 6-4 Transmission rate

........................................................................................................................................................................................................................

6 Once the test set is in place, it will display pattern and AIS alarms. This is due to the fact 
that we have not established a cross-connection. Enter a cross-connection either through 
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the GUI using the cross-connect wizard. Enter the command according to the optical pack 
and function slot under test.

........................................................................................................................................................................................................................

7 Check the transmission at the test set. It should show no alarms. If alarms are present, 
check the test set provisioning and the cross-connection to ensure they correspond to the 
pack under test. Make any adjustments necessary, and do not continue the test until 
transmission is good.

........................................................................................................................................................................................................................

8 Check that the pack in FN-1 is the active pack with the GUI command View > Protection 
and selecting the associated pack. 

If slot 1 is the active slot continue with testing, if slot 2 is active and slot 1 is standby, 
reseat the pack in slot 2, switching the active path to slot 1.

........................................................................................................................................................................................................................

9 At the LS LGX Bay, move the Test Set RX cable to the Standby TX Port, see Figure 6-2. 
Examine the test traffic received by the test set. Look for errors or any other signal 
information that the test set is capable of indicating. The Standby OCN card should be 
running without errors.

Figure 6-2 Optical test arrangement RX fiber moved

........................................................................................................................................................................................................................

10 Remove the Test Set TX cable from the Active OCN Card in FN-1. This will result in an 
Active to Standby OCN card switch. Verify that the traffic switched to the current Active 
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OCN card FN-2, and that there is a LOS alarm issued against the current Standby OCN 
card FN-1. Retrieving the alarms can be accomplished by selecting the Alarm List button 
on the top right of the GUI.

Note: The test set will indicate that there was a transmission hit indicating the 
switch, but should clear and show good transmission.

........................................................................................................................................................................................................................

11 Return the Test Set TX Cable to normal operation and ensure that the LOS alarm clears.

........................................................................................................................................................................................................................

12 Delete any cross-connects through the GUI Cross-Connection Wizard.

........................................................................................................................................................................................................................

13 Select Configuration > Update System... > Update All.

........................................................................................................................................................................................................................

14 Repeat this test on all OCN ports for all optical packs which will reside in the shelf.

........................................................................................................................................................................................................................

15 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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7 Operational tests

Overview

Purpose

This section provides instructions to test protection switching and the non-transmission 
cabling for the Alcatel-Lucent 1665 Data Multiplexer (Alcatel-Lucent 1665 DMX). This 
section is not intended to replace acceptance test procedures. If problems are encountered, 
see Alcatel-Lucent 1665 Data Multiplexer (DMX) Alarm Messages and Trouble Clearing 
Guide, 365-372-302 for detailed troubleshooting procedures.

Contents

This chapter provides information on the following topics

Tools, test equipment and accessories

The tools, test equipment and accessories necessary to perform the procedures in this 
section are listed in “Tools, test equipment, and accessories” (p. II-2).

Tools, test equipment and accessories 7-1

Office alarm test 7-2

Automatic protection switching and alarm test 7-6

Manual switching tests 7-9

External timing verification 7-10

Miscellaneous (environmental) discrete telemetry test 7-14

Modem connection test 7-17

Final operations 7-19
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Safety instructions

Note: All precautions should be observed when handling fiber. 

Unterminated optical connectors may emit laser radiation. Do not view beam with 
optical instruments.

Office alarm test

Description

This test verifies proper operation and wiring of the office alarms.

Audible and visual reporting of critical, major, minor alarms will be verified.

Prerequisite

The following is a list of items to verify before beginning tests in this section.

• The Alcatel-Lucent 1665 DMX Main OLIUs should be optically looped from the 
previous section. Verify that the Alcatel-Lucent 1665 DMX shelf is clear of all alarms 
(only green LEDs are lighted) prior to and after completing this test.

• The office alarm cable will be temporarily connected during this procedure. Table 7-1, 
“Office alarm connections” (p. 7-3) lists the office alarm connections.

• It is a requirement that alarms on the Alcatel-Lucent 1665 DMX do not affect and are 
not affected by other equipment via office alarm connections. During this test, the 
alarm state of other equipment connected to the same office alarms as the Alcatel-
Lucent 1665 DMX should be examined after creating or clearing every alarm.

WARNING

Laser hazard

NOTICE

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.

NOTICE
The operational tests in this section are run only in an out-of-service mode of 
operation. Office alarms will normally be connected only during the office 
alarm test to prevent constant alarms throughout this section. 
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• A properly grounded ESD wrist strap must always be worn while handling circuit 
packs.

• This test should be performed on all shelves where office alarm reporting is required.

• After completing the office alarm test, the Alcatel-Lucent 1665 DMX office alarms 
should be disconnected from the office alarm system for the remainder of the test 
procedures. This will prevent the office alarms from being activated while performing 
the other tests in this section.

Table 7-1 Office alarm connections

Office alarm test procedure

................................................................................................................................................

1 Connect the office alarm cable to J12 (ALM) on the backplane of the Alcatel-Lucent 1665 
DMX shelf. If the shelf to be tested is part of a multiple shelf bay arrangement, the office 
alarm cable connects to shelf 1.

................................................................................................................................................

2 Verify that one of the function groups is equipped with a pair of LNW7/LNW8/LNW801 
DS1, LNW16/LNW19B DS3 or LNW18/LNW20 TMUX circuit packs.

................................................................................................................................................

3 Establish a CIT session by following the procedure under “Use of WaveStar® CIT 
software” (p. 5-6) in Chapter 5, “Software download and circuit pack installation”.

Conn.. Pin# Color Designation Name

J12-J13 1

2

3

4

BL-W

W-BL

O-W

W-O

RYMJV1

RYMJV2

RYMJA1

RYMJA2

Minor Alarm Visible

Minor Alarm Visible Return

Minor Alarm Audible

Minor Alarm Audible Return

5

6

7

8

G-W

W-G

BR-W

W-BR

RYMNV1

RYMNV2

RYMNA1

RYMNA2

Major Alarm Visible

Major Alarm Visible Return

Major Alarm Audible

Major Alarm Audible Return

9

10

11

12

S-W

W-S

BL-R

R-BL

RYCRV1

RYCRV2

RYCRA1

RYCRA2

Critical Alarm Visible

Critical Alarm Visible Return

Critical Alarm Audible

Critical Alarm Audible Return
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................................................................................................................................................

4 Select Configuration > Cross-Connections.

................................................................................................................................................

5 Use the Cross-Connection Wizard to enter a new cross-connection at the STS-1 rate, 
UPSR Ring Add/Drop, between m1-1-1 and fn1-1 (fn will be a,b,c or d depending on the 
slot where the DS1, DS3, or TMUX CP is located).

This command creates a cross-connection to map 28 DS1s of a DS1circuit pack or the first 
DS3 of a DS3/EC1 or TMUX circuit pack in a Function unit slot(s) to the first STS-1 of 
the Main OLIUs.

................................................................................................................................................

6 Select Configuration > Alarms > Alarm Severity Assignment Profile.

................................................................................................................................................

7 After screen appears, click the “+” next to ASAP Type System, Highlight DEFAULT and 
click the Provision Button.

................................................................................................................................................

8 After the screen on the right appears, click on the Alarm Level on the Power/Fuse 
Failure row and change the alarm severity to Major.

................................................................................................................................................

9 Click APPLY.

................................................................................................................................................

10 Unseat one of the LNW7/LNW8/LNW801, LNW16/LNW19B or LNW18/LNW20 circuit 
packs from the function group being used. 

Result: Activated office alarms: MN visual, MN audible.

Note: Alarms will not be activated until the alarm delay time has passed. The default 
time is 2 seconds. 

................................................................................................................................................

11 Press the ACO pushbutton on the SYSCTL.

Result: Activated office alarm: MN visual. 
The MN audible alarm clears.
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................................................................................................................................................

12 Using a small flat bladed screwdriver, set one of the circuit breakers to OFF.

Result: Activated office alarms: MJ visual, MJ audible.

................................................................................................................................................

13 Press the ACO pushbutton on the SYSCTL.

Result: Activated office alarm: MJ visual.
The MJ audible alarm should clear.

................................................................................................................................................

14 Unseat the second circuit pack from the same function group pair as the circuit pack 
removed in Step 10.

Result: Activated office alarms: CR visual, CR audible. 

................................................................................................................................................

15 Press the ACO pushbutton on the SYSCTL. 

Result: Activated office alarm: CR visual.
The CR audible alarm should clear.

................................................................................................................................................

16 Reseat the pair of function units.

................................................................................................................................................

17 Turn on the breaker that was turned off in Step 12.

Result: After a few minutes, all alarm indications should clear.

................................................................................................................................................

18 Disconnect the office alarm cable connected in Step 1 for the remainder of the test 
procedures in this chapter.

................................................................................................................................................

19 Select Configuration > Alarms > Alarm Severity Assignment Profile.

................................................................................................................................................

20 After screen appears, click the “+” next to ASAP Type System, Highlight DEFAULT and 
click the Provision Button.
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................................................................................................................................................

21 After the screen on the right appears, click on the Alarm Level on the Power/Fuse 
Failure row and change the alarm severity Default to Minor.

................................................................................................................................................

22 Click Apply, then Yes.

Note: Do NOT delete the cross-connect that was entered for this test.

................................................................................................................................................

23 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Automatic protection switching and alarm test

Description

This section provides the procedures for verifying the Alcatel-Lucent 1665 DMX shelf 
automatic protection switching.

Note the following:

• These tests do NOT simulate circuit pack failures.

• The tests will verify proper alarm reporting and LED indications when circuit 
packs are removed.

• All protected circuit packs will be tested. 

• A properly grounded wrist strap must always be worn while handling circuit 
packs. 

• This test is performed with the Alcatel-Lucent 1665 DMX shelf optically looped 
back on itself (that is, with the IN of the OLIU M1 looped to the OUT of the OLIU 
M1, and the IN of the OLIU M2 looped to the OUT of the OLIU M2). 

• Prior to performing each test, the shelf under test must be clear of all alarms (that 
is, only green LEDs are lit).
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A properly grounded ESD wrist strap MUST be worn when handling circuit packs.

Unterminated optical connectors may emit laser radiation. Do not view beam with 
optical instruments. 

Main OLIU switching test 

Use this procedure to test the following Main OLIU circuit packs in a UPSR (default) 
configuration:

OC-3

LNW82

OC-12

LNW48, LNW50, LNW54, LNW82, LNW203

OC-48

LNW27, LNW29, LNW32, LNW76, LNW82, LNW202, LNW504

OC-192

LNW56, LNW58, LNW59, LNW502, LNW504

It should be noted that switching tests for Function unit circuit packs were performed in 
the previous chapter.

NOTICE

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.

CAUTION

ESD hazard

WARNING

Laser hazard
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................................................................................................................................................

1 Establish a CIT session by following the procedure under “Use of WaveStar® CIT 
software” (p. 5-6) in Chapter 5, “Software download and circuit pack installation”. 

................................................................................................................................................

2 Select View > Cross-Connections.

................................................................................................................................................

3 Choose shelf (Alcatel-Lucent 1665 DMX) and click Select.

................................................................................................................................................

4 Verify that the cross-connection entered in the previous section is on the list. If the cross 
connect exist proceed to Step 7; otherwise, continue to establish a cross connection.

................................................................................................................................................

5 Select Configuration > Cross-Connections.

................................................................................................................................................

6 Use the Cross-Connection Wizard to enter a new cross-connection at the STS-1 rate, 
UPSR Ring Add/Drop, between m1-1-1 and fn1-1 (fn will be a,b,c or d depending on the 
slot where the DS1, DS3, or TMUX CP is located).

This command creates a cross-connection to map 28 DS1s of a DS1 circuit pack or the 
first DS3 of a DS3/EC1 or TMUX circuit pack in a Function unit slot(s) to the first STS-1 
of the Main OLIUs.

................................................................................................................................................

7 Select View > Protection.

................................................................................................................................................

8 Under Path Protection choose m-1-1.

................................................................................................................................................

9 Click Select.

................................................................................................................................................

10 Note the Active Path: (m1-1-1 or m2-1-1).

The M1 OLIU is associated with Ring 1 and the M2 OLIU is associated with Ring 2.

................................................................................................................................................

11 Disconnect the optical fiber connected to the IN port of the OLIU that is the active 
receiver.
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Result: The MN* and then NE alarm LED should light on the SYSCTL and the 
FAULT LED should flash on the OLIU.

................................................................................................................................................

12 Click Refresh in the View Protection window.

Result: The Active path has changed. (If m1-1-1 was active before, m2-1-1 is active 
now).

................................................................................................................................................

13 Reconnect the fiber at the OLIU.

Result: After a short time, the MN* and NE alarm LEDs on the SYSCTL and the 
FAULT LED on the OLIU should extinguish.

................................................................................................................................................

14 Repeat Step 10 through Step 13 to verify a switch back to the OLIU that was originally 
active.

................................................................................................................................................

15 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Manual switching tests

Description

This test will initiate switching commands from the CIT and verify proper switching and 
LED indications.

Main OLIU switching test

Note: An STS-1 cross-connect should still exist from the previous tests.

................................................................................................................................................

1 Select Fault > Protection Switch.

................................................................................................................................................

2 Under Path Protection choose Path m-1-1.

* Only if the ASAP has been set back to “Default”.
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................................................................................................................................................

3 Click Select.

................................................................................................................................................

4 Note the Active Path.
The M1 OLIU is associated with Ring 1 and the M2 OLIU is associated with Ring 2.

................................................................................................................................................

5 In the Switch Type: pull-down, choose Manual.

................................................................................................................................................

6 Click Apply, then Yes.

Requirement: The ring that was active in Step 4 is no longer active and the other ring 
is now active.

................................................................................................................................................

7 In the Switch Type pull-down, choose Clear.

................................................................................................................................................

8 Click Apply, then Yes.

................................................................................................................................................

9 Repeat Step 4 through Step 8 to verify a switch back to the original ring.

................................................................................................................................................

10 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

External timing verification

Description

This test should be performed if the Alcatel-Lucent 1665 DMX shelf is going to be 
externally timed. The shelf timing cable must be installed and connected between the 
Alcatel-Lucent 1665 DMX shelf and the office timing source (BITS clock) and the timing 
source must be active.
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Timing verification test procedure

................................................................................................................................................

1 Determine the frame format (SF or ESF) and line code (AMI or B8ZS) of the DS1 timing 
signals being generated by the timing source.

................................................................................................................................................

2 Select Configuration > Timing/Sync.

................................................................................................................................................

3 In the Timing Mode: pull-down, verify External Timing is displayed. If not choose 
External and click OK, Yes, Yes and select Configuration > Timing/Sync.

................................................................................................................................................

4 Click on the Timing Input Ports tab at the top of the window.

................................................................................................................................................

5 Enter the DS1 Input and Output Format: (SF or ESF) for REF-1 and REF-2.

................................................................................................................................................

6 Enter the DS1 Input Line Code: (AMI or B8ZS) for REF-1 and REF-2.

Note: During the installation test, ensure the Clock Mode Switching is provisioned 
to “Revertive”. Otherwise, the system will go into holdover during some of the 
following test. The Clock Mode Switching option is located on the System Timing 
tab.

................................................................................................................................................

7 Enter the SSM Support (Enabled or Disabled).

Note: SSM is only supported on VLF mains and ESF framed inputs.

................................................................................................................................................

8 Click OK.

................................................................................................................................................

9 Select View > Timing/Sync.

Result: 

• Correct line coding and frame format

• Provisioned and active timing mode are both external

• Both references are in service (IS)
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• Which of the two references is active.

Note: If a reference does not indicate IS, that input is not receiving a proper timing 
reference. Verify:

– Cabling between the timing source and the Alcatel-Lucent 1665 DMX shelf

– Correct line coding

– Correct frame format.

................................................................................................................................................

10 At the rear of the shelf (see Figure 7-1, “Alcatel-Lucent 1665 DMX shelf backplane” 
(p. 7-13), disconnect the input timing cable from the connector associated with the active 
reference.

Requirement: The MN LED lights on the SYSCTL and the FAULT LED flashes on 
the MAIN OLIU circuit pack associated with that reference (SYNC1 is associated 
with M1 and SYNC2 is associated with M2).
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Figure 7-1 Alcatel-Lucent 1665 DMX shelf backplane 

Note: Above is the Alcatel-Lucent 1665 DMX shelf, but it should be noted that the 
timing connections are the same for the Alcatel-Lucent 1665 DMX high-capacity 
shelf.

................................................................................................................................................

11 Click Refresh in the View Timing/Sync window.

Result: The other reference is now the active reference.

SYNC1
9 PIN PLUG
PIN #:

GRAY
JACKET

RED
JACKET

P

P

BL
W

W
BL

IN1-T
IN1-R

OUT1-T
OUT1-R

SEE ED8C871-10 FOR
CABLE ORDERING
INFORMATION

1
6

2
7

5 SHIELDS

GRAY
JACKET

5 SHIELDS

SYNC2
9 PIN PLUG
PIN #:

7
2

6
1

W
BL

P

RED
JACKET

BL
W

P

IN2-R
IN2-T

OUT2-R
OUT2-T

J17
MODEM

J23 D IN

-48VB
-48RTNB

J22 C IN

J14
SYNC2P15

J11
MISC

J21 B IN

-48VA
-48RTNA

J20 A IN

J9
SYNC1

J15
FAN P14

STANDARD DMX
OR

HIGH CAPACITY DMX (SHOWN)

MISCELLANEOUS DISCRETE
CONNECTOR (J11)
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................................................................................................................................................

12 Reconnect the timing cable at the rear of the shelf.

Requirement: The MN LED extinguishes on the SYSCTL and the FAULT LED on 
the OLIU stops flashing.

................................................................................................................................................

13 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Miscellaneous (environmental) discrete telemetry test

Description

Miscellaneous discrete telemetry access allows the maintenance center to control and 
monitor equipment co-located with the Alcatel-Lucent 1665 DMX shelf. Perform this 
procedure for shelves that are cabled for miscellaneous discrete telemetry.

Miscellaneous discrete telemetry test procedure

................................................................................................................................................

1 Determine which environmental inputs are to be monitored via the Alcatel-Lucent 1665 
DMX shelf.

................................................................................................................................................

2 Verify that the miscellaneous discrete cable is connected to the J11 MISC connector on the 
shelf. See Figure 7-1, “Alcatel-Lucent 1665 DMX shelf backplane” (p. 7-13).

................................................................................................................................................

3 See Table 7-2, “Miscellaneous (environmental) discrete telemetry connections” (p. 7-16) 
to determine the wire color of the cable lead associated with the environmental input to be 
tested.

................................................................................................................................................

4 At the far end of the cable, short the associated environmental input lead to the red-slate 
(R-S) Input Common lead.

................................................................................................................................................

5 Verify that the minor (MN) alarm lights on the SYSCTL.
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................................................................................................................................................

6 From the system view click Alarm List.

Result: Verify that the correct environmental alarm has been activated.

................................................................................................................................................

7 Remove the short and verify that the minor (MN) alarm indication on the SYSCTL clears.

................................................................................................................................................

8 Repeat Step 3 through Step 7 for each environmental input being used.

................................................................................................................................................

9 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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Figure 7-2 Miscellaneous (environmental) discrete functions 

Table 7-2 Miscellaneous (environmental) discrete telemetry connections

Conn. Pin# Color Designation Name

 J11 1

2

3

4

BL-W

W-BL

O-W

W-O

TLMI1

TLMI2

TLMI3

TLMI4

Env. Input - #1

Env. Input - #2

Env. Input - #3

Env. Input - #4

5

6

7

8

G-W

W-G

BR-W

W-BR

TLMI5

TLMI6

TLMI7

TLMI8

Env. Input - #5

Env. Input - #6

Env. Input - #7

Env. Input - #8

Env. Alarm/Status

Env. Input #19

Env. Input #2

Env. Input #1

2

1

20

Water, Fire, etc.)
High Temp, High

Inputs (Open Door,

Remote Terminal

Input Common

19

Env. Output #3

Env. Output #2

Env. Output #1

Pump, etc.
Generator,

25

24

23

22

21

Env. Output #4

J11

Output Common

To
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Modem connection test

Description

This test will verify proper modem connection to the Alcatel-Lucent 1665 DMX shelf.

This test should only be performed if a modem is required.

Modem connection test procedure

................................................................................................................................................

1 Verify the generic parameters of the modem are set to the following:

Modem parameters

• 1200, 2400, 4800, 9600, or 19,200 baud 

• Full duplex

9

10

11

12

S-W

W-S

BL-R

R-BL

TLMI9

TLMI10

TLMI11

TLMI12

Env. Input - #9

Env. Input - #10

Env. Input - #11

Env. Input - #12

13

14

15

16

O-R

R-O

G-R

R-G

TLMI13

TLMI14

TLMI15

TLMI16

Env. Input - #13

Env. Input - #14

env-15 fan shelf failed

Env. Input - #16

17

18

19

20

BR-R

R-BR

S-R

R-S

TLMI17

TLMI18

TLMI19

TLMIC48VT
RN

Env. Input - #17

Env. Input - #18

Env. Input - #19

Input Common

21

22

23

24

25

BL-BK

BK-BL

O-BK

BK-O

G-BK

TLMO1

TLMO2

TLMO3

TLMO4

TLMOC

Env. Output - #1

Env. Output - #2

Env. Output - #3

Env. Output - #4

Output Common

Conn. Pin# Color Designation Name



........................................................................................................................................................................
7-18 Alcatel-Lucent 1665 DMX R9.0

365-372-304R9.0 Issue 2
July 2010

........................................................................................................................................................................

Modem connection testOperational tests

• 8 data bits

• No parity bits

• 1 start bit

• 1 stop bit

• No flow control

• Transparent data mode - ON

• Direct operating mode - ON

Note: Modems supporting a large set of options and error detection capabilities may 
require other options be set before using the modems to download generic software. 
See manufacture’s manuals for instructions on setting modem parameters.

................................................................................................................................................

2 Verify that the modem cable is properly connected from the modem to J17 (MODEM) on 
the backplane of the Alcatel-Lucent 1665 DMX shelf.

................................................................................................................................................

3 Verify that the modem is connected to the phone line.

................................................................................................................................................

4 Select Administration > Data Communications.

................................................................................................................................................

5 Click the Serial Port tab.

................................................................................................................................................

6 Choose CIT Port: cit-2.

................................................................................................................................................

7 Choose Baud Rate: to match the modem being connected.

................................................................................................................................................

8 Dial into the modem using an application such as HyperTerminal from a PC with a 
modem configured to similar parameters.

................................................................................................................................................

9 After a connection is established, press the enter key.

Result: /* SYSTEM TID: LT-DMX */
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................................................................................................................................................

10 Enter the command:

act-user:LT-DMX:LUC01:ctag::DMX2.5G10G;

Result: A message indicating that the command completed will be displayed along 
with the Alcatel-Lucent disclosure.

................................................................................................................................................

11 Enter the command:

canc-user:LT-DMX:LUC01:ctag;

Result: A message indicating that the command completed will be displayed.

................................................................................................................................................

12 Disconnect the HyperTerminal session.

................................................................................................................................................

13 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Final operations

Description

The following procedure ensures that all test signals and cross-connects have been 
removed and the Alcatel-Lucent 1665 DMX shelf is alarm free and ready for network 
connection procedures.

Steps

................................................................................................................................................

1 Select Configuration > Cross-Connections.

................................................................................................................................................

2 Choose Delete leg(s) of an existing cross-connection.

................................................................................................................................................

3 Click Next and continue with the Cross-Connection Wizard to delete the cross-
connections associated with CP main-1, Port 1.
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................................................................................................................................................

4 To verify that all cross-connections are deleted, select View> Cross-Connections.

................................................................................................................................................

5 Choose shelf (Alcatel-Lucent 1665 DMX) and click select.

................................................................................................................................................

6 Verify that no alarm LEDs are lit and no FAULT LED is lit on any circuit pack.

If any alarm is present, see Alcatel-Lucent 1665 Data Multiplexer (DMX) Alarm 
Messages and Trouble Clearing Guide, 365-372-302.

................................................................................................................................................

7 If desired, reconnect the office alarm cable at this time.

................................................................................................................................................

8 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S



I I I-1Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

............................................................................................................................................................................................................................................................

Part III:  Network turn-up and 
testing

Overview

Purpose

This section starts the process of integrating the Alcatel-Lucent 1665 Data Multiplexer 
(Alcatel-Lucent 1665 DMX) into the customer’s network. The section provides the 
procedures to connect inter-office fibers and verify DCC communications and path 
switching. The section is broken down into two areas, Ring (UPSR/BLSR) setup and 
WDMX. If the network is engineered as a ring, proceed to Chapter 6, there is no need to 
procedure to the WDMX chapter. If the network consists of a ring integrated into the 
WDMX application, then proceed to “WDMX setup and testing: integration procedures” 
(p. 9-1).

Contents

This section is organized into the following chapters:

Chapter 8, “OC-3/12/48 ring setup and testing: integration procedures”

Chapter 9, “WDMX setup and testing: integration procedures”
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OverviewNetwork turn-up and testing
III

Tools, test equipment, and accessories

This section lists the tools, test equipment and accessories needed to perform all the 
procedures in this installation manual.

Listed below are the required tools, test equipment and accessories.

Quantity Description Comments

Screwdriver(s) A screwdriver(s) with the appropriate head(s) is (are) 
required for securing the mounting screws, repositioning 
the mounting brackets, installing the interfacing cables, 
and for setting the circuit breakers to the OFF position.

1 ESD Wrist Strap A wrist strap must be worn when handling circuit packs. 
Use the electrostatic discharge (ESD) jack provided on the 
shelf.

1 Multimeter 
(Optional)

The voltmeter must be capable of measuring DC voltage 
in the 40 to 60 volt range. The use of the voltmeter is 
optional since the shelf will alarm or shut down if the 
proper voltage is not supplied.

1 DS1 Error Rate Test 
Set

A DS1 error rate test set is required for testing of DS1 
cabling. A T-BERD 211 or equivalent is recommended.

1 DS3 Error Rate Test 
Set

A DS3 error rate test set is required for testing of DS3 
cabling. A T-BERD 305 or equivalent is recommended.

1 SONET Optical Test 
Set

An OC-3, OC-12, or OC-48 test set is required for testing 
of optical circuit packs. An Agilent OmniBER 718 or 
equivalent is recommended.

1 Optical Power Meter An optical power meter capable of measuring optical 
levels from +5.0 dBm to -30.0 dBm. The meter should 
also have adapters for LC type connectors and any other 
connectors used in the office.

2 or 3 LC-type Optical 
Fiber Jumper 
(108918269)

Two optical fiber jumpers with LC type connectors are 
required to optically loop the Alcatel-Lucent 1665 DMX 
shelf for test purposes.

2 15 dB LC-type LBO 
(108279480)

Two 15-dB LBOs are required when optically looping the 
Alcatel-Lucent 1665 DMX shelf for test purposes.

1 Personal Computer 
(PC)

See Chapter 5, “Software download and circuit pack 
installation”, “PC minimum requirements” (p. 5-2).

1 CIT Interface Cable 8-ft. long RJ45 to 9-pin D-sub serial cable (Comcode 
848748869).
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8 OC-3/12/48 ring setup 
and testing: integration 
procedures

Overview

Purpose

This procedure is used to make fiber connections between Alcatel-Lucent 1665 Data 
Multiplexer (Alcatel-Lucent 1665 DMX) nodes in a ring. It is not intended to replace 
acceptance test procedures. If problems are encountered, see Alcatel-Lucent 1665 Data 
Multiplexer (DMX) Alarm Messages and Trouble Clearing Guide, 365-372-302 for 
detailed troubleshooting procedures.

If additional provisioning procedures are desired, see Alcatel-Lucent 1665 Data 
Multiplexer (DMX) User Operations Guide, 365-372-301.

Contents

This chapter provides information on the following topics

Tools, test equipment and accessories

The tools, test equipment and accessories necessary to perform the procedures in this 
section are listed in Tools, test equipment, and accessories (p. III-2).

Tools, test equipment and accessories 8-1

Fiber installation 8-2

Optical transmission test (OC-192, OC-48, OC-12) 8-9

Automatic protection switching test 8-10

Manual switching tests 8-12

Final operations 8-14
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Safety instructions

Note: All precautions should be observed when handling fiber. 

Unterminated optical connectors may emit laser radiation. Do not view beam with 
optical instruments.

Fiber installation

Description

This section is used to verify proper fiber connections between Alcatel-Lucent 1665 DMX 
nodes.

Prerequisite

The following is a list of items to verify before beginning tests in this section.

• Two people are required to perform the end-to-end turn up in this section (one at each 
adjacent node).

• The Alcatel-Lucent 1665 DMX Main OLIUs should be optically looped from the 
previous section. Verify that the Alcatel-Lucent 1665 DMX shelf is clear of all alarms 
(only green LEDs are lighted) prior to and after completing this test.

• CIT is still connected to the Alcatel-Lucent 1665 DMX.

• The office alarm cable will remain disconnected during this procedure.

A properly grounded ESD wrist strap MUST be worn when handling circuit packs.

WARNING

Laser hazard

NOTICE
The operational tests in this section are run only in an out-of-service mode of 
operation. Office alarms will normally be connected only during the office 
alarm test to prevent constant alarms throughout this section.

CAUTION

ESD hazard
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Unterminated optical connectors may emit laser radiation. Do not view beam with 
optical instruments. 

Note: If the transmit pluggable tranmission module is failed and transmitting an 
invalid signal during installation, no alarms are reported since the receive port at the 
opposite end of the span has not transitioned from AUTO to IS, even though the 
measured receive power is within acceptable levels. 
The failed transmit pluggable transmission module appears as an LOS to the receive 
pluggable transmission module causing the port state to remain AUTO. 
If the receive pluggable transmission module is receiving a signal within acceptable 
levels but does not transition from AUTO to IS, replace the transmit pluggable 
transmission module at the opposite end of the span.

WARNING

Laser hazard

NOTICE

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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Fiber installation procedure 

The following procedures are performed at each end of the optical span being tested.

................................................................................................................................................

1 Verify that the office alarm cable to J12 (ALM) on the backplane of the Alcatel-Lucent 
1665 DMX shelf is disconnected. If the shelf to be tested is part of a multiple shelf bay 
arrangement, the office alarm cable connects to shelf 1.

................................................................................................................................................

2 Enter the shelf TID per the customer order or set TIDs to LT-DMX-1 and LT-DMX-2, etc.

................................................................................................................................................

3 Enable Remote NE Status and Alarm Gateway (AGNE) at LT-DMX-1 only. Select 
Administration > Set NE...

................................................................................................................................................

4 Enable Remote NE Status at the far end node. Select Administration > Set NE...

................................................................................................................................................

5 Dress optical cables in the fiber tray at the bottom front of the shelf. 

Note: We recomment that the fibers be dressed by alternating the use of the front and 
back sections of the fiber tray.The fibers coming from slots A1 and D2 should just be 
dressed out the opening and not in the fiber tray. The packs in slots A2 and D1 should 
be dressed in the front tray and then alternate the next packs (moving to the center of 
the shelf ) to the back section of the fiber tray. 

................................................................................................................................................

6 Route the optical jumpers from the bottom of the shelf.

................................................................................................................................................

7 Establish communications with the technician at the other end of the optical span.

................................................................................................................................................

8 At both ends of the optical span, remove protective covers from receive and transmit 
optical jumper cables and clean LC connectors.

Note: The Alcatel-Lucent 1665 DMX OLIUs require single-mode lightguide cable. 
It may take from 15 seconds to 3.5 minutes for the FAULT LEDs to stop flashing after 
the cables are connected, depending on the setting of the signal degrade threshold.
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................................................................................................................................................

9 At both ends of the optical span, ensure that only the dual LC adapter is installed on the 
OLIU (no LBO).

Note: For Alcatel-Lucent 1665 DMX ring configurations, optical fibers extend in 
two different directions to make up the ring. At each shelf (node) in the ring, the M1 
OLIU will connect to the M2 OLIU in one adjacent node, and the M2 OLIU will 
connect to the M1 OLIU in the other adjacent node. Likewise, when the Alcatel-
Lucent 1665 DMX is interfacing with another Alcatel-Lucent 1665 DMX at low-
speeds (OC-3, OC-12 or OC-48) using 0x1S1 and 0x1S2 protection, the Function 
Group slot (A, B, C, D, or G) 1 will connect to Main 1 or Function/Growth slot 2 on 
the shelf the Alcatel-Lucent 1665 DMX is being connected to. The Function Group 
slot (A, B, C, D, or G) 2 will connect to Main 2 or Function/Growth slot 1.

................................................................................................................................................

10 At each end of the optical span, connect the optical fiber transmit cables to the OLIU OUT 
connectors.

................................................................................................................................................

11 At each end of the optical span, measure the optical power of the optical fiber receive 
cables using an optical power meter.

................................................................................................................................................

12 Determine the LBO value required based on the received optical power measurement. See 
the following table.

Table 8-1 Attenuation Table

Optics Circuit Pack
Received Power 
(dBM) LBO (dB)

OC-48 (High 
Speed)

LNW27

LNW29

LNW32

+3.0 to -9.0

-9.0 to -29.0

15

 0

LNW76 -3.0 to -18.0 0

Low-Speed 
Optics (OC-3, 
OC-12, OC-48)

LNW31 (OC-48) 0.0 to -18.0 0
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Table 8-2 Attenuation table (Pluggable Transmission Modules)

OC-12 (high 
speed)

LNW48 -8.0 to -28.0  0

LNW50 +2.0 to -7.0 10

-7.0 to -30.5  0

LNW54 +2.0 to -7.0 10

-7.0 to -29.0 0

OC-192 (high 
speed)

LNW56 +2.0 to -1.0 5

-1.0 to -14.0 0

LNW58 -1.0 to -11.0 0

SFP/XFP optics Circuit Pack
Received 
Power (dBM) LBO (dB)

S15512 LNW37, LNW45, 
LNW55, LNW82, 
LNW705

-8.0 to -23.0 0

OC-3 IR1-I1 LNW37, LNW45, 
LNW55, LNW82, 
LNW705

-8.0 to -28.0 0

OC-3 LR1-I1 LNW37, LNW45, 
LNW55, LNW82, 
LNW705

0.0 to -5.0 15

-5.0 to -10 10

-10 to -34.0 0

OC-12 IR1-I1 LNW49, LNW55, 
LNW82, LNW705

-8.0 to -28.0 0

OC-12 LR1-I1 LNW49, LNW55, 
LNW82, LNW705

+2.0 to -5.0 15

-5.0 to -15 10

-15 to -28.0 0

OC-12 LR2-I1 LNW49, LNW55, 
LNW82

+2.0 to -5.0 15

-5.0 to -15 10

-15 to -28.0 0

Optics Circuit Pack
Received Power 
(dBM) LBO (dB)
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OC3/12 LR-2 
S622C47-61 EL

LNW37, LNW45, 
LNW49, LNW55, 
LNW82, LNW705

-8.0 to -28.0 15

OC-48 SR-I1 LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

-3.0 to -18.0 0

OC-48 LR-I1 LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

+3.0 to -5.0 15

-5.0 to -10.0 10

-10.0 to -15.0 5

-15.0 to -27.0 0

OC-48 LR2-I1 LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

+3.0 to -5.0 15

-5.0 to -10.0 10

-10.0 to -15.0 5

-15.0 to -27.0 0

S2DxxC6 series LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

+3.0 to -5.0 15

-5.0 to -10.0 10

-10.0 to -15.0 5

-15.0 to -27.0 0

OC192SR1-C1 LNW59, LNW502 -1.0 to -11 0

OC192IR2-C1 LNW59, LNW502 +2.0 to -1.0 5

-1.0 to -14 0

OC192LR2-C1 LNW59, LNW502 +4.0 to 0.0 15

0.0 to -7.0 10

-7.0 to -24.0 0

X10GxxC5* 
series

LNW59, LNW502, 
LNW705 

-8.0 to -24 15

Notes:
* LNW705 only uses X10G31C5-X10G59C5

SFP/XFP optics Circuit Pack
Received 
Power (dBM) LBO (dB)
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................................................................................................................................................

13 Select the proper LBO based on the value required and the comcode as listed below.

................................................................................................................................................

14 Clean LC LBOs and install LBO assemblies in the OLIU IN connector.

................................................................................................................................................

15 At the far end, connect the input optical fiber to the proper OLIU IN connector.

Requirement: The FAULT LED on the OLIU extinguishes.

................................................................................................................................................

16 At the near end, connect the input optical fiber to the proper OLIU IN connector.

Requirement: The FAULT LED on the OLIU extinguishes.

................................................................................................................................................

17 Disconnect the fiber cable from the OUT connector on the OLIU at one end of the span. 
At the other end, verify that the associated FAULT LED is flashing, indicating a loss of 
signal. Reconnect the fiber and repeat the process for the other direction of transmission.

................................................................................................................................................

18 Enable communications with the adjacent Alcatel-Lucent 1665 DMX nodes. 
Configuration > DCC Terminations...

................................................................................................................................................

19 Select Port AID: dcc-m1-1, OSI Over DCC: enabled, LAPD Role: user-side.

................................................................................................................................................

20 Select Port AID: dcc-m2-1, OSI Over DCC: enabled, LAPD Role: network-side.

................................................................................................................................................

21 Set the timing to internal (free running) at LT-DMX-1 and line time LT-DMX-2. 
Configuration > Timing/Sync... Timing Mode: Free Running.

Code Comcode Loss (dB)

ABLCS-05.0 108279381 5

ABLCS-10.0 108279431 10

ABLCS-15.0 108279480 15

ABLCS-20.0 108279530 20



........................................................................................................................................................................
Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

8-9

........................................................................................................................................................................

Optical transmission test (OC-192, OC-48, OC-12)OC-3/12/48 ring setup and testing: integration 
procedures

................................................................................................................................................

22 Verify proper communications with the adjacent Alcatel-Lucent 1665 DMX nodes. 
Administration>OSI Neighbor Map.

Result: The adjacent node appears in the neighbor list.

................................................................................................................................................

23 Perform steps in this procedure on all adjacent nodes in the ring.

................................................................................................................................................

24 After all connections and tests have been made, verify optical fiber cables are placed in 
fiber tray and properly routed in bay framework.

................................................................................................................................................

25 Reconnect the office alarm cable disconnected in Step 1.

................................................................................................................................................

26 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Optical transmission test (OC-192, OC-48, OC-12)

Overview

The following test verifies error-free transmission between nodes.

Transmission test procedure

................................................................................................................................................

1 At the test location, select Performance > View PM Reports > OCn Section...

................................................................................................................................................

2 Choose CP main-1, Port 1

................................................................................................................................................

3 Click Select.

................................................................................................................................................

4 Select Time Period: 15-Min, Monitored Date: Current Date and Monitor Level: 0 UP.
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................................................................................................................................................

5 Click Select All to move all Available Parameters to the Selected Parameters column.

................................................................................................................................................

6 Click Apply.

Result: The Response Window indicates no transmission errors.

................................................................................................................................................

7 Repeat Step 1 through Step 6 substituting CP main-2 in Step 2.

................................................................................................................................................

8 Repeat Step 1 through Step 7 for all Alcatel-Lucent 1665 DMX shelves at the test 
location.

................................................................................................................................................

9 Repeat Step 1 and Step 8 for each node in the ring.

................................................................................................................................................

10 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Automatic protection switching test

Description

This section provides the procedures for verifying the Alcatel-Lucent 1665 DMX shelf 
automatic and manual protection switching.

Note the following:

• These tests do NOT simulate circuit pack failures.

• A properly grounded wrist strap must always be worn while handling circuit packs.

• Prior to performing each test, the shelf under test must be clear of all alarms (that is, 
only green LEDs are lighted).
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 Main OLIU switch test

................................................................................................................................................

1 In order to perform path switching, an add/drop cross-connection must be entered. Select 
Configuration > Cross-Connections... and use the Cross-Connection Wizard to enter an 
add/drop cross-connection.

................................................................................................................................................

2 Select View > Protection...

................................................................................................................................................

3 Under Path Protection choose Path m-1-1 and click Select.

................................................................................................................................................

4 Note the Active Path (m1 or m2).

................................................................................................................................................

5 Disconnect the optical fiber connected to the IN port on the active path OLIU.

Result: The MN and then MJ alarm LED should light on the SYSCTL and the FAULT 
LED should flash on the OLIU.

................................................................................................................................................

6 Click Refresh in the View Protection window.

................................................................................................................................................

7 Verify the Active Path has changed (from m1 to m2 or m2 to m1).

................................................................................................................................................

8 Reconnect the optical fiber to the OLIU. 

Result: After a short time, the MJ alarm LED on the SYSCTL and the FAULT LED on 
the OLIU should extinguish.

................................................................................................................................................

9 Repeat Step 2 through Step 8 to verify a switch back to the OLIU that was originally 
active.

................................................................................................................................................

10 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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Manual switching tests

Description

This test will initiate switching commands from the CIT and verify proper switching and 
LED indications.

Note: An STS-1 cross-connect is required in order to perform manual switching.

Manual switching test procedure

................................................................................................................................................

1 Enter an STS-1 add/drop cross-connection between an equipped Function unit and the 
Main OLIU. Select Configuration > Cross-Connections... and use the Cross-Connection 
Wizard to enter an add/drop cross-connection.

................................................................................................................................................

2 Select Fault > Protection Switch...

................................................................................................................................................

3 Under Path Protection choose Path m-1-1 and click Select.

................................................................................................................................................

4 Note the Active Path (m1 or m2).

................................................................................................................................................

5 Choose Switch Type: Manual.

................................................................................................................................................

6 Click Apply.

................................................................................................................................................

7 Verify that the Active Path: has changed (m1 to m2 or m2 to m1).

................................................................................................................................................

8 Repeat Step 2 through Step 7 to verify a switch back to the original ring.

................................................................................................................................................

9 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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Function units/growth slots, switching test

This test will initiate switching commands from the CIT and verify proper switching and 
LED indications.

Note: This procedure should be performed on each Function unit equipped with 
protected electrical TDM circuit packs. 

................................................................................................................................................

1 Select Fault > Protection Switch...

................................................................................................................................................

2 Click on 1+1 Equip fn-x (x is a,b,c or d corresponding to the function group equipped).

................................................................................................................................................

3 Click Select.

................................................................................................................................................

4 Note which Function unit or Growth Slot circuit pack is the active circuit pack.

................................................................................................................................................

5 In the Switch Type: pull-down, select Manual (Normal).

................................................................................................................................................

6 Click Apply.

Result: The pack that was active should now be the standby pack and the pack that 
was standby is now active. Transmission should take a momentary hit as it is switched 
to the other pack. This information should agree with the ACTIVE LEDs on the circuit 
packs.

................................................................................................................................................

7 Repeat Step 1 through Step 6 to verify a switch back to the original Function unit circuit 
pack, with the same results as the previous step.

................................................................................................................................................

8 Repeat this procedure for each Function unit pair.

................................................................................................................................................

9 Swap circuit packs from another function group to test any unequipped function slots.
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................................................................................................................................................

10 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Final operations

Description

The following procedure ensures that all test signals and cross-connects have been 
removed and the Alcatel-Lucent 1665 DMX shelf is alarm free and ready for network 
connection procedures.

Steps

................................................................................................................................................

1 Select Configuration > Cross-Connections...

................................................................................................................................................

2 Use the Cross-Connection Wizard to Delete leg(s) of an existing cross-connection 
associated with CP main-1, Port 1.

................................................................................................................................................

3 Select Configuration > Update System... > Update All.

................................................................................................................................................

4 Verify that no alarm LEDs are lit and no FAULT LED is lit on any circuit pack.

If any alarm is present, see Alcatel-Lucent 1665 Data Multiplexer (DMX) Alarm Messages 
and Trouble Clearing Guide, 365-372-302.

................................................................................................................................................

5 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Clear PM registers

The following steps will clear all the performance monitoring registers:

................................................................................................................................................

1 Select Performance > Initiate PM Registers > Both.
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................................................................................................................................................

2 If desired, reconnect the office alarm cable at this time.

................................................................................................................................................

3 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S
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9 WDMX setup and testing: 
integration procedures

Overview

Purpose

This chapter is used to verify WDMX connectivity between Alcatel-Lucent 1665 Data 
Multiplexer (Alcatel-Lucent 1665 DMX) nodes. The chapter includes the LNW785 8 
channel Optical Multiplexer Demultiplexer (OMD) and the LNW705 XM10G/8 
Muxponder circuit packs. It is not intended to replace acceptance test procedures.

The testing performed in this procedure uses an OC-48 test set. If the OC48 PTM and test 
sets are unavailable, other rates or signals can be substituted, i.e OC-3/-12 or GigE. If 
additional provisioning procedures are desired, see Alcatel-Lucent 1665 Data Multiplexer 
(DMX) User Operations Guide, 365-372-301 and 3Alcatel-Lucent 1665 Data Multiplexer 
(DMX) Alarm Messages and Trouble Clearing Guide, 365-372-302 for detailed 
troubleshooting procedures.

Contents

This chapter provides information on the following topics:

Turn-up and test the LNW785 8-channel OMD  9-4

Turn up and test the LNW705 muxponder  9-7

Integrating the LNW705 into the LNW785  9-10

Connecting the ring (Mains) to the WDMX  9-12

Removing provisioning and equipage from the LNW705 and LNW785  9-16
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How to use this chapter

All of the sections in this chapter are stand alone procedures and are not intended to be 
followed in any sequence. Locate the procedure in this chapter and follow the procedure 
based on the requirements of the turn-up. When one procedure relies on steps from 
another procedure or continues on with the next procedure, the link is provided in the 
procedure.

Tools, test equipment and accessories

The tools, test equipment and accessories necessary to perform the procedures in this 
section are listed in Tools, test equipment, and accessories (p. III-2).

Prerequisite

The following is a list of items to verify before beginning tests in this section.

• Two or more people are required to perform the end-to-end turn up in this section (one 
at each adjacent node).

• The office alarm cable will remain disconnected during this procedure.

Safety instructions

Note: All precautions should be observed when handling fiber. 

Unterminated optical connectors may emit laser radiation. Do not view beam with 
optical instruments.

A properly grounded ESD wrist strap MUST be worn when handling circuit packs.

WARNING

Laser hazard

NOTICE
The operational tests in this section are run only in an out-of-service mode of 
operation. Office alarms will normally be connected only during the office 
alarm test to prevent constant alarms throughout this section.

CAUTION

ESD hazard
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Unterminated optical connectors may emit laser radiation. Do not view beam with 
optical instruments. 

WARNING

Laser hazard

NOTICE

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.
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Turn-up and test the LNW785 8-channel OMD

Description

This section provides the procedure to provision and test an optical span using the 8-
channel OMD LNW785 circuit pack. The procedure requires an LNW785 at both ends of 
the span and that there is least one OC-192/10Gbps source at each end of the span. The 
source OC-192 could be an LNW502, LNW59, or an OC-192/10Gbps from a alien shelf 
but the source MUST be compatible with the wavelengths on the LNW785. The LNW502 
or LNW59 must be equipped with X10G52C5, X10G53C5, X10G54C5, or X10G55C5. If 
using an alien 10Gbps source, see Table 9-1, “Channel/port assignments” (p. 9-17) for the 
wavelengths specifications.

If the LNW705 is used as the test signal, proceed to “Turn up and test the LNW705 
muxponder” (p. 9-6)

................................................................................................................................................

1 Determine and document the test signal frequency.

................................................................................................................................................

2 Install the LNW785 into the Alcatel-Lucent 1665 DMX shelf by opening both faceplate 
latches and seating in the slot while closing the latches.

Note: The LNW785 can be installed in any Function/Growth slot. When the shelf is 
to be configured as an add/drop, it is recommended that the Growth slots are not used 
because the passthrough fibers would have to route over the SYSCTL.If the Main slots 
are not equipped with VLF mains (LNW59, LNW82, LNW504), then the circuit packs 
in a Function/Growth slot must be the same type. 

................................................................................................................................................

3 Login to the Alcatel-Lucent 1665 DMX using the WaveStar® CIT.

................................................................................................................................................

4 Create OCH Cross-connections
Select Configuration > OCH Cross-connections from the System View

................................................................................................................................................

5 Select the Create a new OCH cross-connection radio button in the OCH Cross-
Connection Wizard. Click Next.
Click the 2-way Add/Drop radio button from the cross-connection list. Click Next.
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................................................................................................................................................

6 Click Select, then select REMAID and the port will appear on the right side of the screen, 
click on the Port to highlight it then click Select.

................................................................................................................................................

7 Click Select for the Add/Drop port, expand the circuit pack (OMD5/8) and click on the 
Port and the port will appear on the right side of the screen, click on the Port to highlight 
it then click Select.

Note: The port is determined by the test signal wavelength documented in Step 1.

................................................................................................................................................

8 Click Next, then Finish and complete the cross-connection by clicking on Yes in the 
confirmation window.

................................................................................................................................................

9 Connect fibers from Test port to selected channel on LNW785, while observing optical 
power requirements and cleaning procedures. See Table 1-2, “Alcatel-Lucent 1665 DMX 
optical circuit pack laser safety specifications” (p. 1-11) and Table 1-3, “Alcatel-Lucent 
1665 DMX optical PTM laser safety specifications” (p. 1-12) for Alcatel-Lucent 1665 
DMX optical power specifications.

Note: The LNW785 circuit pack has variable optical attenuators(VOAs) on the 
inputs for individual channel-power control. It can perform automatic channel power 
balancing of the add channels via the VOAs.

................................................................................................................................................

10 Repeat Step 2 to Step 9 at the remote Network Element.

................................................................................................................................................

11 Connect the Transmit fibers on the LNW785 at each end, following proper fiber cleaning 
procedures.

................................................................................................................................................

12 Connect the Receive fibers on the LNW785 at each end, while observing optical power 
requirements and cleaning procedures.

Result: Span is in-service

................................................................................................................................................

13 If adding a span in the other direction using the LNW785 repeat Step 1 through Step 12, 
otherwise continue.
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................................................................................................................................................

14 Perform end-to-end testing. Follow the end to end testing procedures determined by the 
input test signal. If the test signal is the Alcatel-Lucent 1665 DMX as part of a ring, 
proceed to Chapter 8, “OC-3/12/48 ring setup and testing: integration procedures” and 
locate the appropriate procedure.

................................................................................................................................................

15 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Turn up and test the LNW705 muxponder 

Description

The following procedure is a simple method of testing end to end continuity of the 
LNW705 Muxponder circuit. The test requires that a LNW705 is installed in two nodes 
and that there is fiber continuity between the two LNW705s. The fiber path could be a 
direct fiber connection, through a passive optics device, a LNW785 or through a DWDM 
like the Alcatel-Lucent 1695 EON system. In any case, the LNW705 link must be 
established. Once the end-to-end link has been established, an OC-3/OC-12/OC-48 test set 
and PTMs will be used to perform the end to end test.

Steps

This procedure provides the steps needed to equip and test the Alcatel-Lucent 1665 DMX 
with an LNW705. The steps include installing and equipping the LNW705 with the 10G 
and low speed PTMs, along with all the necessary provisioning.

................................................................................................................................................

1 Install the LNW705 into the Alcatel-Lucent 1665 DMX shelf by opening both faceplate 
latches and seating in the slot while closing the latches.

Note: The LNW705 can be installed in any Function/Growth slot. If the Main slots 
are not equipped with VLF mains (LNW59, LNW82, LNW504), then the circuit packs 
in a Function/Growth slot must be the same type.

................................................................................................................................................

2 Install the appropriate 10G PTM “Channel/port assignments” (p. 9-17) into Port 9.
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................................................................................................................................................

3 Install an OC-3/OC-12/OC-48 PTM in Port 1 of the LNW705 [see Appendix E, 
“Pluggable transmission modules (PTM)” (p. E-1)].

Note: The PTMs at both ends of the circuit must be the same rate.

For purposes of this document, the examples in the procedures below are equipped 
with an OC48 PTM. Any other signal listed in Appendix E, “Pluggable transmission 
modules (PTM)” (p. E-1) could be substituted, however use the guidelines set in 
Table 9-2, “XM10G/8 PTM port guidelines” (p. 9-18) for the port restrictions.

................................................................................................................................................

4 Login to the Alcatel-Lucent 1665 DMX using the WaveStar® CIT.

................................................................................................................................................

5 Provision the PTM/OTU-2
Select Configuration > Equipment from the System View

................................................................................................................................................

6 Click the “+” next to XM10G/8 circuit pack to expand the list.

................................................................................................................................................

7 Highlight the PTM sc9 and click Select.

................................................................................................................................................

8 Enter the Frequency in the Expected Frequency and click Apply.

Note: The frequency is determined by the PTM inserted in Port 9. See the LNW705 
column in Table 9-1, “Channel/port assignments” (p. 9-17) for acceptable values.

................................................................................................................................................

9 Highlight the Port 1 and click Select.

................................................................................................................................................

10 Set the Signal type to match the PTM type, using the pull down window (for example if 
the PTM is a OC48SR1-I1, set the Signal Type to OC48) and click Apply.

................................................................................................................................................

11 Perform a single node self test by connecting an OC-48 test set to Port 1, while observing 
the proper optical power levels and cleaning procedures.
Insert a 15 dB LBO into the input of Port 9 and connect a fiber from the output of Port 9 to 
the input of Port 9.
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................................................................................................................................................

12 Connect an OC-48 test set to the PTM in port 1 while observing the proper optical power 
levels listed in Table 9-4, “Attenuation table (pluggable transmission modules)” (p. 9-20).

................................................................................................................................................

13 Condition the test set to transmit and receive a STS-48 PRBS test signal. 

Result: Observe error-Free Transmission.

................................................................................................................................................

14 Inject a single error from the test set.

Result: Test set reports the error.

................................................................................................................................................

15 Repeat Step 1 to Step 14 at the other node.

................................................................................................................................................

16 Remove fiber and LBOs from Port 9 of both LNW705s.

................................................................................................................................................

17 Establish the end to end link on the 10G PTM while observing the proper optical levels 
listed in Table 9-4, “Attenuation table (pluggable transmission modules)” (p. 9-20). If 
connecting through the LNW785 go to Procedure , “Integrating the LNW705 into the 
LNW785” (p. 9-9), otherwise continue.

................................................................................................................................................

18 Locate and connect the span fibers to the LNW705 while observing the proper optical 
levels listed in Table 9-4, “Attenuation table (pluggable transmission modules)” (p. 9-20).

................................................................................................................................................

19 Repeat Step 18 at the LNW705 at the other node on the opposite end of the span.

................................................................................................................................................

20 Observe test set and verify error-free transmission. If only one test set is available, connect 
a fiber from the In port to the Out port of the PTM in port 1 at one end. Use the 
information listed in Table 9-4, “Attenuation table (pluggable transmission modules)” 
(p. 9-20) to determine the proper LBO/Attenuator.

Note: Test duration may be determined by engineering specification or by the end 
customer.
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................................................................................................................................................

21 Disconnect test set(s) and fiber jumper from ports.

................................................................................................................................................

22 Remove PTM from LNW705 if necessary and clear any associated alarms by Selecting
Configuration > Update System>Update Inventory.

................................................................................................................................................

23 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Integrating the LNW705 into the LNW785

Description

The output of the LNW705 OTU-2 signal is compatible with the input channels of the 
LNW785. The procedure below assumes that Step 1 through Step 16 in “Turn up and test 
the LNW705 muxponder” (p. 9-6) have been completed.

Steps

................................................................................................................................................

1 Install the LNW785 into the Alcatel-Lucent 1665 DMX shelf by opening both faceplate 
latches and seating in the slot while closing the latches.

Note: The LNW785 can be installed in any Function/Growth slot. When the shelf is 
to be configured as an add/drop, it is recommended that the Growth slots are not used 
because the passthrough fibers would have to route over the SYSCTL. If the Main 
slots are not equipped with VLF mains (LNW59, LNW82, LNW504), then the circuit 
packs in a Function/Growth slot must be the same type. 

................................................................................................................................................

2 Login to the Alcatel-Lucent 1665 DMX using the WaveStar® CIT.

................................................................................................................................................

3 Create OCH Cross-connections
Select Configuration > OCH Cross-connections from the System View
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................................................................................................................................................

4 Select the Create a new OCH cross-connection radio button in the OCH Cross-
Connection Wizard. Click Next.

................................................................................................................................................

5 Click the 2-way Add/Drop radio button from the cross-connection list. Click Next.

................................................................................................................................................

6 Click Select and expand the circuit pack list by clicking the “+” next to XM10G/8, 
highlight Port 9 OTU-2 and the port will appear on the right side of the screen, click on 
the AID to highlight it then click Select.

................................................................................................................................................

7 Click Select for the Add/Drop port, expand the circuit pack (OMD5/8) and click on the 
Port (the port must match XM10G/8 OTU-2 port) and the port will appear on the right 
side of the screen, click on the AID to highlight it then click Select.

................................................................................................................................................

8 Click Next, then Finish and complete the cross-connection by clicking on Yes in the 
confirmation window.

................................................................................................................................................

9 Connect fibers from the LNW705 Port 9 to the corresponding channel on the LNW785 
while observing proper optical power levels and cleaning procedures.

................................................................................................................................................

10 Repeat Step 1 though Step 9 at the remote node.

................................................................................................................................................

11 Connect the Transmit fibers to the OTS port on the LNW785 at each end of the span, 
following proper fiber cleaning procedures.

................................................................................................................................................

12 Connect the Receive fibers, while observing optical power requirements and cleaning 
procedures

................................................................................................................................................

13 Observe test set and verify error-free transmission. If only one test set is available, connect 
a fiber from the In port to the Out port of the PTM in port 1 at one end. Use the 
information listed in Table 9-4, “Attenuation table (pluggable transmission modules)” 
(p. 9-20) to determine the proper LBO/Attenuator.
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Note: Test duration may be determined by engineering specification or by the end 
customer.

................................................................................................................................................

14 Disconnect test set(s) and fiber jumper from ports.

................................................................................................................................................

15 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Connecting the ring (Mains) to the WDMX

Description

This section provides guidance on how to integrate an OC-48/OC-192 into the WDMX. 
Depending on the Main circuit packs and the port rate, the ring can be integrated through 
the LNW705 and/or the LNW785. All of the OC-48 Main circuit pack can be integrated 
into the LNW705, however only the LNW59 and LNW502 can be integrated directly into 
the LNW785 providing the circuit pack is equipped with one of the compatible PTMs 
listed in Table 9-1, “Channel/port assignments” (p. 9-17). 

Important! The procedures in this section make two assumptions, the first is that the 
span between LNW785s or the span between the two LNW705s is established while 
the second is that this is a new turn-up and not on an existing network. 

LNW705/OC-48

The LNW705 span is established and tested using “Turn up and test the LNW705 
muxponder” (p. 9-6) procedure. In some instances, only one direction may be added to the 
WDMX circuit pack. Main 1 is always referred to as the West direction, while Main 2 is 
the East

................................................................................................................................................

1 Determine the direction of the Span, Main 1 or Main 2.

................................................................................................................................................

2 Install an OC-48 PTM in the assigned port slot. See Appendix E, Table E-1, “Alcatel-
Lucent approved pluggable transmission modules” (p. E-11).

Note: The OC-48 PTM is restricted to ports 1, 3, 5, and 7.
Both ends of the circuit must have the PTM installed in the same port.
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................................................................................................................................................

3 Login to the Alcatel-Lucent 1665 DMX using the WaveStar® CIT.

................................................................................................................................................

4 Provision the PTM
Select Configuration > Equipment from the System View

................................................................................................................................................

5 Click the “+” next to XM10G/8 circuit pack to expand the list.

................................................................................................................................................

6 Highlight the Port x and click Select.

................................................................................................................................................

7 Set the Signal type to match the PTM type, using the pull down window (for example if 
the PTM is a OC48SR1-I1, set the Signal Type to OC48) and click Apply.

................................................................................................................................................

8 Connect the fibers from Main 1/Main2 to the PTM in the LNW705 while observing proper 
optical levels, fiber cleaning procedures and fiber routing in the shelf.

................................................................................................................................................

9 Repeat Step 1 to Step 8 at the other end of the circuit.

Result: Once both ends are completed the Mains should go into service and LOS 
alarms cleared between the nodes.

................................................................................................................................................

10 If configuring the other direction, repeat Step 1 to Step 9.

................................................................................................................................................

11 Check off the appropriate box in Table I-3, Installation acceptance checklist

........................................................................................................................................................E N D  O F  S T E P S

LNW785/OC192

The LNW785 span is established and tested using the “Turn-up and test the LNW785 8-
channel OMD” (p. 9-4) procedure. In some instances, only one direction may be added to 
the WDMX circuit pack. Main 1 is always referred to as the West direction, while Main 2 
is the East
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................................................................................................................................................

1 Determine the direction of the Span, Main 1 or Main 2.

................................................................................................................................................

2 Install an OC-192 PTM in the assigned port slot in the Main circuit pack see Table 9-1, 
“Channel/port assignments” (p. 9-17).

Note: Only the first 4 wavelengths can be used in the LNW59 and LNW502, PTMs 
X10G52C5 through X10G55C5.

................................................................................................................................................

3 Login to the Alcatel-Lucent 1665 DMX using the WaveStar® CIT.

................................................................................................................................................

4 Provision the PTM/OTU-2
Select Configuration > Equipment from the System View

................................................................................................................................................

5 Click the “+” next to Main 1 circuit pack to expand the list.

................................................................................................................................................

6 Highlight the PTM and click Select.

................................................................................................................................................

7 Enter the Frequency in the Expected Frequency and click Apply, then Close.

Note: The frequency is determined by the PTM inserted in Port 9. See the LNW705 
column in Table 9-1, “Channel/port assignments” (p. 9-17) for acceptable values.

................................................................................................................................................

8 Create OCH Cross-connections
Select Configuration > OCH Cross-connections from the System View

................................................................................................................................................

9 Select the Create a new OCH cross-connection radio button in the OCH Cross-
Connection Wizard. Click Next.

................................................................................................................................................

10 Click the 2-way Add/Drop radio button from the cross-connection list. Click Next.
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................................................................................................................................................

11 Click Select and expand the circuit pack list by clicking the “+” next to Main 1, highlight 
Port 1 OTU-2 and the port will appear on the right side of the screen, click on the AID to 
highlight it then click Select.

................................................................................................................................................

12 Click Select for the Add/Drop port, expand the circuit pack (OMD5/8) and click on the 
Port (the port must match Main 1 OTU-2 port) and the port will appear on the right side of 
the screen, click on the AID to highlight it then click Select.

................................................................................................................................................

13 Connect the fibers from Main 1/Main2 PTM to the corresponding channel in the LNW785 
while observing proper optical levels, fiber cleaning procedures and fiber routing in the 
shelf.

................................................................................................................................................

14 Repeat Step 1 to Step 13 at the other end of the circuit.

Result: Once both ends are completed the Mains should go into service and LOS 
alarms cleared between the nodes.

................................................................................................................................................

15 If configuring the other direction, repeat Step 1 to Step 14.

................................................................................................................................................

16 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

Removing provisioning and equipage from the LNW705 and 
LNW785

Description

This section provides procedures on how to properly remove provisioning from the 
Alcatel-Lucent 1665 DMX shelf once testing is completed and the equipment/ports are no 
longer needed. Locate the procedure below to remove the equipment and return the 
Alcatel-Lucent 1665 DMX back to the original status.
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Deleting the OCH cross-connection

................................................................................................................................................

1 Login to the Alcatel-Lucent 1665 DMX using the WaveStar® CIT.

................................................................................................................................................

2 Retrieve OCH Cross-connections.
Select View > OCH Cross-connections from the System View

................................................................................................................................................

3 Click the “+” next to OMD5/8 circuit pack to expand the list.
Record the list of ports to be used when deleting OCH cross-connections. If there are more 
than one OMD5/8 circuit packs installed, click on the “+” next to the others to document 
the list of OCH cross-connection for the remaining circuit packs.

................................................................................................................................................

4 Delete OCH Cross-connections
Select Configuration > OCH Cross-connections from the System View

................................................................................................................................................

5 Select the Delete an existing OCH cross-connection radio button in the OCH Cross-
Connection Wizard. Click Next.

................................................................................................................................................

6 Click the “+” next to OMD5/8 circuit pack to expand the list

................................................................................................................................................

7 Highlight one of the OCH cross-connections from the list recorded in Step 3 and click 
Next.

................................................................................................................................................

8 Highlight All Legs and click Next, Finish, then Yes.

................................................................................................................................................

9 Repeat Step 5 through Step 8 for all remaining OCH cross-connections recorded in Step 3.

................................................................................................................................................

10 End the OCH cross-connection Wizard session by clicking Close.

........................................................................................................................................................E N D  O F  S T E P S
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Delete LNW785 circuit pack

................................................................................................................................................

1 Remove the LNW785 circuit pack from the Alcatel-Lucent 1665 DMX shelf.

................................................................................................................................................

2 Update the Alcatel-Lucent 1665 DMX inventory.
Select Configuration > Update System > Update Inventory

................................................................................................................................................

3 Click Yes to acknowledge the request.

........................................................................................................................................................E N D  O F  S T E P S

Delete low-speed PTM

................................................................................................................................................

1 Remove Low Speed PTM from LNW705 by reversing the procedure in Appendix E, 
“Install pluggable transmission modules” (p. E-3).

................................................................................................................................................

2 If removing the LNW705 from the shelf proceed to Delete LNW705 circuit pack (p. 9-16), 
otherwise provision the port back to Signal Type Not Available.
STNA Select Configuration > Equipment

................................................................................................................................................

3 Click the “+” next to the XM10G/8 that had the PTM installed to expand the list.

................................................................................................................................................

4 Locate the port where the PTM was installed and highlight the port and click Select.

................................................................................................................................................

5 After the screen on the right appears, provision the Signal Type to STNA by using the pull 
down arrow and select STNA then Apply then Close.

........................................................................................................................................................E N D  O F  S T E P S

Delete LNW705 circuit pack

................................................................................................................................................

1 Remove the LNW705 circuit pack from the Alcatel-Lucent 1665 DMX shelf.
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................................................................................................................................................

2 Update the Alcatel-Lucent 1665 DMX inventory
Select Configuration > Update System > Update Inventory

................................................................................................................................................

3 Click Yes to acknowledge the request.

........................................................................................................................................................E N D  O F  S T E P S

Table 9-1 Channel/port assignments 

Apparatus 
Code Channel LNW705

LNW785
OCH Frequency

X10G52C5 52 9520 9520 195200 GHz

X10G53C5 53 9530 9530 195200 GHz

X10G54C5 54 9540 9540 195200 GHz

X10G55C5 55 9550 9550 195200 GHz

X10G56C5 56 9560 9560 195200 GHz

X10G57C5 57 9570 9570 195200 GHz

X10G58C5 58 9580 9580 195200 GHz

X10G59C5 59 9590 9590 195200 GHz
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LNW705 XM10G/8 port guidelines

The following table list the PTM restrictions and guidelines.

Table 9-2 XM10G/8 PTM port guidelines

Port 
Number

Signal Type

OC-3/STM1 OC-12/STM4 OC-48/STM16 1Gbe 1GFC 2GFC

1 Yes Yes Yes Yes Yes Yes

2 Yes Yes No Yes Yes No

3 Yes Yes Yes Yes Yes Yes

4 Yes Yes No Yes Yes No

5 Yes Yes Yes Yes Yes Yes

6 Yes Yes No Yes Yes No

7 Yes Yes Yes Yes Yes Yes

8 Yes Yes No Yes Yes No
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Table 9-3 Attenuation table

Optics Circuit Pack
Received Power 
(dBM)

LBO 
(dB)

OC-48 (High 
Speed)

LNW27

LNW29

LNW32

+3.0 to -9.0

-9.0 to -29.0

15

 0

LNW76 -3.0 to -18.0 0

Low-Speed 
Optics (OC-3, 
OC-12, OC-48)

LNW31 (OC-48) 0.0 to -18.0 0

OC-12 (high 
speed)

LNW48 -8.0 to -28.0  0

LNW50 +2.0 to -7.0 10

-7.0 to -30.5  0

LNW54 +2.0 to -7.0 10

-7.0 to -29.0 0

OC-192 (high 
speed)

LNW56 +2.0 to -1.0 5

-1.0 to -14.0 0

LNW58 -1.0 to -11.0 0



........................................................................................................................................................................
9-20 Alcatel-Lucent 1665 DMX R9.0

365-372-304R9.0 Issue 2
July 2010

........................................................................................................................................................................

Removing provisioning and equipage from the LNW705 and
LNW785

WDMX setup and testing: integration procedures

Table 9-4 Attenuation table (pluggable transmission modules)

SFP/XFP optics Circuit Pack
Received 
Power (dBM)

LBO 
(dB)

S15512 LNW37, LNW45, 
LNW55, LNW82, 
LNW705

-8.0 to -23.0 0

OC-3 IR1-I1 LNW37, LNW45, 
LNW55, LNW82, 
LNW705

-8.0 to -28.0 0

OC-3 LR1-I1 LNW37, LNW45, 
LNW55, LNW82, 
LNW705

0.0 to -5.0 15

-5.0 to -10 10

-10 to -34.0 0

OC-12 IR1-I1 LNW49, LNW55, 
LNW82, LNW705

-8.0 to -28.0 0

OC-12 LR1-I1 LNW49, LNW55, 
LNW82, LNW705

+2.0 to -5.0 15

-5.0 to -15 10

-15 to -28.0 0

OC-12 LR2-I1 LNW49, LNW55, 
LNW82

+2.0 to -5.0 15

-5.0 to -15 10

-15 to -28.0 0

OC-48 SR-I1 LNW55, LNW62, 
LNW82, LNW202

-3.0 to -18.0 0

OC-48 LR-I1 LNW55, LNW62, 
LNW82, LNW202, 
LNW705

+3.0 to -5.0 15

-5.0 to -10.0 10

-10.0 to -15.0 5

-15.0 to -27.0 0

OC-48 LR2-I1 LNW55, LNW62, 
LNW82, LNW202, 
LNW705

+3.0 to -5.0 15

-5.0 to -10.0 10

-10.0 to -15.0 5

-15.0 to -27.0 0

OC192SR1-C1 LNW59, LNW502 -1.0 to -11 0
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OC192IR2-C1 LNW59, LNW502 +2.0 to -1.0 5

-1.0 to -14 0

OC192LR2-C1 LNW59, LNW502 +4.0 to 0.0 15

0.0 to -7.0 10

-7.0 to -24.0 0

S622CxxEL LNW37, LNW45, 
LNW49, LNW55, 
LNW82, LNW705

+5.0 to -10.0
-10.0 to -29.0

0
0

S2DxxC6 series LNW55, LNW62, 
LNW82, LNW202

+3.0 to -5.0 15

-5.0 to -10.0 10

-10.0 to -15.0 5

-15.0 to -27.0 0

X10GxxC5* 
series

LNW59, LNW502, 
LNW705 

-8.0 to -24 15

Notes:
* LNW59 and LNW502 do not use X10G56C5, X10G57C6, X10G58C8 and 

X10G59C5

SFP/XFP optics Circuit Pack
Received 
Power (dBM)

LBO 
(dB)
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Part IV:  Supplementary 
information and 
installation checklist

Overview

Purpose

This section provides supplementary information that is useful when installing the 
Alcatel-Lucent 1665 Data Multiplexer (Alcatel-Lucent 1665 DMX) system and using this 
Installation Manual.

Contents

This section is organized into the following sections:

Appendix A, “Fiber cleaning”

Appendix B, “Installing fiber connectors and LBOs”

Appendix C, “Backplane pin replacement”

Appendix D, “Fiber labeling”

Appendix E, “Pluggable transmission module installation”



............................................................................................................................................................................................................................................................
IV-2 Alcatel-Lucent 1665 DMX R9.0

365-372-304R9.0 Issue 2
July 2010

............................................................................................................................................................................................................................................................

OverviewSupplementary information and installation checklist
IV



A-1Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

............................................................................................................................................................................................................................................................

A Fiber cleaning

Overview

Purpose

This appendix describes the Alcatel-Lucent recommended method for the cleaning and 
inspection of optical connectors using specific tools and materials that have been proven to 
be effective in the assembly and testing of optical transmission equipment. It is critical that 
connector faces are clean and free from particular contamination to assure proper 
performance and reliability of lightwave systems. With the modern high speed, high 
power, and wider bandwidth optical transmission systems, clean connectors along the 
optical path are essential for successful operation.

Contents

This appendix provides information on the following topics:

Objectives

This chapter provides information to perform the following:

1. Properly clean an optical connector.

2. Inspect an optical connector for cleanliness.

Equipment requirements and recommendations A-2

Safety instructions A-3

Cleaning/inspecting optical connectors A-4

Cleaning pluggable optics modules A-9
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Equipment requirements and recommendationsFiber cleaning

Related information

A course on connector cleaning and the connector inspection process is now offered 
through Alcatel-Lucent University, Course Code: LMC200H “Understanding Fiber Optic 
Cleaning, Inspection and Testing.” To learn more about this course, consult your local 
Alcatel-Lucent Account Representative.

Equipment requirements and recommendations

Description

For proper cleaning, the following equipment and materials are recommended:

Table A-1 Required and recommended equipment and materials

Product
Model/ 
Description Comcode ITE #

Installation 
Order #

Optical Fiber 
Scope

Noyes OFS 
300-200X

408197028 ITE-7129 33712900

2.5mm 
Universal 
adapter cap

For use with 
the Noyes OFS 
300-200X

408197044 ITE-7129D1 33712901

1.25mm 
Universal 
adapter cap

For use with 
the Noyes OFS 
300-200X

408197069 ITE-7129D2 33712902

Video Fiber 
Scope1

Noyes VFS-1 TBD TBD TBD

Individual 
presaturated 
alcohol 
wipes

99% pure 
isopropyl 
alcohol

901375147 ITE-7136 33713600

CLETOP 
Cleaning 
Cassette

Type A Reel 901375154 ITE-7137 33713700

CLETOP 
Cleaning 
Cassette 
Replacement 
Reel

Type A Reel 901375014 ITE-7137 D1 33713701
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Safety instructionsFiber cleaning

Note: The equipment and material listed above has been tested and is proven 
effective when used in conjunction with this procedure. Substitution of equipment or 
materials is at the discretion of the user and is not recommended.

Safety instructions

Description

Never view an energized optical cable with the naked eye or with an optical magnifying 
instrument. Disconnected or separated optical connectors may emit invisible laser 
radiation and direct exposure can severely injure the eye. If inspecting the endface of a 
connector with a fiberscope, be absolutely certain that the system is deactivated.

Alcohol is flammable and is harmful if swallowed, inhaled or absorbed through the skin. 
Keep alcohol away from heat, sparks, or flame. Avoid contact with eyes, skin and 
clothing.

Luminex 
Stick port 
cleaners

1.25 mm 901375030 ITE-7134 33713400

Luminex 
Stick port 
cleaners 

2.5 mm 901375022 ITE-7135 33713500

Luminex 
Cloth

5.5” x 5.5” 408201226 R6033 23603300

Notes:  
1. This equipment may not be necessary at all locations. It is to be used when 

the ports need to be verified for cleanliness. If care is exercised when 
cleaning fibers, the video scope may not be needed.

Product
Model/ 
Description Comcode ITE #

Installation 
Order #

WARNING

Laser hazard

WARNING

Noxious substance hazard
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Cleaning/inspecting optical connectorsFiber cleaning

Cleaning/inspecting optical connectors

Introduction

The procedure that follows utilizes the “Wet/Dry” method for connector cleaning. This 
method first applies a “wet” solvent such as high purity alcohol to the connector endface 
to dissolve/remove any organic particulate or oily films, followed by a “dry” double clean 
wipe using the CLETOP cleaning cassette. 

This procedure is recommended for connector ferrules 2.5 mm and 1.25 mm in diameter 
associated with ST, SC, FC, and LC connectors. The ferrule of a fiber optic connector 
consists of a ceramic or stainless steel cylinder with a hole located longitudinally down the 
center of its axis, allowing enough tolerance for a fiber to pass through. 

All optical connectors should be cleaned prior to being connected. Keep the protective 
ferrule dust cap on the connector until initiating the cleaning process.

Cleaning procedure

The following cleaning procedure is acceptable for field service/installation activities:

........................................................................................................................................................................................................................

1 Remove the dust cap from the connector ferrule, thus exposing the connector endface.

........................................................................................................................................................................................................................

2 Open an individual foil packet of pre-saturated isopropyl alcohol (99% pure) wipe. 

See Figure A-1, “Cleaning the ferrule endface” (p. A-5).

Grasp the connector housing and place the connector ferrule endface perpendicular to the 
alcohol wipe.

Drag it against the wipe three (3) times in a figure eight pattern. This action applies the 
alcohol solvent to the endface and initially loosens and scrubs away organic/solid 
contaminates.
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Cleaning/inspecting optical connectorsFiber cleaning

Figure A-1 Cleaning the ferrule endface

........................................................................................................................................................................................................................

3 If a CLETOP cassette cleaner is not available, proceed with Step 7. Otherwise, hold the 
CLETOP cassette cleaner in the palm of your hand with the cassette shutter door facing 
up.

See Figure A-2, “CleTop cleaner” (p. A-6).

Rotate the cassette lever all the way down with your thumb. Do not release the lever. The 
lever advances the “dry” Luminex cleaning cloth inside the case and simultaneously opens 
the shutter. The CLETOP cassette shutter door is now open and ready for cleaning the 
connector.



............................................................................................................................................................................................................................................................
A-6 Alcatel-Lucent 1665 DMX R9.0

365-372-304R9.0 Issue 2
July 2010

............................................................................................................................................................................................................................................................

Cleaning/inspecting optical connectorsFiber cleaning

Figure A-2 CleTop cleaner

........................................................................................................................................................................................................................

4 Insert and press the connector ferrule endface perpendicular against the cleaning cloth in 
the first of two slots of the cleaner. 

See Figure A-3, “Acceptability criteria for fiber cleaning” (p. A-8).

Drag it down (in the direction indicated by the arrows on the cleaner). Make certain not to 
release the lever of the cassette.

........................................................................................................................................................................................................................

5 Lift the connector from the first slot and rotate it 90 degrees and repeat the downward 
motion using the second slot. Be sure the ferrule is pressed snug against the cleaning cloth 
while dragging the ferrule to assure the proper cleaning action.

........................................................................................................................................................................................................................

6 Release the cassette lever allowing the shutter door to close to its initial position. Continue 
with Step 5.

........................................................................................................................................................................................................................

7 Wrap a Luminex cleaning cloth around the ferrule and rotate the connector housing, 
cleaning the outside periphery of ferrule. 

Follow this by folding an unused portion of the cloth over the end of the ferrule endface 
and then with light pressure from the thumb, slightly drag the cloth from the center of the 
ferrule to the edge while rotating the connector 360 degrees. If the Luminex cleaning cloth 
is not available, a lint free cleanroom optic wipe can be used. The Luminex cleaning cloth 
is washable and can be used multiple times, optic wipes are single use and disposable.
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Cleaning/inspecting optical connectorsFiber cleaning

........................................................................................................................................................................................................................

8 Inspect the connector for cleanliness. If necessary, repeat the cleaning process.

See “Connector inspection” (p. A-7).

........................................................................................................................................................E N D  O F  S T E P S

Connector inspection 

After cleaning the connector, inspect the ferrule endface to ensure that it is free from any 
particulate contamination using an optical fiber inspection scope of at least 200X 
magnification. When using an optical fiber scope (for example, the Noyes OFS 300-200X) 
exercise extreme caution to assure fiber being examined is de-energized.

........................................................................................................................................................................................................................

1 Follow the instructions in the manual provided with the Optical Fiber Scope to view the 
ferrule endface of the fiber under inspection.

........................................................................................................................................................................................................................

2 The visual area of the ferrule endface (ferrule and fiber) as observed by the inspection 
system/scope should be free of any contaminates. See Figure A-3, “Acceptability criteria 
for fiber cleaning” (p. A-8).

Repeat the Cleaning procedure if the fiber endface does not meet the following 
requirements:

Requirement: No fixed type of contamination (contaminates that remain at the same 
location after three wet-dry cleaning cycles), regardless of size, is allowed in the 
restricted area of the glass fiber endface. 

Requirement: The restricted area is defined as ~66 microns (µm) diameter for both 
singlemode and multimode fibers.

Requirement: No chips, cracks or scratches are allowed near the core of the glass 
fiber endface.

Requirement: No large floating (loose) contaminates are allowed on the glass fiber 
and ceramic ferrule endface.

WARNING
When using an optical power meter to verify the connector and fiber to be 
clean, take special precaution to make sure the no power is being emitted from 
the fiber before viewing.
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Cleaning/inspecting optical connectorsFiber cleaning

Figure A-3  Acceptability criteria for fiber cleaning 

........................................................................................................................................................................................................................

3 After the connector has been verified to be cleaned, it should be immediately inserted into 
the adapter buildout of the optical component. This will assure maximum cleanliness and 
effectiveness of the connector.

........................................................................................................................................................................................................................

4 If the cleaned connector cannot be immediately connected to a corresponding adapter, the 
connector ferrule must be protected with a connector dust cap. Before placing the cap on 
the ferrule, make sure the cap is clean. This can be accomplished by inserting a CLETOP 
stick cleaner (swab) of the same inside diameter as the cap (either 2.5 or 1.25 mm) and 
rotate the stick 360 degrees three (3) times. Following this procedure, carefully place the 
cap over the ferrule. When the cleaned connector is ready for assembly, it should be re-
inspected for cleanliness prior to connection.

........................................................................................................................................................E N D  O F  S T E P S

Fiber adapters or circuit pack connectors

During testing and/or trouble shooting activities it may be necessary to clean the optical 
buildout adapter or the circuit pack connector. The following procedure is recommended.

66um

core

fiber

Restricted Area
1/2 SM Core + 1/2 Fiber
Diameters - 66 µm dia.

No Loose or No Fixed
Contamination

Monitor 
Viewing
Area

No LOOSE 
contamination or 
particulate fibers 
in viewing area. If 
not removable in 3 
cleaning attempts, 
it is defined as 
fixed particulate. 

Fixed particles 
(<8.0µm in size) 
allowed in this area.

NOTICE
Do not attempt to clean ports equipped with yellow Light guide BuildOut (LBO) 
attenuators. Attenuators contain a thin glass lens that is extremely fragile. The 
LBO will be damaged if cleaned using this method.
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Cleaning pluggable optics modulesFiber cleaning

........................................................................................................................................................................................................................

1 Using the appropriate CLETOP stick cleaner (2.5 mm for SC, ST, and FC connectors, 1.25 
mm for LC connectors) dampen the stick cleaner with Ethyl alcohol using the alcohol 
wipe. Insert the stick cleaner into the adapter rotating the stick 360 degrees while 
inserting. Push/rotate stick until the stick cleaner makes contact with the connector. Apply 
slight pressure upon contact and rotate stick 360 degrees at least three (3) times.

........................................................................................................................................................................................................................

2 Remove the stick cleaner rotating it upon removal.

........................................................................................................................................................................................................................

3 Using a dry CLETOP stick cleaner of appropriate diameter, repeat the above cleaning 
procedure. This procedure will clean the side walls of the adapter and the endface of the 
circuit pack connector.

........................................................................................................................................................................................................................

4 Gently insert the Video Fiber Scope probe into the port until the fiber ferrule comes into 
view.

........................................................................................................................................................................................................................

5 Verify that the fiber ferrule is clean. Repeat Step 1 through Step 3 if the fiber does not 
meet the requirements specified in “Connector inspection” (p. A-7).

........................................................................................................................................................E N D  O F  S T E P S

Cleaning pluggable optics modules

Purpose

This task describes the Alcatel-Lucent recommended method for cleaning pluggable 
optics modules using specific tools and materials that have been proven to be effective in 
the assembly and testing of optical transmission equipment.

Note: Pluggable optics modules are shipped with a water-tight process plug installed 
into the optical ports to maintain cleanliness during storage and/or transportation. It is 
recommended that the process plug be kept in place to maintain cleanliness until the 
optical fiber is connected. With proper care and handling, cleaning the pluggable 
optics modules should not be necessary.Because a major source of contamination is 
often a contaminated mating connector, it is extremely important to clean the 
connector ferrule end surface each time before making connections.
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Cleaning pluggable optics modulesFiber cleaning

Steps

Complete the following steps to clean a pluggable optics module.

........................................................................................................................................................................................................................

1 Remove the protective process plug from the pluggable optics module. Keep the process 
plug clean until reinstalled later, if required.

When performing this step hold the canned dry nitrogen or air upright. If the canned dry 
nitrogen or air is held upside down, inert gas may be released onto the connector surface. 
The inert gas leaves contamination on the connector surface that cannot be removed.

........................................................................................................................................................................................................................

2 While holding the canned dry nitrogen or air, position the tip of the nozzle extension as 
close as possible, but not close enough to make physical contact, to the sleeve inside the 
port receptacle and make three consecutive short blows (approximately one second each). 

Repeat this step for the other port.

........................................................................................................................................................................................................................

3 Using the stereo zoom scope, visually inspect the optics module. If required, repeat Step 2 
up to two more times then go to the next step.

........................................................................................................................................................................................................................

4 If required, insert a CLETOP stick into the transmit (TX) port sleeve until vertical force 
can be applied to the fiber stub end surface. Rotate the CLETOP stick five full rounds. 

........................................................................................................................................................................................................................

5 Using the stereo zoom scope, visually inspect the optics module. If required, repeat Step 4.

CAUTION

Corrosive substance hazard

NOTICE
This step should only be performed on the transmit (TX) port if the air blows 
did not work. Do not perform this step on the receive (RX) port. The receive 
(RX) port contains a lens for focusing a wide input. The lens is more easily 
scratched than cleaned.

NOTICE
It is recommended that the process plug be installed into the optical ports on 
the pluggable optics module to maintain cleanliness until the optical fiber is 
connected.
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Cleaning pluggable optics modulesFiber cleaning

........................................................................................................................................................................................................................

6 If required, reinstall the process plug into the optical ports to maintain cleanliness.

........................................................................................................................................................E N D  O F  S T E P S
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B Installing fiber 
connectors and LBOs

Overview

Purpose

This appendix provides procedures for installing and removing Line Build Out units 
(LBOs) and fiber connectors onto input and output ports found on the Alcatel-Lucent 1665 
Data Multiplexer (Alcatel-Lucent 1665 DMX) optical circuit packs. 

Contents

This appendix provides information on the following topics:

Objectives

This appendix provides information to perform the following:

• Install and remove LC-type LBOs onto and from LC-type ports.

• Install and remove LC-type fiber connections.

Fiber cleaning

See Appendix A, “Fiber cleaning” for fiber cleaning information. Do not attempt to clean 
LBOs as they may be damaged by a cleaning attempt. Discard suspect LBOs and replace 
with a new unit.

LBOs B-2

Fiber connections B-4
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LBOsInstalling fiber connectors and LBOs

LBOs

General

LBOs are fixed-value optical attenuators that mate into mounting blocks and provide a 
specific connector interface (LC, ST, FC or SC-type) for external fiber connections. The 
Alcatel-Lucent 1665 DMX optical circuit packs are equipped with LC-type connector 
ports designed for use with LC-type LBOs and fiber connectors. Dust caps should be 
applied on all LBOs when not installed in connector ports.

LC-type connector port

The LC-type connector port will only accept LC-type LBOs for external fiber connection. 

Figure B-1 LC-Type Connector Ports on Circuit Pack

LC-type LBO

Alcatel-Lucent 1665 DMX utilizes Alcatel-Lucent’s state-of-the-art AllWave 
ADVANTAGE™ Fiber Optic Attenuators. These attenuators reduce optical power from the 
transmitter that can result in over-saturation of the receiver, have low reflection to meet 
stringent system requirements, and are backward-compatible with existing transmission 
systems. Unique to the AllWave ADVANTAGE optical connectivity solution (OCS), the 
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LBOsInstalling fiber connectors and LBOs

new LC™ optic attenuators are designed to provide flat spectral loss across the full 
spectrum, allowing the attenuators to be used in the 1300-nm, 1400-nm, and 1500-nm 
bands.

Figure B-2 LC-Type LBO

Assembly of LC-type LBO into LC block

The LC-type LBOs are installed into the LC-type connector by aligning the alignment key 
with the slot in the connector port and pushing the LBO into the port until it snaps into 
place.

Figure B-3 LC-type LBO inserted Into LC-type connector port 

Removal of LC-type LBO from LC block

The LC-type LBOs are removed from the LC-type connector port by depressing the tab to 
release the LBO and then pulling straight out.

ALIGNMENT KEY

SNAP-ACTION TAB

ALIGNMENT
SLOT

15 dB LBO
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Fiber connectionsInstalling fiber connectors and LBOs

Figure B-4 Removing LC-type LBO From LC-type connector port

Fiber connections

General

Alcatel-Lucent 1665 DMX uses AllWave ADVANTAGE™ Lightguide Jumpers, part of 
Lucent’s AllWave ADVANTAGE™ Optical Connectivity Solution (OCS). These jumpers 
contain a boot angled at 40 degrees, allowing the jumpers to dress appropriately into the 
fiber tray. The angled boot eliminates projection outside the front of the shelf assembly.

All fiber connectors should be cleaned and inspected before assembling into connector 
ports. See Appendix A, “Fiber cleaning” for Fiber Cleaning information. Dust caps should 
be applied to all fiber connectors when not installed in a connector port.

LC-type connections

LC-type fiber connectors use a snap-action, lever-tab locking method to join the fiber 
connector to the port connector.

DEPRESS TAB
TO RELEASE LBO
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Fiber connectionsInstalling fiber connectors and LBOs

Figure B-5 LC-Type fiber connector

The LC-type fiber connector is assembled onto an LC-type connector port of a circuit pack 
or LC-type LBO by aligning the alignment key with the slot in the connector port and 
pushing the connector into the port until it snaps into place.

The LC-type fiber connector is removed from a connector port by depressing the snap-
action lever to disengage the fiber connector.

Figure B-6 LC-type fiber connection

ALIGNMENT KEY SNAP-ACTION TAB SNAP-ACTION LEVER

DEPRESS LEVER
TO RELEASE THE
SNAP-ACTION TAB
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C Backplane pin 
replacement

Overview

Purpose

This appendix provides information and the procedures used when a connector and/or pin 
on the Alcatel-Lucent 1665 Data Multiplexer (Alcatel-Lucent 1665 DMX) backplane has 
been bent or broken.

Contents

This appendix provides information on the following topics:

Objectives

This appendix provides information and procedures to do the following:

• Identify a bent or broken pin

• Determine the correct replacement pin and pin kit

• Straighten bent pin

• Replace broken pins

Pin and connector background C-2

Repair kits and tools C-3

Simple repair methods C-4

Replacement methods C-5
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Pin and connector backgroundBackplane pin replacement

Pin and connector background

Description

This section describes the procedures for the repair/replacement of the press-fit connector 
pins used on the backplane of the Alcatel-Lucent 1665 DMX shelf. Trouble clearing 
procedures may lead you to inspect the backplane for damaged connectors. 

Circuit packs are plugged into METRAL™ signal pin connectors which have been press-
fit into the backplane. A plastic shroud is included with the connectors to protect the pins. 
The signal pin press-fit terminals in these connectors my be replaced individually if they 
have been damaged beyond simple repair methods.

D-subminiature connectors

Interface cabling to and from the Alcatel-Lucent 1665 DMX shelves is connected through 
D-Subminiature connectors which have been press-fit into the backplane. Should these 
connectors be damaged beyond simple repair methods, contact your next level of support 
for the replacement procedure.

RJ45 jacks

Interface cabling to and from the Alcatel-Lucent 1665 DMX shelves is connected through 
RJ45 connectors (jacks) which have been press-fit into the backplane. Should these jacks 
be damaged beyond simple repair methods, contact your next level of support for the 
replacement procedure. 

Shelves and backplanes

The Alcatel-Lucent 1665 DMX has its connectors and terminal identifiers stenciled on the 
back surface for identification of location or position. The stenciling can only be seen 
when the back cover is removed.

Pins are identified by a column and row position on the backplane. D-Subminiature 
connectors are identified by their designation and J-number. All the METRAL™ pins used 
on the Alcatel-Lucent 1665 DMX shelves have the same tail length of 4.30 mm (0.169 
in.).

Table C-1, “Backplane locations of METRAL pins” (p. C-3) show the location and type of 
METRAL™ pins on the Alcatel-Lucent 1665 DMX backplane.
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Table C-1 Backplane locations of METRAL pins

Repair kits and tools

Repair kits

For the repair or replacement of METRAL signal pins, use one of the following repair 
kits:

• Berg Electronic MT370-01 Shelf Level Press-Fit Repair Kit

• IMDARC R-6004 Metral Pin Repair Kit - Comcode 407959881

This kit include the tools, parts and instructions for repair and replacement of signal pins.

Replacement pins

Replacement pins are available. These pins are defined by the mating length extending 
beyond the inside of the plastic shroud and by their tail length for press-fitting into the 
backplane. The tail length includes a compliant press-fit section needed to achieve a gas-
tight connection in four contact areas. All the METRAL pins used on the Alcatel-Lucent 
1665 DMX shelves have the same tail length of 4.30 mm (0.169 in.).

Additional replacement signal pins may be ordered in packages of 100 by the part number 
shown in Table C-2, “Metral pins” (p. C-3).

Table C-2 Metral pins

Row Column Type

Mating 
Length 
(mm)

Tail 
Length 
(mm)

001, 154, 156, 162 GND Signal Pin 5.75 4.30

001, 154, 156, 162 a, b, c, d, e Signal Pin 8.00 4.30

All others All others Signal Pin 5.75 4.30

Type
Mating Length 
(mm) Berg Part #

Ground 5.75 88929-502

Signal Pin 5.75 88929-502

Signal Pin 8.00 88929-519
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Simple repair methods

Precautions

Proper ESD precautions must be followed.

Make sure that you have adequate space to access the backplane area and that you have 
good light sources so that you can see what you are doing.

Visual examination

Visually examine the connector pins to determine which pins may have been damaged and 
the degree of the damage. Pins that have been slightly bent may be carefully restored to 
their initial straight position. Examine both sides of the backplane to determine if the 
press-fit termination has been disturbed. These pins depend on an undisturbed interference 
fit between the terminal body and the plated-through hole in the backplane to create a 
reliable connection.

If the visual examination suggests that the connector pins are loose or are damaged beyond 
repair, replace the connector pin.

METRAL backplane pins 

Follow the instructions and use the tools provided in the MT370-01 Shelf Level Press-Fit 
Repair Kit to straighten METRAL pins which may have been bent out of position.

Guide pins and keying pins

If a stainless steel guide pin or keying pin has been bent out of alignment, attempts to 
straighten it may damage the backplane. The recommended alternative is to replace the 
bent pin.

NOTICE
These procedures should be done with the shelf out of service and powered 
down to ensure no further damage to the equipment or to the person doing the 
repair. If service cannot be removed or rerouted, contact your next level of 
support before proceeding.

CAUTION

ESD hazard

NOTICE
This is a delicate procedure. Take your time to gently straighten the pin in 
several small steps. Large movements may damage adjacent pins.
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D-subminiature pins

The D-subminiature connectors on the Alcatel-Lucent 1665 DMX backplane are all of the 
receptacle type. These connectors are designated as jacks and not as plugs. The individual 
connector terminals are protected somewhat by the molded plastic insert inside the 
connector shell. It is unlikely that these terminals would be bent in the manner that the 
exposed pin terminals of a plug might be bent. The damage concern for these receptacle 
terminals is that they may be “crushed” or otherwise distorted out of shape. Attempts to 
“straighten” these terminals may result in fracturing them. If a receptacle terminal has 
been damaged to the extent that the mating plug connector cannot be connected, then the 
recommended alternative is to replace the entire backplane.

RJ45 jacks

The RJ45 connectors (jacks) are press-fitted into the Alcatel-Lucent 1665 DMX 
backplane. Should these jacks be damaged beyond simple repair methods, contact your 
next level of support for the replacement procedure.

Replacement methods

Background

Connector pins are designed to withstand a considerable removal force. An impact-type 
tool is used to generate a controlled removal force. Similarly, proper insertion of a press-fit 
connector pin is done with an impact-type tool to control the insertion forces and not 
damage adjacent pins.

Precautions

Read the following Important statements before proceeding:

Note: Any press-fit connector pin may be removed and replaced one time in the 
Alcatel-Lucent 1665 DMX backplane. A second removal and replacement in the same 
plated-through hole may not meet the long-term reliability objectives. If a replacement 
is needed for a previously replaced connector pin, contact your next level of support 
before proceeding. 

Note: Protect the surrounding area from any debris which may be generated during 
the pin removal and replacement.

Steps

Use the procedure below to replace pins when required:
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........................................................................................................................................................................................................................

1 Verify that the problem cannot be fixed using a simple repair procedure.

........................................................................................................................................................................................................................

2 Secure the proper tool kit.

........................................................................................................................................................................................................................

3 Read the tool kit instructions before beginning.

........................................................................................................................................................................................................................

4 Plan and write out a “Method of Steps” specific to your location.

........................................................................................................................................................................................................................

5 Follow the instructions provided to remove the damaged pin.

........................................................................................................................................................................................................................

6 Install the replacement pin.

........................................................................................................................................................................................................................

7 Verify that the new pin is securely in the backplane.

........................................................................................................................................................................................................................

8 If the replacement is not successful, contact your next level of support.

........................................................................................................................................................E N D  O F  S T E P S

Guide and keying pin procedure

If it becomes necessary to replace Guide or Keying Pins, contact your next level of support 
for tooling, replacement parts and detailed replacement procedures. The replacements will 
need to installed with screws and washers.

D-subminiature pin procedure

If it becomes necessary to replace either the D-Subminiature pins or connector, contact 
your next level of support for detailed replacement procedures.

RJ45 jacks

If it becomes necessary to replace a RJ45 connector, contact your next level of support for 
the replacement procedure.
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D Fiber labeling

Overview

Purpose

This chapter describes the labeling of the fiber.

Contents

This chapter contains the following.

Fiber description

Fibers

There are three different types of single-mode fiber used with the Alcatel-Lucent 1665 
Data Multiplexer (Alcatel-Lucent 1665 DMX) system, simplex blue fiber, simplex yellow 
fiber, and the customer's fiber, and two types of multi-mode fiber used with the Alcatel-
Lucent 1665 DMX, multi-mode simplex gray fiber and the customer's multi-mode fiber. 

Gray fiber

Gray fiber is made up of a multi-mode gray colored fiber equipped with LC connectors at 
both ends. The Gray Fibers come in different lengths as well as custom lengths. The length 
is given on the protection boot of the LC connector.

These fibers are used to make connections from the circuit pack to the LGX. Installation is 
covered in 2, 4, 5, and 8.

Fiber description D-1

Fiber labels D-3
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Yellow fiber

Yellow fiber is made up of a single-mode yellow colored fiber equipped with LC 
connectors at both ends. The Yellow Fibers come in different lengths as well as custom 
lengths. The length is given on the protection boot of the LC connector.

These fibers are used to make connections from the circuit pack to the LGX. Installation is 
covered in 2, 4, 5, and 8.

Outside fiber

Outside fiber is the fiber connecting the customer equipment to the Alcatel-Lucent 1665 
DMX. Depending on the customers specifications, these fibers may be any combination of 
SC, FC, or ST connectors. The length of these fibers depends on the system interface 
setup. This fiber is usually referred to as the Outside Bay or Plant Fiber.

Outside Bay Fiber management should be specified by the customer. It is beyond the 
scope of this document to specify the route or dressings that the fiber should take once it 
leaves the equipment bays.
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Precautions

Single-mode fiber testing requirements

All fibers should be tested after they are installed as follows:

• All fibers should be tested after installation, but prior to turn-up

• Before fibers are tested, they should be labeled properly and all cable tags should be 
removed.

• A 1310-nm or 1550-nm test source and an ITE# 7116 (or equivalent) optical power 
meter should be used to perform all tests.

• The light source shall first be measured for a reference point/baseline.

• No fiber jumper may have a measured loss of more than 2 dB.

Fiber labels

Introduction

If pre-printed labels are not available, use a label-maker to create labels for each end of 
each fiber. The label should include:

• Rack location

• Circuit pack

• Port

• Direction (IN,OUT)

Labeling the fibers

To apply the labels to the connectors, use the following procedure.

........................................................................................................................................................................................................................

1 Remove the appropriate label from the backing sheet or the label maker.

NOTICE

Equipment Damage

Fiber is constructed of glass and should be treated with care. It should not be 
pulled or stretched. This could cause damage to the fiber or the fiber connector.

Fiber should not be bent in a radius of less than 1-1/2”.
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........................................................................................................................................................................................................................

2 Apply the label to the strain relief boot, close to the body of the LC connector.

........................................................................................................................................................................................................................

3 Adhere the end of the label with the printed text first.

........................................................................................................................................................................................................................

4 The label must be oriented perpendicular to the main axis of the connector.

........................................................................................................................................................................................................................

5 Wrap the label around the boot so that the second wrap is directly on top of the first wrap. 
(The label will wrap around the boot approximately two times). The text is printed 
diagonally on the label so that it can be read when applied the correct way.

Note: Do not apply the label diagonally to the boot. The label must wrap directly on 
top of itself for the adhesive to work.

........................................................................................................................................................E N D  O F  S T E P S
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E Pluggable transmission 
module installation

Overview

Purpose

This chapter describes how to insert a pluggable transmission module (PTM) into a 
Alcatel-Lucent 1665 Data Multiplexer (Alcatel-Lucent 1665 DMX) circuit pack. PTMs 
are sometimes referred to as SFP (small form-factor pluggable) modules.

Contents

This chapter contains the following.

Pluggable transmission modules (PTM)

Description

This section contains the instructions for the installation of the pluggable transmission 
modules.

NOTICE

Laser Safety

When connecting fiber loops between the IN and OUT ports on optical circuit 
packs, always connect to the IN port first and then the OUT port. This will 
prevent any optical radiation from being present at the fiber end.

Pluggable transmission modules (PTM) E-1

Install pluggable transmission modules E-3

Pluggable transmission modules E-10
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........................................................................................................................................................................................................................

1 See the engineering job specification. Identify the proper circuit pack type and the port 
socket being equipped with the pluggable module. Make sure the transmission rate (OC-3, 
OC-12, OC-48, OC-192, 100Base Ethernet GbE, FICON) matches the rate of the PTM 
See Table E-1, “Alcatel-Lucent approved pluggable transmission modules” (p. E-11).

Note: Pluggable modules are shipped with a dust plug installed into the ports to 
maintain cleanliness during storage and/or transportation. It is recommended that the 
dust plug be kept in place to maintain cleanliness. With proper care and handling, 
cleaning the pluggable modules should not be necessary.

........................................................................................................................................................................................................................

2 Check the ports for cleanliness and clean the pluggable module if necessary. See 
Appendix A, “Fiber cleaning”.

........................................................................................................................................................................................................................

3 Insert the pluggable module in the required socket of the circuit pack faceplate, then 
wiggle the module to verify that it is locked in the socket. See “Pluggable transmission 
modules (PTM)” (p. E-1). Verify that all unused sockets are equipped with dust plugs.

Note: If installing PTMs in a LNW705, see Table 9-2, “XM10G/8 PTM port 
guidelines” (p. 9-18) for installation guidelines.

........................................................................................................................................................................................................................

4 Repeat Step 1 through Step 3 if more modules need to be installed.

........................................................................................................................................................................................................................

5 Check off the appropriate box in Table I-3, Installation acceptance checklist.

........................................................................................................................................................E N D  O F  S T E P S

NOTICE
Never mechanically clean the receive (RX) port. Air blows only should be used 
on the receive (RX) port. The receive (RX) port contains a lens for focusing a 
wide input. The lens is more easily scratched than cleaned.
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Install pluggable transmission modules

Steps

Complete the following steps to install pluggable transmission modules in a circuit pack 
that has already been installed in a shelf.

........................................................................................................................................................................................................................

1 Determine the circuit pack and socket being equipped with the pluggable transmission 
module.

........................................................................................................................................................................................................................

2 Hold the connector/latch-end of the module in your left hand with the gold fingers facing 
you. The module should be positioned in manner similar to Figure E-1, “Pluggable 
transmission module with dust plug (optical PTMs only)” (p. E-3).

Figure E-1 Pluggable transmission module with dust plug (optical PTMs only)

Note: Do not remove the dust plug unless you are ready to connect fibers or if you 
need to clean the module.

Dust plugs (Optical PTMs only) There are a variety of different types of dust plugs. 
Any of the following examples could be similar to the dust plug in your pluggable 
transmission module.

Figure E-2 Examples of dust plugs

........................................................................................................................................................................................................................

3 Referring to Figure E-3, “Module types” (p. E-4) below, determine the type of latching 
mechanism on the pluggable transmission module you have.

MA-DMX-422

MA-DMX-421
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Figure E-3 Module types

Gold Fingers

Gold Fingers

MA-DMX-445

1

2

3

Gold Fingers

Port

Port

Port
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Note: Optical pluggable transmission modules are shipped with a dust plug installed 
into the optical ports to maintain cleanliness during storage and/or transportation. It is 
recommended that the dust plug be kept in place to maintain cleanliness until the 
cabling is connected. With proper care and handling, cleaning the pluggable 
transmission modules should not be necessary.

Gold Fingers

Gold Fingers

Gold Fingers

MA-DMX-439

4

5

6

Port

Port

Port

7

8

MA-DMX-442

Gold FingersPort

Gold Fingers

Port
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........................................................................................................................................................................................................................

4 Referring to Step 3, what type of latching mechanism does your module have?.

........................................................................................................................................................................................................................

5 Before inserting the module, the latch must be in the closed position. With the dust plug in 
place, the latch is in the closed position.

Figure E-4 shows the open and closed position of the latch. Depending on your PTM type, 
the appearance of the port opening and latch mechanism may vary.

Figure E-4 Latch type 3 (opened and closed)

........................................................................................................................................................................................................................

6 Proceed to Step 8.

........................................................................................................................................................................................................................

7 Before inserting the module, the latch must be in the closed position. With the dust plug in 
place, the latch is in the closed position.

Figure E-5 shows the open and closed position of the latch. Depending on your PTM type, 
the appearance of the port opening and latch mechanism may vary.

If... Then...

Type 1 or 2 (optical) Proceed to Step 8

Type 3 (optical) Continue with Step 5

Type 4, 5, or 6 (optical) Proceed to Step 7

Type 7 or 8 (electrical) Proceed to Step 7

MA-DMX-423

Swivel Latch
Closed Position

(to the right)

Swivel Latch
Open Position

(to the left)
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Figure E-5 Latch type 4, 5, 6, 7 and 8 (opened and closed)

........................................................................................................................................................................................................................

8 With your left hand, hold the pluggable transmission module by the dust plug (optical) or 
port end (electrical). The ports are in your left hand and the gold fingers are visible (facing 
you). (Do not insert pluggable transmission module.)

........................................................................................................................................................................................................................

9 Rotate the module; the dust plug or port end is facing you and the gold fingers are pointing 
away from you and are facing to the right. (Do not insert pluggable transmission module.)

........................................................................................................................................................................................................................

10 Insert the pluggable transmission module in the required socket of the circuit pack 
faceplate. Confirm that the pluggable transmission module is locked in the socket. Verify 
that all unused sockets on the circuit pack are equipped with dust covers.

MA-DMX-424

Swivel Latch
Closed Position

(to the left)

Swivel Latch
Open Position
(to the right)
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Figure E-6 Insert pluggable transmission module into socket

Result: The port appears in the WaveStar® CIT System View indicating successful 
installation. 

If response is not correct, replace the pluggable transmission module. If the pluggable 
transmission module fails when inserted, and another pluggable transmission module 
in the shelf fails at the same time, replace the newly-installed pluggable transmission 
module. Each pluggable transmission module has unique internal data for warranty 
purposes. If this data for any reason is not unique, both pluggable transmission 
modules with the duplicated information will be declared failed. See the Alcatel-
Lucent 1665 Data Multiplexer (DMX) Alarm Messages and Trouble Clearing Guide, 
365-372-302.

........................................................................................................................................................................................................................

11 Push on the dust plug or port end to insert the module. The latch automatically catches 
when the module is inserted. The module is secure.

MA-DMX-427

Gold Fingers

Socket
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To verify that the pluggable transmission module is properly latched in the cage, gently 
pull the pluggable transmission module (parallel to the direction the pluggable 
transmission module was installed). Do not rotate the swivel latch or activate the de-
latching feature on the pluggable transmission module.

........................................................................................................................................................................................................................

12

........................................................................................................................................................................................................................

13 To test the OC-n optical port on installed OLIU circuit packs, loop back the OC-n optical 
port on itself (IN to OUT) with a 15-dB Attenuator.

Result: No alarms on the OLIU.

........................................................................................................................................................................................................................

14 Remove the lightguide jumper used to loop back the OC-n optical port and the LBO.

Result: The port LED starts flashing. The MN and NE LEDs are lighted on the 
SYSCTL circuit pack.

........................................................................................................................................................................................................................

15 From the System View window, select Configuration > Update System > Update All.

Result: The port LED stops flashing. All alarms are cleared.

........................................................................................................................................................................................................................

16 Repeat Step 1 to Step 15 for additional pluggable transmission modules.

........................................................................................................................................................................................................................

17 If installing ethernet pluggable transmission module continue, otherwise proceed to Step 
23

........................................................................................................................................................................................................................

18 To test optical Ethernet ports, with the appropriate fiber type (Single/Multi-Mode) loop 
back the optical Ethernet port to itself (In to Out) LBOs are not required with optical 
Ethernet ports.

If installing a pluggable transmission module 
in an... Then...

Optical OLIU circuit pack, Continue with Step 13.

Ethernet/DATA circuit pack, Proceed to Step 23.
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........................................................................................................................................................................................................................

19 From the System View window, double click on the optical port under test.

Result: In the Fault tab, Port Monitoring Mode: should display IS 
Alarms tab Highest Alarms: should display Not Alarmed

........................................................................................................................................................................................................................

20 Remove the lightguide jumper used to loop back the optical Ethernet port and click 
Refresh to the View Equipment window.

Result: The FAULT LED on the pack and port LED starts flashing. The CR and NE 
LEDs are lighted on the SYSCTL circuit pack. In the Alarms tab Highest Alarms: 
should display Critical.

........................................................................................................................................................................................................................

21 From the System View window, select Configuration > Update System > Update All.

Result: The port LED stops flashing. All alarms are cleared.

........................................................................................................................................................................................................................

22 Repeat Step 18 toStep 21 for additional ethernet pluggable transmission modules.

........................................................................................................................................................................................................................

23 If all pluggable transmission modules are installed, then from the System View menu click 
on the Alarm List button to verify that no alarms are present for the pluggable 
transmission modules just installed on the circuit packs.

........................................................................................................................................................E N D  O F  S T E P S

Pluggable transmission modules

Alcatel-Lucent approved Class 1 SFP transceivers

The following table lists all the current approved pluggable transmission modules to be 
used with Alcatel-Lucent 1665 DMX.
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Table E-1 Alcatel-Lucent approved pluggable transmission modules

Apparatus Code Comcode Description Used in

BASE-T-C1
FE and GbE 
(electrical - NOT 
OSP)

109565549 Electrical PTM, 
provisionable to 100 or 
1000 Mbps, Lucent 
approved RJ-45 Cat 5-E 
cable, maximum span 
length of 100 meters

LNW63, LNW64, 
LNW170

S15512 109602599 OC-3 PTM TRCVR Short 
Reach, 1.3 SR-1, 1310 nm

LNW37, LNW45, 
LNW55, LNW82, 
LNW705

OC3IR1-I1 109453894 OC-3 PTM TRCVR 
Intermediate Reach, 1.3 
IR-1, 1310nm

LNW37, LNW45, 
LNW55, LNW82, 
LNW705

OC3LR1-I1 109453886 OC-3 PTM TRCVR Long 
Reach, 1.3 LR-1, 1310nm

LNW37, LNW45, 
LNW55, LNW82, 
LNW705

OC3X12X48-IR1-I1 109708131 OC3/STM1/OC12/STM4/
OC48/STM16 SFP, 15km, 
1310nm

LNW55, LNW82

OC3X12X48-LR1-
I1

109708149 OC3/STM1/OC12/ 
STM4/OC48/STM16, 
40km, 1310nm

LNW55, LNW82

OC12IR1-I1 109453902 OC-12 PTM TRCVR 
Intermediate Reach, 1.3 
IR-1, 1310nm

LNW49, LNW55, 
LNW82, LNW705

OC12LR1-I1 109467522 OC-12 PTM TRCVR 
Long Reach, 1.3 LR-1, 
1310nm

LNW49, LNW55, 
LNW82, LNW705

OC12LR2-I1 109604447 OC-12 PTM TRCVR 
Long Reach, 1.5 LR-2 
(80km), 1550

LNW49, LNW55, 
LNW82, LNW705

S622C47EL 109664086 OC3/12 622Mb/s Coarse 
WDM (CDWDM) Ch47 
1471nm SM

LNW37. LNW45, 
LNW49, LNW55, 
LNW82, LNW203, 
LNW705
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S622C49EL 109664094 OC3/12 622Mb/s Coarse 
WDM (CDWDM) Ch49 
1491 nm SM

LNW37. LNW45, 
LNW49, LNW55, 
LNW82, LNW203, 
LNW705

S622C51EL 109664102 OC3/12 622Mb/s Coarse 
WDM (CDWDM) Ch51 
1511nm SM

LNW37. LNW45, 
LNW49, LNW55, 
LNW82, LNW203, 
LNW705

S622C53EL 109664110 OC3/12 622Mb/s Coarse 
WDM (CDWDM) Ch53 
1531nm SM

LNW37. LNW45, 
LNW49, LNW55, 
LNW82, LNW203, 
LNW705

S622C55EL 109664128 OC3/12 622Mb/s Coarse 
WDM (CDWDM) Ch55 
1551nm SM

LNW37. LNW45, 
LNW49, LNW55, 
LNW82, LNW203, 
LNW705

S622C57EL 109664136 OC3/12 622Mb/s Coarse 
WDM (CDWDM) Ch57 
1571 nm SM

LNW37. LNW45, 
LNW49, LNW55, 
LNW82, LNW203, 
LNW705

S622C59EL 109664144 OC3/12 622Mb/s Coarse 
WDM (CDWDM) Ch59 
1691nm SM

LNW37. LNW45, 
LNW49, LNW55, 
LNW82, LNW203, 
LNW705

S622C61EL 109664151 OC3/12 622Mb/s Coarse 
WDM (CDWDM) Ch61 
1611nm SM

LNW37. LNW45, 
LNW49, LNW55, 
LNW82, LNW203, 
LNW705

OC48SR1-I1 109564518 OC-48 PTM TRCVR 
Short Reach, 1.3 SR-1 
(2km), 1310nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW705

OC48LR1-I1 109493528 OC-48 PTM TRCVR 
Long Reach, 1.3 LR-1 
(40km), 1310nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

Apparatus Code Comcode Description Used in
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OC48LR2-I1 109504431 OC-48 PTM TRCVR 
Long Reach, 1.5 LR-2 (80 
km), 1550 nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

S2D23C6 109610378 OC-48/STM16/OTU1 
DWDM 
192.3THz/1558.983nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

S2D25C6 109610394 OC-48/STM16/OTU1 
DWDM 
192.5THz/1557.363nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

S2D27C6 109610410 OC-48/STM16/OTU1 
DWDM 
192.7THz/1555.747nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

S2D31C6 109610451 OC-48/STM16/OTU1 
DWDM 
193.1THz/1552.524nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

S2D33C6 109610477 OC-48/STM16/OTU1 
DWDM 
193.3THz/1550.918nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

S2D35C6 109610493 OC-48/STM16/OTU1 
DWDM 
193.5THz/1549.315nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

S2D37C6 109610519 OC-48/STM16/OTU1 
DWDM 
193.7THz/1547.715nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

S2D45C6 109610600 OC-48/STM16/OTU1 
DWDM 
194.5THz/1541.349nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

Apparatus Code Comcode Description Used in
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S2D47C6 109610626 OC-48/STM16/OTU1 
DWDM 
194.7THz/1539.766nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

S2D49C6 109610642 OC-48/STM16/OTU1 
DWDM 
194.9THz/1538.186nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

S2D53C6 109610691 OC-48/STM16/OTU1 
DWDM 
195.3THz/1535.036nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

S2D55C6 109610717 OC-48/STM16/OTU1 
DWDM 
195.5THz/1533.465nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

S2D59C6 109610766 OC-48/STM16/OTU1 
DWDM 
195.9THz/1530.334nm

LNW55, LNW62, 
LNW82, LNW202, 
LNW402, LNW504, 
LNW705

OC192SR1-C1 109537902 OC-192 XFP TRCVR 
Short Reach, 1.3 SR-1 (2 
km), 1310 nm

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

OC192IR2-C1 109537563 OC-192 XFP TRCVR 
Intermediate Reach, 1.5 
IR-2 (40 km), 1550 nm

LNW59, LNW705

OC192LR2-C1 109537555 OC-192 XFP TRCVR 
Long Reach, 1.5 LR-2 (80 
km), 1550 nm

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G21C5 109615005 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1560.606 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G22C5 109615013 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1559.794 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G23C5 109615021 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1558.983 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

Apparatus Code Comcode Description Used in
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X10G24C5 109615039 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1558.173 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G25C5 109615047 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1557.173 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G26C5 109615054 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1556.555 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G27C5 109615062 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1555.747 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G28C5 109615070 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1554.940 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G52C5 109615310 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1535.822 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G53C5 109615328 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1535.036 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G54C5 109615336 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1534.250 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G55C5 109615344 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1533.465 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G56C5 109615351 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1532.681 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G57C5 109615369 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1531.898 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

X10G58C5 109615377 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1531.116 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

Apparatus Code Comcode Description Used in



............................................................................................................................................................................................................................................................
E-16 Alcatel-Lucent 1665 DMX R9.0

365-372-304R9.0 Issue 2
July 2010

............................................................................................................................................................................................................................................................

Pluggable transmission modulesPluggable transmission module installation

X10G59C5 109615385 OC-192/STM-64/OTU2 
DWDM, Long Reach, 
1530.334 nm,

LNW59, LNW502, 
LNW504, LNW603, 
LNW705

100BASE-ZX-I1 109703157 100 Mb/s optical Fast 
Ethernet SFP TRCVR

LNW63, LNW64, 
LNW74, LNW87, 
LNW170

100BASE-LX-I1  109527812 Optical Fast Ethernet 
PTM LC-type connectors
(FE-1310SM)

LNW63, LNW64, 
LNW74, LNW87, 
LNW170

100BASE-FX-I1 109703140 100 Mb/s optical Fast 
Ethernet SFP TRCVR

LNW63, LNW64, 
LNW87, LNW170

ESCON-MM-I1 
(ESCON)

 109523886 ESCON, Multi-Mode 
PTM, LC-type connectors
(ESCON - 1310)

LNW73, LNW73C

GE-1X2XFC-SX-I1
(1000BASE-SX, 
1Gbps)

109570606 GbE short-reach, Single 
Mode PTM, supports 
Ethernet and Fibre-
Channel traffic, LC-type 
connectors OSP hardened
(GbE/FC/2FC-850)

LNW63, LNW64, 
LNW73, LNW73C, 
LNW87, LNW170, 
LNW705

GE-1X2XFC-LX-I1 
(1000BASE-LX,
1 Gbps)

109568782 GbE long-reach, Single 
Mode PTM, supports 
Ethernet, FICON, and 
Fibre-Channel traffic, LC-
type connectors, OSP 
hardened
(GbE/FC/2FC-1310)

LNW63, LNW64, 
LNW73, LNW73C, 
LNW87, LNW170, 
LNW705

1000BASE-ZX-I1
(1000BASE-ZX, 
1Gbps)

109541862 GbE long-reach, Single 
Mode PTM, supports 
Ethernet, LC-type 
connectors, OSP hardened 
(GbE - 1550)

LNW63, LNW64, 
LNW74, LNW87, 
LNW170

1000BASE-LX-I1
(1000BASE-LX, 
1Gbps)

109541854 GbE long-reach, Single 
Mode PTM, supports 
Ethernet, LC-type 
connectors, OSP hardened 
(GbE - 1550)

LNW63, LNW64, 
LNW74, LNW87, 
LNW170

Apparatus Code Comcode Description Used in
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1000BASE-SX-I1
(1000BASE-SX, 
1Gbps)

109541847 GbE Short-reach, Single 
Mode PTM, supports 
Ethernet, LC-type 
connectors, OSP hardened 
(GbE - 850)

LNW63, LNW64, 
LNW87, LNW170

Apparatus Code Comcode Description Used in
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A

ABN
Abnormal (status condition)

ACO
Alarm Cutoff

ACO/SW
Alarm Cutoff and Test

ADM
Add/Drop Multiplexer

AGNE
Alarm Gateway Network Element

AIS
Alarm Indication Signal

AMI
Alternate Mark Inversion

ANSI
American National Standards Institute

APS
Automatic Protection Switch

ARM
Access Resource Manager

AS&C
Alarm, Status, and Control

ASCII
American Standard Code for Information Interchange

ASN.1
Abstract Syntax Notation 1

ASNE
Alarm Server Network Element
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ATM
Asynchronous Transfer Mode

Auto
Automatic

AUXCTL
Auxiliary Control

............................................................................................................................................................................................................................................................

B

B3ZS
Bipolar 3-Zero Substitution

B8ZS
Bipolar 8-Zero Substitution

BDFB
Battery Distribution and Fuse Bay

BER
Bit Error Ratio

BIP
Bit Interleaved Parity

BITS
Building Integrated Timing Supply

BRI
Basic Rate Interface

............................................................................................................................................................................................................................................................

C

CC
Clear Channel

CCITT
International Telephone and Telegraph Consultative Committee

CEV
Controlled Environment Vault

CD-ROM
Compact Disk, Read-Only Memory

CDTU
Channel and Drop Test Unit

CIT
Craft Interface Terminal



............................................................................................................................................................................................................................................................
Alcatel-Lucent 1665 DMX R9.0
365-372-304R9.0 Issue 2
July 2010

GL-3

............................................................................................................................................................................................................................................................

Acronyms and abbreviationsGlossary

CLF
Carrier Line Failure Status

CLK
Clock

CMISE
Common Management Information Service Element

CMOS
Complementary Metal Oxide Semiconductor

CMTS
Cable Modem Termination System

CO
Central Office

CP
Circuit Pack

CPE
Customer Premises Equipment

CR
Critical (alarm status)

CSA
Carrier Serving Area

CSU
Channel Service Unit

CS&O
Customer Support and Operations

CV
Coding Violation

CVFE
Coding Violation Far End

............................................................................................................................................................................................................................................................

D

DCC
Data Communications Channel

DCE
Data Communications Equipment

DEMUX
Demultiplexer
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DLC
Digital Loop Carrier

DPLL
Digital Phase-Locked Loop

DRI
Dual Ring Interworking

DS1
Digital Signal Level 1

DS3
Digital Signal Level 3

DSLAM
Digital Subscriber Line Access Multiplexer

DSNE
Directory Services Network Element

DSX
Digital Cross-Connect Panel

DT
Distant Terminal

DTE
Data Terminating Equipment

............................................................................................................................................................................................................................................................

E

EC-1
Electrical Carrier Level 1

ECI
Equipment Catalog Item

EEPROM
Electrically-Erasable Programmable Read-Only Memory

EIA
Electronic Industries Association

EMC
Electromagnetic Compatibility

EMI
Electromagnetic Interference

EOOF
Excessive Out of Frame
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EPROM
Erasable Programmable Read-Only Memory

EQ
Equipped (memory administrative state)

ES
Errored Seconds

ESD
Electrostatic Discharge

ESF
Extended Super Frame

EST
Environmental Stress Testing

............................................................................................................................................................................................................................................................

F

FCC
Federal Communications Commission

FDDI
Fiber Distribution Data Interface

FE
Far End

FE ACTY
Far End Activity

FEBE
Far End Block Error

FE ID
Far End Identification

FEPROM
Flash EPROM

FERF
Far End Receive Failure

FE SEL
Far End Select

FIT
Failures in 109 hours of operation.
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G

GbE
Gigabit Ethernet

GNE
Gateway Network Element

GR
Telcordia Technologies General Requirement

GTP
General Telemetry Processor

GTSIP
Global Technical Support Information Platform

GUI
Graphical User Interface

............................................................................................................................................................................................................................................................

H

HECI
Humans Equipment Catalog Item

............................................................................................................................................................................................................................................................

I

IC
Internal Clock

ID
Identifier

IEC
International Electrotechnology Commission

IMF
Infant Mortality Factor

INC
Incoming Status

I/O
Input/Output

IP
Internet Protocol

IR
Intermediate Reach
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IS
In Service

ISCI
Intershelf control Interface

ISI
Intershelf Interface

ISDN
Integrated Services Digital Network

ISO
International Standards Organization

ISP
Internet Service Provider

IVHS
Intelligent Vehicle Highway System

............................................................................................................................................................................................................................................................

L

LAN
Local Area Network

LAPD
Link Access Procedure "D"

LBO
Line Build Out

LCN
Local Communications Network

LEC
Local Exchange Carrier

LED
Light-Emitting Diode

LOF
Loss of Frame

LOP
Loss of Pointer

LOS
Loss of Signal

LR
Long Reach
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LS
Low Speed

............................................................................................................................................................................................................................................................

M

MD
Mediation Device

MJ
Major Alarm

MM
Multimode

MML
huMan-Machine Language 

MN
Minor Alarm

MPEG
Moving Picture Experts Group

MSDT
Multi-Services Distant Terminal

MTBF
Mean Time Between Failures

MTBMA
Mean Time Between Maintenance Activities

Mult
Multipling

MUX
Multiplex

MXBIU
Multiplexer and Backplane Interface Unit

............................................................................................................................................................................................................................................................

N

NE
Near End

NE
Network Element

NE ACTY
Near-End Activity
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NEBS
Network Equipment-Building System

nm
Nanometer (10-9 meters)

NMA
Network Monitoring and Analysis

NMON
Not Monitored (provisioning state)

NRZ
Nonreturn to Zero

NNI
Network-Network Interface

NSA
Not Service Affecting

NSAP
Network Services Access Point

NTF
No Trouble Found

............................................................................................................................................................................................................................................................

O

OAM&P
Operations, Administration, Maintenance, and Provisioning

OC-1
Optical Carrier Level 1 Signal (51.84 Mb/s)

OC-3
Optical Carrier Level 3 Signal (155 Mb/s)

OC-12
Optical Carrier Level 12 Signal (622 Mb/s)

OC-48
Optical Carrier Level 48 Signal

OLIU
Optical Line Interface Unit

OOF
Out of Frame

OOL
Out of Lock
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OPS/INE
Operations System/Intelligent Network Element

OS
Operations System

OSGNE
Operations System Gateway Network Element

OSI
Open Systems Interconnection

OSMINE
Operations Systems Modifications for the Integration of Network Elements

OSP
Outside Plant

............................................................................................................................................................................................................................................................

P

P-bit
Performance Bit

PC
Personal Computer

PCU
Power Conversion Unit

PID
Program Identification

PINFET
Positive Intrinsic Negative Field Effect Transistor

PJC
Pointer Justification Count

PLL
Phase-Locked Loop

PM
Performance Monitoring

PMN
Power Minor Alarm

POH
Path Overhead

POP
Points of Presence
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POTS
Plain Old Telephone Service

PRM
Performance Report Message

PROTN
Protection

PRS
Primary Reference Source

PSU
Power Supply Unit

PTM
Pluggable Transmission Module

PVC
Permanent Virtual Circuit

PWR
Power

............................................................................................................................................................................................................................................................

R

RAM
Random Access Memory

RPP
Reliability Prediction Procedure (described in Telcordia Technologies TR-NWT-00032)

RT
Remote Terminal

NARTAC
Lucent Regional Technical Assistance Center (1-866-LUCENT8)

RZ
Return to Zero

............................................................................................................................................................................................................................................................

S

SA
Service Affecting

SCADA
Supervisory Control and Data Acquisition

SD
Signal Degrade
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SDH
Synchronous Digital Hierarchy

SEFS
Severely Errored Frame Seconds

SEO
Single-Ended Operations

SES
Severely Errored Seconds

SF
Super Frame (format for DS1 signal)

SFP
Small Form Pluggable

SID
System Identification

SLA
Service Level Agreements

SLIM
Subscriber Loop Interface Module

SM
Single Mode

SONET
Synchronous Optical NETwork

SPE
Synchronous Payload Envelope

SQU
Sync Quality Unknown

SRD
Software Release Description

STS, STS-n
Synchronous Transport Signal

STM
Synchronous Transfer Mode

STS-1 SPE
STS-1 Synchronous Payload Envelope

STS-3c
Synchronous Transport Level 3 Concatenated Signal
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STS-12c
Synchronous Transport Level 12 Concatenated Signal

SYSCTL
System Controller (circuit pack)

............................................................................................................................................................................................................................................................

T

T1X1 and T1M1
The ANSI committees responsible for telecommunications standards

TA
Telcordia Technologies Technical Advisory

TABS
Telemetry Asynchronous Byte Serial (Protocol)

TARP
Target ID Address Resolution Protocol

TCA
Threshold-Crossing Alert

TCP/IP
Transmission Control Protocol/Internet Protocol

TCVCXO
Termperature-Compensated Voltage-Controlled Crystal Oscillator

TDM
Time Division Multiplexing

TID
Target Identifier

TL1
Transaction Language 1

TLB
Timing Looped Back

TOP
Task Oriented Practice

TR
Telcordia Technologies Technical Requirement

TSA
Time Slot Assignment

TSI
Time Slot Interchange
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TSO
Technical Support Organization

............................................................................................................................................................................................................................................................

U

UAS
Unavailable Seconds

UNI
User Network Interface

UOC
Universal Optical Connector

UPD/INIT
Update/Intialize

UPSR
Unidirectional Path Switched Rings

............................................................................................................................................................................................................................................................

V

VF
Voice Frequency

VLAN
Virtual Local Area Network

VLSI
Very Large Scale Integration

VM
Violation Monitor

VMR
Violation Monitor and Removal

VoIP
Voice over Internet Protocol

VONU
Virtual Optical Network Unit

VPN
Virtual Private Network

VT
Virtual Tributary

VT1.5
Virtual Tributary 1.5 (1.728 Mb/s)
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VT-G
Virtual Tributary Group

............................................................................................................................................................................................................................................................

W

WAN
Wide Area Network

Terms and definitions

0x1
See Ring (0x1) Low-Speed Interface.

1+1
The 1+1 protection switching architecture protects against failures of the optical transmit/receive 
equipment and their connecting fiber facility. One bidirectional interface (two fibers plus associated 
OLIUs on each end) is designated "service," and the other is designated "protection." In each 
direction, identical signals are transmitted on the service and protection lines ("dual-fed"). The 
receiving equipment monitors the incoming service and protection lines independently, and selects 
traffic from one line (the "active" line) based on performance criteria and technician/OS control. In 
1+1 both service and protection lines could be active at the same time (service in one direction, 
protection in the other).

1xN, 1x1
1xN protection switching pertains to circuit pack protection that provides a redundant signal path 
through the Alcatel-Lucent 1665 Data Multiplexer (Alcatel-Lucent 1665 DMX) (it does not cover 
protection switching of an optical facility; se "1+1"). In 1xN switching, a group of N service circuit 
packs share a single spare protection circuit pack. 1x1 is a special case of 1xN, with N=1. In 1x1 
only one is active at a time. 

1GE
Gigabit Ethernet - 1.250 Gbps line rate.

............................................................................................................................................................................................................................................................

A

Active
Active identifies a 1+1 protected OC-N line which is currently selected by the receiver at either end 
as the payload carrying signal or a 1x1 or 1xN protected circuit pack that is currently carrying 
service. (See Standby).

AGNE - Alarm Gateway Network Element
A defined NE in an alarm group through which members of the alarm group exchange information.
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AIS - Alarm Indication Signal
A code transmitted downstream in a digital network that shows that an upstream failure has been 
detected and alarmed. 

AMI - Alternate Mark Inversion
A line code that employs a ternary signal to convey binary digits, in which successive binary ones 
are represented by signal elements that are normally of alternating, positive and negative polarity 
but equal in amplitude, and in which binary zeros are represented by signal elements that have zero 
amplitude.

ASCII - American Standard Code for Information Interchange 
A standard 8-bit code used for exchanging information among data processing systems and 
associated equipment.

Auto
One possible state of a service interface port. In this state, the port will automatically be put "in 
service" if a good incoming signal is detected on the port.

Automatic Protection Switch
A feature that allows another synchronization source to be automatically selected and the 
synchronization source provisioning to be automatically reconfigured in the event of a 
synchronization source failure or network synchronization change, for example, a fiber cut.

Available Time
In performance monitoring, the 1-second intervals.

............................................................................................................................................................................................................................................................

B

B3ZS - Bipolar 3-Zero Substitution
A line coding method that replaces a string of three zeros with a sequence of symbols having some 
special characteristic.

B8ZS - Bipolar 8-Zero Substitution
A line coding method that replaces a string of eight zeros with a sequence of symbols having some 
special characteristic.

Backbone Ring
A host ring.

BER - Bit Error Ratio
The ratio of bits received in error to the total bits sent.

BIP - Bit Interleaved Parity 
A method of error monitoring over a specified number of bits, that is BIP-3 or BIP-8.

BITS - Building Integrated Timing Supply 
A single clock that provides all the DS1 and DS0 synchronization references required by clocks in 
a building.
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Broadband
Any communications channel with greater bandwidth than a voice channel; sometimes used 
synonomously with wideband. Also refers to signals at the DS3 (44.736 Mb/s) and higher. 
Wideband refers to lower rates (i.e. DS1, VT1.5, etc.).

............................................................................................................................................................................................................................................................

C

CC - Clear Channel
A provisionable mode for the DS3 output that causes parity violations not to be monitored or 
corrected before the DS3 signal is encoded.

CCITT - International Telephone and Telegraph Consultative Committee
An international advisory committee under United Nations’ sponsorship that has composed and 
recommended for adoption worldwide standards for international communications. Recently 
changed to the International Telecommunications Union Telecommunications Standards Sector 
(ITU-TSS).

Channel
A logical signal within a port. For example, for an EC-1 port, there is one STS-1 channel and 
sometimes 28 VT1.5 channels. See Port.

Channel State Provisioning
A feature that allows a user to suppress reporting of alarms and events during provisioning by 
supporting multiple states (automatic, in-service and not monitored) for VT1.5 and STS-1 channels. 
See Port State Provisioning.

CV - Coding Violation
A performance monitoring parameter.

CVFE - Coding Violation Far-End
An indication returned to the transmitting terminal that an errored block has been detected at the 
receiving terminal.

............................................................................................................................................................................................................................................................

D

DACS III-2000
Digital Access and Cross-Connect System that provides clear channel switching at either the DS3 
or the STS-1 rates, eliminating the need for manual DSXs.

DACS IV-2000
Digital Access and Cross-Connect System that provides electronic DS3/STS-1 or DS1/VT1.5 
cross-connect capability, eliminating the need for manual DSXs.

DCC - Data Communications Channel
The embedded overhead communications channel in the SONET line. It is used for end-to-end 
communications and maintenance. It carries alarm, control, and status information between 
network elements in a SONET network.
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DCE - Data Communications Equipment
In a data station, the equipment that provides the signal conversion and coding between the data 
terminal equipment (DTE) and the line. The DCE may be separate equipment or an integral part of 
the DTE or of intermediate equipment. A DCE may perform other functions usually performed at 
the network end of the line.

DDM-2000
Lucent’s first generation SONET multiplexers that multiplex DS1, DS3, or EC-1 inputs into EC-1, 
OC-1, OC-3, or OC-12 outputs. 

Default Provisioning
The parameter values that are preprogrammed as shipped from the factory.

Demultiplexing
A process applied to a multiplexed signal for recovering signals combined within it and for restoring 
the distinct individual channels of these signals.

DEMUX - Demultiplexer
The DEMUX direction is from the fiber toward the DSX.

Digital Multiplexer
Equipment that combines time-division multiplexing several digital signals into a single composite 
digital signal. 

DRI - Dual Ring Interworking
Two ring networks interconnected at two common nodes.

Drop and Continue
A technique that allows redundant signal appearances at two central offices in a DRI network, 
allowing protection against central office failures.

DS1
Digital Signal Level 1 (1.544 Mb/s).

DS1(28) Circuit Pack
The DS1(28) circuit pack interfaces to the DSX-1 panel.

DS3
Digital Signal Level 3 (44.736 Mb/s).

DS3/EC-1 Circuit Pack
The DS3/EC-1 circuit pack interfaces to the DSX-3 panel.

DSn - Digital Signal Rate n
One of the possible digital signal rates at Alcatel-Lucent 1665 DMX interfaces: DS1 (1.544 Mb/s) 
or DS3 (44.736 Mb/s).

DSNE - Directory Services Network Element
A designated network element that is responsible for administering a database that maps network 
element names (TIDs) to addresses (NSAPs - network service access points) in an OSI subnetwork. 
There can be one DSNE per ring. Can also be a GNE.
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DSX - Digital Cross-Connect Panel
A panel designed to interconnect to equipment that operates at a designated rate. For example, a 
DSX-3 interconnects equipment operating at the DS3 rate.

DTE - Data Terminating Equipment
That part of a data station that serves as a data source (originates data for transmission), a data sink 
(accepts transmitted data), or both.

Dual Homing
A network topology in which two Alcatel-Lucent 1665 DMX serve as hosts supporting up to 16 
OC-3 rings or 4 OC-12 rings. Each OC-3 and OC-12 ring is interconnected between the two 
separate hosts.

DWDM
Dense Wave Division Multiplexer

............................................................................................................................................................................................................................................................

E

EC-1, EC-n - Electrical Carrier
The basic logical building block signal with a rate of 51.840 Mb/s for an EC-1 signal and a rate of 
n times 51.840 Mb/s for an EC-n signal. An EC-1 signal can be built in two ways: A DS1 can be 
mapped into a VT1.5 signal and 28 VT1.5 signals multiplexed into an EC-1 (VT1.5 based EC-1), 
or a DS3 can be mapped directly into an EC-1 (DS3 based EC-1).

ECI - Equipment Catalog Item
The bar code number on the faceplate of each circuit pack used by some inventory systems.

ES - Errored Seconds
A performance monitoring parameter. 

ESF - Extended Super Frame
The format for a DS1 signal.

............................................................................................................................................................................................................................................................

F

FC100
Fibre Channel 100 Mbps interface

FC400

Fibre Channel 400 Mbps interface

FE - Far End
Any other network element in a maintenance subnetwork other than the one the user is at or working 
on. Also called remote.

FE ACTY - Far End Activity
An LED on the SYSCTL circuit pack faceplate.
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FEBE - Far End Block Error
An indication returned to the near-end transmitting node that an errored block has been detected at 
the far end.

FEPROM - Flash EPROM
Nonvolatile Electrically-erasable Programmable Read-Only Memory.

FERF - Far End Receive Failure
An indication returned to the transmitting terminal that the receiving terminal has detected an 
incoming section failure.

FE SEL - Far End Select
An LED on the faceplate of the SYSCTL circuit pack.

FICON 
FICON is equivalent to Fibre Channel throught layers 1-3.

FICON_EXP

FIT
Failures in 109 hours of operation.

Free Running
An operating condition of a clock in which its local oscillator is not locked to an internal 
synchronization reference and is using no storage techniques to sustain its accuracy.

FT-2000
Lucent’s SONET OC-48 Lightwave System.

Function Unit
Refers to any one of a number of different circuit packs that can reside in the A, B, C, or D function 
unit slots on the Alcatel-Lucent 1665 DMX.

............................................................................................................................................................................................................................................................

G

GNE - Gateway Network Element
A network element that has an active X.25 link. Can also be a DSNE.

............................................................................................................................................................................................................................................................

H

Hairpin Routing
A cross-connection between function units (inter-function unit). For example, function unit C to 
function untis A, B, or D. Also, a cross-connection within the same function unit (intra-function 
unit). Cross-connections go through Main, but no bandwidth or time slots are taken from the 
backbone ring. Eliminates need for another shelf.
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Holdover
An operating condition of a network element in which its local oscillator is not locked to any 
synchronization reference but is using storage techniques to maintain its accuracy with respect to 
the last known frequency comparison with a synchronization reference.

............................................................................................................................................................................................................................................................

I

IC - Internal Clock
Used in synchronization messaging.

ID
See shelf ID and site ID.

IR - Intermediate Reach
A term used to describe distances of 15 to 40 km between optical transmitter and receiver without 
regeneration. See long reach.

IS - In Service
One possible state of a DS1, DS3, or EC-1 port. Other possible states are "auto" (automatic) and 
"nmon" (not monitored).

............................................................................................................................................................................................................................................................

J

Jitter
Timing jitter is defined as short-term variations of the significant instants of a digital signal from 
their ideal positions in time.

............................................................................................................................................................................................................................................................

L

LBO - Line Build Out
An equalizer network between the Alcatel-Lucent 1665 DMX and the DSX panel. It guarantees the 
proper signal level and shape at the DSX panel.

LED - Light Emitting Diode
Used on a circuit pack faceplate to show failure (red) or service state. It is also used to show the 
alarm and status condition of the system.

Line Timing
The capability to directly derive clock timing from an incoming OC-N signal while providing 
theuser the capability to provision whether switching to an alternate OC-N from a different source 
(as opposed to entering holdover) will occur if the OC-N currently used as the timing reference for 
that NE becomes unsuitable as a reference. For example, intermediate nodes in a linear network are 
line timed. See Loop Timing.

Local
See Near-End.
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Locked Cross-Connection
This is a variation of the ring cross-connection that allows the user to lock the path selector to a 
specified rotation of the ring. Any signal received from the other rotation of the ring is ignored.

LOF - Loss of Frame
A failure to synchronize to an incoming signal.

Loop Timing
Loop timing is a special case of line timing. It applies to NEs that have only one OC-N interface. 
For example, terminating nodes in a linear network are loop timed. See Line Timing.

LOP - Loss of Pointer
A failure to extract good data from an STS-1 payload.

LOS - Loss of Signal
The complete absence of an incoming signal.

LR - Long Reach
A term used to describe distances of 40 km or more between optical transmitter and reciever without 
regeneration. See Intermediate Reach.

............................................................................................................................................................................................................................................................

M

Main
The two slots (M-1 and M-2) on the Alcatel-Lucent 1665 DMX shelf in which the OC-48 OLIU 
circuit packs are installed.

Midspan Meet
The capability to interface between two lightwave terminals of different vendors. This applies to 
high-speed optical interfaces.

Multiplexing
The process of combining several distinct digital signals into a single composite digital signal.

Mult - Multipling
The cascading of signals in a bay. In the MULT mode, the DS1 external reference can be cascaded 
to other shelves in a bay using Mult cables. Normally starting with the bottom shelf (Number 1) and 
working towards the top of the bay.

............................................................................................................................................................................................................................................................

N

NE - Near End
The network element the user is at or working on. Also called local.
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NE - Network Element
The basic building block of a telecommunications equipment within a telecommunication network 
that meets SONET standards. Typical internal attributes of a network element include: onr or more 
high- and low-speed transmission ports, built-in intelligence, synchronization and timing 
capability, and access interfaces for use by technicians and/or operation systems. In addition, a 
network element may also include a time slot interchanger.

NE ACTY - Near End Activity
An LED on the faceplate of the SYSCTL circuit pack.

NMA - Network Monitoring and Analysis
An operations system designed by Telcordia Technologies which is used to monitor network 
facilities.

NMON - Not Monitored
A provisioning state for equipment that is not monitored or alarmed.

Node
In SONET, a node is a line terminating element.

Non-Revertive
A protection switching mode in which, after a protection switch occurs, the equipment remains in 
its current configuration after any failure conditions that caused a protection switch to occur clear 
or after any external switch commands are reset. See Revertive.

NSAP - Network Services Access Point
An address that identifies a network element. Used for maintenance subnetwork communication 
using the OSI protocol.

............................................................................................................................................................................................................................................................

O

OC, OC-n - Optical Carrier
The optical signal that results from an optical inversion of an STS signal; that is, OC-1 from STS-
1 and OC-n from STS-n.

OC-1
Optical Carrier Level 1 Signal (51.844 Mb/s).

OC-3
Optical Carrier Level 3 Signal (155 Mb/s).

OC-3c (STS-3c)
Optical Carrier Level 3 Concatenated Signal. Low-speed broadband equivalent to three STS-1s 
linked together with a single path overhead.

OC-12
Optical Carrier Level 12 Signal (622 Mb/s).

OC-12c (STS-12c)
Optical Carrier Level 12 Concatenated Signal. High-speed broadband equivalent to twelve STS-1s 
linked together with a single path overhead.
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OC-48
Optical Carrier Level 48 Signal.

Operations Interface
Any interface that provides information on the system performance or control. These include the 
equipment LEDs, SYSCTL faceplate, and office alarms.

OS - Operations System
A central computer-based system used to provide operations, administration, and maintenance 
functions.

OSI - Open Systems Interconnection
Referring to the OSI reference model, a logical structure for network operations standardized by the 
Internation Standards Organization (ISO).

OSGNE - Operations System Gateway Network Element
An OSGNE serves as a single interface to the OS for NEs in the same subnetwork using X.25 
interfaces.

............................................................................................................................................................................................................................................................

P

Pass Through
Paths that are cross-connected directly across an intermediate node in a ring network.

Plesiochronous Network
A network that contains multiple maintenance subnetworks, each internally synchronous and all 
operating at the same nominal frequency, but whose timing may be slightly different at any 
particular instant. For example, in SONET networks, each timing traceable to their own Stratum 1 
clock are considered plesiochronous with respect to each other.

PM - Performance Monitoring
Measures the quality of service and identifies degrading or marginally operating systems (before an 
alarm would be generated).

Port
The physical, electrical, or optical interface on a system. For example, DS1, DS3, EC-1, OC-3, OC-
12, and OC-48. See Channel.

Port State Provisioning
A feature that allows a user to supress alarm reporting and performance monitoring during 
provisioning by supporting multiple states (automatic, in-service, and not monitored) for low-speed 
ports. See Channel State Provisioning.

Proactive Maintenance
Refers to the process of detecting degrading conditions not severe enough to initiate protection 
switching or alarming, but indicative of an impending signal fail or signal degrade defect (for 
example, performance monitoring).
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Protection Line
As defined by the SONET standard, the protection line is the pair of fibers (one transmit and one 
receive) that carry the SONET APS channel (K1 and K2 bytes in the SONET line overhead). On a 
Alcatel-Lucent 1665 DMX, a protection line is a pair of fibers that terminate an OLIU circuit pack 
in the Main-2, A-2, B-2, C-2, D-2, or G-2 slots. See Service Line.

Product Family 2000
Lucent’s first line of SONET standard network products providing total network solutions.

............................................................................................................................................................................................................................................................

R

Reactive Maintenance
Refers to decting defects/failures and clearing them.

Remote
See Far-End (FE).

Revertive
A protection switching mode in which, after a protection switch occurs, the equipment returns to 
the nominal configuration (that is, the service equipment is active, and the protection equipment is 
standby) after the clearing of any failure conditions that caused a protection switch to occur or after 
any external switch commands are reset. See Non-Revertive.

Ring
A configuration of nodes comprised of network elements connected in a circular fashion. Under 
normal conditions, each node is interconnected with its neighbor and includes capacity for 
transmission in either direction between adjacent nodes. Path switched rings use a head-end bridge 
and tail-end switch. Line switched rings actively reroute traffic over a protection line. 

Ring (0x1) Low-Speed Interface
Formerly referred to as dual 0x1 or single 0x1. In ring applications, the Alcatel-Lucent 1665 DMX 
may use a 0x1 interface, meaning both fibers carry service, as opposed to a linear (1+1) low-speed 
interface where one fiber is used for service and other for protection. See 1+1.

RPP - Reliability Prediction Procedure
Described in Telcordia Technologies TR-NWT-00032.

RT - Remote Terminal
An unstaffed equipment enclosure that may have a controlled or uncontrolled environment.

............................................................................................................................................................................................................................................................

S

Self-Healing
Ring architecture in which two or more fibers are used to provide route diversity. Node failures only 
affect traffic dropped at the failed node.

SEO - Single-Ended Operations
The maintenance capability that provides remote access to all Alcatel-Lucent 1665 DMX systems 
from a single location over the DCC.
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Service Line
On a Alcatel-Lucent 1665 DMX, a service (or "working") line is a pair of fibers (one transmit and 
one receive) that terminate on an OLIU circuit pack in the Main-1, A-1, B-1, C-1, or D-1 slots. As 
defined by the SONET standard, the SONET APS channel is not defined on a service line. See 
Protection Line.

SES - Severely Errored Seconds
This performance monitoring parameter is a second in which a signal fail occurs, or more than a 
preset amount of coding violations (dependent on the type of signal) occurs.

SF - Super Frame
The format for DS1 signals.

Small Form Pluggable (SFP)Optics
SFP optics are used on the LNW37/45/49/70/73/74 packs. SFP optics are “pluggable" optics. This 
means that the circuit pack does not come equipped with optics. The customer orders the number 
and type of optics required at the time of installation. Additional optics can be ordered as new 
services are required. Thus Alcatel-Lucent 1665 DMX interface density is made scalable to meet 
the unique needs of each customer. The SFP optics also allow for some versatility in the span 
lengths and rates that can be covered by the same pack. The SFP optics adhere to Telcordia GR-253 
and ITU G.957 standards.

Single 0x1 Cross-Connection
In a dual-homed application, the Alcatel-Lucent 1665 DMX uses a single 0x1 cross-connection to 
map the VT1.5 channels between the DDM-2000 FiberReach, OC-3 Multiplexer, or OC-12 
Multiplexer and the Alcatel-Lucent 1665 DMX rings. This single 0x1 architecture maps low speed 
to high speed on a specified ring rotation. The high speed to low speed drop is made on the same 
specified ring with no path switching. Protection is provided at the VT1.5 end points.

Single Homing
A network topoly in which a single DDM-2000 FiberReach, OC-3 Multiplexer, or OC-12 
Multiplexer serves as a Alcatel-Lucent 1665 DMX host supporting up to six OC-3 or OC-12 rings. 

Standby
Standby identifies a 1+1 protected OC-N line which is not currently selected by the receiver at 
either end as the payload carrying signal, or 1x1 or 1xN protected circuit pack that is not currently 
carrying service. See Active.

Status
The indication of a short-term change in the system.

STS, STS-n - Synchronous Transport Signal
The basic building block signal with a rate of 51.840 Mb/s for an STS-1 signal and a rate of n times 
51.840 Mb/s for an STS-n signal.

STS-1 SPE - STS-1 Synchronous Payload Envelope
A 125-microsecond frame structure composed of STS path overhead and the STS-1 payload.

STS-3c 
Synchronous Transport Level 3 Concatenated Signal. See OC-3c.
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Subnetwork
Group of SONET network elements that share a SONET data communications channel.

Synchronization Messaging
SONET synchronization messaging is used to communicate the quality of network timing, internal 
timing status, and timing states throughout a subnetwork.

SYSCTL - System Controller
The system controller circuit pack that provides overall administrative control of the terminal.

............................................................................................................................................................................................................................................................

T

T1X1 and T1M1
The ANSI committees responsible for telecommunications standards.

TCA - Threshold Crossing Alert
A condition set when a performance monitoring counter exceeds a user-selected threshold. A TCA 
does not generate an alarm but is available on demand through the CIT and causes a message to be 
sent to NMA via the X.25/TL1 interface.

TL1 - Transaction Language 1
A Telcordia Technologies machine-to-machine communications language that is a subset of ITU-
TSS, formerly CCITT’s, human-machine language.

............................................................................................................................................................................................................................................................

U

UAS - Unavailable Seconds
In performance monitoring, the count of seconds in which a signal is declared failed or, in which, 
10 consecutively severely errored seconds (SES) occurred, until the time when 10 consecutive non-
SES occur.

Unidirectional
A protection switching mode in which the system at each end of an optical span monitors both 
service and protection lines and independently chooses the best signal (unless overridden by an 
equipment failure or by an external request, such as a forced switch or lockout). In a system that 
uses unidirectional line switching, both the service and protection lines may be active 
simultaneously, with one line carrying traffic in one direction and other line carrying traffic in the 
other direction. For a 1+1 protection scheme the K1 and K2 bytes in the SONET line overhead are 
used to convey to the far end which line the near-end receiver has chosen, so that an "active" 
indication may be made at the far end.

UOC - Univeral Optical Connector
Receptacles on the faceplate of some OLIUs that accept ST, SC, or FC connectors.

UPD/INIT
A push-button on the SYSCTL faceplate.
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V

VM - Violation Monitor
A mode of the DS3 circuit pack in which it will monitor but not remove P-bit parity violations on 
the DS3 signal from the received fiber.

VMR - Violation Monitor and Removal
A mode of the DS3 circuit pack in which it will monitor and remove P-bit parity violations on the 
DS3 signal received from the fiber.

VT - Virtual Tributary
A structure designed for transport and switching of a sub-DS3 payload.

VT1.5
A 1.728 Mb/s virtual tributary.

VT-G - Virtual Tributary Group
A 9-row by 12-column SONET structure (108 bytes) that carries one or more VTs of the same size. 
Seven VT groups (756 bytes) are byte-interleaved within the VT-organized STS-1 synchronous 
payload envelope

............................................................................................................................................................................................................................................................

Z

Zero Code Suppression
A technique used to reduce the number of consecutive zeros in a line-codes signal (B3ZS for DS3 
signals and B8ZS for DS1 signals).
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Alarm Cut-Off (ACO), 7-4, 7-5
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alarm reporting, 7-6

alarm status indications
user settable, 3-57

alarm(s)
critical (CR), 3-57, 7-3, 7-5

default delay time, 7-4

environmental, 3-57

fan shelf, 7-6, 8-10

LED, 7-6

major (MJ), 3-57, 7-3, 7-5
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office, 7-2, 7-4, 8-2, 9-2

Alternate Mark Inversion (AMI), 
7-11

automatic protection switch, 7-6, 
8-10
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B battery distribution fuse board 
(BDFB), 2-10, 2-15, 2-16, 
2-17, 2-18

bay frame ground, 1-4

bipolar 8 zero substitution 
(B8ZS), 7-11

BITS clock, 7-10
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10/100Base-T, 3-32

1000Base-T, 3-64, 3-65, 3-66

1000Base-T optical fiber
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1000Base-T,
3-65, 3-66,
3-67

CIT interface, I-5, II-2, III-2

discrete cables, 3-57

DS1, 3-7, 3-8, 3-10, 3-15, 
3-26

DS1 color codes, 3-10

DS3/EC-1, 3-14, 3-25

DS3/EC-1 cable connections, 
3-18, 3-19, 3-20, 3-29, 3-30

environmental, 3-57

IAO LAN/TCP-IP, 3-39

miscellaneous discrete, 3-57

modem, 3-43, 3-44

OC-3, 3-62, 3-63, 3-64

OC-48, 3-62

OC-48 optical fiber, 3-61

office alarm, 3-51, 3-53, 
3-54, 6-5

office alarm connections, 
3-56, 3-57

optical fiber, 3-62, 3-63, 
3-64, 3-65, 3-66

power, 2-15, 2-17

power cable, 4-2

SYNC, 3-48

SYNC cable connections, 
3-51

cabling
checklist, 2-3, 3-2

power, 2-15

central office (CO), 3-51, 3-57

CIT
interface cable, II-2, III-2

serial port, 3-67

software, 5-6

CIT Interface Cable, I-6

CIT interface cable, I-5, II-2, 
III-2

CLETOP cleaning cassette, I-5, 
A-2

coaxial wire stripper, I-3

commands, 7-9, 8-12, 8-13

connectors
DB-15 pinouts, 3-5

DB-25 pinouts, 3-5

DB-62 pinouts, 3-5

DB-9 pinouts, 3-5

pinouts, 3-5

RJ-45 pinouts, 3-5

crimping tool, I-3

critical alarm (CR), 3-57, 7-3, 7-5

cross-connect tests, 6-6
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cross-connects, 6-6
VT1.5, 6-6

D DB-15 connector pinouts, 3-5

DB-25 connector pinouts, 3-5

DB-62 connector pinouts, 3-5

DB-9 connector pinouts, 3-5

discrete, 3-57

DS1
cable assemblies, 3-7, 3-8, 

3-10, 3-15, 3-26

DS1 error rate test set, I-3, II-2, 
III-2

DS1 timing reference, 3-50

DS3 error rate test set, I-4, II-2, 
III-2

DS3/EC-1
cables, 3-14, 3-25

DSX, 3-7, 3-10, 3-14, 3-26, 6-6

DSX cabling, 6-6

E EIA-type bay frame
network bay frame

EIA-type, 2-2

Electrostatic Discharge (ESD), 
1-3

environmental alarm, 3-57

environmental discrete, 3-57, 
7-14, 7-16

ESD
damage, 1-4

electronic components, 1-4

jack, I-3, II-2, III-2

wrist strap, 1-4, 1-5, I-3, II-2, 
7-3, 7-6, III-2, 8-10

Extended superframe (ESF), 7-11

external buffer relay, 3-51

F fan alarm, 7-6, 8-10

...........................................................................

...........................................................................

...........................................................................

...........................................................................

FDA/CDRH, 1-1
21 CFR 1040.10 and 

1040.11, 1-1

FDA/CDRH regulations, 1-9

fiber cleaning, A-1
acceptable criteria, A-8

function group, 7-5

function unit, 7-5, 8-13

G ground, I-3, 2-7
bay frame, 1-4

I IAO LAN/TCP-IP
cabling, 3-39

IEC
60825-1, 1-1

IEC requirements, 1-9

J jumper(s)
optical fiber, I-4, II-2, 6-36, 

6-37, 6-38, 6-40, 6-41, 
6-45, 6-48, III-2

L labels
laser safety, 1-2

Laser, 1-10

laser
classes, 1-10

DMX optical specifications, 
1-10

product classifications, 1-9

radiation, 7-2, 8-2, 9-2

safety, 1-1

laser radiaition, 3-65, 3-66

laser radiation, 3-61, 3-63, 3-65, 
3-66, 6-6, 7-7, 8-3, 9-3, A-3

LBO, I-4, II-2, III-2, B-2, B-3

LBO Table, 8-5, 9-19

LC Block, B-3

...........................................................................

...........................................................................

...........................................................................

LC-type connector port, B-2

LC-type fiber connectors, B-4

LED, 7-6, 8-10

LGX, 3-61, 3-62, 3-64, 3-66

line coding, 7-11

local equipment tests, 6-6

Luminex Stick port cleaners, I-5, 
A-3

M major alarm (MJ), 3-57, 7-3, 7-5

minor alarm (MN), 3-57, 7-3, 
7-4

miscellaneous discrete, 7-14, 
7-16

modem, 3-43, 7-17
cable, 7-18

modem cable, 3-44

mult office alarms, 3-54

multi, 4-14

multimeter, I-3, II-2, III-2

N network bay frame, 2-2
seismic, 2-2

O OC-3
optical fiber cables, 3-62, 

3-63, 3-64

OC-48
optical fiber cables, 3-61, 

3-62

office alarm, 3-51, 3-54, 7-2, 
7-4, 8-2, 9-2

alarm(s)

office, 7-2, 7-3

cable, 3-51, 7-2, 8-2, 9-2

connections, 3-56, 3-57, 7-2

mult, 3-54

relay contacts, 3-51

test, 7-3
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office alarm cable, 3-53, 3-54, 
6-5

office alarm panel, 3-53, 3-54

ohmmeter, I-3

optical attenuators, B-2

optical fiber scope, I-4, A-2

out-of-service mode, 7-2, 8-2, 
9-2

P Personal Computer (PC), II-2, 
III-2

CIT requirements, I-5, I-6

pinouts
connectors, 3-5

power
cables, 4-2

power cable, 2-15, 2-17

product disposal, xxiv

product take-back, xxiv

protection network, 3-53

protection switching, 7-1
automatic, 7-6, 8-10

R recycle, xxiv

remote terminal (RT), 3-57

RJ-45 connector pinouts, 3-5

S safety
instructions, 1-6, A-3

laser, 1-1

laser instructions, 1-3

laser warning labels, 1-2

screwdriver(s), I-3, II-2, III-2

seismic network bay frame, 2-2

serial port, 3-67

single-mode fiber, 3-61

standards

.............................................................................

Pacific Bell Equipment 
Framework Standard PBS-
000-102PT, 2-2

Superframe (SF), 7-11

SYNC cable, 3-48
cable(s)

SYNC, 3-46

SYNC cables
DS1 timing, 3-51

synchronization cable 
connections, 3-51

timing, 3-51

T telemetry, 3-57, 7-14
connections, 7-16

telemetry panel, 3-59

test equipment
CIT interface cable, I-5

DS1 error rate test set, I-3, 
II-2, III-2

DS3 error rate test set, I-4, 
II-2, III-2

LBO, II-2, III-2

multimeter, I-3

ohmmeter, I-3

optical fiber jumpers, I-4, 
II-2, III-2

optical fiber scope, I-4, A-2

Personal Computer (PC), II-2, 
III-2

video fiber scope, I-4, A-2

timing
DS1, 3-51

external sync, 3-50

tools
CLETOP cleaning cassette, 

I-5, A-2

coaxial wire stripper, I-3

crimping, I-3

Luminex Stick port cleaners, 
I-5, A-3

.............................................................................
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screwdriver(s), I-3, II-2, III-2

torque wrench, I-3

wire-wrap gun, I-3

torque wrench, I-3

transient currents, 3-51

transient voltages, 3-51

V video fiber scope, I-4, A-2

VT1.5
cross-connects, 6-6

W wire-wrap gun, I-3

wrist strap
ESD, 1-4, 1-5, I-3, II-2, 7-3, 

7-6, III-2, 8-10
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